SoftMax® Pro
User’s Manual

Version 4.3 Software
for Macintosh® and Windows®

Molecular Devices
Molecular Devices Corporation
Sunnyvale, California 94089

Part # 5900-0328
Rev. A
Molecular Devices Corporation

SoftMax® Pro User’s Manual

COPYRIGHT

© Copyright 2002, Molecular Devices Corporation. All rights reserved. No part of this publication may be reproduced, transmitted, transcribed, stored in a retrieval system, or translated into any language or computer language, in any form or by any means, electronic, mechanical, magnetic, optical, chemical, manual, or otherwise, without the prior written permission of Molecular Devices Corporation.

TRADEMARKS AND PATENTS

FlexStation, FLIPR, SoftMax, SpectraMax, and Vmax are registered trademarks and Automix, Emax, PathCheck, ThermoMax, UVmax, and VersaMax are trademarks of Molecular Devices Corporation. All other trademarks or registered trademarks are the property of their respective owners.

Automix is covered by U.S. Patent Number 5,112,134; PathCheck is covered by U.S. Patent Number 5,959,738.

These trademarks are not to be used in any type of promotion or advertising without written permission from Molecular Devices Corporation.

DISCLAIMER

Molecular Devices Corporation reserves the right to change its products and services at any time to incorporate technological developments. This manual is subject to change without notice.

Although this manual has been prepared with every precaution to ensure accuracy, Molecular Devices Corporation assumes no liability for any errors or omissions, nor for any damages resulting from the application or use of this information. This manual does not represent a commitment on the part of Molecular Devices Corporation. The software described in this document is furnished under a license agreement or nondisclosure agreement. The software may be used or copied only in accordance with the terms of the agreement. It is against the law to copy the software on any medium except as specifically allowed in the license or nondisclosure agreement.
SOFTMAX PRO LICENSE AGREEMENT AND WARRANTY

Important: Please read this license agreement carefully before opening the software package. The right to use this Molecular Devices Corporation (“MDC”) software is sold only on the condition that the user agrees to the terms of this license agreement. If you do not agree to the terms of this license, you may return the unopened package to MDC or its authorized agent for a full refund. However, opening the software package indicates your acceptance of these terms and conditions.

LICENSE AGREEMENT

In consideration of payment of the license fee, which is part of the purchase price you paid for this product, Molecular Devices Corporation (“MDC”), the licensor, hereby grants a non-exclusive license to you, the Licensee (“User”), to use SoftMax Pro and its utilities (“Software”) included with SoftMax Pro upon license. The user is licensed to copy the software for a backup or archival copy as necessary. Simultaneous use of the software with more than one MDC Microplate Reader System per license is expressly prohibited. Simultaneous use of the software on four (4) computers solely for the purpose of analyzing already acquired data is expressly permitted. The user is expressly prohibited from using the software to control any other instrument, computing hardware, or peripherals other than MDC Microplate Systems.

This license agreement does not grant the user title to the software, or any copyrights of proprietary rights in the software. The user may not sublicense, rent, lease, modify, translate, decompile, or disassemble the software for any purpose. The User, however, does own the media on which the software is originally or subsequently recorder or fixed. MDC retains title and ownership of the software recorded on the original disc and all subsequent copies of the software, regardless of the form or media in or on which the original and other copies may exist. This license is not a sale of the original software or any copy.

LIMITED WARRANTY

MDC warrants that the disc on which the program is furnished is free of defects in materials and workmanship and will operate under normal use for a period of 90 days from the date of delivery. Except as provided above, the Software is provided “as is” without additional warranties of any kind either express or implied, including, but not limited to, any implied warranty of merchantability or fitness for a particular purpose. The entire risk as to the quality and performance of the Software is the User’s. MDC does not warrant that the functions contained in the Software will meet the User’s requirements nor that the operation of the program will be uninterrupted or error free. Some states do not allow the exclusion of implied warranties and, therefore the above exclusion may not apply to you.

LIMITATION OF REMEDIES

MDC’s entire liability and the User’s only remedy with respect to the Limited Warranty set forth above is:

1) The replacement of any discs not meeting the Limited Warranty set forth above, provided such discs are returned to MDC with evidence of date of purchase; or

2) If MDC is unable to deliver a replacement disc which is free of defects in materials and workmanship, the user may terminate this license agreement upon return of all materials including manual and disc(s) to MDC for a full refund of the purchase price.

In no event will MDC be liable to the User for any damages, including any lost profits, lost savings, or other incidental or consequential damages arising out of the use or inability to use the software even if MDC has been advised of the possibility of such damages, or for any claim by another party. Some states do not allow the limitation or exclusion of liability for incidental or consequential damages so the above limitations or exclusions may not apply to you.
CLARIFICATION

Life Science Edition

SoftMax Pro for Life Sciences is licenced to one MDC microplate reader system. Simultaneous use of the software with more than one microplate reader is expressly prohibited. Simultaneous use of the software on three (3) additional computers (in addition to the computer controlling the instrument, if applicable) solely for the purpose of analyzing previously-acquired data is expressly permitted.

Drug Discovery Edition

SoftMax Pro for Drug Discovery is licenced to one MDC microplate reader system. Simultaneous use of the software with more than one microplate reader is expressly prohibited. Simultaneous use of the software on three (3) additional computers (in addition to the computer controlling the instrument, if applicable) solely for the purpose of analyzing previously-acquired data is expressly permitted.

Enterprise Edition

SoftMax Pro Enterprise is sold as a site license. A license for each reader-connected computer and analysis-seat computer needs to be purchased.

Additional software licenses can be purchased by calling our Customer Service department at (800) 635-5577

DURATION AND TERMINATION

The License is effective from the date of the first use of the Software by the User until terminated or until the expiration of fifty years, whichever comes first. The User may terminate the License by returning to MDC all Software documentation, the original Software, all backup and archival copies of the Software, and all demonstration copies of the Software. The License agreement will terminate automatically without notice from MDC if the User fails to comply with any provision of this License Agreement. It is incumbent upon the User to take all reasonable measures to effect termination only in accordance with this License Agreement.

GENERAL

1) This License Agreement shall be governed by the laws of the State of California.

2) The provisions of this License Agreement are severable and if any one or more of such provisions are judicially determined to be illegal or otherwise unenforceable, whether in whole or in part, those remaining provisions or portions of the License Agreement unaffected by such determination shall be binding on and enforceable by and between the User and MDC.

3) In the event it becomes necessary to retain the services of an attorney to enforce any provisions of this License Agreement, the non-prevailing party to such legal action and/or litigation agrees to pay the prevailing party’s costs, including reasonable attorney’s fees and court costs, if any.

4) The User acknowledges that by opening the media package the User has read this License Agreement, understands it, and agrees to be bound by its terms and conditions. The User further agrees that this License Agreement constitutes the full and complete agreement between the User and MDC with respect to the Software and the License, which agreement supersedes any proposal or prior agreement, whether oral or written, and any other communication between the User and MDC relating to this License Agreement.
# Contents

Figures ................................................................. 1-xi  
Tables ................................................................. 1-xix

Chapter 1: Welcome to SoftMax Pro .......................... 1-1  
  Introduction ......................................................... 1-3  
  New to SoftMax Pro? ............................................. 1-4  
  What’s New in SoftMax Pro Version 4.3 ................. 1-4  
  About the Documentation .................................... 1-6  
  Conventions Used in This Manual ......................... 1-7  
  Getting Help ....................................................... 1-9  
  Macintosh On-Line Help ...................................... 1-9  
  Windows On-Line Help ......................................... 1-10  
  Troubleshooting and Technical Support .................... 1-12

Chapter 2: Installation ............................................. 2-1  
  Connect the Hardware .......................................... 2-3  
  Connecting to a Macintosh .................................... 2-3  
  Computer System Requirements ............................ 2-6  
    Macintosh Computer ........................................ 2-6  
    Windows-Compatible Computer ............................ 2-7  
  Install SoftMax Pro ............................................. 2-8  
    What Is Installed ............................................ 2-9  
  Enter Registration Information ............................ 2-13  
  Communicating with the MDC Microplate System Instrument 2-15  
  Set Preferences .................................................. 2-16  
    Serial Port .................................................... 2-16  
    Export Format ................................................ 2-17  
    Reader .......................................................... 2-18  
    Filters ......................................................... 2-19  
    Autosave ....................................................... 2-20  
    Autoprint ...................................................... 2-22  
  Assays Folder .................................................... 2-23
Chapter 7: Displaying and Analyzing Data Using Absorbance Instruments

Introduction ................................................................. 7-3
Initial Data Display and Reduction: Plate/CuvetteSet Section ...... 7-4
The Data Display .......................................................... 7-5
   The Display Dialog Box .............................................. 7-6
   Graphing Wells ....................................................... 7-18
   Masking Wells or Cuvettes ......................................... 7-22
Data Reduction ......................................................... 7-23
   Plate Section ......................................................... 7-23
   CuvetteSet Section ................................................... 7-23
   Endpoint .............................................................. 7-27
   Kinetic ...................................................................... 7-28
   Spectrum (SpectraMax Instruments Only) ...................... 7-36
   Data Mode (%Transmittance/Absorbance) ...................... 7-37
   Custom Reduction Formulas ....................................... 7-38
   Recalculation Options .............................................. 7-40
Displaying Data in Group, Graph, and Notes Sections .......... 7-41
   Group Sections ....................................................... 7-41
   Notes Sections ....................................................... 7-47
   Graph Section .......................................................... 7-47
Formulas in SoftMax Pro ............................................. 7-67

Chapter 8: Displaying and Analyzing Data Using Fluorescence or Luminescence Instruments .............................................. 8-1

Introduction ................................................................. 8-3
Initial Data Display and Reduction ................................... 8-4
The Data Display .......................................................... 8-5
   The Display Dialog Box .............................................. 8-6
   Graphing Wells ....................................................... 8-14
   Masking Wells .......................................................... 8-18
Data Reduction ......................................................... 8-19
   Endpoint .................................................................... 8-21
   Kinetic ...................................................................... 8-21
   Spectrum ................................................................. 8-29
   Well Scan .................................................................. 8-30
   FLEX ....................................................................... 8-31
   Custom Reduction Formulas ....................................... 8-35
   Recalculation Options .............................................. 8-37
Displaying Data in Group, Graph, and Notes Sections .......... 8-38
   Group Sections ....................................................... 8-38
   Notes Sections ....................................................... 8-45
   Graph Section .......................................................... 8-45
Formulas in SoftMax Pro ............................................. 8-64
Chapter 9: File Management and Printing ................................................. 9-1

File Creation and Management ......................................................... 9-3
  Default Protocol ................................................................. 9-3
  Locating Protocol and Data Files ............................................ 9-5
  Creating New Files ............................................................. 9-5
  Opening Files ................................................................. 9-6
  Saving Files Manually ............................................................. 9-8
  Autosave ................................................................. 9-9

Printing ................................................................. 9-11
  The Printed Report ............................................................. 9-12
  Customizing the Report .................................................... 9-12
  The Print Dialog Box ............................................................ 9-14

Exporting/Importing Information .................................................... 9-16
  Exporting Data ................................................................. 9-16
  Importing Data from Analyst, Acquest, ScreenStation, and FLIPR .... 9-21
  Importing and Exporting Templates ........................................ 9-24
  Exporting Graphs ............................................................ 9-25
  Copying and Pasting .......................................................... 9-25

File Protection ................................................................. 9-29
  Password Protection .......................................................... 9-29

Chapter 10: Tutorials ................................................................. 10-1

Introduction ................................................................. 10-3

Tutorial 1: Quantitative Endpoint Assay Tutorial ................................ 10-4
  Hard and Soft Parameters .................................................. 10-4
  Description of the Assay Example ....................................... 10-5
  Define the Protocol ............................................................ 10-6

Start SoftMax Pro (Create a New File) ........................................ 10-6
  Define the Instrument Settings ........................................... 10-9
  Define the Template .......................................................... 10-12
  Set the Reduction Parameters ............................................. 10-19
  Set the Display Parameters ................................................ 10-20
  Read the Plate ............................................................... 10-22
  Data Analysis—Group Sections ........................................... 10-25
  Data Analysis—Standard Curve ........................................... 10-31
  Print a Report ............................................................... 10-34

Tutorial 2: EC 50 Assay Tutorial (FLEX mode only) .......................... 10-35
  Hard and Soft Parameters .................................................. 10-35
  Description of the Assay Example ....................................... 10-36
  Define the Protocol ............................................................ 10-37

Start SoftMax Pro (Create a New File) ........................................ 10-37
  Define the Instrument Settings ........................................... 10-38
  Define the Template .......................................................... 10-48
  Set the Reduction Parameters ............................................. 10-51
  Set the Display Parameters ................................................ 10-52
  Read the Plate ............................................................... 10-54
  Data Analysis—Group Sections ........................................... 10-57
  Data Analysis—Graph ...................................................... 10-64
  Data Analysis—Summary Formula ....................................... 10-65
  Print a Report ............................................................... 10-67
### Chapter 11: Troubleshooting

- Introduction ................................................. 11-3
- Message Boxes and Alerts .......................... 11-3
  - Alerts in the Instrument Settings ........... 11-3
  - Alerts in SoftMax Pro ......................... 11-4
- Error Message Boxes ................................. 11-8
- Communication Problems ......................... 11-10
- Display Problems ................................. 11-14
- Printing Problems ................................. 11-14
- General Problems ................................... 11-15

### Chapter 12: SoftMax Pro Remote Command Language

- Introduction ............................................. 12-3
- Notes On Queued Processing .................. 12-3
- Send/Receive Remote Commands .......... 12-4
- Summarizing Remote Commanding .......... 12-7
- Programmer Notes ................................ 12-7
- Molecular Devices’ Position .................. 12-8
- SoftMax Pro Commands ......................... 12-9
- Visual Basic (Excel Macro) Example .......... 12-14
- MFC C++ Interface to SoftMax Pro Remote Commands that Return Values .................. 12-15

### Appendix A: SoftMax Pro Version Specifications

- Introduction ............................................. A-3
- SoftMax Pro 3.1 Update Specification .......... A-3
  - SpectraMax Plus384 support .................. A-3
  - SpectraMax Gemini XS support .......... A-3
  - Well Scanning Read Mode .................... A-3
  - Apple OS 9 Navigation Services ........... A-5
  - Interprocess Messaging ...................... A-5
  - Instrument Settings Changes .............. A-5
  - Password Protection ......................... A-5
  - Minimum Kinetic Interval .................. A-5
  - Autosave Changes ............................ A-5
  - Autoprint Changes ........................... A-5
- SoftMax Pro 3.1.1 Update Specification .... A-6
  - Correction of Problems in SoftMax Pro 3.1 .. A-6
  - New Interprocess Messaging Features ...... A-6
- SoftMax Pro 3.1.2 Update Specification .... A-7
  - New and Revised Interprocess Messaging Features . A-7
- SoftMax Pro 3.2 Update Specification .... A-7
  - FlexStation Features ......................... A-7
  - New Accessors ................................. A-8
- Checksum .............................................. A-8
- Import/Export ......................................... A-8
- Autoread .............................................. A-8
- Reduction Modifications ..................... A-8
- SoftMax Pro 4.0/4.01 Update Specification . A-9
  - GLP/GMP Support ................................ A-9
  - Criterion Files ................................ A-9
FLIPR Files .............................................. A-9
Robotics .................................................. A-9
FlexStation Enhancements .......................... A-9
Well Scan Mode ........................................ A-10
Export Function Updates ............................. A-10
Multithreading of Serial Input (PC only) ......... A-10
Macintosh Communications Toolbox Support .... A-10
SpectraMax Gemini and Gemini XS Enhancements . A-10
Enhanced 4-Parameter Fit ............................ A-10
Documentation & Software Enhancements ....... A-10
Specifications .......................................... A-10
SoftMax Pro 4.1 Specification ........................ A-11
Specifications .......................................... A-11

Appendix B: Glossary of Terms ...................... B-1

Index .......................................................... I-1
Figures

Figure 1.1: Help Menu for SoftMax Pro for the Macintosh ........................................ 1-9
Figure 1.2: Formula Help Window ................................................................. 1-9
Figure 1.3: Help Menu for SoftMax Pro for Windows ........................................ 1-10
Figure 1.4: Help Contents for SoftMax Pro for Windows ..................................... 1-10
Figure 1.5: Using the Search Function within Help in SoftMax Pro for Windows ..... 1-11
Figure 1.6: Choose a Topic within Help in SoftMax Pro for Windows ..................... 1-11
Figure 1.7: Hypertext Links within SoftMax Pro for Windows ............................... 1-12

Figure 2.1: Serial Cables for Macintosh .......................................................... 2-3
Figure 2.2: Serial Cables for USB Macintosh ..................................................... 2-4
Figure 2.3: Serial Cables for PC ................................................................. 2-5
Figure 2.4: Registration Dialog Box ................................................................. 2-13
Figure 2.5: SoftMax Pro Title Screen Examples .............................................. 2-14
Figure 2.6: SoftMax Pro Default Protocol Untitled Window ................................. 2-14
Figure 2.7: Preferences Dialog Box (Windows, top; Macintosh, bottom) ............... 2-15
Figure 2.8: Serial Port Selection in Preferences Dialog Box ................................. 2-16
Figure 2.9: Serial Port Speed Selection in Preferences Dialog Box (FlexStation only) 2-17
Figure 2.10: Export Format selection in Preferences dialog box ........................... 2-17
Figure 2.11: Reader selection in Preferences dialog box ...................................... 2-18
Figure 2.12: Filters Dialog Box ........................................................................ 2-19
Figure 2.13: Autosave portion of the Preferences Dialog Box ............................... 2-20
Figure 2.14: Autosave Location Dialog Box (Windows) ....................................... 2-21
Figure 2.15: File Prefix Field (Windows) .......................................................... 2-22

Figure 3.1: SoftMax Pro Title Screen Examples .............................................. 3-3
Figure 3.2: SoftMax Pro Screen and Window for Macintosh ................................. 3-4
Figure 3.3: SoftMax Pro Screen and Window for the PC (Windows) ..................... 3-5
Figure 3.4: Status Bars for MDC Microplate System Instruments ........................ 3-7
Figure 3.5: Tool Bar from an Active Graph Section ............................................ 3-11
Figure 3.6: Example of a Tool Bar “Sticking” to the Top of the Window .................. 3-11
Figure 3.7: Closed and Open Sections ............................................................. 3-12
Figure 3.8: Result of Minimizing an Experiment (Tool Bars Hidden) ................. 3-12
Figure 3.9: Separate Section Window ............................................................. 3-13
Figure 3.10: Example Notes Section, Named “Results” ...................................... 3-13
Figure 3.11: Plate Section ............................................................................. 3-15
Figure 3.12: CuvetteSet Section ....................................................................... 3-17
Figure 3.13: Group Section ............................................................................. 3-19
Figure 3.14: Graph Section ............................................................................ 3-21
Figure 3.15: Menu Bar (Macintosh, top; Windows, bottom) .................................. 3-23
Figure 3.16: SoftMax Pro Menus ...................................................................... 3-25

Figure 4.1: Instrument Settings Dialog Boxes for an Endpoint Reading ............... 4-6
Figure 4.2: Instrument Settings Dialog Boxes for a Kinetic Reading .................... 4-7
Figure 4.3: Instrument Settings Dialog Boxes for a Spectrum Reading ............... 4-8
Figure 4.4: Instrument Settings for an Endpoint Reading .................................... 4-9
Figure 4.5: Instrument Settings for a Kinetic Reading ......................................... 4-10
Figure 4.6: Instrument Settings for a Spectrum Reading ...................................... 4-11
Figure 4.7: Wavelength Settings for SpectraMax Instruments ............................. 4-12
Figure 4.8: Wavelength Settings for VersaMax Instruments ............................... 4-12
Figure 4.9: Wavelength Settings for Emax, Vmax, UVmax, and ThermoMax Instruments 4-12
Figure 5.16: Wells to Read Dialog Box with Wells A3–G7 Selected ........................................... 5-19
Figure 5.17: Template Editor Dialog Box ......................................................................................... 5-20
Figure 5.18: The Appearance of the Template Editor Tool Bar under Different Circumstances ............................................................. 5-21
Figure 5.19: The Group Drop-Down List ......................................................................................... 5-22
Figure 5.20: Group Settings Dialog Box Using Default Settings .................................................... 5-23
Figure 5.21: Group Settings Dialog Box for the Group Named “Patient#1” ........................................ 5-25
Figure 5.22: Groups Settings Dialog Box Showing Original Column Format .................................. 5-25
Figure 5.23: Modifying Sample Names and Descriptor Values in the Template Editor ....................... 5-26
Figure 5.24: The Sample Drop-Down List ....................................................................................... 5-26
Figure 5.25: Sample Drop-Down List—Sample Names Defined and Wells Selected ....................... 5-27
Figure 5.26: Assign Area of the Template Editor Tool Bar ............................................................. 5-27
Figure 5.27: Template with Wells Selected for a Series .................................................................. 5-28
Figure 5.28: Series Dialog Box ........................................................................................................ 5-28
Figure 5.29: Fill Options and Replicate Settings .......................................................................... 5-30
Figure 5.30: Graphic Representation of Plate Blank Subtraction .................................................... 5-31
Figure 5.31: Template Editor Showing Plate Blank and Group-Associated Blank Wells ................ 5-32
Figure 5.32: Copy Template and Paste Template Commands in the Plate Menu .............................. 5-33
Figure 5.33: Select Section Dialog Box .......................................................................................... 5-35
Figure 5.34: Alert Regarding Replacing Data for Plate Section ...................................................... 5-35
Figure 5.35: Status Bar during a Kinetic Reading (SpectraMax) ....................................................... 5-35
Figure 5.36: Instrument Settings Dialog Boxes for FLEX Mode ..................................................... 5-39
Figure 5.37: Instrument Settings Dialog Box .................................................................................. 5-40
Figure 5.38: Wavelength Settings .................................................................................................. 5-42
Figure 5.39: Readings Setting .......................................................................................................... 5-42
Figure 5.40: PMT Sensitivity Setting ............................................................................................... 5-43
Figure 5.41: Wells to Read Section of the Instrument Settings with Wells Selected ....................... 5-44
Figure 5.42: FLEX Timing Settings Box .......................................................................................... 5-44
Figure 5.43: Automix Settings Box ................................................................................................ 5-45
Figure 5.44: Compound Source Settings Box ................................................................................. 5-45
Figure 5.45: Compound Transfer Settings Box .............................................................................. 5-46
Figure 5.46: Triturate Settings Box ................................................................................................ 5-47
Figure 5.47: Pipette Tips Layout Settings Box .................................................................................. 5-48
Figure 5.48: Compound & Tip Columns Settings Box ..................................................................... 5-49
Figure 5.49: Select Section Dialog Box .......................................................................................... 5-51
Figure 5.50: Alert Regarding Replacing Data for Plate Section ...................................................... 5-52
Figure 5.51: Status Bar during a FLEX Reading .............................................................................. 5-52
Figure 6.1: Create Database Dialog Box .......................................................................................... 6-8
Figure 6.2: Database Save As Dialog Box ....................................................................................... 6-9
Figure 6.3: Database Creation Message .......................................................................................... 6-9
Figure 6.4: Administrator Login Dialog Box .................................................................................. 6-9
Figure 6.5: Administrator’s Dialog Box -- Users Tab shown ........................................................... 6-10
Figure 6.6: Groups Page ................................................................................................................ 6-11
Figure 6.7: Report Page .................................................................................................................. 6-12
Figure 6.8: License Page ................................................................................................................ 6-13
Figure 6.9: User Information Page in Add New User Wizard ........................................................... 6-14
Figure 6.10: User Privileges Page in Add New User Wizard ............................................................ 6-15
Figure 6.11: User Privileges Dialog Box ......................................................................................... 6-16
Figure 6.12: Modify User Dialog Box ............................................................................................ 6-18
Figure 6.13: Remove User Warning Message .................................................................................. 6-18
Figure 6.14: Add Software Product Dialog Box .............................................................................. 6-19
Figure 6.15: Delete Software Dialog Box ....................................................................................... 6-20
Figure 7.32: Formula Button Activated and Column Formulas Shown .................................. 7-44
Figure 7.33: Column Formula Dialog Box ............................................................................ 7-45
Figure 7.34: Calculation Dialog Box ...................................................................................... 7-46
Figure 7.35: Graph Options Dialog Box ................................................................................ 7-49
Figure 7.36: Standards and Unknowns Groups Created......................................................... 7-50
Figure 7.37: Standard2 Group Section .................................................................................... 7-50
Figure 7.38: Graph Options Dialog Box with Plot Name Changed to “Standard#1” .......... 7-51
Figure 7.39: Graph Options Dialog Box with Second Plot Added for Standard#2 .......... 7-51
Figure 7.40: Graph Displaying Three Standards Plots ......................................................... 7-52
Figure 7.41: Plot Showing Error Bars .................................................................................... 7-53
Figure 7.42: Graph with No Fit .............................................................................................. 7-53
Figure 7.43: Graph with Linear Fit ........................................................................................ 7-55
Figure 7.44: Graph with Semi-Log Fit .................................................................................... 7-56
Figure 7.45: Graph with Log-Log Fit ....................................................................................... 7-57
Figure 7.46: Graph with Quadratic Fit ...................................................................................... 7-58
Figure 7.47: Graph with 4-Parameter Fit .................................................................................. 7-59
Figure 7.48: Graph with Log-Logit Fit ...................................................................................... 7-60
Figure 7.49: Graph with Point-to-Point Fit .............................................................................. 7-61
Figure 7.50: Graph with Cubic Spline Fit ............................................................................... 7-62
Figure 7.51: Graph with Exponential Fit .................................................................................. 7-63
Figure 7.52: Graph Options Dialog Box ................................................................................. 7-65
Figure 7.53: Scatter Graph with Points Connected (Linear Fit Applied) ......................... 7-66
Figure 7.54: Bar Graphs—Cluster and Stack ......................................................................... 7-66
Figure 7.55: X-Axis Dialog Box .............................................................................................. 7-67

Figure 8.1: Relationship of Sections ......................................................................................... 8-3
Figure 8.2: Plate Section: Endpoint, Kinetic, Spectrum, Well Scan, and FlexStation Display Dialog Boxes ................................................................. 8-7
Figure 8.3: Choices for a 384-Well Plate Display: Normal, Vertical, Rotated, Large, and Interleaved .................................................................................................................. 8-9
Figure 8.4: Default Displays for a Plate Section ....................................................................... 8-10
Figure 8.5: Display Dialog Box for Kinetic Threshold Display ............................................. 8-11
Figure 8.6: Kinetic Data Displayed as Threshold with Reduced Number ............................ 8-12
Figure 8.7: Kinetic Data (Reduced) Displayed as Ranged ....................................................... 8-13
Figure 8.8: Endpoint Data (Reduced) Displayed as Gray Scale ........................................... 8-14
Figure 8.9: Graph Options Dialog ......................................................................................... 8-16
Figure 8.10: Well Graph for a Single Kinetic Microplate Well (Raw Data) ......................... 8-16
Figure 8.11: Well Graph for Three Kinetic Wells of a Microplate (Raw Data) ................. 8-17
Figure 8.12: Masked Wells in a Plate Section .......................................................................... 8-18
Figure 8.13: Reduction Dialog Boxes for All Modes ............................................................. 8-20
Figure 8.14: Different Reductions of the Same Data Using Different MaxRFU Points .......... 8-22
Figure 8.15: Different Lag Time Settings ............................................................................... 8-23
Figure 8.16: Kinetic Reduction with Absolute Values Enabled ............................................. 8-24
Figure 8.17: Limits in Reduction Dialog Box (RFU shown) .................................................. 8-25
Figure 8.18: Kinetic Reduction with Absolute Values Enabled and MaxRFU Value Increased .......................................................................................... 8-25
Figure 8.19: FLEX Mode Reduction Dialog Box—Smoothing Setting ................................. 8-33
Figure 8.20: FLEX Display Options showing % Baseline option ........................................ 8-34
Figure 8.21: FLEX Mode Reduction Dialog Box—Interpolate Raw Data Checkbox .......... 8-34
Figure 8.22: Top: Raw Data without Interpolation; Bottom: Interpolated Data .................. 8-35
Figure 8.23: “Custom” Selected Showing Formula Button (Endpoint) ............................. 8-36
Figure 8.24: Wavelength Calculation Dialog Box (Endpoint) .............................................. 8-36
Figure 8.25: Cursor Positioned on a Line between Columns ................................................ 8-39
Figure 8.26: Dragging a Column Divider Line ........................................ 8-40
Figure 8.27: The “Show Formulas” Command in the Group Menu .................. 8-40
Figure 8.28: Formulas Shown in Group Columns ........................................ 8-41
Figure 8.29: Formula Button Activated and Column Formulas Shown ............... 8-42
Figure 8.30: Column Formula Dialog Box .............................................. 8-42
Figure 8.31: Calculation Dialog Box ..................................................... 8-44
Figure 8.32: Graph Options Dialog Box ................................................... 8-47
Figure 8.33: Standards and Unknowns Groups Created ................................ 8-48
Figure 8.34: Standard2 Group Section ................................................... 8-48
Figure 8.35: Graph Options Dialog Box with Plot Name Changed to “Standard#1” 8-49
Figure 8.36: Graph Options Dialog Box with Second Plot Added for Standard#2 8-49
Figure 8.37: Graph Displaying Three Standards Plots ................................ 8-50
Figure 8.38: Plot Showing Error Bars .................................................... 8-51
Figure 8.39: Graph with No Fit .............................................................. 8-51
Figure 8.40: Graph with Linear Fit ......................................................... 8-53
Figure 8.41: Graph with Semi-Log Fit ...................................................... 8-54
Figure 8.42: Graph with Log-Log Fit ....................................................... 8-55
Figure 8.43: Graph with Quadratic Fit .................................................... 8-56
Figure 8.44: Graph with 4-Parameter Fit ................................................ 8-57
Figure 8.45: Graph with Log-Logit Fit ..................................................... 8-58
Figure 8.46: Graph with Point-to-Point Fit .............................................. 8-59
Figure 8.47: Graph with Cubic Spline Fit ............................................... 8-59
Figure 8.48: Graph with Exponential Fit ................................................ 8-60
Figure 8.49: Graph Options Dialog Box ................................................... 8-62
Figure 8.50: Scatter Graph with Points Connected (Linear Fit Applied) .............. 8-63
Figure 8.51: Bar Graphs—Cluster and Stack ............................................ 8-63
Figure 8.52: X-Axis Dialog Box .............................................................. 8-64

Figure 9.1: The Assays Menu ............................................................... 9-3
Figure 9.2: Set Folder Dialog Box—Macintosh ............................................ 9-3
Figure 9.3: Select Folder Dialog Box—Windows ......................................... 9-4
Figure 9.4: Save as... Dialog Box—Macintosh .......................................... 9-6
Figure 9.5: Save as... Dialog Box—Windows ............................................. 9-6
Figure 9.6: Preferences Dialog Box ........................................................ 9-9
Figure 9.7: Print Dialog Box ................................................................. 9-12
Figure 9.8: Moving a Section Upward .................................................... 9-13
Figure 9.9: Format Text Dialog Box (Macintosh) ...................................... 9-14
Figure 9.10: Print Dialog Box for the Macintosh ....................................... 9-14
Figure 9.11: Print Dialog Box for Windows (Epson Stylus 800 Shown) ............. 9-15
Figure 9.12: Choosing an Export Format from the Preferences Dialog Box ........ 9-16
Figure 9.13: Display Dialog Box ............................................................. 9-17
Figure 9.14: Export Dialog Box—Windows and Macintosh .......................... 9-18
Figure 9.15: Import Dialog Box ............................................................. 9-22
Figure 9.16: Error Message Generated When Pasting Mismatched Data ............ 9-26
Figure 9.17: Set Password/Sheilding Dialog Box ....................................... 9-31
Figure 9.18: Password Required Dialog Box ............................................ 9-32

Figure 10.1: Default Protocol/Tutorial 1 Notes and Plate#1 Sections Open ............ 10-7
Figure 10.2: Instrument Settings Dialog Box Showing Wavelengths Settings .... 10-10
Figure 10.3: Instrument Settings Dialog Box Showing Automix & Blanking  (Absorbance) or Automix (Fluorescence)10-11
Figure 10.4: Template with Plate Blank Wells Assigned .............................. 10-12
Figure 10.5: Template with First Standards Entered .................................... 10-12
Tables

Table 2.1 Files that Are Installed .................................................. 2-10
Table 3.1 Notes Section Menu Commands and Tool Bar Buttons .................. 3-14
Table 3.2 Plate Section Menu Commands and Tool Bar Buttons .................. 3-16
Table 3.3 CuvetteSet Section Menu Commands and Tool Bar Buttons .............. 3-18
Table 3.4 Group Section Menu Commands and Tool Bar Buttons .................. 3-20
Table 3.5 Graph Section Menu Commands and Tool Bar Buttons .................. 3-22
Table 4.1 Features Available in the Instrument Settings Dialog Box for Absorbance Instruments .................................................. 4-5
Table 4.2 Columns Created and Their Formulas ..................................... 4-26
Table 4.3 Column vs. Wavelength Priority .......................................... 4-45
Table 5.1 Features Available in the Instrument Settings Dialog Box for Fluorescence Instruments .................................................. 5-5
Table 5.2 Columns Created and Their Formulas ..................................... 5-24
Table 5.3 Column vs. Wavelength Priority .......................................... 5-36
Table 7.1 Using Vmax Points (Example) .............................................. 7-34
Table 7.2 Wavelength Reduction Formula Examples .................................. 7-39
Table 7.3 Kinetic and Spectrum Reduction Formula Examples ....................... 7-40
Table 7.4 Minimum Number of Standards Required for Curve Fits ................. 7-64
Table 8.1 Using Vmax Points (Example) .............................................. 8-27
Table 8.2 Using Vmax Points (Example) .............................................. 8-31
Table 8.3 Wavelength Reduction Formula Examples .................................. 8-36
Table 8.4 Kinetic and Spectrum Reduction Formula Examples ....................... 8-37
Table 8.5 Minimum Number of Standards Required for Curve Fits ................. 8-61
Table 9.1 PC File Name Extensions and Macintosh Document Types ............... 9-7
Table 9.2 ASCII Data File Fields and Descriptors ................................... 9-20
Table 9.3 ASCII Template File Columns and Descriptions .......................... 9-24
Table 9.4 New vs. Duplicate within an Experiment ................................... 9-28
Table 9.5 Actions Protected by Password ............................................ 9-30
Table 10.1 Instrument Settings for Absorbance and Fluorescence Instruments .... 10-9
Table 10.2 Instrument Settings for FLEX Mode .................................... 10-39
Chapter 1: Welcome to SoftMax Pro

Introduction ......................................................... 1-3
New to SoftMax Pro? ............................................. 1-4
What’s New in SoftMax Pro Version 4.3 ................. 1-4
About the Documentation ........................................ 1-6
   Conventions Used in This Manual ....................... 1-7
Getting Help ....................................................... 1-9
   Macintosh On-Line Help ..................................... 1-9
   Windows On-Line Help ..................................... 1-10
   Troubleshooting and Technical Support ................. 1-12
Introduction

SoftMax® Pro is designed for use with Molecular Devices’ Microplate Readers (Emax™, Vmax®, UVmax™, ThermoMax™, and VersaMax™), Microplate Spectrophotometers (SpectraMax®), and Microplate Spectrofluorometers (SpectraMax Gemini fluorescence reader family and FlexStation instruments). SoftMax Pro allows you to create files containing all of the parameters required for acquiring and analyzing data from Molecular Devices Microplate System instruments. You may also import data from other Molecular Devices instruments such as Analyst and FLIPR systems for display and analysis.

SoftMax Pro is available for Power Macintosh computers using OS 8.6 or greater (OS X in Classic mode only) and PC-compatible computers using Windows 2000, NT 4.x, and XP.

SoftMax Pro is powerful, yet easy to use. It performs three major functions:

- **Instrument Control**—SoftMax Pro allows you to set up and run a complete assay. Instrument settings can be saved as a protocol file and used repeatedly for reading different microplates. All stand-alone instrument functions can be controlled using the software. In addition, SoftMax Pro provides capabilities that are not available when using MDC Microplate System instruments in stand-alone mode (for example, user-defined Kinetic run times, read intervals, Automix™ parameters, and more).

- **Data Collection and Display**—SoftMax Pro collects and stores all raw data received from the instrument. Data is displayed on the computer screen in a grid format that corresponds to the wells in a microplate (all instruments) or individual cuvettes (SpectraMax Plus or Plus 384 only). How the data is shown depends on other settings made using the software.

- **Data Reduction and Plotting**—You can reduce the data using built-in formulas or you can define custom reduction formulas. More than one reduction can be shown and results from different microplates and/or cuvettes can be compared within the same experiment.

Several read modes are possible using SoftMax Pro. Some may be performed in either a microplate (Plate section) or in a cuvette (CuvetteSet section); others may be performed only in a microplate. Which read modes are available depend upon which instrument you are using.

- **Endpoint**—A single reading is made at one or more wavelengths (up to six separate wavelengths can be chosen using SpectraMax instruments). Default values reported are optical density (OD), relative fluorescence units (RFU), or relative luminescence units (RLU), depending on the instrument type.

- **Kinetic**—Data is collected over time and the default display is OD, RFU, or RLU vs. time. Multiple readings are made at regular intervals which you define. Default data reductions for Kinetic data are Vmax, Vmax per Sec, Time to Vmax, or Onset Time.
• **Spectrum** — Absorbance or fluorescence data is collected across a spectrum of wavelengths and displayed as OD, RFU, or RLU versus wavelength. The default reduction displays the wavelength that corresponds to the maximum signal.

• **Well Scan** — Fluorescence data is collected from a single well in a microplate using one of several scan patterns up to a maximum number of points. Data is displayed in gray scale by default; readings from multiple wavelength pairs can be shown separately or together (if together, they are displayed in different colors).

• **FLEX** — (FlexStation only) Fluorescence data is collected from a single well in a microplate over time. Readings from multiple wavelength pairs can be shown separately or together (if together, they are displayed in different colors).

**NOTE** A chart showing the read modes that are available for absorbance instruments can be found in Table 4.1 on page 4-5; a chart showing the read modes that are available for fluorescence/luminescence instruments can be found in Table 5.1 on page 5-5.

**NOTE** For absorbance instruments, any of the read modes can display data as %Transmittance or OD.

SoftMax Pro can collect data from one or more microplates and/or cuvettes and store it in a single data file, using the same or different instrument settings for different microplates or cuvettes. For example, microplates containing different samples can be read using the same or different modes, all within the same experiment.

**New to SoftMax Pro?**

If you have not used SoftMax Pro before, Molecular Devices recommends that you install the software and then proceed to Chapter 10, “Tutorials,” which guides you through the basics of using SoftMax Pro. Sample files that demonstrate the advanced use capabilities of SoftMax Pro are explained in Chapter 5 of the *Formula Reference Guide*.

**What’s New in SoftMax Pro Version 4.3**

**Separate Editions and Enterprise Administrator**

Three different editions of SoftMax Pro are now available:

• Life Science (LS) Edition, for life science use (shipped with all bench top microplate readers)

• Drug Discovery (DD) Edition, for drug discovery data analysis (shipped with FlexStation; can be used to analyze data files from Analyst systems and FLIPR systems)

• Enterprise Administrator (EA) software is a separate software module (for Windows only) that links with the Enterprise Edition of SoftMax Pro. Enterprise Administrator provides the capability to assign multiple users (up to 175) and multiple permissions/privileges and electronic signature capability.

21 CFR Part 11 Compliance

• Enterprise Administrator software allows an administrator to assign user levels and permissions regarding the use of SoftMax Pro Enterprise Edition.

• A full audit trail showing all user activities is included as part of the Enterprise Edition of SoftMax Pro when coupled with the Enterprise Administrator software.

Password Protection

Password protection continues to be available with all but the Enterprise Edition of SoftMax Pro. While the Enterprise Edition will respect password-protected files generated from other versions, the option to password-protect a file is not available in Enterprise Edition.

Shielding

Shielding is no longer offered. Shielded data files will revert to password-protected files with the password scrambled so that password protection cannot be removed. Shielded protocols will simply have the shielding removed.

Electronic Statements

Electronic statements (“E-Statements”) provide a way of signing SoftMax Pro files electronically (with the Enterprise Edition only). A new menu item under Experiments allows the user to add an Electronic Statements section to a document. Electronic statements allow those with permission to do so to sign a statement stating that a document has been approved or reviewed, for example. Once a statement has been signed, the document may not be modified. Statements and electronic signatures are saved with the document. Statements are NOT saved with protocols.

New File Extensions for Enterprise Edition

File extensions for the Life Science and Drug Discovery editions of SoftMax Pro remain unchanged (.PPR and .PDA). New file extensions are created by Enterprise Edition software, however. .EDA (data) and .EPR (protocol). These new file extensions will be recognized only by Enterprise Edition software, prohibiting opening or modification of such files by other editions of SoftMax Pro. This helps to ensure that the integrity of the 21 CFR Part 11 compliant features of the Enterprise Edition is maintained.

The Enterprise Edition can open all file extensions from all other versions.

User Access in Enterprise Edition

User access to the Enterprise Edition of SoftMax Pro is tied to a database created and saved with Enterprise Administrator. User privileges are set within Enterprise Administrator and these privileges determine which menu choices are available to that user within SoftMax Pro. A user may also log in to the Enterprise Edition as a "guest." That user will be able to open/view files but may not make any modifications to the documents and may not save them under the same name.
Chapter 1: Welcome to SoftMax Pro

About the Documentation

The SoftMax Pro documentation set consists of this manual which includes written tutorials, an on-line help system, and a formula reference guide. Additional documents on disk may also be provided to cover the latest information regarding the software. An outline of the contents of this manual follows, along with introductory information that should help you get started using SoftMax Pro.

NOTE: Screens and parts of screens represented in this manual may depict either the Macintosh or the Windows version of the software. The two interfaces are quite similar, but show subtle differences such as where the Help menu is located, etc. Depending upon which computer platform you are using, which operating system you are using, and the type of screen that is depicted, your screen may look different from the one shown. Note that Macintosh screens are depicted using MacOS versions 8.6 and later.

• The rest of this chapter provides introductory information regarding the program and its features.
• Chapter 2, “Installation,” describes how to install SoftMax Pro on your computer and how to connect the computer and the instrument correctly.
• Chapter 3, “SoftMax Pro Overview,” explains how the SoftMax Pro software program is organized and how it is used with various instruments.
• Chapters 4 and 5 discuss how to prepare for and conduct a reading using SoftMax Pro. Chapter 4 deals with absorbance instruments; Chapter 5 deals with readings made using fluorescence instruments.
• Chapter 6 discusses the Enterprise Edition of SoftMax Pro and how it works with Enterprise Administrator software. Included are pre-installation cautions and installation instructions for Enterprise Administrator software, along with how to set up SoftMax Pro to interface with the database created in Enterprise Administrator.
• Chapters 7 and 8 describe how data is displayed during and after a reading and how you can customize the display using absorbance instruments and the fluorescence instruments, respectively. They also describe data reduction and the different means for analyzing the raw data received from the different instruments.
• Chapter 9, “File Management and Printing,” explains how to customize reports and manage the files created by SoftMax Pro. Other topics include importing, exporting, copying, pasting, duplicating data, both within SoftMax Pro and to and from other external programs, and details about how to import FLIPR and Analyst System files.
• Chapter 10, “Tutorials,” provides two written tutorials that will help you learn the basics of working with SoftMax Pro if you are a new user.
• Chapter 11, “Troubleshooting,” describes alert messages that may appear while using SoftMax Pro and what to do should they occur. Other information in this chapter discusses possible communication problems with the MDC Microplate System instrument and other computer-related issues.
• Chapter 12, “SoftMax Pro Remote Command Language,” describes the robotic integration commands that can be used with Windows-compatible
Chapter 1: Welcome to SoftMax Pro

PCs to control the various functions of the instruments that work with SoftMax Pro.

- Appendix A, “SoftMax Pro Version Specifications,” lists the changes that have been made for previous versions of SoftMax Pro.
- Appendix B, “Glossary of Terms,” provides a list of terms used in this manual and their meanings.

This manual assumes that you are familiar with the basic operating environment of your computer. We recommend that you become familiar with your computer’s operating features prior to installing and using SoftMax Pro.

Conventions Used in This Manual

This manual uses visual cues and standard text formats as follows.

Visual Cues

The following typographic conventions are used in this manual.

<table>
<thead>
<tr>
<th>Format</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Menu Item</strong></td>
<td>Menu titles and selections.</td>
</tr>
<tr>
<td>Text Entry/Key Name</td>
<td>Keys that you press on the keyboard or placeholders for information you must provide (entries that you type from the keyboard). Information shown in this font should be entered exactly as it appears. For example, if you are asked to type <strong>filename</strong>, you would type the actual name for the file instead of the word shown in this font.</td>
</tr>
<tr>
<td><strong>Drawer</strong></td>
<td>Buttons shown on the screen. Note that sometimes an actual representation of the button may be shown.</td>
</tr>
</tbody>
</table>

The accompanying text applies only to SoftMax Pro for Macintosh.

The accompanying text applies only to SoftMax Pro for Windows.

Keyboard Formats

Key designations, combinations, and sequences appear in the following formats.

<table>
<thead>
<tr>
<th>Format</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>/Key</td>
<td>Selections on the Macintosh can be made using the mouse, but often shortcuts are available using the keyboard. Shortcuts commonly use the “command” key in conjunction with another key and are shown with the command key symbol (/) followed by the accompanying key. To use a shortcut, you must press and hold the command key while pressing the second key.</td>
</tr>
<tr>
<td>Key1+Key2</td>
<td>A plus sign (+) between key names means to press and hold down the first key while you press the second key (within Windows). For</td>
</tr>
</tbody>
</table>
example, “press ALT+ESC” means to press and hold down the ALT key and press the ESC key. Then release both keys.

A comma (,) between key names means to press and release the keys one after the other. For example, “press ALT, F” means to press and release the ALT key, and then press and release the F key.

**NOTE:** The names of keys found on Windows-compatible PC computer keyboards vary somewhat from machine to machine. The key names shown in this manual reflect typical key names. Yours should be similar but may not be exactly like those shown. For example, the “print screen” key may be shown on some keyboards as “Prt Scrn”; other keyboards may spell out the complete key name.

**Messages**

The following types of messages may appear in this manual:

**NOTE:**

Calls attention to information that should be followed during installation, use, and/or servicing of the instrument or software.

**CAUTION:**

Indicates a potentially hazardous situation which, if not avoided, might result in minor or moderate injury, loss of data, or mechanical damage. It is also used to alert against unsafe practices.

**WARNING:**

Used whenever an action or condition might potentially cause serious injury to yourself or to others who might use the instrument or computer.
Getting Help

Macintosh On-Line Help

On-line help is available while working with SoftMax Pro for the Macintosh by clicking the Help menu at the far right of the menu bar.

Choosing either of the two help options at the bottom of this menu (SoftMax Pro Help or Formula Help) causes a Help window to appear. This window provides a list of topics on the left and information about the selected topic on the right. Figure 1.2 shows the window for Formula Help. In this figure, the topic "Math Functions" has been selected (on the left) and the corresponding information about that topic appears on the right.
You can access on-line help within SoftMax Pro for Windows by selecting the Help menu in the menu bar. Three types of help are immediately available: you can view the contents of the help file, seek specific help about formulas, or get general information about how to use the help function.

**Figure 1.3: Help Menu for SoftMax Pro for Windows**

Choosing Contents (by clicking on the menu item with the mouse or pressing ALT, H, C) brings up the SoftMax Pro help Contents window, showing the general organization of the help that is available.

**Figure 1.4: Help Contents for SoftMax Pro for Windows**
Help Options from the Contents Window

- You can search for a particular item or subject by clicking the [Search] button (located in the tool bar at the top of the Contents window).

![Search](image)

**Figure 1.5: Using the Search Function within Help in SoftMax Pro for Windows**

After entering a search subject, clicking the [Show Topics] button will cause a list of related topics to appear in the box below.

![Show Topics](image)

**Figure 1.6: Choose a Topic within Help in SoftMax Pro for Windows**

- You can return to the window viewed previously by clicking the [Back] button.
- Clicking the [History] button will provide a list of all areas you have viewed within the Help function.
Text that appears in green with an underline contains a hypertext link to more detailed information about that item. Figure 1.7 below shows some examples of hypertext links.

![Softmax Pro Help](image)

Figure 1.7: Hypertext Links within SoftMax Pro for Windows

Additional options are available, depending upon where you are within the Help function. More information about Windows Help can be found in the Microsoft Windows User’s Guide that accompanies your Windows software.

**Troubleshooting and Technical Support**

If you encounter a problem while using SoftMax Pro, refer first to Chapter 11, “Troubleshooting,” and try to locate a remedy for the problem. For problems with SoftMax Pro that are not listed there, or if you need additional assistance, in the U.S., call Molecular Devices Technical Services group at (800) 635-5577; elsewhere, call your local representative.
Chapter 2: Installation

Connect the Hardware .................................................. 2-3
   Connecting to a Macintosh ...................................... 2-3
Computer System Requirements ................................. 2-6
   Macintosh Computer ............................................. 2-6
   Windows-Compatible Computer .............................. 2-7
Install SoftMax Pro .................................................. 2-8
   What Is Installed ................................................ 2-9
Enter Registration Information .................................. 2-13
Communicating with the MDC Microplate System Instrument . . . . 2-15
Set Preferences ....................................................... 2-16
   Serial Port ....................................................... 2-16
   Export Format ................................................... 2-17
   Reader ............................................................ 2-18
   Filters ............................................................ 2-19
   Autosave ......................................................... 2-20
   Autoprint ......................................................... 2-22
Assays Folder ......................................................... 2-23
Chapter 2: Installation

**Connect the Hardware**

⚠️ **CAUTION:** Turn OFF the power to both the instrument and the computer before connecting or disconnecting any components or cables. Not doing so could potentially result in damage to components in either or both machines.

The type of cable used to connect your computer to the MDC Microplate System instruments depends upon the particular computer and also the particular instrument you are connecting. SpectraMax and VersaMax instruments have 8-pin DIN serial ports; Emax, Vmax, UVmax, and ThermoMax instruments have 25-pin serial ports. Most older Macintosh models have 8-pin DIN (round) modem ports; newer Macintosh models may not have a serial port but instead have a USB port. PC models vary but typically have either a 9-pin or 25-pin serial port (check your particular computer to determine the type of serial connection needed). If your computer does not have a serial port or existing ports are in use, you may need to add a serial port through the use of an adapter.

![Connecting to a Macintosh](image)

**NOTE:** If your Macintosh has a single serial port, refer to Chapter 11, “Troubleshooting,” for information regarding connection to the MDC Microplate System instrument.

**Serial Connection**

The SpectraMax, VersaMax, and FlexStation have an 8-pin DIN serial port and require the use of an 8-pin DIN to 8-pin DIN Macintosh straight-through serial cable (see Figure 2.1 below) to connect them to a Macintosh having a serial port. This cable is **NOT the same as a Macintosh printer cable**. Connect one end of the cable to the Macintosh (to either the printer or modem port) and the other connector to the MDC Microplate System instrument.

Use an 8-pin DIN to DB-25 Macintosh modem cable to connect the Macintosh to an Emax, Vmax, UVmax, or ThermoMax. Connect the 8-pin, round DIN connector to the Macintosh (to either the printer or modem port) and the 25-pin connector to the MDC Microplate System instrument.

**NOTE:** Enterprise Administrator must be installed by an administrator. Detailed installation information for Enterprise Administrator can be found in Chapter 6.
Chapter 2: Installation

Figure 2.1: Serial Cables for Macintosh
Left: 8-Pin DIN to 8-Pin DIN Serial Cable (not the same as a Macintosh printer cable); Right: 8-Pin DIN to DB-25 Modem (Serial) Cable.

Connecting the 8-pin end of either cable to the modem port of the Macintosh is preferred since this allows the printer port to remain available. If you do connect to the Macintosh printer port, first deactivate AppleTalk using the AppleTalk Control Panel or the Chooser desk accessory in the Apple () menu.

**NOTE** If you are running other applications that use AppleTalk, it may be necessary to quit them before making AppleTalk inactive.

**USB Connection**

iMac and G4 Macintosh computers do not have a serial port. You can connect a serial cable to these Macintosh models and the MDC Microplate System instrument through the use of a USB-to-serial adapter.1

---

1. Currently, Molecular Devices has tested adapters supplied by both Keyspan and Belkin and found that both work without problems. Adapters from other manufacturers may work equally well.
Chapter 2: Installation

2-4 SoftMax Pro User’s Manual

Figure 2.2: Serial Cables for USB Macintosh

Left: USB serial adapter; Right Top: 8-Pin DIN to 8-Pin DIN Serial Cable (not the same as a Macintosh printer cable); and Right Bottom: 8-Pin DIN to DB-25 Modem (Serial) Cable.

1) Plug the USB connector on the serial adapter into the USB port on the back of the Macintosh computer.

2) Plug one end of the 8-pin DIN cable into the USB-to-serial adapter (see Figure 2.2 above). Plug the other end of the 8-pin DIN cable into the serial port of the MDC Microplate System instrument.

The USB-to-serial adapters generally require that you install software for them to function properly.

After you have installed SoftMax Pro (described in a later section), access Preferences from the Edit menu. Set the serial port to any open port available with your computer (typically you will choose the “Printer” port as most contemporary Macintosh computers have a built-in modem that uses the “Modem” port), then choose the appropriate instrument, and finally close the dialog box.

Windows-Compatible Computer

The type of cable required to connect your computer to a MDC Microplate System instrument will depend upon the type of MDC Microplate System instrument and the type of serial port(s) available on your computer. SoftMax Pro supports up to nine connections (serial ports). SpectraMax, VersaMax, and FlexStation instruments have 8-pin DIN serial ports; Emax, Vmax, UVmax, and ThermoMax instruments have 25-pin serial ports. The cable should be a straight-through serial cable. The serial connector for your computer may be a 9-pin or 25-pin connector (or you can use an adapter that converts from 9-pins to 25-pins—see Figure 2.3).
Figure 2.3: Serial Cables for PC
Top left: 8-Pin DIN to 9-Pin Serial Cable; top right: 9-Pin to 25-Pin Adapter; bottom left: 25-Pin DIN to 9-Pin Serial Cable; bottom right: 25-Pin to 25-Pin Serial Cable.
Computer System Requirements

The following computer hardware and operating system software specifications are recommended to ensure proper operation of SoftMax Pro. The minimum configuration required is also given.2

Macintosh Computer

<table>
<thead>
<tr>
<th>Recommended System Configuration</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Apple Power Macintosh G4</td>
</tr>
<tr>
<td>• MacOS 9.1 or greater (OS X in Classic mode)</td>
</tr>
<tr>
<td>• 17-inch monitor</td>
</tr>
<tr>
<td>• 256 MB RAM, 6 GB hard disk drive</td>
</tr>
<tr>
<td>• CD-ROM/DVD-ROM drive</td>
</tr>
<tr>
<td>• Extended keyboard</td>
</tr>
<tr>
<td>• USB-to-Serial Adapter and adapter software</td>
</tr>
<tr>
<td>• Epson 740i color printer</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Minimum System Configuration</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Apple Power Macintosh G3</td>
</tr>
<tr>
<td>• MacOS 8.6</td>
</tr>
<tr>
<td>• 17-inch SVGA monitor</td>
</tr>
<tr>
<td>• 128 MB RAM, 2 GB hard disk drive</td>
</tr>
<tr>
<td>• CD-ROM drive</td>
</tr>
</tbody>
</table>

Either configuration above requires a straight-through, serial cable (either an 8-pin DIN to 8-pin DIN for SpectraMax, VersaMax, and FlexStation, or 8-pin DIN to DB 25 cable for Emax, Vmax, UVmax, and ThermoMax). Molecular Devices recommends using only high-quality, double-shielded, straight-through serial cables.

NOTE: If you plan to use SoftMax Pro with a FlexStation instrument or with any instrument if you will be creating large files (in excess of 20 plates per file), Molecular Devices recommends that you increase the amount of RAM in your computer to a minimum of 256 MB.

2 The minimum configuration may not provide enough memory for creating or working with large files (more than one plate or cuvette per file) and/or the use of robotics. If your computer “freezes” or stops functioning, try increasing the amount of memory allocated to the SoftMax Pro program (see Chapter 11 for more information).
Windows-Compatible Computer

<table>
<thead>
<tr>
<th>Windows Recommended System Configuration</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Pentium IV, 1.8+ GHz processor</td>
</tr>
<tr>
<td>• Microsoft Windows 2000</td>
</tr>
<tr>
<td>• 17-inch color SVGA monitor</td>
</tr>
<tr>
<td>• Video adapter and software driver capable of displaying 800 x 600 minimum resolution set to 16-bit high color and small fonts or better</td>
</tr>
<tr>
<td>• 256 MB RAM or greater</td>
</tr>
<tr>
<td>• 6 GB hard disk drive</td>
</tr>
<tr>
<td>• CD-ROM drive</td>
</tr>
<tr>
<td>• Serial port (COM1 – COM9)</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Windows Minimum System Configuration</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Pentium II, 300+ MHz processor</td>
</tr>
<tr>
<td>• Microsoft Windows NT 4.0 or XP</td>
</tr>
<tr>
<td>• 17-inch color SVGA monitor</td>
</tr>
<tr>
<td>• Video adapter and software driver capable of displaying 800 x 600 minimum resolution set to 16-bit high color and small fonts or better</td>
</tr>
<tr>
<td>• 128 MB RAM</td>
</tr>
<tr>
<td>• 2 GB hard disk drive</td>
</tr>
<tr>
<td>• CD-ROM drive</td>
</tr>
<tr>
<td>• Serial port (COM1)</td>
</tr>
</tbody>
</table>

All of these configurations require a straight-through serial cable or USB converter. More about the types of cables needed for the different instruments follows in this chapter. Molecular Devices recommends using only high-quality, double-shielded, straight-through serial cables.

**NOTE:** If you plan to use SoftMax Pro with a FlexStation instrument or with any instrument if you will be creating large files (in excess of 20 plates per file), or if you will be using any robotic applications, Molecular Devices recommends that you increase the amount of RAM in your computer to a minimum of 256 MB.
Install SoftMax Pro

Three versions of SoftMax Pro are available: Life Sciences, Drug Discovery, and Enterprise Edition. The Life Sciences version provides instrument control and analysis functions for all SpectraMax and earlier instruments. The Drug Discovery version provides instrument control and analysis functions for the FlexStation instrument as well as import and analysis of data files from FLIPR and Analyst instruments. The Enterprise Edition includes all features from both the Life Sciences and Drug Discovery versions and also contains features that enable 21 CFR Part 11 compliance.

**NOTE:** Only an “administrator” may install the Enterprise Edition of SoftMax Pro, and this should be done after installing the Enterprise Administrator software program. The administrator must enable certain functions within SoftMax Pro that link these two programs together and will have the required information about all users of SoftMax Pro Enterprise Edition in order to do so. If you are an administrator and need to learn more about installing these programs, you should first read the installation instructions in the manual that accompanies the Enterprise Administrator software. Then return to this section and read the rest of the installation instructions for the Enterprise Edition.

**NOTE:** If the administrator password to a database is lost, the data within that database will be unretrievable. Administrators may wish to develop a procedure to safeguard their user name and password to prevent alteration and/or data loss.

Follow these instructions to install SoftMax Pro from the CD to your computer’s hard disk.

1. Insert the SoftMax Pro CD into the CD-ROM drive.
2. **Macintosh:** Double-click the CD-ROM drive icon to open it.
   **Windows:** Open “My Computer” and then double-click the CD-ROM drive icon to open it.
3. Double-click the Installer icon (Macintosh) or Setup icon (Windows) and follow the screen prompts.
4. The “Welcome” screen suggests that you close all other programs before beginning installation of SoftMax Pro software. It is also recommended that you disable any virus protection software you may have running before installing SoftMax Pro. Click [Cancel] to exit the installer and close any programs and/or disable virus protection and then start the installer again from step 3 above. To continue with installation, click [Next].
5. The screen named “Choose Destination Location” asks you to select the drive where the software will be installed. A default location will be shown on the screen. If you have more than one hard drive in your computer, you may change the destination to the disk drive where you wish SoftMax Pro to reside or accept the default location.
6. The “Setup Type” screen asks you to choose between “Complete” (the default) or “Basic.” Choose Basic to install everything except the tutorial files. Otherwise, click [Next] to continue.
Chapter 2: Installation

7) If you purchased the Drug Discovery version of SoftMax Pro, a default protocol will be installed automatically. If you purchased either the Life Sciences or Enterprise Administrator version of SoftMax Pro, however, you will be asked to choose whether the default protocol should be absorbance or fluorescence. If an instrument is connected to your computer, SoftMax Pro will automatically detect the appropriate instrument setting. If no instrument is connected, choosing absorbance will assign the SpectraMax 190 as the default; choosing fluorescence will assign the SpectraMax Gemini XS. You may change either instrument preference later.

NOTE: During installation, an “Assays” folder is created which contains protocol files for all instrument types, regardless of the choice made above. Some of these protocols will not be appropriate for your particular instrument (they might have reductions that are appropriate only for absorbance or fluorescence instruments, for example). Nevertheless, all protocols can be opened, run, and/or customized to be appropriate for any MDC Microplate System instrument.

8) Click [Next] to start the actual installation of SoftMax Pro files.

9) When installation is complete, the “Finished” screen will appear. Click [Close] to end the installer/setup program. On the Macintosh, remove the CD by dragging its icon to the Trash. On the PC, close the window for the CD and “My Computer” and then press the CD eject button on the CD-ROM drive. Replace the CD in its holder and store it in a safe place.

An open folder named “SoftMax Pro 4.3” will be visible on your screen. This folder contains the SoftMax Pro program. If you want SoftMax Pro to be able to communicate with your MDC Microplate System instrument, be sure to turn the instrument on prior to starting the SoftMax Pro program. After the instrument is powered on and has completed its start-up sequence, double-click the “Spf” icon ( ) to start SoftMax Pro.

NOTE: In Windows, a shortcut for the program will be available in the Start menu under “Programs\SoftMax Pro 4.3\Spf.”

NOTE: An uninstall program is available for Windows computers. Should you need to remove older versions of SoftMax Pro from your hard drive, using the uninstall program is recommended since it also removes information regarding SoftMax Pro from the Windows Registry. To remove SoftMax Pro from a Macintosh computer, simply drag the SoftMax Pro folder and any other SoftMax Pro files you may have on your hard drive to the trash. When you uninstall the program, make sure to backup your data to a folder outside of the SoftMax Pro folder, because the SoftMax Pro folder will be deleted.

What Is Installed

SoftMax Pro can create and use two types of programs: protocol files and data files. Protocol files function similarly to template files: opening a protocol file establishes instrument setup parameters (such as absorbance, endpoint, number of wavelengths, etc.) that can be used as is or modified to suit the needs of your assay. Data files are the result of running a protocol file and contain all
the information collected from the instrument based on the settings from the protocol file.

A folder called “SoftMax Pro 4.3” will be installed in the area you specified on your computer’s hard drive. Within that folder are a number of separate files and subfolders as shown in Table 2.1. Commonly used protocol files are grouped within subfolders that describe the type of assay (e.g., “Kinetic ELISA”).

Protocol files are included to assist with method development. Each protocol file contains predefined groups that have been created based on expectation of use with that protocol. Often all you need to do is open the Template Editor and assign the groups so that what is shown there matches the layout of the plate being used for the reading. Should it be necessary to create or modify groups, information about doing this can be found in Chapters 4 or 5 (for absorbance or fluorescence instruments, respectively).

Certain data files are also included, some of which appear within the Tutorials folder (some assist with learning basic operation of SoftMax Pro and are linked to written tutorials found later in this manual; others are included for you to open and continue learning on your own). Information about the tutorial files is found in Chapter 10.

Note that folder and filenames are the same for Windows and Macintosh except that Windows files have the extension “.ppr” or “.pda” appended to the file name for protocol files or data files, respectively (Enterprise Edition files use extensions “.epr” and “.eda”).

All of the protocol files that are on the software CD are installed as shown in the table below and can be seen in the Assays menu within SoftMax Pro.

Table 2.1: Files that Are Installed

<table>
<thead>
<tr>
<th>Folder</th>
<th>Files</th>
</tr>
</thead>
<tbody>
<tr>
<td>[Main]</td>
<td>Default Protocol</td>
</tr>
<tr>
<td>Basic Protocols</td>
<td>All Kinetic ODs for Export.ppr</td>
</tr>
<tr>
<td></td>
<td>Basic Endpoint Protocol.ppr</td>
</tr>
<tr>
<td></td>
<td>Basic Kinetic Protocol.ppr</td>
</tr>
<tr>
<td></td>
<td>Basic Luminescence.ppr</td>
</tr>
<tr>
<td></td>
<td>Basic Pathcheck Protocol.ppr</td>
</tr>
<tr>
<td></td>
<td>Basic Percent Binding.ppr</td>
</tr>
<tr>
<td></td>
<td>Basic Percent Control.ppr</td>
</tr>
<tr>
<td></td>
<td>Basic Spectrum.ppr</td>
</tr>
<tr>
<td></td>
<td>Basic TRF Protocol.ppr</td>
</tr>
<tr>
<td></td>
<td>Raw Optical Density.ppr</td>
</tr>
<tr>
<td>Cytoproliferation</td>
<td>CyQUANT Fluorescence.ppr</td>
</tr>
<tr>
<td>Drug Discovery, Analyst</td>
<td>Basic FP (w-o bkgrd subtraction).ppr</td>
</tr>
<tr>
<td>[not installed with Life Sciences version]</td>
<td>Basic FP.ppr</td>
</tr>
<tr>
<td></td>
<td>FPIA Assays (w-o bkgrd subtraction).ppr</td>
</tr>
<tr>
<td></td>
<td>FPIA Assays.ppr</td>
</tr>
<tr>
<td></td>
<td>G Factor Determination.ppr</td>
</tr>
<tr>
<td></td>
<td>LDL Determination.ppr</td>
</tr>
</tbody>
</table>
### Table 2.1: Files that Are Installed

<table>
<thead>
<tr>
<th>Folder</th>
<th>Files</th>
</tr>
</thead>
<tbody>
<tr>
<td>Drug Discovery, FLIPR</td>
<td>EC50 percent.ppr&lt;br&gt;EC50 and 2factor.ppr</td>
</tr>
<tr>
<td>[not installed with Life Sciences version]</td>
<td></td>
</tr>
<tr>
<td>Endpt ELISA</td>
<td>AP and pNPP .ppr&lt;br&gt;Bgalactosidase w ONPG.ppr&lt;br&gt;HRP and ABTS w Acid Stop.ppr&lt;br&gt;HRP and ABTS w SDS Stop.ppr&lt;br&gt;HRP and OPD w Acid Stop.ppr&lt;br&gt;HRP and TMB.ppr&lt;br&gt;Urease and Urea Bromocresol.ppr</td>
</tr>
<tr>
<td>Kinetic ELISA</td>
<td>K ELISA with AP and pNPP.ppr&lt;br&gt;K ELISA with HRP and ABTS.ppr&lt;br&gt;K ELISA with HRP and OPD.ppr&lt;br&gt;K ELISA with HRP and TMB.ppr</td>
</tr>
<tr>
<td>LAL Kinetic Chromogenic</td>
<td>Analyst Qualification.ppr&lt;br&gt;Interference Screening.ppr&lt;br&gt;Interference Validation.ppr&lt;br&gt;Reagent Qualification.ppr&lt;br&gt;Routine Testing complete.ppr&lt;br&gt;Routine Testing simple.ppr&lt;br&gt;RSE CSE Standardization.ppr</td>
</tr>
<tr>
<td>LAL Kinetic Turbidimetric</td>
<td>Analyst Qualification.ppr&lt;br&gt;Interference Screening.ppr&lt;br&gt;Interference validation.ppr&lt;br&gt;Reagent Qualification.ppr&lt;br&gt;Routine Testing complete.ppr&lt;br&gt;Routine Testing simple.ppr&lt;br&gt;RSE CSE standardization.ppr</td>
</tr>
<tr>
<td>Nucleic Acids</td>
<td>DNA Background Constant.ppr&lt;br&gt;DNA Plate Blank Method.ppr&lt;br&gt;DNA Pre-Read Method.ppr&lt;br&gt;Oligreen.ppr&lt;br&gt;PicoGreen.ppr</td>
</tr>
<tr>
<td>Other</td>
<td>Antisera Titer.ppr&lt;br&gt;Gemini Optimization.ppr&lt;br&gt;ID 50 Determination.ppr&lt;br&gt;Kinetic With PathCheck.ppr&lt;br&gt;Michaelis Menten.ppr&lt;br&gt;Multiple Peak Protocol.ppr&lt;br&gt;Multiple Peak wavelength and OD.ppr&lt;br&gt;Parallel Line Analysis.ppr&lt;br&gt;Pipettor Regular Test Method.ppr&lt;br&gt;Sample Associated Blank.ppr&lt;br&gt;tTest.ppr</td>
</tr>
</tbody>
</table>
Chapter 2: Installation

Table 2.1: Files that Are Installed

<table>
<thead>
<tr>
<th>Folder</th>
<th>Files</th>
</tr>
</thead>
<tbody>
<tr>
<td>Protein Assays</td>
<td>A280 with cuvette ref.ppr</td>
</tr>
<tr>
<td></td>
<td>A280 with water constant.ppr</td>
</tr>
<tr>
<td></td>
<td>BCA.ppr</td>
</tr>
<tr>
<td></td>
<td>Bradford.ppr</td>
</tr>
<tr>
<td></td>
<td>Lowry.ppr</td>
</tr>
<tr>
<td></td>
<td>NanoOrange.ppr</td>
</tr>
<tr>
<td>Tutorial</td>
<td>☐ Drug Discovery Data Files</td>
</tr>
<tr>
<td></td>
<td>[not included with Life Sciences version]</td>
</tr>
<tr>
<td></td>
<td>☐ Example Text Files for Analyst System</td>
</tr>
<tr>
<td></td>
<td>Import</td>
</tr>
<tr>
<td></td>
<td>Read Me First.txt</td>
</tr>
<tr>
<td></td>
<td>SampleFPData.txt</td>
</tr>
<tr>
<td></td>
<td>SampleFPIData.txt</td>
</tr>
<tr>
<td></td>
<td>SampleGFactorFPData.txt</td>
</tr>
<tr>
<td></td>
<td>SampleIntensityLDLData.txt</td>
</tr>
<tr>
<td></td>
<td>Basic FP (w-o bkgrd subtraction).pda</td>
</tr>
<tr>
<td></td>
<td>Basic FP.pda</td>
</tr>
<tr>
<td></td>
<td>FPIA Assays (w-o bkgrd subtraction).pda</td>
</tr>
<tr>
<td></td>
<td>FPIA Assays.pda</td>
</tr>
<tr>
<td></td>
<td>G Factor Determination.pda</td>
</tr>
<tr>
<td></td>
<td>G Factor Determination.pda</td>
</tr>
<tr>
<td></td>
<td>LDL Determination.pda</td>
</tr>
<tr>
<td></td>
<td>☐ Formula Reference Guide Examples</td>
</tr>
<tr>
<td></td>
<td>Example 5-1 Method 1.pda</td>
</tr>
<tr>
<td></td>
<td>Example 5-1 Method 2.pda</td>
</tr>
<tr>
<td></td>
<td>Example 5-2.pda</td>
</tr>
<tr>
<td></td>
<td>Example 5-3.pda</td>
</tr>
<tr>
<td></td>
<td>Example 5-4.pda</td>
</tr>
<tr>
<td></td>
<td>Example 5-5.pda</td>
</tr>
<tr>
<td></td>
<td>Example 5-7.pda</td>
</tr>
<tr>
<td></td>
<td>☐ tTest and Parallel Line Analysis</td>
</tr>
<tr>
<td></td>
<td>Parallel lines.pda</td>
</tr>
<tr>
<td></td>
<td>tTest.pda</td>
</tr>
<tr>
<td></td>
<td>Absorbance Default Protocol.ppr</td>
</tr>
<tr>
<td></td>
<td>Drug Discovery Default Protocol.ppr</td>
</tr>
<tr>
<td></td>
<td>Endtut.pda</td>
</tr>
<tr>
<td></td>
<td>Gemini Default Protocol.ppr</td>
</tr>
<tr>
<td></td>
<td>Tutorial2.pda</td>
</tr>
</tbody>
</table>

**NOTE:** The data files for the tutorial are in *.pda Format. You can access them by going to **File>Open** and locating the Tutorial folder in your SoftMax Pro folder. Only *.ppr files can be seen through the **Assays** menu.
Enter Registration Information

Turn the instrument on and allow it to complete its start-up sequence (approximately 30-90 seconds, depending on the instrument type). Then double-click the SoftMax Pro program icon ( ) inside the SoftMax Pro folder (Mac) or click the desktop icon or choose SoftMax Pro from the Start menu (Windows) to start the software program. The first time you open SoftMax Pro, a registration dialog box will appear, asking that you enter your name, company, and the serial numbers of the software program and MDC Microplate System instrument. The software serial number can be found on the original SoftMax Pro CD, on the inside cover of this manual, and on the software Warranty Registration Card (please remember to fill out this card and return it to Molecular Devices Corporation). The instrument serial number (S/N) is located on a label affixed to the back of the instrument. Type the information in the spaces provided and then click [OK]. Note that the option to click [OK] will not be available until all information has been entered.

![Registration Dialog Box](image)

*Figure 2.4: Registration Dialog Box*

After all information has been entered correctly and you click [OK], a title screen will appear (see Figure 2.5) showing the registration information you entered. If you have difficulty entering the registration information, refer to Chapter 11, “Troubleshooting,” for assistance.
After a few seconds, the title screen will be replaced by an untitled SoftMax Pro window (see Figure 2.6). The screen you see may be different, depending upon the type of instrument you are using.

**Figure 2.5: SoftMax Pro Title Screen Examples**

**Figure 2.6: SoftMax Pro Default Protocol Untitled Window**
Communicating with the MDC Microplate System Instrument

After installation of SoftMax Pro, you will note that the instrument icon in the upper left-hand corner of the window appears with an “X” and the words “No port selected” through it. You must access the Preferences settings (from the Edit menu, choose the Preferences command) to select the proper communications port (which port depends on the configuration of your computer—typically either “modem” or “printer” for the Macintosh and COM1 through COM9 for the PC). Serial ports that are not available will be dimmed. An additional setting (the factory default) is “Neither.” This selection is used when you do not have an instrument connected to the computer but wish to use SoftMax Pro or when the port connection must be disabled for other reasons. Choose the appropriate setting for your computer’s physical serial port connection and click [OK]. The instrument icon should now appear normally (without an X through it).

Figure 2.7: Preferences Dialog Box (Windows, top; Macintosh, bottom)
If the port setting is correct and the MDC Microplate System instrument is on, yet communication is still not functioning properly, quit SoftMax Pro, turn off power to both the computer and the MDC Microplate System instrument, and check that the cable connections between the instrument and computer are secure. Turn both machines on again and restart SoftMax Pro. If an “X” still appears over the icon, refer to Chapter 11, “Troubleshooting,” for more information.

Set Preferences

It is a good idea to set the SoftMax Pro preferences before proceeding to use the program. The preferences include certain configuration settings, such as which port is used for the connection to the instrument, filters for Emax, Vmax, UVmax, and ThermoMax, as well as settings for automatic printing and saving of files, and the format for exported data. To make these selections, choose Preferences from the Edit menu to bring up the Preferences dialog box (see Figure 2.7).

Serial Port

Check that the setting for the serial port matches the physical port used to connect the computer and the instrument. The example dialog box shown at the top of Figure 2.7 shows the serial port set to the Macintosh modem port. The Windows dialog box example shows the serial port set to “None.”

![Figure 2.8: Serial Port Selection in Preferences Dialog Box](image)

Note that COM ports from 1 through 9 that are not available for your particular computer will be shown dimmed.

**NOTE:** A selection of “None” can be made if communication with an instrument is not required or if no instrument is connected to the computer. When this option is selected, the Status Bar in SoftMax Pro will show an instrument icon with an “X” through it, along with the words “No port selected.” This selection allows you to use the serial

3. If you are using a Keyspan serial adapter with a Macintosh computer, set the port to “Printer.”
ports for other purposes (modem connection, network connection, or printing, for example) but does not allow you to communicate with the instrument.

**NOTE:** When the FlexStation is selected in the Preferences, another option becomes available regarding the Serial Comm Speed (see below).

![Figure 2.9: Serial Port Speed Selection in Preferences Dialog Box (FlexStation only)](image)

SoftMax Pro automatically detects the baud rate of the instrument to which the computer is connected and establishes a communication rate accordingly. This option allows you to view the baud rate that is being used and to manually set a different rate, but this should not be done unless a serial communications problem occurs (see Chapter 11, “Troubleshooting,” for more information).

**Export Format**

![Figure 2.10: Export Format selection in Preferences dialog box](image)

The preferences settings regarding the Export Format allow you to choose whether to export data as it appears in plate format or linearly (over time). The option to include text labels along with numerical data and/or to add the filename and date can be activated by clicking the checkboxes next to those items. (The option for “Interpolate Wells” is available only with the FlexStation instrument.) For more information on the Export... function, refer to “Exporting/Importing Information” on page 9-16.
Reader

The Reader pop-up menu indicates which instrument is currently connected to the computer. When the computer is connected to a MDC Microplate System instrument, the instrument type shown in the box will be set to that instrument type.

![Reader selection in Preferences dialog box](image)

If the computer is not connected to an instrument, the Reader type defaults to the last reader connected, but you can choose a different instrument from the menu.

**NOTE:** It is not required that you choose a particular MDC Microplate System instrument prior to writing a protocol using SoftMax Pro when the computer is not connected to an instrument. Choosing an instrument first can be useful, however, since the options available in the Instrument Setup dialog box depend on the choice of instrument (for example, with a SpectraMax you can choose up to six wavelengths but you cannot do this with a Vmax).

Filters

The use of this button applies only to Emax, Vmax, UVmax, and ThermoMax instruments (this button is dimmed when another instrument is selected).
Clicking the [Filters] button brings up a dialog box showing six filter positions.

![Filters Dialog Box]

Figure 2.12: Filters Dialog Box

⚠️ CAUTION: Check that the filter wavelength shown for each position accurately reflects the wavelength of the filter installed in each position of the filter wheel. Highlight and change (type over) incorrect values. If the settings in this dialog box are not correct, subsequent readings will generate incorrect data.

NOTE: While the SpectraMax 250 can also accept two optional filters, the wavelengths for these filters are entered differently, using the instrument front panel. For additional information regarding the installation of optional filters in the SpectraMax 250, refer to the instrument manual.

**Autosave**

Enabling the Autosave feature in the Preferences dialog box will save a data file automatically each time a plate is read.

![Autosave portion of Preferences Dialog Box]

Figure 2.13: Autosave portion of the Preferences Dialog Box

Autosave saves a copy of the file that is currently open. If the file that is open is a protocol file, note that the file will still be “Untitled” (i.e., not yet named).
even after an autosave has occurred. This allows you to autosave to a text file format and then save manually as a SoftMax Pro file.

You can Autosave to one of two different file formats:

- SoftMax Pro—used to save your data automatically in SoftMax Pro format.
- Text File—used when you want to have the data available for use with a spreadsheet or other program for data analysis external to SoftMax Pro.

**NOTE:** If you autosave as a text file, the SoftMax Pro version of the data **WILL NOT BE SAVED AUTOMATICALLY** and you will not be able to automatically re-open the data file in SoftMax Pro. **If you choose to save to this format, you will need to save your data manually,** using the **Save** or **Save As...** commands in the **File** menu if you also want to save a SoftMax Pro file. If you attempt to quit SoftMax Pro before saving a file containing data that has not yet been saved, a message box will appear asking if you want to save the file. You can assign any name to a file you save manually.

**NOTE:** If your protocol contains more than one experiment section when you Autosave to SoftMax Pro file format, each experiment will be saved to a separate data file.

**NOTE:** Enterprise Administrator can update and modify the autosave parameters of Softmax Pro Enterprise Edition.

When Autosave is enabled, the box below the Autosave option becomes active, allowing you to choose the folder within which data files will be saved and the type of file to be saved. You may choose to autosave as a SoftMax Pro file (default) or as a text file and, when saving as a text file, you may choose to append to the same file.

The default folder for saving files is the SoftMax Pro 4.3 folder. To save data files in a different folder, click the **[Set]** button. A dialog box will open, allowing you to choose a new location for saved files.

![Select Directory](image)

*Figure 2.14: Autosave Location Dialog Box (Windows)*

Highlight the folder within which you want files to be saved. The **[Select]** button at the bottom of the dialog box will reflect this choice; clicking the **[Select]** button will set this folder as the default location for saved data files. You can change the location at any time by repeating this process.

To change the file format from SoftMax Pro to ASCII text, select the Text File format from the list.
If the Autosave function is reporting an error, or if files are saved in the wrong location, it may be that a previous version of SoftMax Pro was not uninstalled prior to installing a newer version. Follow the instructions given above to choose the correct folder for saved files.

**Create New File (when saving as Text file only)**

After each Plate section or CuvetteSet section is read, the data will be saved in a new file. This file will contain all the data from the current and previous readings (for example, if you read a Plate section, then another Plate section, followed by a CuvetteSet section, File1 will contain data for Plate1; File2 will contain data for Plate1 and Plate2; and File3 will contain data for both plates and the cuvette). This option is available for both file formats (SoftMax Pro and ASCII text).

⚠️ **CAUTION:** If you Autosave to ASCII text format, you will **not** have a SoftMax Pro version of the file unless you also manually save the file using the **Save as...** command.

**Append to File (when saving as Text file only)**

If you are saving data to an ASCII text file, you may choose to save all data to a single file for all plates and/or cuvettes by choosing “Append to File.” This option is dimmed (not available) if you are saving to a SoftMax Pro file.

**File Prefix**

The information entered into the “File Prefix” field is automatically given to new files that are saved automatically. The default prefix is “Data.” Accepting this default saves files starting with the name “Data” followed by a sequential number beginning with “1.” For example, the first microplate read would be saved under the file name “Data 1.”

![Preferences](Image)

**Figure 2.15: File Prefix Field (Windows)**

You can change this default prefix to any other prefix (up to 15 characters). To change the prefix, click within the File Prefix field, highlight the existing information, and type over the word to enter a new prefix.

If the File Prefix field is left blank, the date of the run will be used as the file prefix.

**Append Date**

Enabling the checkbox for Append Date will cause the date to be included in the automatic file name for the saved data file. For example, using the file pre-
fix “Data,” the first file saved on January 31, 2001, would have the name “Data 01/31/2001 1.” Note that, if a time is not appended (see the next item), SoftMax Pro indexes the runs for that day starting with “1” and incrementing upward with each successive run.

Append Time

Enabling the checkbox for Append Time will include the time in the automatic file name for the saved data file in the format hhmmss. For example, using the file prefix “Data,” the file saved at 10:12:38 a.m. would have the name “Data 101238.”

Autoprint

Checking this box will enable automatic printing of a report after each plate is read. This report will contain information from each section that is designated to be included in the report (the default is15 for all sections to be included). For more information on reports, and including or excluding sections, see Chapter 3, “SoftMax Pro Overview.”
Assays Folder

The **Assays** menu is used to choose the folder that will contain protocol files you wish to access most often. After installation of SoftMax Pro, the protocol files shown under the **Assays** menu will be the basic protocols shipped with the software. Other folders are installed with SoftMax Pro containing protocol files for other types assays—you may select one of these folders instead, if desired.

To change the default folder, choose **Assays** and then choose **Set Folder...**. A dialog box will appear, asking you to choose the folder or directory containing the protocol files you wish to have appear in the **Assays** menu. Select one of the other folders within the SoftMax Pro directory/folder or, if you have other protocol files in a different location, choose that location and then click **Select**.

**NOTE**  If you do not see any files in the Assays menu or if the files shown are not correct, it may be that a previous version of SoftMax Pro was not uninstalled prior to installation of a newer version. This can cause SoftMax Pro to default to using the old directory for assay files rather than the directory associated with the most current program version. Follow the instructions given above to choose the correct folder for the default assays folder.
Chapter 3: SoftMax Pro Overview

Introduction ................................................. 3-3
The SoftMax Pro Window ................................. 3-3
Window Size ................................................. 3-6
Status Bar ...................................................... 3-7
Experiments and Sections ................................. 3-8
   Experiments ............................................. 3-8
   Sections .................................................. 3-9
   Notes Section .......................................... 3-13
   Plate Section .......................................... 3-15
   CuvetteSet Section ..................................... 3-17
   Group Section .......................................... 3-19
   Graph Section .......................................... 3-21
Instrument Settings ....................................... 3-23
Menus and Commands ...................................... 3-23
   Apple Menu ............................................ 3-26
   About SoftMax Pro .................................... 3-26
   File Menu .............................................. 3-26
   Edit Menu ............................................. 3-28
   View Menu ............................................. 3-30
   Experiment Menu ...................................... 3-30
   Control Menu .......................................... 3-31
   Assays Menu ........................................... 3-32
   Plate Menu ............................................. 3-33
   CuvetteSet Menu ....................................... 3-35
   Notes Menu ............................................ 3-36
   Graph Menu ............................................ 3-37
   Group Menu ............................................ 3-38
   Window Menu .......................................... 3-39
   Help Menu—Windows ................................. 3-39
   Help Menu—Macintosh ............................... 3-39
Interprocess Messaging ................................. 3-40
Introduction

This chapter presents a general description of the features and use of SoftMax Pro. It describes:

- the parts of the SoftMax Pro window, including experiments and sections;
- the menus and tool bars found within the SoftMax Pro program;
- the basic steps required to perform a reading (complete information regarding reading using SoftMax Pro can be found in Chapters 4 or 5—choose the chapter that is appropriate for the instrument you are using); and
- the basic types of data analysis (detailed information regarding data analysis can be found in Chapters 7 or 8—choose the chapter that is appropriate for the instrument you are using).

SoftMax Pro employs standard Macintosh and Windows conventions for using menus, dialog boxes, windows, and the mouse. This manual assumes that you are familiar with the basic operation of your computer. While some general instructions are given here, and many of the terms used in SoftMax Pro are defined in Appendix B, “Glossary of Terms,” if you need additional assistance regarding the basic use of your computer, please review the documentation accompanying it.

The SoftMax Pro Window

When you start SoftMax Pro, a title screen will appear, showing the information entered during registration, along with the SoftMax Pro version, the instrument type (if connected), the ROM version installed in the instrument (if available), and copyright information.

Figure 3.1: SoftMax Pro Title Screen Examples
After a few seconds, the title screen will be replaced by an untitled SoftMax Pro window. The window for the Macintosh should now look similar to the one in Figure 3.2. The window for the PC should look similar to the one in Figure 3.3.

The SoftMax Pro screen contains these major elements:

• A menu and status bar located at the top of the screen;
• An untitled window showing an experiment containing various sections, depending upon the configuration of the default protocol used and the type of instrument chosen in the Preferences or connected to the computer.

The menu and status bars are always visible while you are using SoftMax Pro, no matter where you are within the program.

![Figure 3.2: SoftMax Pro Screen and Window for Macintosh](image)
Figure 3.3: SoftMax Pro Screen and Window for the PC (Windows)
Window Size

You may change the size of the window shown on the Macintosh by dragging the size box (at the bottom right corner of the window) in any direction. You can expand the window to the full size of the screen by clicking the zoom box (in the upper right corner of the window). If you extend the bottom edge of the window beyond the last section or the right edge beyond the edge of the sections, the intervening space will be gray. To resize the window again, drag the size box to a different position or click the zoom box again. Clicking the zoom box will restore the previous window size.

NOTE: If you move the SoftMax Pro window such that the title bar is under the status bar, you will have to hide the status bar before you can move the window to see the title bar again.

You may change the size of the window shown in Windows by dragging the side, bottom, or corner of the window (when the cursor changes into a double-headed arrow). You can expand the window to the full size of the screen by clicking the Maximize button in the upper right corner of the window. If you extend the bottom edge of the window beyond the last section or the right edge beyond the edge of the sections, the intervening space will be gray. You can also reduce the window to an icon by clicking the Minimize button in the upper right corner of the window. When the window is shown as an icon, it is still functional; double clicking the icon will restore the window to its previous size. Other options are available for resizing windows—refer to the documentation that came with your Windows software for more information.

NOTE: The width of the experiment and sections shown in the window is constrained by the width set for the printed page size. The dimensions and orientation of the printed page (and, consequently, the display size) may be changed by selecting either Page Setup... (Macintosh) or Print Setup... (Windows) from the File menu.
Status Bar

Near the top of the SoftMax Pro window is a status bar that shows the type of instrument that is connected to the computer or selected as the Reader type via the Preferences menu (see Figure 3.4).

**Figure 3.4: Status Bars for MDC Microplate System Instruments**

The status bar shows some or all of the following items, depending on the type of instrument connected or chosen (from left to right):

- **Instrument icon.** An icon such as that shown at the left indicates that the instrument is communicating properly with the computer. If an “X” appears on top of the icon, the computer is not making proper contact with the instrument.
  
  **NOTE:** Double-clicking the instrument icon opens the Preferences dialog box.

- **Temperature display.** With ThermoMax, VersaMax, SpectraMax, or FlexStation instruments, a small window after the instrument icon shows the current temperature within the microplate chamber in degrees Celsius.
  
  **NOTE:** With the SpectraMax Plus and Plus384, the SoftMax Pro status bar shows the temperature within the microplate chamber. This is different from the front panel of the instrument which displays the temperature within the cuvette chamber. The readings should be very similar to one another after both chambers have reached equilibrium. During warm-up, however, you may notice a discrepancy in temperatures, which is normal.
Chapter 3: SoftMax Pro Overview

The **Read** button. If a single Plate or CuvetteSet section has been created in the experiment window, clicking the **Read** button starts the reading. This reading is based on the settings chosen in the Instrument Settings dialog box (refer to “Instrument Setup”) for the plate.

If more than one Plate or CuvetteSet section has been created in the experiment window and no Plate or CuvetteSet section is currently active, clicking the **Read** button opens a dialog box asking you to select which plate (or cuvette) to read. If a CuvetteSet or Plate section is active when you click the **Read** button, that section is read automatically.

The **REF** button. If a CuvetteSet section has been created and is active, this button will be displayed. Clicking the **REF** button will reference the cuvette. The reference is based on information entered in the Instrument Settings dialog box. The reference reading may be taken before or after the sample reading. This setting applies only to the SpectraMax Plus and Plus384.

The **Incubator** button. With ThermoMax, VersaMax, SpectraMax, and FlexStation instruments, clicking the button that shows a thermometer causes the “Incubator” dialog box to appear, allowing you to set and regulate the temperature of the microplate/cuvette chamber. The temperature setting can be left at the default or can be specified by typing a different value in the box.

**NOTE:** The incubator setting is independent of the protocol being run. Running an assay does not automatically set the temperature set point. After a reading, however, the temperature set point, range, and average temperature are recorded in the saved file.

The **Automix** button. Clicking this button shakes the microplate. (Note: This is a “manual” shaking of the plate as opposed to an “automatic” shaking that can be chosen in the instrument settings and is not enabled for the Emax.)

The **Drawer** button. Clicking this button opens or closes the microplate drawer.

**NOTE:** The status bar can be hidden from view by selecting **Hide Status** from the View menu. Selecting **Show Status** from the view menu will restore it to view.

Experiments and Sections

Experiments

Each SoftMax Pro file contains at least one experiment (and can contain more than one). Within an experiment are one or more sections (discussed below). Experiments define a naming scope for the sections within them and provide quick access to different types of information without the need to open or refer to multiple files.

An experiment can be selected by clicking its tool bar (the area that shows the experiment name) with the mouse. Selecting an experiment causes its tool bar to change from light gray to darker gray and the experiment title to be shown in boldface type. Selecting is different from activating an experiment. Selecting an experiment allows you to perform actions on the entire experiment (such
as deleting or duplicating it). Multiple experiments can be selected by holding down the Shift key while clicking the individual tool bars of the experiments.

A single click anywhere within an inactive experiment activates it. Activating an experiment allows you to add new sections to it or to perform other operations within that experiment. (With sections, however, selecting and activating are identical functions. Clicking anywhere within an inactive section activates and selects it.)

You can create a new experiment by choosing New from the Edit menu. Choosing Duplicate from the Edit menu creates an identical copy of the currently selected experiment (excluding data). The new experiment retains the same name as the original, with the word “Copy” appended when you choose to Duplicate (e.g., the duplication of “Experiment1” produces “Experiment1 Copy”) and an increment of number when you choose New (e.g., “Experiment1” becomes “Experiment2”).

An experiment can be deleted if it is no longer needed. The Delete command in the Edit menu changes depending upon which experiment is active. For example, if the experiment labeled “Experiment #1” is active, the Edit menu will show Delete Experiment #1. Using the Macintosh, you can also delete the selected experiment by pressing Ô-; within Windows, you can press CTRL-. Take care before deleting experiments that they do not contain information you wish to save.

You may delete multiple experiments simultaneously by holding down the Shift key and activating the tool bars of the experiments you wish to delete. Having done this, the Edit menu will now show Delete Selection instead of Delete Experiment.

You can add new sections to the active experiment using the New Section command under the Edit menu.

## Sections

There are five types of sections: Notes, Plate, Cuvette, Group, and Graph. A brief synopsis of these sections is given below.

**Notes sections** are used to record information pertaining to the experiment. You can enter text in this section as you desire; in addition, you can create summaries containing formulas for displaying reduced data. Text in Notes sections can be formatted (font, size, and style any way you choose).

Each **Plate section** shows a grid of cells which corresponds to the wells of the microplate. To the right of or underneath this grid is a box showing the current instrument settings (except incubator settings, which are always shown at the bottom of the Plate section after data is acquired). In the Plate section, you define a template to be used for analysis, determine the instrument settings, choose how the data will be displayed, and define the type of reduction (if any) that will be performed on the raw data received from the instrument.

**CuvetteSet sections (SpectraMax Plus or Plus only)** determine how the cuvette will be read, define templates to be used for analysis, display data as it is acquired from the instrument, define how the data will be displayed, and define the type of data reduction. The CuvetteSet section can display samples in three different ways: three samples per row, one sample per row, and in a grid of cells which is similar to a microplate format. To the right of the data display in the section is a
Chapter 3: SoftMax Pro Overview

box showing the current instrument settings, except incubator settings (these are
shown at the bottom of the CuvetteSet section after the first cuvette in the set is
read).
Group sections are created automatically when groups are defined in the Template Editor. The example shown at left is for a group named “Standard.” Protocol
files generally contain default groups; you can create others as needed. Each
Group section contains default columns of data which can also be changed, if desired. Within a Group section, you can resize columns, modify existing columns to
use different analysis formulas, add columns containing new formulas, and/or
add one or more summaries at the bottom of the section.
Graph sections are used to plot information from groups (defined in the Template
Editor). Values associated with the X- or Y-axes depend on the type of group selected for graphing. More about Graph sections can be found in Chapters 7 or 8
(choose the chapter that is appropriate for the instrument you are using).

General Information about Sections
Sections are either active or inactive. When active, the section title bar is colored dark gray. Multiple sections can be active at the same time. The tool bars
of inactive sections are color coded to make it easier to discern a section’s
type:
Inactive Experiment or Section . . . . . . . Color (Pastel Shade)
Experiment . . . . . . . . . . . . . . . . . . . . . . . . .
Plate . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
CuvetteSet. . . . . . . . . . . . . . . . . . . . . . . . . .
Notes . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Group. . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Graph. . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Gray
Purple
Green
Yellow
Pink
Blue

Clicking anywhere in an inactive section makes it active. Selecting an experiment deactivates any individual section within it that may have been active
and vice versa. Activating a section also activates the experiment containing
that section. To activate multiple sections at the same time, hold down the
Shift key and click in the tool bars of the sections you wish to activate. Doing
this allows you to move, copy, duplicate, print, and delete multiple sections
simultaneously.
The “section” item in the SoftMax Pro menu bar is shown when a changes to
reﬂect the type of section that is active. If a Plate section is active, for example,
this menu item will show “Plate.” If an experiment or multiple sections are
selected, this menu item will not be shown.
New Plate, Cuvette, Notes, or Graph sections can be created whenever you
need them and more than one of each type of section can exist in a single SoftMax Pro experiment. (Group sections are created automatically when you
deﬁne new groups in the Template Editor or may be created with the Duplicate command.)
A section can be deleted if it is no longer needed. The Delete command in the
Edit menu changes depending upon which section is active. For example, if
the section titled “Plate #1” is active, the Edit menu will show Delete Plate
#1. Using the Macintosh, you can also delete the active section by pressing
–; within Windows, you can press CTRL+–. Take care when deleting sections
that they do not contain information you wish to save. You may also delete

3-10

SoftMax Pro User’s Manual


multiple sections simultaneously by making them active—the **Delete** command in the **Edit** menu will change to show **Delete Selection**.

**NOTE:** Deleting a Group section automatically deletes references to that group from the Template. See either Chapter 4 or 5 (choose the chapter that is appropriate for the instrument you are using) for more information.

Section tool bars contain buttons and pull-down menus. Buttons in the tool bar are only enabled when that section is **active** (the section does **not** need to be **open**). Menu equivalents exist for all tool bar functions. Figure 3.5 shows the active tool bar from a Graph section.

**Figure 3.5:** Tool Bar from an Active Graph Section

If you scroll the window vertically so that part of an open/active section is hidden, its tool bar “sticks” to the top of the window (see Figure 3.6). This feature prevents the active tool bar from becoming unavailable if you are viewing the bottom of a section that is longer than the size of the window. When the next section scrolls to the top of the window, its tool bar replaces the previous one but is **not active**, even if the section is open (until you click within it). If you scroll back so that even a small part of the previous (active) section is visible, its tool bar returns to the top of the window.

**Figure 3.6:** Example of a Tool Bar “Sticking” to the Top of the Window.
Opening and Closing Sections

Newly created experiments and sections are initially shown in their full-size (open) form. You can close them, however, to show just their tool bars, if desired. Sections that are created automatically by SoftMax Pro may be shown initially either open or closed, depending on the default protocol file in use.

To open or close a single section within SoftMax Pro, click its indicator located in the top left corner of the tool bar. When an experiment or section is closed, the indicator points to the right ( ); when open, the indicator points down ( ). Figure 3.7 shows an open experiment containing three sections—the first two are closed and the last one is open.

![Figure 3.7: Closed and Open Sections](image)

The Notes#1 and Plate#1 sections are closed; the Standards section is open.

To open or close multiple sections within an experiment (or multiple experiments in a file) simultaneously, use the Expand and Minimize commands in the View menu. Selecting Minimize ( for Macintosh;  for Windows) will close all sections (leaving experiments open) to show only section title bars. Selecting Expand ( for Macintosh;  for Windows) will open all sections.

**NOTE:** If you close or minimize an experiment, the tool bars in that experiment will be hidden (see Figure 3.8). If all sections are presently expanded, the Expand command is dimmed (unavailable).

![Figure 3.8: Result of Minimizing an Experiment (Tool Bars Hidden)](image)

You may also open a section in a separate window. Double-clicking the section icon (in the tool bar) or selecting New Window from the active section menu (either Plate, CuvetteSet, Graph, Notes, or Group) causes the currently active section to open as a separate window (a copy of the tool bar still remains in the original experiment, but the section is closed; clicking the closed section places the new window behind the main window (the original section remains closed). Clicking on the triangle in the section tool bar closes the new window and causes the section in the experiment to open (and closing the separate window opens the section within the experiment again). All
of the tool bar options applicable to the section are available in the separate window (except the triangle indicator).

![Figure 3.9: Separate Section Window](image)

**Notes Section**

<table>
<thead>
<tr>
<th>Tool Bar</th>
<th>Body</th>
<th>Summaries</th>
</tr>
</thead>
</table>

**Results of Tests Performed**

*This test was run by:*

*Date and time the test was run:*

*Verified by:*

Acceptability criteria for this test: Optical Density greater than 0.030 and less than 0.030.

- Results of Test #1: Acceptable
- Results of Test #2: Acceptable
- Results of Test #3: Acceptable

If the tests report “Out of Specification,” please view the individual plate sections to determine which wells are out of acceptable range.

**Figure 3.10: Example Notes Section, Named “Results”**
The Notes section is used to record information that pertains to the experiment. You can enter text of any kind and add summaries containing reduction formulas.

The Notes section is divided into two areas:

- The tool bar
- The body

You may create multiple Notes sections within the same experiment.

The tool bar contains the following items (shown with their tool bar or mouse equivalents). These menu items and buttons are active only when a Notes section is active.

### Table 3.1: Notes Section Menu Commands and Tool Bar Buttons

<table>
<thead>
<tr>
<th>Menu Command/ Mouse Equivalent</th>
<th>Description</th>
<th>Tool Bar Button</th>
</tr>
</thead>
<tbody>
<tr>
<td>Notes section icon</td>
<td>Opens the Notes section in a new window</td>
<td>📚 (double-click)</td>
</tr>
<tr>
<td>Name of Notes section</td>
<td>Opens the Section dialog box</td>
<td>📒 Introduction (double-click)</td>
</tr>
<tr>
<td><strong>New Window in the Notes menu</strong></td>
<td>Opens the section in a new window</td>
<td></td>
</tr>
<tr>
<td><strong>Section Name in the Notes menu</strong></td>
<td>Opens the Section Name dialog box</td>
<td></td>
</tr>
<tr>
<td><strong>Create Summary in the Notes menu</strong></td>
<td>Opens the Calculation dialog box, allowing you to create a summary</td>
<td>📊</td>
</tr>
<tr>
<td><strong>Edit Summary in the Notes menu or double-click the summary (pointer changes to double-headed arrow)</strong></td>
<td>Opens the Calculation dialog box, allowing you to edit the summary</td>
<td>📊</td>
</tr>
<tr>
<td><strong>Show/Hide Formulas in the Notes menu</strong></td>
<td>Shows/hides the calculations used to derive summaries</td>
<td></td>
</tr>
<tr>
<td>Printer icon</td>
<td>Includes/excludes section from printed report</td>
<td>📇</td>
</tr>
</tbody>
</table>
Plate Section

The Plate section is used to collect data from the instrument, define how the data is displayed, and what the initial reduction of the data will be. In addition, the Template Editor in the Plate section is used to create a “map” of the contents of the microplate.

Choosing a particular function or command in the Plate section can be done in several ways. You can use the mouse to click on a button, choose a command from one of the drop-down menus in the menu bar, or press a keystroke combination to activate a command or function.

The Plate section is divided into four areas:

- **Tool bar**
- **Data display** (shown in a microplate grid format)
- **Instrument settings**, shown to the right of or below the data display, depending on the plate type and printer settings
- **Reduction settings**, shown to the right of or below the data display, depending on the plate type and printer settings
- **Fluid transfer and checksum status** for the FlexStation instrument

When the grid in the Plate section shows colors, this means that a template has been defined for this Plate section. Each group defined in the template has a different color (the icon of the corresponding group table will have the same color).

If your experiment requires multiple plates, you can create as many Plate sections as needed.

The **Plate** menu contains the items shown in Table 3.2 (shown with their tool bar or mouse equivalents). These menu items and buttons are active only when a Plate section is active.

---

**Figure 3.11: Plate Section**

The Plate section is used to collect data from the instrument, define how the data is displayed, and what the initial reduction of the data will be. In addition, the Template Editor in the Plate section is used to create a “map” of the contents of the microplate.

Choosing a particular function or command in the Plate section can be done in several ways. You can use the mouse to click on a button, choose a command from one of the drop-down menus in the menu bar, or press a keystroke combination to activate a command or function.

The Plate section is divided into four areas:

- **Tool bar**
- **Data display** (shown in a microplate grid format)
- **Instrument settings**, shown to the right of or below the data display, depending on the plate type and printer settings
- **Reduction settings**, shown to the right of or below the data display, depending on the plate type and printer settings
- **Fluid transfer and checksum status** for the FlexStation instrument

When the grid in the Plate section shows colors, this means that a template has been defined for this Plate section. Each group defined in the template has a different color (the icon of the corresponding group table will have the same color).

If your experiment requires multiple plates, you can create as many Plate sections as needed.

The **Plate** menu contains the items shown in Table 3.2 (shown with their tool bar or mouse equivalents). These menu items and buttons are active only when a Plate section is active.
### Table 3.2: Plate Section Menu Commands and Tool Bar Buttons

<table>
<thead>
<tr>
<th>Menu Command/ Mouse Equivalent</th>
<th>Description</th>
<th>Tool Bar Button</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plate section icon</td>
<td>Opens the Plate section in a new window</td>
<td>![Plate #1] (double-click)</td>
</tr>
<tr>
<td>Name of Plate section</td>
<td>Opens the Section dialog box</td>
<td>![Plate #1] (double-click)</td>
</tr>
<tr>
<td><strong>Instrument Setup...</strong> in the Control menu</td>
<td>Opens the Instrument Settings dialog box for this plate</td>
<td>![Setup]</td>
</tr>
<tr>
<td><strong>Template...</strong> in the Plate menu</td>
<td>Opens the Template dialog box allowing you to create or edit the template</td>
<td>![Template]</td>
</tr>
<tr>
<td><strong>Reduction...</strong> in the Plate menu</td>
<td>Opens the Reduction dialog box containing reduction settings</td>
<td>![Reduction]</td>
</tr>
<tr>
<td>Double-click in a single well or when several wells are selected; <strong>Graph</strong> in the Plate menu</td>
<td>Enlarges selected well(s) to a Well Graph display (Kinetic and Spectrum modes only); choosing <strong>Graph</strong> again returns to regular display (toggle)</td>
<td>![Graph]</td>
</tr>
<tr>
<td><strong>Display...</strong> in the Plate menu</td>
<td>Opens the Display dialog box containing display choices</td>
<td>![Display]</td>
</tr>
<tr>
<td><strong>Mask</strong> in the Plate menu</td>
<td>Masks the selected wells</td>
<td>![Mask]</td>
</tr>
<tr>
<td>Printer icon</td>
<td>Includes/excludes section from printed report</td>
<td>![Printer]</td>
</tr>
<tr>
<td><strong>Section Name...</strong> in the Plate menu</td>
<td>Opens the Section dialog box, allowing you to rename the section</td>
<td>![Section Name]</td>
</tr>
<tr>
<td><strong>New Window</strong> in the Plate menu</td>
<td>Opens the section in a new window</td>
<td>![New Window]</td>
</tr>
<tr>
<td><strong>Copy Template</strong> in the Plate menu</td>
<td>Copies the template, allowing it to be pasted to another Plate section</td>
<td>![Copy Template]</td>
</tr>
<tr>
<td><strong>Paste Template</strong> in the Plate menu</td>
<td>Pastes a previously copied template to a new Plate section</td>
<td>![Paste Template]</td>
</tr>
<tr>
<td><strong>Export Template</strong> in the Plate menu</td>
<td>Opens the Export Template to... dialog, allowing you to export a template to an ASCII text file</td>
<td>![Export Template]</td>
</tr>
<tr>
<td><strong>Import Template</strong> in the Plate menu</td>
<td>Opens the Import Template to... dialog, allowing you to import a template from an ASCII text file</td>
<td>![Import Template]</td>
</tr>
</tbody>
</table>
Chapter 3: SoftMax Pro Overview

CuvetteSet Section

The CuvetteSet section allows you to collect data from the cuvette port of the SpectraMax Plus or Plus 384, define a template to be used for analysis, define how the data will be displayed, and define the type of data reduction. The Template Editor in the CuvetteSet section is used to describe the contents of the Cuvette.

Choosing a particular function or command in the CuvetteSet section can be done in several ways. You can use the mouse to click on a button, choose a command from one of the drop-down menus in the menu bar, or press a key-stroke combination to activate a command or function.

The CuvetteSet section is divided into four areas:
- Tool bar
- Data display (can be shown in three different ways: three samples per row, one sample per row, and in a grid of cells which is similar to a microplate format)
- Instrument settings, shown to the right of the data display
- Reduction settings, shown at the bottom of the data display

When colors appear in the name labels above individual cuvettes (when displayed as one or three cuvettes per row) or when colored areas appear when the CuvetteSet section is displayed as a grid, this means a template has been defined for the CuvetteSet section. Each group defined in the template has a different color (the icon of the corresponding group table will have the same color).

If your experiment requires multiple cuvettes, you can add up to 96 cuvettes in a single CuvetteSet section and/or create more than one CuvetteSet section.

The Cuvette menu contains the items shown in Table 3.3 (shown with their tool bar or mouse equivalents). These menu items and buttons are active only when a CuvetteSet section is active.

Figure 3.12: CuvetteSet Section

The CuvetteSet section allows you to collect data from the cuvette port of the SpectraMax Plus or Plus 384, define a template to be used for analysis, define how the data will be displayed, and define the type of data reduction. The Template Editor in the CuvetteSet section is used to describe the contents of the Cuvette.

Choosing a particular function or command in the CuvetteSet section can be done in several ways. You can use the mouse to click on a button, choose a command from one of the drop-down menus in the menu bar, or press a key-stroke combination to activate a command or function.

The CuvetteSet section is divided into four areas:
- Tool bar
- Data display (can be shown in three different ways: three samples per row, one sample per row, and in a grid of cells which is similar to a microplate format)
- Instrument settings, shown to the right of the data display
- Reduction settings, shown at the bottom of the data display

When colors appear in the name labels above individual cuvettes (when displayed as one or three cuvettes per row) or when colored areas appear when the CuvetteSet section is displayed as a grid, this means a template has been defined for the CuvetteSet section. Each group defined in the template has a different color (the icon of the corresponding group table will have the same color).

If your experiment requires multiple cuvettes, you can add up to 96 cuvettes in a single CuvetteSet section and/or create more than one CuvetteSet section.

The Cuvette menu contains the items shown in Table 3.3 (shown with their tool bar or mouse equivalents). These menu items and buttons are active only when a CuvetteSet section is active.
### Table 3.3: CuvetteSet Section Menu Commands and Tool Bar Buttons

<table>
<thead>
<tr>
<th>Menu Command/ Mouse Equivalent</th>
<th>Description</th>
<th>Tool Bar Button</th>
</tr>
</thead>
<tbody>
<tr>
<td>CuvetteSet section icon</td>
<td>Opens the CuvetteSet section in a new window</td>
<td><img src="_double-click" alt="CuvetteSet icon" /></td>
</tr>
<tr>
<td>Name of CuvetteSet section</td>
<td>Opens the Section dialog box</td>
<td><img src="double-click" alt="CuvetteSet section icon" /></td>
</tr>
<tr>
<td>Instrument Setup... in the Control menu</td>
<td>Opens the Instrument Settings dialog box for this CuvetteSet section</td>
<td><img src="Setup" alt="Setup" /></td>
</tr>
<tr>
<td>Template... in the CuvetteSet menu</td>
<td>Opens the Template dialog box allowing you to create or edit the template</td>
<td><img src="Template" alt="Template" /></td>
</tr>
<tr>
<td>Reduction... in the CuvetteSet menu</td>
<td>Opens the Reduction dialog box containing reduction settings</td>
<td><img src="Reduction" alt="Reduction" /></td>
</tr>
<tr>
<td>Double-click a single cuvette or several selected cuvettes; Graph in the CuvetteSet menu</td>
<td>Enlarges selected well(s) to a Well Graph display (Kinetic and Spectrum modes only); choosing Graph again returns to regular display (toggle)</td>
<td><img src="Graph" alt="Graph" /></td>
</tr>
<tr>
<td>Display... in the CuvetteSet menu</td>
<td>Opens the Display dialog box containing display choices</td>
<td><img src="Display" alt="Display" /></td>
</tr>
<tr>
<td>Mask in the CuvetteSet menu</td>
<td>Masks the selected cuvettes</td>
<td><img src="Mask" alt="Mask" /></td>
</tr>
<tr>
<td>Printer icon</td>
<td>Includes/excludes section from printed report</td>
<td><img src="Print" alt="Print" /></td>
</tr>
<tr>
<td>Section Name... in the CuvetteSet menu</td>
<td>Opens the Section dialog box, allowing you to rename the section</td>
<td><img src="Section" alt="Section" /></td>
</tr>
<tr>
<td>New Window in the CuvetteSet menu</td>
<td>Opens the section in a new window</td>
<td><img src="Window" alt="Window" /></td>
</tr>
<tr>
<td>Copy Template in the CuvetteSet menu</td>
<td>Copies the template, allowing it to be pasted to another CuvetteSet section</td>
<td><img src="Copy" alt="Copy" /></td>
</tr>
<tr>
<td>Paste Template in the CuvetteSet menu</td>
<td>Pastes a previously copied template to a new CuvetteSet section</td>
<td><img src="Paste" alt="Paste" /></td>
</tr>
<tr>
<td>Export Template in the CuvetteSet menu</td>
<td>Opens the Export Template to... dialog, allowing you to export a template to an ASCII text file</td>
<td><img src="Export" alt="Export" /></td>
</tr>
<tr>
<td>Import Template in the CuvetteSet menu</td>
<td>Opens the Import Template to... dialog, allowing you to import a template from an ASCII text file</td>
<td><img src="Import" alt="Import" /></td>
</tr>
</tbody>
</table>
Group Section

Figure 3.13: Group Section

Group sections are created automatically when you create or select groups for the experiment in the Template Editor. A Group section is a table which shows all of the information for a particular group. A group is a set of associated samples which have been created in the Template. Depending on the default assay chosen, certain group types (such as Standard or Unknown) may have been created; you can create others as required. Group sections may also be created by duplicating existing Group sections.

The Group section is divided into three areas:

- The tool bar
- The body of the Group table
- The summaries

The Group menu contains the following items (shown with their tool bar or mouse equivalents). These menu items and buttons are active only when a Group section is active.
### Table 3.4: Group Section Menu Commands and Tool Bar Buttons

<table>
<thead>
<tr>
<th>Menu Command/ Mouse Equivalent</th>
<th>Description</th>
<th>Tool Bar Button</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>New Window</strong> in the <strong>Group</strong> menu</td>
<td>Opens the Group section in a new window</td>
<td><img src="double-click" alt="double-click" /></td>
</tr>
<tr>
<td>Name of Group section</td>
<td>Opens the Group settings dialog box</td>
<td><img src="Standard" alt="Standard" /></td>
</tr>
<tr>
<td><strong>Group Settings</strong> in the <strong>Group</strong> menu</td>
<td>Opens the Group Settings dialog box</td>
<td></td>
</tr>
<tr>
<td><strong>Create Summary</strong> in the <strong>Group</strong> menu</td>
<td>Opens the Calculation dialog box, allowing you to create a summary</td>
<td><img src="Calculation" alt="" /></td>
</tr>
<tr>
<td><strong>Create Column</strong> in the <strong>Group</strong> menu</td>
<td>Opens the Calculation dialog box, allowing you to create a column</td>
<td><img src="Calculation" alt="" /></td>
</tr>
<tr>
<td><strong>Edit Summary</strong> in the <strong>Group</strong> menu or double-click the summary (pointer changes to double-headed arrow)</td>
<td>Opens the Calculation dialog box, allowing you to edit the summary</td>
<td><img src="Calculation" alt="" /></td>
</tr>
<tr>
<td><strong>Edit Column</strong> in the <strong>Group</strong> menu or double-click the column</td>
<td>Opens the Calculation dialog box, allowing you to edit the column</td>
<td><img src="Calculation" alt="" /></td>
</tr>
<tr>
<td><strong>Show/Hide Formulas</strong> in the <strong>Group</strong> menu</td>
<td>Shows/hides the formulas used in columns and summaries</td>
<td></td>
</tr>
<tr>
<td><strong>Autosize</strong> in the <strong>Group</strong> menu</td>
<td>Enlarges or reduces column size to fit the largest piece of text</td>
<td></td>
</tr>
<tr>
<td><strong>Hide/Show All</strong> in the <strong>Group</strong> menu</td>
<td>Hides one or more selected columns or shows all columns that were hidden</td>
<td></td>
</tr>
<tr>
<td><strong>Hide Replicates</strong> in the <strong>Group</strong> menu</td>
<td>Hides data from all replicates</td>
<td></td>
</tr>
<tr>
<td>Printer icon</td>
<td>Includes/excludes section from printed report</td>
<td><img src="printer" alt="printer" /></td>
</tr>
</tbody>
</table>
Graph Section

To create a graph section, choose New Graph from the Experiment menu. The Plots dialog box opens automatically and a default plot called “Plot#1” is selected. The plot will default to the first group available in the experiment.

Once a graph has been created, new plots can be added and deleted, the axes can be customized, and the size (displayed area) of the graph can be changed. Grid lines can be enabled or disabled (default is enabled). Graphs may be displayed as bar graphs or scatter plots.

The Graph section is divided into three areas:
• The tool bar
• The body of the Graph section
• Plots information below the graph
You may create more than one Graph section within an experiment. Plots in the Graph section must be defined from groups within the same experiment section as the graph, with one exception: if you duplicate an experiment that contains data in the Plate section and has a plot defined in a Graph section, that plot will remain in the duplicated Graph section (and new plots may be added).

The Graph menu contains the following items (shown with their tool bar or mouse equivalents). These menu items and buttons are active only when a Graph section is active.

**Table 3.5: Graph Section Menu Commands and Tool Bar Buttons**

<table>
<thead>
<tr>
<th>Menu Command/ Mouse Equivalent</th>
<th>Description</th>
<th>Tool Bar Button</th>
</tr>
</thead>
<tbody>
<tr>
<td>New Window in the Graph menu</td>
<td>Opens the Graph section in a new window</td>
<td>(double-click)</td>
</tr>
<tr>
<td>Name of Graph section</td>
<td>Opens the Section dialog box</td>
<td>StandardCurve (double-click)</td>
</tr>
<tr>
<td><strong>Graph Settings</strong> in the Graph menu</td>
<td>Opens the Graph Settings dialog box</td>
<td></td>
</tr>
<tr>
<td><strong>X Axis...</strong> in the Graph menu</td>
<td>Opens the X Axis Settings dialog box</td>
<td></td>
</tr>
<tr>
<td><strong>Y Axis...</strong> in the Graph menu</td>
<td>Opens the Y Axis Settings dialog box</td>
<td></td>
</tr>
<tr>
<td>Printer icon</td>
<td>Includes/excludes section from printed report</td>
<td></td>
</tr>
<tr>
<td><strong>Graph Options</strong> in the Graph menu</td>
<td>Opens the Graph Options dialog box</td>
<td></td>
</tr>
<tr>
<td>Export Graph in the Graph menu</td>
<td>Opens the Export Graph As... dialog box</td>
<td></td>
</tr>
</tbody>
</table>
Instrument Settings

You must specify the type of reading to be performed prior to actually reading a microplate or a cuvette.

Instrument settings allow you to choose a read mode (Endpoint, Kinetic, Spectrum, Well Scan, or FLEX), a read type (fluorescence, time-resolved fluorescence, or luminescence) if using an instrument that performs fluorescent readings, the number of wavelengths or the range of Spectrum data, timing for Kinetic runs, and so on. Which settings are available depend upon the type of instrument connected or chosen in the Preferences and whether you are reading a plate or a cuvette.

Complete information regarding instrument settings can be found in Chapters 4 or 5 (choose the chapter that is appropriate for the instrument and/or read mode you are using).

Menus and Commands

The menu bar for SoftMax Pro is located at the top of the window (just beneath the title bar).

![Menu Bar](image)

**Figure 3.15: Menu Bar (Macintosh, top; Windows, bottom)**

While working with SoftMax Pro, you may access its tools and features through several means: menus, tool bars, dialog boxes, and keystrokes. Figure 3.16 shows all of the menu items that are available in SoftMax Pro.

When menu items are unavailable, they are dimmed (shown as gray rather than black)—available choices depend on the action you are performing with the software. An ellipsis (three dots) following a menu item indicates that choosing this item will bring up a dialog box. Menu items followed by a triangle are hierarchical menus: choosing such an item causes a submenu to appear to the right of the original item. Certain menu items can also be chosen by pressing keys on the keyboard. Within Windows, menu items contain an underlined letter in their names. Pressing the ALT key will activate the menu bar; pressing a letter key that corresponds to the underlined letter of a menu name will then activate that menu. Subsequent menu items can be activated (chosen) by simply pressing the underlined letter in their names (you do not need to press ALT again). For example, to open a file from within SoftMax Pro using the keyboard shortcut, you would press ALT, F, O which will first activate the menu bar, then select the File menu, then choose Open from the File menu.

When available, a shortcut key combination will be shown to the right of the command in the menu. On the Macintosh, begin by pressing and holding down the command (⌘) key followed by the key shown in the shortcut. Windows users should press and hold the control (CTRL) key followed by the key shown in the shortcut.
Some menus are divided into groups of items that perform related functions. Dividers show as thin, horizontal lines between menu items.

**File.** Items in this menu relate to entire SoftMax Pro files. Commands to open, print, apply password protection, and save files are located here.

**Edit.** This menu contains features for changing items within SoftMax Pro. Commands to select, copy/paste, delete and duplicate items are located here. This menu also contains the **Preferences** command, which allows you to set options regarding printing, communication with the MDC Microplate System instrument, and saving files.

**View.** Choices regarding what is shown and how it is shown are available here. The last section in this menu provides a navigational tool, allowing you to choose the particular section you would like to view (a section chosen in this manner will open if it was closed and will be brought into view within the window).

**Experiment.** Choices in this menu allow you to create new sections within the current experiment, as well as to create a completely new experiment.

**Control.** Items in this menu allow you to set up and activate MDC Microplate System instrument functions.

**Assays.** This menu allows you to choose the folder containing the protocols you have saved and shows those protocols below the divider, making it easy to open one or more of them. A second level of folders can be stored within the Assays folder and will appear on the Assays menu, allowing you to separate protocols further, as desired.

The last menu item (farthest right on the menu bar) changes to reflect the **section type** that is currently active. If a Plate section is active, for example, the last menu item will be **Plate.** An active Graph section causes this menu to show **Graph.** If an experiment is selected, this menu will not be shown.

Menus function differently depending upon whether you are using Windows or the Macintosh (and can function differently depending on the OS in use). On the Macintosh, clicking and holding the mouse button down while the pointer is on any of the main menu items causes a drop-down list to appear. To choose a command from a list, drag the mouse until the choice is highlighted and then release the mouse button. Within Windows and with some versions of the Macintosh OS, clicking on the main menu item causes the drop-down menu to remain, allowing you to click once on any menu item to choose it.

Additionally, a number of buttons are available in different sections of the SoftMax Pro experiment and section tool bars. Clicking these buttons accomplishes many of the same actions as choosing menu items.
Figure 3.16: SoftMax Pro Menus

Ellipsis (…) indicates that choosing this command will open a dialog box.
Chapter 3: SoftMax Pro Overview

Apple Menu

About SoftMax Pro

(Macintosh only) Displays the SoftMax Pro version, registration information, ROM version (if available from the instrument), and copyright information. If an instrument is connected to the Macintosh running SoftMax Pro, the instrument type will also be displayed. You will need to know this information if you call for technical support. Other items in the Apple menu depend on the settings of your Macintosh.

File Menu

New... (⌘N; CTRL+N)—Opens a new file window, allowing you to begin a new or different data file. Information from each SoftMax Pro window (which can consist of one or more experiments with their sub-sections) is saved to a separate file.

Open... (⌘O; CTRL+O)—Opens an existing SoftMax Pro file (or an older SoftMax file). When you choose Open from the File menu, a dialog box appears. To open a file from the list of available files, double-click the filename to be opened, or click once on the filename and then click the [Open] button.

Close (⌘W; CTRL+W)—Closes the front-most (active) window. If you have only one file open, this file will be closed. If you have changed the file in any way since it was opened, a dialog box will open asking if you want to save the file before closing. (This menu item is dimmed if no window is open.)

Save (⌘S; CTRL+S)—Saves the active window to a file. The active file name is shown at the top of the status window (protocol files are always shown as “Untitled”). To save the file in a different folder/subdirectory or under a different name, use Save As.... If the file has not yet been saved and given a name (is “Untitled”), the Save As... dialog box will appear and you will be asked to name the file. (This menu item is dimmed if the file has already been saved and no changes have been made.)

Save As...—Saves a file with a new file name or into a new folder or subdirectory. See “Saving Files Manually” on page 9-8 for more information about using the Save As... command for saving files.

Import/Export...— A submenu offers the following choices:

Import brings tab-delimited ASCII text file information into SoftMax Pro.
Export creates a file of Plate section data, CuvetteSet section data, and/or Group table section data. All information from SoftMax Pro can be saved as tab-delimited ASCII (or text) format, which is suitable for importing into word processing or spreadsheet programs.
**Import Analyst** allows you to import verbose reports generated using Criterion Host or SCREENPLAY software for all instrument modes. **Import FLIPR** allows you to import “FPD” files exported from FLIPR software.

For more information on importing or exporting files, see “Exporting/Importing Information” on page 9-16.

**Page Setup/Print Setup**—You should access this command after you select a different printer in the Chooser (Macintosh), if you choose a different printer using Windows, or if you want to use a different paper size or printing option. Choosing **Page Setup/Print Setup** opens a dialog box with various options for printing. More about this function can be found in the documentation that accompanies your computer and/or printer.

**NOTE:** The **Page Setup/Print Setup** command also controls how SoftMax Pro sections are displayed on your monitor (the width of the display corresponds to the width of the page size).

**Print (Section name/Selection)**—Allows you to print just the active section(s).

**Print...** ([⌘P; CTRL+P])—With the Macintosh, choose this command and then click either “Print all” or “Print report.” Print all sends all sections to the printer in the order they appear in the window. Print report sends those sections selected to be in the report to the printer in the order they appear in the window. From Windows, choose **Print** and then specify a page range or leave the default to print all pages.

**NOTE:** Make sure you have selected the correct printer prior to choosing one of the Print options in the **File** menu. If you start to print and discover the wrong printer is selected, choose [Cancel] to exit from the Print dialog box, select the correct printer (using the Chooser or the **Print Setup** command), and then repeat the printing process.

**Quit** ([⌘Q; CTRL+Q])—Closes SoftMax Pro as well as any SoftMax Pro files you may have open. If you have open files that have changed and have not yet been saved, a dialog box will ask if you want to save them before quitting.
Chapter 3: SoftMax Pro Overview

Edit Menu

**Undo** (⌘Z; CTRL+Z)—Restores the last text operation to the condition that existed before the editing was done (used primarily when entering text in Notes sections). This menu item is dimmed if no actions have been taken or if undoing the last action is not possible.

**Cut** (⌘X; CTRL+X)—Removes highlighted information (text or data) from the document and stores it on the clipboard so it can be pasted elsewhere. (This menu item is dimmed if no selection has been made or if the selection cannot be cut.)

**Copy** (⌘C; CTRL+C)—Copies selected (highlighted) text or data and stores it on the clipboard so it can be pasted elsewhere. (This menu item is dimmed if no selection has been made or if the selection cannot be copied.)

Parts of an experiment can be copied within the same experiment or to another application using the Copy and Paste commands. You may also use this command to copy information from SoftMax Pro into other programs.

**Paste** (⌘V; CTRL+V)—Pastes information from the clipboard just to the right of the insertion point in the document. Can also be used to import tab-delimited data into SoftMax Pro. (This menu item is dimmed if nothing has been copied to the clipboard.)

**Clear**—Clears or erases highlighted text (or data) without storing it on the clipboard. (This menu item is dimmed if nothing has been selected.) You can remove one or more columns from a Group table, or text or formulas from a Notes section, by highlighting the column or text/formula and then choosing **Clear** from the Edit menu. Columns and text or formulas can also be removed by highlighting them and pressing the Delete key on the Macintosh or Backspace key on the PC.

**Select All** (⌘A; CTRL+A)—The **Select All** command can be used in Notes, Plate, Cuvette, and Group sections when a section is active (it is not available in Graph sections).

In a Notes section, if no summaries are present, it will select all text. If summaries are present at the top or bottom of the Notes section, this command will select all text but not the summaries (which must be selected individually). If the text is broken up by summaries, this command will select the largest block of text that it can (bounded by summaries).

In a Plate section, this command will select all wells, if one or more wells in the grid array has already been selected. If no wells have been selected, this command will be dimmed.

In a CuvetteSet section, this command will select all cuvettes if one or more cuvettes has already been selected. If no cuvettes have been selected, this command will be dimmed.

In a Group section, this command will select all columns in the group table but will not include any summaries at the bottom of the group table (summaries must be selected individually).

**Delete Section/Selection** (⌘−; CTRL+-)—Deletes the currently active section(s) or experiment(s). A warning dialog box will appear asking if you really want to delete the section(s) or experiment(s).
**Duplicate Section/Experiment**—Creates new section(s) or experiment(s) that are exactly like the active section(s) or experiment(s) and positions the duplicated selection(s) after the currently active section(s). The names of the new section(s) or experiment(s) will have the word “Copy” appended to their name(s). For example, if you duplicate a section named “Plate#1,” the duplicate section will be called “Plate#1Copy.” Subsequent duplications will append an incremented number after the name (e.g., “Plate#1Copy#2”). For more information about this command and what is included when a section is duplicated, see “Duplicate and New” on page 9-27.

**Text Style...** ([⌘ T; ⌘T] T; CTRL+T)—Allows you to change the attributes of selected text. (This command is dimmed if no text has been selected.)

**Preferences...** (double-click the instrument icon)—Through the Preferences dialog box, you can choose settings for the following options:

- Serial port connection (modem port or printer port for the Macintosh; COM1 or COM2 for the PC) that will be used to connect to the MDC Microplate System instrument. A third option, “Neither,” should be used when no instrument is connected to the computer.
- Export format (Time versus Plate, and whether or not to include labels).
- The instrument connected to the computer or, if none is connected, the type of instrument for which the software should be configured.
- Whether or not files will be saved automatically, as well as the location where saved files will be stored and the autonaming conventions that will be used (Autosave).
- Whether or not reports should be printed automatically and print settings that will be used (Autoprint).
- Wavelengths of filters installed in the Emax, Vmax, UVmax, or ThermoMax instruments (not used with SpectraMax, FlexStation, or VersaMax instruments).

**Suspend Recalculation**—Stops SoftMax Pro from performing calculations based on changes you make to the settings or other program information. This command is used most often when you want to make a number of changes to the settings without having to wait while the results of each change are recalculated.

**Recalculate Now** ([⌘±; ⌘±])—Causes SoftMax Pro to recalculate data based on the current settings. This command is used most often when you have suspended automatic recalculation.
### View Menu

The View menu provides three commands: **Minimize** \((\text{M; CTRL+M})\), **Expand** \((\text{E; CTRL+E})\), and **Hide Status**. In addition to these choices, the names of the experiments appear at the bottom of the menu (sections within experiments are shown as submenus), allowing you to go to a specific experiment or section within an experiment by choosing the item. If the section was closed, selecting it from the View menu will open and activate it. The currently active section is shown in the menu with a checkmark next to it.

- **Minimize** \((\text{M; CTRL+M})\)—If you select Minimize while a section within an experiment is active, the sections within that experiment are minimized. If you choose Minimize while an experiment tool bar is active, all experiments will be minimized (sections within are hidden and only the experiment tool bars are visible).

- **Expand** \((\text{E; CTRL+E})\)—If you select Expand while a section within an experiment is active, the sections within that experiment are expanded. If you choose Expand while an experiment tool bar is active, all sections within all experiments become visible (the sections may be minimized or expanded).

- **Hide Status/Show Status**—Hides or displays the status bar.

### Experiment Menu

The Experiment menu provides five commands: **New**, **New Notes**, **New Plate**, **New CuvetteSet**, and **New Graph**.

- **New**—Creates a new experiment directly following the active experiment (the new experiment then becomes the active experiment). All sections shown in the experiment that was active when this command is chosen are duplicated in the new experiment.

- **New Notes**—Creates a new Notes section below the active section.

- **New Plate**—Creates a new Plate section below the active section. The new Plate section will be a copy of the active Plate section or, if no Plate section currently exists, the new Plate section will use SoftMax Pro default settings.

- **New CuvetteSet**—Creates a new CuvetteSet section below the active section. The new CuvetteSet section will be a copy of the active CuvetteSet section or, if no CuvetteSet section currently exists, the new CuvetteSet section will use SoftMax Pro default settings.

- **New Graph**—Creates a new Graph section below the active section and brings up the Plots dialog box, allowing you to select the graph options.
Chapter 3: SoftMax Pro Overview

Control Menu

### Instrument Setup...
This command is available only if a Plate section or CuvetteSet section is active. Choosing **Instrument Setup** opens the Instrument Settings dialog box which allows you to enter the mode for the run (Endpoint, Kinetic, Spectrum, Well Scan, or FLEX), the wavelength settings, Automix parameters, pre-read blanking, strips, PathCheck, AutoRead, timing for Kinetic runs, Speed Read for Spectrum scans, read type, and plate type.

**NOTE**: Not all options are available for all instruments. The options that are visible depend on the type of instrument that is connected to the computer (or selected in the Preferences).

**Button Equivalent**: in the Plate section or CuvetteSet section tool bar.

### Read
In a single plate experiment, the **Read** command reads the plate or cuvette immediately. If no Plate section or CuvetteSet section is active in an experiment containing multiple Plate sections or CuvetteSet sections, the **Read** command displays a dialog box asking you to select which Plate section or CuvetteSet section to read. The default Plate section or CuvetteSet section, selected by pressing the Return key, is chosen on these criteria:

- The selected Plate or CuvetteSet section, if one is selected.
- The next unread Plate or CuvetteSet section.
- The first plate or cuvette, if all have been read.

Once a reading is in progress, menu items are no longer available until the reading is finished.

**Button Equivalent**: in the Status bar.

### Ref
Available only when a CuvetteSet section is active and a SpectraMax Plus or Plus384 is connected or chosen in the Preferences. This command causes the SpectraMax Plus or Plus384 to read the cuvette in the cuvette port and applies the reading as a reference to all cuvettes in the CuvetteSet section.

**Button Equivalent**: in the Status bar.

### Close Drawer
Closes the drawer, at which time the menu item changes to **Open Drawer**. The drawer opens or closes immediately.

**Button Equivalent**: in the Status bar.

### Incubator
(Available with ThermoMax, VersaMax, SpectraMax, and FlexStation instruments only) Allows you to turn the incubator on or off. When on, you can enter a setting for regulation of the temperature in the microplate chamber.

**Button Equivalent**: in the Status bar.

### Calibration
Calibration performs an air reference reading at each wavelength and updates the non-volatile RAM of the instrument, thus providing new air calibration for the instrument.
**Open Tip Drawer**—(FlexStation only) Opens the topmost drawer of the FlexStation instrument that contains pipette tips. When this command has been selected and the tip drawer is open, the command on the menu changes to show **Close Tip Drawer**.

**Open Compound Drawer**—(FlexStation only) Opens the middle drawer of the FlexStation instrument that contains compounds that can be injected. When this command has been selected and the compound drawer is open, the command on the menu changes to show **Close Compound Drawer**.

**NOTE:** You may not open both the tip and compound drawers simultaneously. Because of this, when you select **Open Tip Drawer**, the Control menu will change to show **Close Tip Drawer** and the **Open Compound Drawer** command will be dimmed. Likewise, when you select **Open Compound Drawer**, the menu will change to show **Close Compound Drawer** and **Open Tip Drawer** will be dimmed.

**Set Air Gap**—(FlexStation only) This value can be set from 0 to 200 milliliters and sets the distance from the tip of the pipette to the bottom of the microplate well. (The software calculates depending on the setting chosen for either a 96- or 384-well plate type.) Setting this value to a positive number assists in ensuring that aspirated fluid does not drip while the tips are being moved during an injection, helping to prevent contamination. With subsequent transfers, you will need to calculate the volume of fluid within a well to determine the value to assign for the air gap setting to avoid tip contact with fluid in the well.

**Recover**—(FlexStation only) This menu item can be used to reboot the FlexStation in the event of a fatal error encountered (typically while fluid remains in the tips). More information regarding the function and appropriate times to choose this menu item can be found in the FlexStation instrument manual.

### Assays Menu

**Set Folder...**—Allows you to select a folder or subdirectory containing commonly used protocol files. In addition to any protocol files residing within this folder (which will be listed below the dividing line and may be opened by clicking them), an additional level of subfolders (if any) will be shown below a center division. Protocol files can be used repeatedly (for specific types of assays, for example). These files can be named in any way you choose.

**Folder name(s) after dividing line**—Choosing any of these folders will open a submenu showing protocol files residing in this subfolder. Select one of the protocol files to open it.

**File name(s) after dividing line**—The files that appear here are protocol files that reside within the folder determined using the **Set Folder...** command. You can quickly open and use one of these protocol files by selecting it from the Assays menu.
Plate Menu

This menu item changes to show CuvetteSet, Plate, Notes, Graph, or Group, depending on the type of section that is currently active. If no section is active, this menu item does not appear.

Template...—Opens the Template Editor. The Template Editor allows you to describe the samples that are in the wells, thus providing the link between the raw data and the analysis groups. You can create new groups in the template or assign wells to already established groups.

If your experiment contains multiple Plate sections, the template for each Plate section must be defined using the Template Editor in that section. You can create a new template or modify an existing one using the Template Editor.

NOTE: Each Plate section requires that a template be created in order to identify groups within that plate. However, two or more Plate sections may use the same template, or the same groups may be used in different templates.

After groups are defined in the template and you return to the Plate section, the data display will show the group areas in different colors.

Button Equivalent: in the Plate section tool bar.

Reduction...—Opens the Reduction dialog box. Options available in the Reduction dialog box depend on the type of reading performed (Endpoint, Kinetic, Spectrum, Well Scan, or FLEX) and the instrument used to collect the data. The Reduction dialog box is used for initial reduction of the data collected from the microplate reader. The optical density information collected is reduced to a single number per well. More information regarding reduction options can be found in Chapters 7 or 8—choose the chapter that is appropriate for the instrument you are using.

Button Equivalent: in the Plate section tool bar.

Display...—Opens the Display dialog box. Allows you to decide how the information in the Plate section will be displayed. More information regarding display options can be found in Chapters 7 or 8—choose the chapter that is appropriate for the instrument you are using.

Button Equivalent: in the Plate section tool bar.

Graph...—The Well Graph command is modal, so it can be activated both during data acquisition and after data has been acquired for a Kinetic, Spectrum, Well Scan, or FLEX reading. You can get a “close up” view of the plot shown in one or more wells by first selecting the well(s) and then choosing the Graph... command. (This command is dimmed if the instrument settings are for an Endpoint reading or if no well in the Plate display has been selected.)

Button Equivalent: in the Plate section tool bar.

Mask—Allows you to “hide” certain wells so that they will not be taken into account when performing analyses. (This command is dimmed if no
data has been acquired or if no wells in the plate have been selected.)

Button Equivalent: 

**Copy Template**—While a Plate section is open and active, choosing this command allows you to copy the template from this Plate section to the Clipboard, allowing you to paste it into a different Plate section (in the same or in a different experiment or into a Plate section in another SoftMax Pro file).

**Paste Template**—If you have copied a template from a Plate section, you can then create or activate/open another Plate section and choose **Paste Template**. In this way, you can use the same template for more than one Plate section or you can modify the pasted template as desired. If you are pasting a template into a new experiment and groups from the source template do not exist in the destination experiment, pasting the template will create them. Existing groups of the same name will not be changed by the pasting process. For example, if the template being copied contains the groups “Standards” and “Unknown,” and the group “Standards” already exists in the destination experiment, the group “Unknown” will be created but all information regarding the group “Standards” in the destination experiment will remain unchanged. If you copy and paste the template with the same experiment, no new groups are created. Group names can be edited in the pasted template (these changes will be reflected in the original template also).

**Export Template**—Opens the Export Template to... dialog, allowing you to export a template to a tab-delimited ASCII text file.

**Import Template**—Opens the Import Template to... dialog, allowing you to import a template from a tab-delimited ASCII text file.

**Section Name...**—Allows you to change the name of the Plate section.

Mouse Equivalent: double-click the name of the Plate ( ) in the Plate section tool bar (to the right of the Plate section icon).

**New Window**—Opens the active section in a separate window.

Mouse Equivalent: double-click the icon in the Plate section tool bar.
CuvetteSet Menu

This menu item changes to show CuvetteSet, Plate, Notes, Graph, or Group, depending on the type of section that is currently active. If no section is active, this menu item does not appear.

**Template**—Opens the Template Editor.
The Template Editor allows you to describe the samples that are in the wells, thus providing the link between the raw data and the analysis groups. You can create new groups in the template or assign cuvettes to already established groups.

If your experiment contains multiple CuvetteSet sections, the template for each CuvetteSet section must be defined using the Template Editor in that section. You can create a new template or modify an existing one using the Template Editor.

After groups are defined in the template and you return to the CuvetteSet section, the data display will show the cuvettes that are assigned to groups by means of colors in their locator headings (if viewing by one or three cuvettes per row) or as colored outlines (if viewing in a grid), if you have a color monitor, or in shades of gray on a monochrome monitor.

Button Equivalent: \( \text{Template} \) in the CuvetteSet section tool bar.

**Reduction**—Opens the Reduction dialog box. Options available in the Reduction dialog box depend on the type of reading performed (Endpoint, Kinetic, Spectrum, Well Scan, or FLEX) and the instrument used to collect the data. The Reduction dialog box is used for initial reduction of the data collected from the microplate reader. The optical density information collected is reduced to a single number per well.

Button Equivalent: \( \text{Reduction} \) in the CuvetteSet section tool bar.

**Display**—Opens the Display dialog box. Allows you to decide how the information in the CuvetteSet section will be displayed.

Button Equivalent: \( \text{Display} \) in the CuvetteSet section tool bar.

**Graph**—During data collection and after data has been acquired for a Kinetic or Spectrum reading, you can get a “close up” view of the plot shown in one or more cuvettes by first selecting the cuvette(s) and then choosing this command. (This command is dimmed if the instrument settings are for an Endpoint reading or if no well in the Plate display has been selected.)

Button Equivalent: \( \text{Graph} \) in the CuvetteSet section tool bar.

**Mask**—Allows you to “hide” certain cuvettes so that they will not be taken into account when performing analyses. (This command is dimmed if no data has been acquired or if no cuvettes in the set have been selected.)

Button Equivalent: \( \text{Mask} \) in the CuvetteSet section.

**Copy Template**—While a CuvetteSet section is open and active, choosing this command allows you to copy the template from this CuvetteSet section to the Clipboard, allowing you to paste it into a different CuvetteSet section (in the same or in a different experiment or into a CuvetteSet section in another SoftMax Pro file).
**Paste Template**—If you have copied a template from a CuvetteSet section, you can then create or activate/open another CuvetteSet section and choose *Paste Template*. In this way, you can use the same template for more than one CuvetteSet section or you can modify the pasted template as desired.

If you are pasting a template into a new experiment and groups from the source template do not exist in the destination experiment, pasting the template will create them. Existing groups of the same name will not be changed by the pasting process. For example, if the template being copied contains the groups “Standards” and “Unknown,” and the group “Standards” already exists in the destination experiment, the group “Unknown” will be created but all information regarding the group “Standards” in the destination experiment will remain unchanged. If you copy and paste the template with the same experiment, no new groups are created. Group names can be edited in the pasted template (these changes will be reflected in the original template also).

**Export Template**—Opens the Export Template to... dialog, allowing you to export a template to a tab-delimited ASCII text file.

**Import Template**—Opens the Import Template to... dialog, allowing you to import a template from a tab-delimited ASCII text file.

**Section Name...**—Allows you to change the name of the CuvetteSet section.

*Mouse Equivalent: double-click the name of the CuvetteSet section ( ) to the right of the CuvetteSet section icon.*

**New Window**—Opens the active section in a separate window.

*Mouse Equivalent: double-click the icon in the CuvetteSet section.*

---

**Notes Menu**

*This menu item changes to show CuvetteSet, Plate, Notes, Graph, or Group, depending on the type of section that is currently active. If no section is active, this menu item does not appear.*

**Create Summary...**—When the Notes section is active, choosing *Create Summary* opens a dialog box allowing you to give a title to a new summary and then enter a formula to be used for the summary.

*Button Equivalent: in the Notes section.*

**Edit Summary**—If you have created a summary and need to change it, you can do so by first highlighting the summary you wish to edit and then choosing *Edit Summary*. (This command is dimmed if you have not yet created a summary or if the summary has not been selected.) The dialog box then appears showing the name and formula.

*Mouse Equivalent: Double-clicking the summary performs the same function.*

*Button Equivalent: in the Notes section.*
Show Formulas—Choosing this command shows the formulas associated with the summaries you have created in the Notes section. After choosing Show Formulas, the menu name changes to Hide Formulas. (This command is dimmed if you have not created any summaries.)

Section Name.—Allows you to change the name of the Notes section.
Mouse Equivalent: double-click the name of the Notes section (Introduction) to the right of the Notes section icon.

New Window—Opens the active section in a separate window.
Mouse Equivalent: double-click the icon in the Notes section.

Graph Menu

This menu item changes to show CuvetteSet, Plate, Notes, Graph, or Group, depending on the type of section that is currently active. If no section is active, this menu item does not appear.

Graph Options.—You can select from three types of graphs: Scatter (with symbols plotted and/or the points connected), Cluster Bar, or Stack Bar and you can set the height of the graph to be something other than the default percentage (100%). The font used for the title, legend, and/or axes can be changed and/or modified in size and style. Plots can be added, deleted, or edited. Editing plots allows you to change the plot name, its source (from which experiment and group), as well as the items to be plotted (for example, concentration vs. values).

Button Equivalent: in the Graph section.

X-axis.—Sets the X-axis parameters (tick marks, scale, label, gridlines, and autorange).
Button Equivalent: in the Graph section.

Y-axis.—Sets the Y-axis parameters (tick marks, scale, label, gridlines, and autorange).
Button Equivalent: in the Graph section.

Section Name.—Allows you to change the name of the Graph section.
Mouse Equivalent: double-click the name of the Graph section (Standard Curve) to the right of the Graph section icon.

Export Graph—Creates a file containing a picture of the graph with a filename of your choice. On the Macintosh, the graphic is in PICT format; in Windows, the graphic is in EMF (Enhanced MetaFile) format.

New Window—Opens the active section in a separate window.
Mouse Equivalent: double-click the icon in the Graph section.
**Group Menu**

This menu item changes to show CuvetteSet, Plate, Notes, Graph, or Group, depending on the type of section that is currently active. If no section is active, this menu item does not appear.

**Create Column**—If a Group section is currently active, you can add a column to the display by choosing this command. If no columns are highlighted, the column will be added at the end of the group. If you select a column first, the new column will be added to the right of the highlighted column.

- Button Equivalent: in the Group section.

**Create Summary**—Allows you to create a summary and enter a formula for this summary for the Group. Summaries appear at the bottom of the group table.

- Button Equivalent: in the Group section.

**Edit Column**—Selecting a column makes this command active. Choosing Edit Column allows you to change the formula associated with the column and to change the column name.

- Mouse Equivalent: Double-clicking the column performs the same function.
- Button Equivalent: in the Group section.

**Edit Summary**—Allows you to edit the formula associated with the summary, as well as to change the summary name. (This command is dimmed if a summary has not yet been created.) First highlight the summary and then select this command.

- Mouse Equivalent: Double-clicking a summary performs the same function.
- Button Equivalent: in the Group section.

**Autosize**—Choosing this command expands or shrinks the width of selected columns to accommodate the largest piece of text in the column.

- Mouse Equivalent: Double-clicking the line to the right of the column heading performs the same function.

**Hide**—Hides the selected column from view. (This command is dimmed if a column has not been selected.)

- Mouse Equivalent: Dragging the line to the right of the column heading until it is on top of the line to the left of the column performs the same function.

**Hide Replicates**—Hides data for all replicates (if any) from view.

**Show All**—Shows all columns or replicates that were hidden previously.

**Show Formulas**—Causes a new row to appear beneath the headings of each column showing the formulas used to determine the data in the columns. After choosing this command, the menu name changes to Hide Formulas.

**Group Settings**—Opens the Group Settings dialog box, allowing you to rename a group and/or change the sample or group descriptors used, as well as to modify the units used with each descriptor.

- Mouse Equivalent: double-click the name of the Group section to the right of the Group section icon.

**New Window**—Opens the active section in a separate window.

- Mouse Equivalent: double-click the icon in the Graph section.
### Window Menu

**Tile**—If you have several windows open, choosing the **Tile** command will resize and arrange all open windows side by side.

**Cascade**—If you have several windows open, choosing the **Cascade** command will resize and layer the open windows so that each title bar will be visible.

**Arrange Icons**—If you have several files open but reduced to icons, choosing the **Arrange Icons** command will move all icons to the bottom of the SoftMax Pro window and put them in order.

Beneath the line will appear the names of all open files within SoftMax Pro. The active file will have a checkmark next to it. Choosing one of the file names shown here will cause that file to come to the forefront of the screen (and will restore the file to its previous size if it had been minimized).

### Help Menu—Windows

**Contents**—Displays the contents of the Help screens, allowing you to choose from the listed topics. Clicking a topic opens the help screen associated with it.

**Index**—Shows the alphabetical listing of all items that can be viewed within the Help function. Clicking a topic opens the help screen associated with it.

**Using Help**—Allows you to choose from an indexed list of topics or to search for the type of help you’re looking for.

**About SoftMax Pro**—Opens the About screen which gives the serial number, ROM version, and the instrument type connected to the computer, as well as the software version for SoftMax Pro.

### Help Menu—Macintosh

**About Help**—Brings up a dialog box explaining how to use the Apple Guide which gives detailed information about the help function on the Macintosh.

**Show/Hide Balloons**—Depending upon whether or not you have balloon help turned on or off, this menu presents the choice to reverse the setting.

**SoftMax Pro Help**—Opens the help section devoted to SoftMax Pro. Items are presented in alphabetical order.

**Formula Help**—Opens the formula help section which provides information about how to use formulas, including formula examples.
Interprocess Messaging

(This feature is available on the Windows Operating System only)

SoftMax Pro can be controlled by other Windows applications by means of an ASCII string-based messaging system. Commands are available for opening and saving files, controlling instruments, selecting sections, exporting data from Plate, CuvetteSet, and Group sections, and importing Templates. The available commands for interprocess messaging are described in Chapter 12, “SoftMax Pro Remote Command Language” along with examples for programming these commands.
Chapter 4: Reading Microplates and Cuvettes Using Absorbance Instruments

Introduction ......................................................... 4-3
Instrument Settings ............................................. 4-4
  Instrument Settings Options ......................... 4-9
Template Editor .................................................. 4-20
  Selecting Wells or Cuvettes in the Template Editor ...... 4-22
  The Template Editor Tool Bar ....................... 4-23
  Blanking .................................................. 4-33
  Copying and Pasting Templates .................. 4-35
  Exporting and Importing Templates ............. 4-37
Reading a Microplate or a Cuvette ......................... 4-39
  Reading a Microplate ................................ 4-40
  Reading a Cuvette (SpectraMax Plus and Plus384 only) .... 4-41
  General Information about a Reading ............. 4-43
Chapter 4: Reading Microplates and Cuvettes Using Absorbance Instruments

Introduction

Reading a microplate or cuvette using SoftMax Pro is a three-part process:

• Prepare SoftMax Pro to collect data;
• Prepare the microplate(s) and/or cuvette(s) to be read; and
• Read the microplate(s) and/or cuvette(s)

Before reading a microplate or cuvette, you must create the Plate section(s) and/or CuvetteSet section(s) and define the instrument settings for the reading. **Instrument Settings must be defined prior to collecting data and may NOT be changed after data is collected.** In addition, it is recommended that you define a template and set the reduction and display parameters prior to reading the microplate or cuvette, since these parameters determine how data is displayed and analyzed, but these last parameters may be set up and/or modified after data collection.

A typical process for preparing, collecting, and analyzing data is as follows:

1) Start SoftMax Pro.
2) Create Plate section(s) and/or CuvetteSet section(s) as needed.
3) Define instrument settings (use buttons in the Plate section/CuvetteSet section tool bars or the **Control** menu).
4) Define the template, reduction parameters, and display parameters.
5) Prepare the microplate(s) and/or cuvette(s) to be read and place them in the instrument.
6) Initiate the reading.
7) Save the data file.
8) Modify the template, reduction parameters, or display parameters as you wish (or, if you didn’t set them up in Step 4, do so now).
9) Save the data file.
10) Analyze the data using the Group section tables and Graph sections.
11) Save the data file when you are finished.

This chapter discusses how to define instrument settings, create a template, and initiate a reading. Data analysis is covered in Chapter 7, “Displaying and Analyzing Data Using Absorbance Instruments.”
Instrument Settings

**NOTE:** Not all instrument settings are available with all instruments. Only the settings that pertain to the instrument that is connected to the computer or the one chosen in the Preferences will be shown in the Instrument Settings dialog box.

You must specify the instrument settings prior to actually reading a microplate or cuvette. These settings include:

**Microplate or Cuvette:**
- The read mode—Endpoint, Kinetic, or Spectrum.
- Wavelength(s) used with Endpoint and Kinetic mode or the wavelength range for Spectrum mode
- Timing for Kinetic runs
- Speed Read (SpectraMax Plus, Plus\textsuperscript{384}, 190, and 340PC only)

**Microplate Only:**
- Automix (all instruments except Emax)
- Blanking (pre-read plate)
- Pathlength correction (using the SpectraMax Plus, Plus\textsuperscript{384}, 190, and 340PC only)
- Strips (SpectraMax and VersaMax instruments only)
- Autocalibrate

Settings for the reading are made in the Instrument Settings dialog box, which can be accessed in three ways:

1) Choose **Instrument Setup...** from the **Control** menu;
2) Click the [Setup] button in the tool bar of the active, expanded Plate or CuvetteSet section; or
3) Double-click anywhere in the settings box (located to the right of the well grid) in the active, expanded Plate or CuvetteSet section.

**NOTE:** You may create more than one Plate or CuvetteSet section in a single experiment, and the instrument settings associated with each Plate/CuvetteSet section can be different. **Instrument Setup...** can only be chosen while a Plate/CuvetteSet section is active, and the settings you choose will affect only that section. A new Plate or Cuvette-Set section that is created in an experiment that contains an active Plate or CuvetteSet section will contain the same instrument settings found in the previously active section. The settings for the new section can be modified as desired.
Table 4.1 lists all possible instrument settings choices based on instrument type. When you have defined the instrument settings, click the [OK] button to close the Instrument Settings dialog box. After closing, a summary of the instrument settings will appear in the box to the right of the data display in the Plate/CuvetteSet section. The MDC Microplate System instrument will use these settings to read the plate or cuvette.

**Table 4.1: Features Available in the Instrument Settings Dialog Box for Absorbance Instruments**

<table>
<thead>
<tr>
<th>Feature</th>
<th>Type</th>
<th>Wavelength</th>
<th>Pre-Read Plate</th>
<th>AutoMix (Before)</th>
<th>AutoMix (During)</th>
<th>Timing</th>
<th>Strips</th>
<th>Auto-Calibrate</th>
<th>Path-Check</th>
<th>Speed Read</th>
<th>Assay Plate Type</th>
<th>Column Wavelength Priority</th>
</tr>
</thead>
<tbody>
<tr>
<td>Emax</td>
<td>Endpoint</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Vmax/UVmax/ThermoMax</td>
<td>Endpoint</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SpectraMax 340/250, Plus</td>
<td>Endpoint</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SpectraMax 190, 190 PC</td>
<td>Endpoint</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SpectraMax 340PC</td>
<td>Endpoint</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SpectraMax Plus384, 340PC384</td>
<td>Endpoint</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>VersaMax</td>
<td>Endpoint</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Kinetic</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Spectrum</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

*Using the SpectraMax Plus384 only.

**NOTE:** Incubator control is an instrument setup parameter that is **not** found in the Instrument Settings dialog box.
Chapter 4: Reading Microplates and Cuvettes Using Absorbance Instruments

Figure 4.1: Instrument Settings Dialog Boxes for an Endpoint Reading
Chapter 4: Reading Microplates and Cuvettes Using Absorbance Instruments

Figure 4.2: Instrument Settings Dialog Boxes for a Kinetic Reading
Figure 4.3: Instrument Settings Dialog Boxes for a Spectrum Reading
Instrument Settings Options

Read Mode

Choices for the read mode are Endpoint, Kinetic, or Spectrum. Available read modes depend on the type of instrument connected or selected in the Preferences (see Table 4.1 on page 4-5 for a complete listing of available read modes by instrument). To select a read mode, click the appropriate section in the Instrument Settings dialog box.

Endpoint

A single reading of the microplate taken at a single or multiple wavelength(s). Values reported are optical density or %Transmittance (if this has been selected in the Reduction dialog box). The default reduced values are !Lm1 (or !Lm2-!Lm6, depending upon whether or not multiple wavelengths were chosen) and !Pathlength (!Pathlength applies to Plate sections in the SpectraMax Plus, Plus384, 190, 190PC, 340PC, 340PC384, and VersaMax Plus only).

![Instrument Settings for an Endpoint Reading](image)

Figure 4.4: Instrument Settings for an Endpoint Reading

You can choose up to 6 wavelengths with SpectraMax or up to 2 wavelengths with VersaMax instruments; choose 1 or 1-Ref with Emax, Vmax, UVmax, or ThermoMax instruments.
Kinetic
Data is collected over time with multiple readings taken at regular intervals. The default reduced values calculated for Kinetic data are Vmax (mOD/min), Time to Vmax (seconds), Onset Time (seconds), Time at Minimum, Time at Maximum, Time at 1/2 Maximum, Slope, and Area Under Curve.

Figure 4.5: Instrument Settings for a Kinetic Reading
Timing—When Kinetic mode is chosen, the Timing parameter is active, allowing you to enter the total Kinetic run time and the time interval between readings. A default value will be shown for the run time; to change this value, click in the box. Up and down arrows will appear, enabling you to increase or decrease the value shown. Highlight the hours, minutes, or seconds shown and then click the up or down arrow until the desired value is reached. You can also select an existing value and enter a new value using the keyboard.

After entering a total run time and an interval between readings, the total number of readings that will result is shown below the run time. The minimum read interval is determined by which instrument is connected to the computer or, if no instrument is connected, by which instrument has been chosen in the Reader section of the Preferences dialog box and the particular settings chosen for that instrument. The minimum interval for SpectraMax and VersaMax instruments depends on the number of wavelengths, the Automix status, the number of strips, and the distance the monochromator and filter wheel of the instrument must move. The minimum interval for Vmax, UVmax, and ThermoMax instruments depends on the number of wavelengths and the Automix status. If you set the interval time to be shorter than the instrument’s minimum read interval, the program will alert you with a message. Additionally with SpectraMax and VersaMax instruments, an interval that is too short will cause a warning message to appear telling you that no calibration can occur between reads.

NOTE: If you are writing a protocol that will be used with a different instrument (other than the one connected to the computer or chosen in the Reader preferences), you can disregard the alert and save the setup. However, if you attempt a reading using a protocol which has settings that are not correct for the particular instrument you are using, an error message will instruct you to change any setting that is out of range before a reading can be initiated.
**NOTE:** To achieve the shortest possible interval for Kinetic readings using SpectraMax and VersaMax instruments, choose wavelengths in *ascending* order.

**Spectrum**

(SpectraMax instruments only) Measures absorbance (optical density) or % Transmittance across a Spectrum of wavelengths. The default reduced value reported for each well is the wavelength of maximum absorbance when optical density is displayed or the wavelength of minimum absorbance when % Transmittance is shown.

**Figure 4.6: Instrument Settings for a Spectrum Reading**

All Spectrum readings are made using the scanning monochromator of the SpectraMax.

**Wavelengths**

**For Endpoint or Kinetic Readings**

**SpectraMax Instruments**

Choose the number of different wavelengths to be read. At least one wavelength must always be specified. Selecting more than one wavelength will cause a corresponding number of wavelength setting boxes to appear (maximum six wavelengths).
Chapter 4: Reading Microplates and Cuvettes Using Absorbance Instruments

4-12 SoftMax Pro User’s Manual

Figure 4.7: Wavelength Settings for SpectraMax Instruments

The wavelengths specified previously (or the defaults) will be shown in the boxes. You can choose a wavelength from the choices using the pull-down menu or simply highlight the wavelength you would like to replace and type a new wavelength (within the available range of the SpectraMax instrument) over the previous one. Note that the pull-down menu shows only common monochromator settings.

VersaMax Instruments

Choose whether to read at one or two wavelengths. At least one wavelength must always be specified. Selecting two wavelengths will cause two wavelength setting boxes to appear.

Figure 4.8: Wavelength Settings for VersaMax Instruments

The wavelengths specified previously (or the defaults) will be shown in the boxes. You can choose a wavelength from the choices in the pull-down menu or simply type any wavelength (within the available range of the VersaMax instrument) over an existing setting. The pull-down menu will show only common monochromator settings.

Emax, Vmax, UVmax, ThermoMax Instruments

Choose either single or dual wavelength. The wavelength(s) must be chosen from the drop-down list of values. The values shown in this list are filter values that have been entered into the filters list under Preferences in the Edit menu (this list must match the actual filters installed in the instrument).

Figure 4.9: Wavelength Settings for Emax, Vmax, UVmax, and ThermoMax Instruments
Dual wavelength is represented by Lm1-Ref because the subtraction of the second wavelength from the first takes place in the firmware of these instruments, causing a single number to be reported by SoftMax Pro.

For Spectrum Readings

**SpectraMax Instruments**

When Spectrum is selected, the Wavelengths section of the dialog box changes to request a wavelength scanning range and a wavelength increment (Step) between the start and stop settings (see Figure 4.10).

The minimum selectable increment is 1 nm.

![Wavelengths](image)

*Figure 4.10: Wavelength Selection for a Spectrum Reading*

**Speed Read (SpectraMax Plus, Plus384, 190, and 340PC only)**

Speed Read performs a fast Spectrum scan of Plate sections or CuvetteSet sections. Speed Read does not measure the total amount of light available at each wavelength (I₀) but uses the values stored in NVRAM of the instrument. As a result, Speed Read may not provide as accurate an absorbance measurement of each wavelength in the scan as with the normal mode.

![Speed Read](image)

*Figure 4.11: Speed Read Section of the Instrument Settings Dialog Box*
PathCheck Pathlength Correction (SpectraMax Plus, Plus$^{384}$, 190, and 340PC only)

The Instrument Settings dialog box for the SpectraMax Plus, Plus$^{384}$, 190, and 340PC includes a section for PathCheck (pathlength correction—see Figure 4.12). When enabled, this feature can be used to normalize the data acquired from microplate readings to a 1 cm pathlength, thereby correcting each OD to the value expected if the sample were read in a 1 cm cuvette, achieving significantly greater precision. Enable or disable pathlength correction by clicking in the checkbox at the top of this section. When enabled, a checkmark will appear in the box.

Pathlength correction is used to report OD or percent transmittance for each microplate well with the depth of the fluid in the well normalized to 1 cm. Two methods for pathlength correction are available when using the SpectraMax Plus or Plus$^{384}$: one involves cuvette measurements (cuvette reference) and the other involves a pathlength correction constant stored in the instrument (water constant). Pathlength correction for the SpectraMax 190 and 340PC uses the water constant. The actual pathlength, $d$, of a solvent is found from the following equation:

$$d (\text{cm}) = \frac{\text{Sample} (\text{OD}_{1000} - \text{OD}_{900})}{k}$$

When a cuvette reference is used for pathlength correction, the value of $k$ is obtained by taking OD measurements on the fluid in the cuvette at two wavelengths, 1000 and 900 nm:

$$k = \text{Cuvette} (\text{OD}_{1000} - \text{OD}_{900})$$

When using the pathlength correction constant (water constant), the value of $k$ is obtained from the instrument. This constant is recorded into nonvolatile...
memory when the instrument is manufactured and may differ slightly from instrument to instrument.

Once the actual pathlength, \( d \), in cm is found, the following equation is used to perform the pathlength correction:

\[
\text{OD}_{1\text{cm}} = \frac{\text{od}_{1\text{cm}}}{d(\text{cm})} \times \text{OD}_{\text{sample}}
\]

### Pre-Read Blanking vs. Background Constant Subtraction

In previous versions of SoftMax Pro, selecting PathCheck automatically enabled the Pre-Read Plate (blanking) function which is used to subtract the absorbance due to the plate material on a well-by-well basis before pathlength correction is applied. Now, however, the program default enables subtraction of a background constant (default is 0.0) from the absorbance values that are read. Often users do not take the time to pre-read plates (which provides the most accurate method for reducing background signal from absorbance readings). Subtracting a background offset provides a better result if no pre-read blanking is chosen.

**NOTE:** If you choose to pre-read a plate, be sure to disable the background constant subtraction (both choices are available in the Instrument Settings dialog box).

To pre-read a plate, place water in the wells. Wells pre-read with water generally have less absorbance than do dry wells (e.g., at 426 nm, Nunc microplates read with and without water in the wells give absorbance values of approximately 0.037 and 0.049, respectively). Thus, pre-reading a dry plate results in pathlength-corrected absorbance values that are lower than the cuvette values. If the pre-read step is omitted entirely, the pathlength corrected results are overcorrected.

If the plates are sufficiently transparent at the wavelength(s) of interest and have low well-to-well variability, the pre-read doesn’t have to be made on the same plate that will contain samples—another clean plate from the same lot will be adequate. More conveniently, a single plate can be pre-read and that pre-read data can be stored for subsequent use. SoftMax Pro allows you to copy and paste pre-read plate data from one plate section to another, provided the instrument settings are identical in the two plate sections.

If the plates are inherently variable at the wavelength(s) of interest, however, it may be necessary to use the same plate for pre-reading and reading samples to ensure that adequate well-by-well correction is achieved.

If you are using a SpectraMax Plus or Plus and PathCheck is enabled, you can choose to “Read Cuvette Reference” or to use the “Water Constant.” “Read Cuvette Reference” requires that you place a standard 1 cm cuvette containing water or aqueous buffer in the cuvette port. The instrument then takes readings of the cuvette at 900 and 1000 nm and uses those values for pathlength correction. “Water Constant” uses parameters stored in non-volatile instrument memory at the factory (based on readings of deionized water). The SpectraMax 190 and 340PC also use the “water constant” when performing pathlength correction.
To determine a number for use as a background constant, pre-read an entire microplate at the wavelengths of interest. Average these numbers and use the average as the background constant.

**PathCheck on SpectraMax Plus/Plus**

**Cuvette Reference or Water Constant—Which Should I Use?**

The PathCheck measurement is based on the absorbance of water at 1000 and 900 nm. If the sample is completely aqueous, has no turbidity, has a low salt concentration, and has no interfering color or compounds, then using the water constant is fine. The cuvette reference (using the sample buffer or diluent) must be used if there is any turbidity, more than 5% organic solvent (PathCheck should be accurate up to about 5%), high salt concentration, or interference in the 900 to 1000 nm range. [To determine possible color or compound interference: measure the OD at 900 and 1000 nm (both measured with air reference); subtract the 900 nm value from the 1000 nm value; and then do the same for pure water. If the delta OD for the sample differs from the delta OD for water, then the cuvette reference must be used.] If the buffer is clear but the sample is turbid, the error associated with PathCheck will not meet specification (2.5% for SpectraMax Plus or Plus). PathCheck should not be used with high levels of turbidity since the light scatter from turbidity cannot be subtracted out from the absorbance reading of the sample.

**NOTE:** With the SpectraMax Plus or Plus, choosing “Read Cuvette Reference” for the PathCheck option is different from a reference reading of a cuvette in a CuvetteSet section (by clicking the [Ref] button in the CuvetteSet section tool bar). The cuvette reference used for PathCheck calculations (measurements at 900 and 1000 nm) does not produce data that can be viewed in a CuvetteSet section and is used only with data in **microplates**, not cuvettes.

**PathCheck and SpectraMax 190 and 340PC**

PathCheck on the SpectraMax 190 and 340PC instruments uses only the water constant. Therefore, samples must be completely aqueous (no solvents), clear, nonturbid, and have no interfering contaminants in the wavelength range of 900 to 1000 nm (not highly colored in the upper wavelength range as in Lowry assays).

PathCheck must be chosen in the Instrument Settings dialog box before reading a plate in order for this feature to be active. After reading, you can choose whether or not to apply the correction in the Reduction dialog box for that Plate section; you can also choose to view the data as percent transmittance (%T) or absorbance (OD). PathCheck cannot be applied after a reading, nor can you change “Water Constant” to “Read Cuvette Reference” after a reading—doing so will require that you replace the existing data with that from a new reading (of both the cuvette and the microplate). For more detailed information regarding the calculations used for pathlength correction, see Chapter 7, “Displaying and Analyzing Data Using Absorbance Instruments.”
Automix

The Automix function is a patented feature that allows you to set automated shaking of the microplate. The options available for Automix depend on the read mode chosen and the type of instrument connected or chosen in the Preferences.

SpectraMax and VersaMax Instruments

**Endpoint**

**Automic & Blanking**

<table>
<thead>
<tr>
<th>Automix</th>
<th>Before Read</th>
<th>Time</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>5</td>
<td>5000</td>
</tr>
</tbody>
</table>

**Blanking**

| Pre-Read Plate |

**Kinetic**

<table>
<thead>
<tr>
<th>Automix</th>
<th>Before Read</th>
<th>Time</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>5</td>
<td>5000</td>
</tr>
</tbody>
</table>

| Blanking |

| Pre-Read Plate |

**Figure 4.13: Automix Settings Box—SpectraMax and VersaMax Instruments**

**Before First Read**

This setting can be used with any read mode. Click the checkbox next to “Before First Read” to shake the microplate before the first reading. Whether you read at a single wavelength or at multiple wavelengths, enabling Automix for “Before First Read” will shake the plate for the set amount of time before the first wavelength reading only. You can accept the default value shown for the amount of time to shake the plate or enter a different value (up to 999 seconds) in the box to the right.

**Between Reads**

This option is applicable only to Kinetic readings and will be displayed only when Kinetic mode is selected. To enable automatic mixing of the microplate between readings during a Kinetic assay, click the checkbox next to this setting. For readings at a single wavelength, “Between Reads” will shake the plate for the set amount of time prior to each reading at that wavelength. For readings at multiple wavelengths, enabling “Between Reads” will shake the plate for the set amount of time before each reading at the first wavelength only. You can accept the default value shown for the amount of time to shake the plate or enter a different value (up to 999 seconds) in the box to the right.

Vmax, UVmax, and ThermoMax Instruments

**Endpoint**

**Automic & Blanking**

<table>
<thead>
<tr>
<th>Automix</th>
<th>Before Read</th>
<th>Time</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>5</td>
<td>5000</td>
</tr>
</tbody>
</table>

| Blanking |

| Pre-Read Plate |

**Kinetic**

<table>
<thead>
<tr>
<th>Automix</th>
<th>Before Read</th>
<th>Time</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>5</td>
<td>5000</td>
</tr>
</tbody>
</table>

| Blanking |

| Pre-Read Plate |

**Figure 4.14: Automix Settings Box for Vmax, UVmax, and ThermoMax**

Automix read intervals for the Vmax, UVmax, and ThermoMax are not user-definable. The Emax does not have Automix capability.
Before First Read

This setting can be used with either Endpoint or Kinetic readings. Click the checkbox next to “Before First Read” to shake the microplate before the first reading (automatically done for five seconds). Whether you read at a single wavelength or dual wavelengths, enabling Automix for “Before First Read” will shake the plate for five seconds before the first wavelength reading only.

Between Reads

This option is applicable only to Kinetic readings and will be displayed only when Kinetic mode is selected. To enable automatic mixing of the microplate between readings during a Kinetic assay, click the checkbox next to this setting. For readings at a single wavelength, “Between Reads” will shake the plate for three seconds prior to each reading at that wavelength. For dual wavelength readings, enabling “Between Reads” will shake the plate for three seconds before each reading at the first wavelength only.

Read Entire Plate/Strips Selection
(SpectraMax and VersaMax Instruments Only)

You may choose to read only certain columns (or strips) of wells in the microplate or to read the entire plate. Partial-plate reading is available for all reading modes, although it is most useful for fast Kinetics and limited Spectrum analyses. The time required for Kinetic and Spectrum readings may be significantly reduced using this setting since the instrument does not have to read the entire plate.

To enable a partial-plate read, highlight the desired columns (see Figure 4.15). Columns do not need to start with “1” but must be contiguous.

![Figure 4.15: Partial Plate Read (Strips) Dialog Box with Eight Strips Selected](image)

If you enable a partial-plate reading, only the columns to be read will be visible in the data display, indicating that no data will be collected for the other wells (all columns will be present in the Template Editor, however).

AutoCalibrate

This checkbox allows you to disable or enable automatic calibration for all instruments. The default setting is checked (enabled). Turning AutoCalibrate off allows the instrument to complete readings more quickly or to begin the first reading of a Kinetic plate faster. However, you should allow the instrument to perform autocalibration of at least one plate prior to disabling this function: calibration settings for the last plate which included an autocalibration are maintained in the instrument memory (NVRAM) until another autocalibration is performed.
AutoRead

This feature enables the automatic reading of subsequent Plate sections in the order in which they appear within an experiment. You can set intervals (delay time) between the plate readings, if desired.

Blanking (Pre-Read Plate)

The blanking selection found in the Instrument Settings dialog box is known as pre-read plate blanking, but pre-reading the plate is only one of five types of blanking available in SoftMax Pro. Understanding the differences between the types of blanking functions will enable you to choose the type of blanking that is appropriate for your assay. Note that blanks can be used in combination and have cumulative effects. Pre-read plate blanking is discussed here; for a description of the other types of blanking that are available and how these blanks work in combination, see “Blanking” on page 4-33.

If pre-read plate blanking is chosen, SoftMax Pro will prompt you to first read the blank plate after you click the [Read] button.

Figure 4.16: Blanking Section of the Instrument Settings Dialog Box

The pre-read values will be stored in the data file and the individual well values collected during the pre-reading of the plate will be subtracted from the individual well values obtained during the actual reading of samples. This is particularly useful for readings in the UV. Pre-read blanking may be turned off in the Reduction dialog box (click on the [Reduction] button) so the data may be seen with and without pre-read blanking subtracted. This option is only available within the Reduction dialog box if pre-read blanking was chosen in the instrument setup.

The purpose of pre-read plate blanks is to correct for well-to-well variability and, in the case of PathCheck, to subtract plate background before applying pathlength correction.

NOTE: A background constant subtraction setting is also available for instruments capable of using PathCheck (in the Instrument Settings > PathCheck option). If you pre-read a plate, you should not use a background constant subtraction and vice versa.

Pre-read blanking is available for all read modes but is most useful for Endpoint readings. When used in Spectrum scan mode (SpectraMax instruments only), the pre-read scan is subtracted on a point-by-point basis from the normal scan. If pre-read is selected using Kinetic mode (not generally recommended), a pre-read with the same Kinetic read interval and duration as the “normal” reading will be done and the ODs at each time point of the pre-read will be subtracted from the OD of the corresponding time point of the “normal” reading.
Molecular Devices recommends that the wells of the pre-read plate be filled with the appropriate buffer for the assay or with water when performing pathlength correction.

Template Editor

The Template Editor is available for Plate and CuvetteSet sections. In both cases, it is used to describe the location of samples, either in the wells of the microplate or in a cuvette, providing the link between the raw data and the analysis groups. The Template Editor is used to create a template which provides SoftMax Pro with a map of what is in the microplates and/or cuvettes.

When you first open the Template Editor for a new Plate section or CuvetteSet section, the grid or display is empty. After selecting wells or cuvettes, you can assign groups, and indicate the type of samples they will contain.

Depending upon the default protocol you are using, certain group names (and associated sample descriptions) may have been created. You can use these predefined groups and/or create new groups to suit your needs. When creating new groups, you may enter any name you wish. Once entered, this name will be available for use in that experiment thereafter. New groups can be created independently from selecting or assigning any wells/cuvettes in the Template Editor.

Each well/cuvette designated as being part of a group has associated with it a group name, a sample name (or replicate ID), a sample descriptor (optional), and a default column format (group type, such as Standards, for example). When a group is applied to selected wells or cuvettes, the group name is displayed in bold type over the wells/cuvettes and the wells/cuvettes bear the same color.
Groups are always visible, both in the Template and in the data display of the Plate section or CuvetteSet section. Even though they are grouped, single wells or cuvettes are still selectable in either the Template Editor or the data display.

Samples and groups may exist across multiple Plate sections or CuvetteSet sections as well as within a single Plate section or CuvetteSet section.

Each template is built upon a hierarchy as follows: the template is composed of samples and groups. A set of one or more replicate wells makes up a sample. A set of related samples forms a group. For example, you may have a group named Standards that consists of seven samples named STD01, STD02 ... STD07. Group names may be up to 32 characters long, while sample names may be 300+ characters long. Samples may be assigned one at a time using the [Assign] button or several at the same time using the [Series] button.

If you create a group in the Template Editor but do not assign any wells to the group, a section for that group will still be created automatically when you close the template. You can remove the group (both its section in the window and its group name in the template) by making that Group section active and choosing Delete Groupname (where “Groupname” is the name assigned to that group in the template) from the Edit menu. Using the Macintosh, you can also delete the selected Group by pressing Control-Option-Delete; within Windows, you can press Control-Lock. Note that deleting the wells assigned to a group from the template does not delete the corresponding Group name from the drop-down list. The only way to remove a group name from this list in the Template Editor is to delete the corresponding Group section from the experiment.
Selecting Wells or Cuvettes in the Template Editor

In the Template Editor for a Plate section or a CuvetteSet section, you can select one or more wells or cuvettes by clicking or dragging on the grid. Multiple (contiguous) wells or cuvettes can be selected by dragging across them. Non-contiguous selections can be made by holding down the Shift key and clicking individual wells or cuvettes. Clicking a row label will select the entire row; clicking a column label will select the entire column. Contiguous columns or rows (1-12 or A-H, for a 96-well plate, for example) can also be selected by dragging. Non-contiguous columns or rows can be selected by holding the ⌘ (command) key on the Macintosh or the CTRL key in Windows and clicking in labels.

- Double-clicking anywhere within a group will select the entire group.
- To deselect all wells quickly, click in the empty border around the Template.
- When you leave the Template Editor (by clicking the [OK] button), the Plate/CuvetteSet section will show the boundaries of the groups created in the template. Group labels and sample descriptors will not be visible—you can see them by holding down the Ctrl+Shift keys. When you release the key(s), the original view of the Plate section or CuvetteSet section will return.
The Template Editor Tool Bar

The tool bar will appear differently depending upon what type of group is selected in the Group drop-down list. The following illustration shows how the tool bar will appear under various circumstances.

<table>
<thead>
<tr>
<th>Group</th>
<th>Edit</th>
<th>Sample</th>
</tr>
</thead>
<tbody>
<tr>
<td>Blank</td>
<td>Clear</td>
<td>BL</td>
</tr>
</tbody>
</table>

When (Plate or Template) Blank is selected.

<table>
<thead>
<tr>
<th>Group</th>
<th>Edit</th>
<th>Sample</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unknowns</td>
<td>Clear</td>
<td>UN01</td>
</tr>
</tbody>
</table>

A group is selected that does not contain sample descriptor information (such as Unknowns column type).

<table>
<thead>
<tr>
<th>Group</th>
<th>Sample</th>
<th>Concentration</th>
</tr>
</thead>
<tbody>
<tr>
<td>Standards</td>
<td>Std01</td>
<td>0 µg/ml</td>
</tr>
</tbody>
</table>

A group is selected for which a concentration has been defined (such as Standards column type).

<table>
<thead>
<tr>
<th>Group</th>
<th>Sample</th>
<th>Dilution Factor</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unknowns</td>
<td>UN01</td>
<td>0</td>
</tr>
</tbody>
</table>

A group is selected for which a dilution factor is defined (such as Unknowns Dilution column type).

Figure 4.18: The Appearance of the Template Editor Tool Bar under Different Circumstances

The tool bar is divided into three areas: the Group area, the Sample area, and the Assign area.

The Group Area

The Group area contains the Group drop-down list which allows you to assign wells to existing groups, create new groups, or modify (using the [Edit] button) existing groups. In addition, it contains the [Clear] button which allows you to clear well assignments in the template.

Group Drop-Down List

This drop-down list consists of two areas, divided by a horizontal gray line. The two items below the gray line (Blank and New) are always available. Items above the gray line are custom groups that may be created as you wish.

The Group drop-down list will appear differently depending upon the custom groups that have been created (by default or by the user). The figure below shows two different instances of the appearance of the Group list.
Depending on the default template used when opening SoftMax Pro, initially no groups may appear above the gray line. As you create new groups, they will be positioned above the line.

- **Blank**—Creates a plate blank in the Plate section or a Template blank in the CuvetteSet section. Note: the name “blank” is reserved for use by the SoftMax Pro program and should not be used when creating custom groups.

- **New**—Creates a new group. The Group Settings dialog box will appear (see Figure 4.20) showing default settings. This dialog box allows you to define the name for a group of related samples, what type of descriptor will be associated with these samples, and the initial column format for the Group section. Whenever a new group is created (whether or not wells are selected in the template), a Group section (table) will also be created. To delete a group, you must delete the Group section. Simply clearing a group from the Template Editor will remove the assignment of wells to that group name, but the name will still show in the group pull-down menu and the Group section will still exist.
**Name:** Use either the default name, “Group#X,” where “X” is an integer that is initially set to “1” and increments (i.e., “1,” “2,” “3,” etc.) as other groups are created, or enter a custom name (up to 32 characters in length).

In the **Sample Descriptor** area of the Group Settings dialog box, you can enable the application of the sample descriptor, if appropriate by clicking the checkbox. You may also choose the units used for the sample descriptor by selecting an option from the **Units** drop-down list or by typing the units you wish to use into the list box.

The Sample Descriptor is automatically enabled when either the Standards or Unknowns(Dilution) column format (see below) is selected. The descriptor defaults to Concentration with the Standards column format and to Dilution with the Unknowns(Dilution) column format. The Sample Descriptor may also be used for time or fraction number information.

**NOTE:** No sample descriptor is assigned automatically for the Basic or Unknowns column format. You may assign a sample descriptor to these column formats manually but, if you choose to do this, the information will not appear automatically in the Group section. To see it, you will need to create a new column containing the formula !Sampledescriptor. For more information about creating columns, see “Adding Columns” on page 7-45.

**Column Format** defines the default column types that will be created for a new group or shows the original column format setting that was used to create the group you are editing.

Four selections are offered: Basic, Standard, Unknowns, and Unknowns (Dilution). Different types of columns will be created for a new group, or changed in an existing group, depending on which of these column format settings you select. Table 4.2 shows the default columns created with each selection type.

**NOTE:** If you are creating a new group for unknowns that have a dilution factor, use the Unknowns(dilution) column format as a base rather than the Unknowns group included in the default protocol.
Table 4.2: Columns Created and Their Formulas

<table>
<thead>
<tr>
<th>Name</th>
<th>Basic</th>
<th>Standard</th>
<th>Unknown</th>
<th>Unknown(Dilution)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Sample</td>
<td>Sample</td>
<td>Sample</td>
<td>Sample</td>
</tr>
<tr>
<td>Formula</td>
<td>!SampleNames</td>
<td>!SampleNames</td>
<td>!SampleNames</td>
<td>!SampleNames</td>
</tr>
<tr>
<td>Name</td>
<td>Wells</td>
<td>Wells</td>
<td>Wells</td>
<td>Wells</td>
</tr>
<tr>
<td>Formula</td>
<td>!WellIDs</td>
<td>!WellIDs</td>
<td>!WellIDs</td>
<td>!WellIDs</td>
</tr>
<tr>
<td>Name</td>
<td>Sample#</td>
<td>Concentration</td>
<td>Values</td>
<td>Values</td>
</tr>
<tr>
<td>Formula</td>
<td>Index</td>
<td>!Concentration*</td>
<td>!WellValues</td>
<td>!WellValues</td>
</tr>
<tr>
<td>Name</td>
<td>Values</td>
<td>Values</td>
<td>R (Outside Standard Range)</td>
<td>R (Outside Standard Range)</td>
</tr>
<tr>
<td>Formula</td>
<td>!WellValues</td>
<td>!WellValues</td>
<td>If(Values)&gt;=‘MinStd@ Standards’ and Values&lt;=‘Max-Std@Standards’, ””, ”R”</td>
<td>If(Values)&gt;=‘MinStd@ Standards’ and Values&lt;= ‘MaxStd@Standards’, ””, ”R”</td>
</tr>
<tr>
<td>Name</td>
<td>Mean Value</td>
<td>MeanValue</td>
<td>Result</td>
<td>Result</td>
</tr>
<tr>
<td>Formula</td>
<td>Average(Values)</td>
<td>Average(Values)</td>
<td>InterpX(STD@StandardCurve,Values)</td>
<td>InterpX(STD@StandardCurve,Values)</td>
</tr>
<tr>
<td>Name</td>
<td>Std.Dev.</td>
<td>MeanResult</td>
<td>MeanResult</td>
<td>MeanResult</td>
</tr>
<tr>
<td>Formula</td>
<td>Stdev(Values)</td>
<td>Average(Result)</td>
<td>Average(Result)</td>
<td>Average(Result)</td>
</tr>
<tr>
<td>Name</td>
<td>CV%</td>
<td>Std.Dev.</td>
<td>Std.Dev.</td>
<td>Std.Dev.</td>
</tr>
<tr>
<td>Formula</td>
<td>Cv(Values)</td>
<td>Stdev(Result)</td>
<td>Stdev(Result)</td>
<td>Stdev(Result)</td>
</tr>
<tr>
<td>Name</td>
<td>CV%</td>
<td>CV%</td>
<td>CV%</td>
<td>CV%</td>
</tr>
<tr>
<td>Formula</td>
<td>Cv(Result)</td>
<td>Cv(Result)</td>
<td>Cv(Result)</td>
<td>Cv(Result)</td>
</tr>
<tr>
<td>Name</td>
<td>Dilution</td>
<td>!Factor*</td>
<td>Adj.Result</td>
<td>MeanResult*!Factor</td>
</tr>
</tbody>
</table>

* !Concentration and !Factor are from SoftMax Pro version 1.x. !Concentration, !Factor, and !SampleDescriptor return identical information.
Chapter 4: Reading Microplates and Cuvettes Using Absorbance Instruments

The [Edit] Button

When you click the [Edit] button, the Group Settings dialog box will appear, reflecting the settings for the active group (currently visible in the group drop-down list). If you wish to edit a group that is not currently active, first choose the group from the drop-down list and then click the [Edit] button. The figure below shows the Group Settings dialog box for the active group called “Patient#1.”

![Group Settings Dialog Box for the Group Named “Patient#1”](image1)

The name, sample descriptors, and column format can be changed for the group that you are editing.

When you edit a group, you will notice that the information shown for the Column Format in the Group Settings dialog box changes to show the name of the original group used to define the group columns (see Figure 4.22).

![Groups Settings Dialog Box Showing Original Column Format](image2)

Figure 4.21: Group Settings Dialog Box for the Group Named “Patient#1”

Figure 4.22: Groups Settings Dialog Box Showing Original Column Format
Changing the column format setting will cause the columns in the group to revert to their original defaults as shown in Table 4.2 on page 4-26. If you have added columns or changed column information within the existing section for the group you are editing, these changes will be removed.

The [Clear] Button

Allows you to deselect, or clear, wells in the map of the microplate. Highlight the wells you wish to clear and then click the [Clear] button.

NOTE: The [Clear] button functions the same way in both the Template Editor for a Plate section and a CuvetteSet section; however, the result of clearing wells or cuvettes differs after you close the Template Editor and return to the Plate section or CuvetteSet section data display. In a Plate section, data for cleared wells will no longer be shown in the data display. In a CuvetteSet section, however, data for cuvettes that have been cleared in the Template Editor will still be shown for both reading and reference.

The Sample Area

The Sample area contains the Sample drop-down list and sample descriptor values (active if defined in the Group Settings dialog box or if assigned automatically by SoftMax Pro).

![Figure 4.23: Modifying Sample Names and Descriptor Values in the Template Editor](image)

CAUTION: When selecting wells or cuvettes to change sample names or descriptors, be sure all wells or cuvettes are replicates of the same sample and group or that you want them to become replicates of the same sample and group. SoftMax Pro does not prohibit selecting individual wells/cuvettes from different samples and/or groups, for example, and changing their descriptions—and they will change to become the same.

Sample Drop-Down List

The sample drop-down list consists of two areas divided by a horizontal gray line. Before other sample names have been defined, a single, pre-defined name (“BL”) appears below the gray line (the sample name “BL” is the name reserved by SoftMax Pro for group-associated blanks). The item above the gray line is the sample ready to be or currently being assigned. After being assigned, it will be shown below “BL” below the gray line.
When this list first appears, the only selection shown below the dividing line is “BL”; the active sample name that is ready to be assigned appears above the line.

When samples are assigned to a group, the default name is the first 3 letters of the group name followed by a number. For a group called “Standard,” for example, the default sample names would be Sta01, Sta02, Sta03, and so on. Sample names can be 300+ characters long; however, only the first five or six characters will be displayed in the template and in the Plate section.

NOTE: You can type a sample name directly into the box next to the arrow for the drop-down list by highlighting and typing over the existing sample name. If one or more wells or cuvettes were highlighted, typing a different name will replace the sample name shown in the template with the name you have typed and, if the name is new, will add this name to those that can be chosen in the drop-down list.

When wells or cuvettes have been selected in the template and sample names have been defined, the sample menu will look like the one below. The checkmark indicates the sample that is currently being named.

Sample Descriptor Field

The field associated with the sample descriptor only appears in the Template Editor tool bar if the group column type that has been selected requires this type of information. Generally the information entered in this field is a dilution or concentration. Position the cursor in this field and enter a number. The label and units assigned to the sample descriptor in the Group Settings dialog box are shown on either side of the field.

Assign Area

The Assign area contains the [Series] and [Assign] buttons.

NOTE: Click this button to apply a sample name to one or more wells that have been selected in the template. You may also perform this operation by using the Enter key on your keyboard.
Series Button and Function

This button is used to define several samples as a series, allowing you to easily enter incremental sample descriptors (for example, dilutions or concentrations) and sample names to the template as long as the increment can be expressed as a mathematical operation.

Replicate Samples and Samples in a Series

You can assign the same group or sample definition (same sample name and description within a group) to multiple wells to create replicates. For example, you might want to read standards in replicate to ensure that anomalies can be excluded prior to generating a standard curve. Replicates can be created using the Assign button or with the series function.

Creating a series is faster than assigning replicates individually. The series option can be used as long as the replicate values conform to a pattern that can be described by a mathematical operator (multiply by 2 or add 5, for example).

A series is defined in one direction (starting from left, right, top, or bottom) and therefore samples must be arranged sequentially in either ascending or descending order.

To create a series, do the following:

1) In the Template Editor, highlight the wells to be part of the series. The wells must be in the shape of a rectangle.

2) Click the Series button to open the Series dialog box.
Chapter 4: Reading Microplates and Cuvettes Using Absorbance Instruments

Figure 4.28: Series Dialog Box

3) Specify the name of the first sample in the series in the box (or accept the default provided by SoftMax Pro). Subsequent replicates use this name as a base and either increment the number within the name or append a number to it. In the example above, the sample name provided by SoftMax Pro describes the first sample ("01") in a group named “Standard,” here shortened to “Sta.”

4) The information shown in the box labeled Sample Descriptor is derived from the information entered in the Group Settings dialog box. If the information for sample descriptor or units is not correct, you may change it here. If you did not already do so, specify the starting value for the first sample in the series. Values for subsequent samples are calculated from this starting value.

5) Choose the operator for the series (+, -, *, or /) from the Step by: drop-down list. Enter the starting value for the series in the Starting value: box. The increment is entered in the box to the right of the Step by: box and below the Starting value: box. Figure 4.28 shows a starting value of ".5" with the operator being division ("/") and the increment being “2.” Thus the series will start with a value of “.5” and divide each subsequent sample by 2 to produce the following series values: .5, .25, .125, etc.

6) You must assign a fill direction (from the top, bottom, left, or right—to describe how the series will fill the wells) and a number of replicates. Various options are diagrammed in Figure 4.29 using a 4 x 4 block of wells (for more information about replicates, see “Replicate Samples and Samples in a Series” on page 4-30). The maximum number of replicates depends on the selection of wells: if you are filling down from the top, for example, and you have chosen a block of wells that is 4 wells wide by 8 wells high, the maximum number of replicates will be four; with the same block of wells selected, filling from the left would allow eight replicates. If the number of replicates you choose does not divide evenly into the number of rows or columns you select, depending on the filling direction, the remaining wells that cannot contain replicates will be labeled as additional individual wells in the series. For example, if you fill a block of 4 x 4 wells from the top, and choose three replicates, then the first three columns will contain the replicates and the last column will contain the additional wells in the series (see the last diagram in Figure 4.29). This replicate feature allows you to quickly define the number of replicates and, in cases where the series has more samples than a single row or column, to name them simultaneously. To create a
series with all 96 samples, highlight all the wells in the plate, select the fill direction, and set the replicates to 1.

![Diagram of fill options and replicate settings]

**Figure 4.29: Fill Options and Replicate Settings**

7) Click **[OK]** to save the series and close the dialog box. While still in the Template Editor, you can view the value assigned to any well by clicking that well. The value will be displayed at the top of the Template Editor. Holding down the **Ctrl+Shift** keys will display the values for all wells.

**NOTE:** Sometimes you may wish the names of a series of samples to increment but may not have a concentration or dilution factor that you wish to enter, or you want the concentration or dilution factor to remain constant. This can be done using the [Series] button, setting the starting value to 1 or another constant value, and either multiplying by 1 or dividing by 1. In this way, the names will increment but the value of concentration or dilution will not change. If you don’t have a concentration or dilution factor, simply deselect the sample descriptor checkbox if it is selected.

**NOTE:** If sample names are set to increment automatically using the Series function, be aware that SoftMax Pro will automatically truncate the sample name to three or four characters, including the incrementing number if the sample name starts with letters. If the sample name is entirely numeric, it will not be truncated. If sample names are very long, and they must be kept long for reference, you will have to set up your replicates manually and will not be able to use the series function.
Blanking

In addition to the pre-read plate blanking selection found in the Instrument Settings dialog box, four more types of blanking are available in SoftMax Pro. Understanding the differences between the types of blanking functions will enable you to choose the type of blanking that is appropriate for your assay. Note that blanks can be used in combination and have cumulative effects.

The five types of blanking that are defined in SoftMax Pro are:

- Pre-read plate blank (Plate section)—discussed earlier on page 4-19
- Ref (CuvetteSet section)
- Plate blank (Plate section)
- Template blank (CuvetteSet section)
- Group blank (Plate section and CuvetteSet section)

**Ref (CuvetteSet section only)**

Performing a reference reading of the cuvette causes the SpectraMax Plus or Plus384 to take a reading of the cuvette in the cuvette port. A single reference reading can be used with one or more cuvettes in a CuvetteSet section (the default applies to all cuvettes in the set) or different reference readings can be taken and applied to different cuvettes in the set. This reference read is then applied to sample reading. See “Reference Reading” on page 4-41 for more information.

**Plate Blanks (Plate section only)**

Wells can be assigned to a “Blank” group in the Template Editor. Unlike pre-read plate blanks, the average value of all the wells in a plate blank group is subtracted from all individual well values obtained during the reading of microplates. When PathCheck is selected for the SpectraMax Plus, or Plus384, 190, or 340PC, the Plate Blank is subtracted after pathlength correction. Plate Blank subtraction may be turned off in the Reduction dialog box so that the data may be seen with or without plate blank subtraction.

**NOTE**: Plate blanks are only subtracted from wells on the same plate to which they are assigned. The checkbox for Plate Blank subtraction only appears in the Reduction dialog box after data has been collected.

For Kinetic and Spectrum data, the blank value is averaged and subtracted on a point-by-point basis. The example below shows a graphic representation of original and average plate blank data, followed by the resulting data with average subtracted.
Chapter 4: Reading Microplates and Cuvettes Using Absorbance Instruments

4-34 SoftMax Pro User’s Manual

Figure 4.30: Graphic Representation of Plate Blank Subtraction

Template Blanks (CuvetteSet section only)

Similar in function to the Plate Blank used with Plate sections, Template Blanking occurs when cuvettes are assigned to a Blank group in the Template Editor of the CuvetteSet section. The average value of all the cuvettes in a template blank group will be subtracted from individual cuvette readings. For Kinetic and Spectrum data, the blank value is averaged and subtracted on a point-by-point basis. Template blanks are subtracted after the reference reading, if any, is subtracted.

NOTE Template blanks are only subtracted from cuvettes within the same CuvetteSet section.

Group-Associated Blanks (Plates and Cuvettes)

Blank wells or cuvettes can be assigned within any group (other than the “Blank” group) in the Template Editor. The average reduced value of the blank wells or cuvettes within that group will be subtracted from individual reduced values within that group only. This blanking function uses the reduced number (example: ILm1-ILm2, Vmax, etc.) only—it does not subtract on a point-by-point basis. When a group blank has been assigned, it is automatically subtracted. To see the reduced number without the group blank subtracted, mask the group blank wells or cuvettes.

Group blanks apply to all wells or cuvettes in a group and thus may be subtracted from wells or cuvettes in more than one Plate section or CuvetteSet section.

Blanks in Combination

It is possible to use blanking functions in combination. You could perform a pre-read plate blanking, assign a blank group in the template, and also include blank wells within different groups. The effects of the different blanking functions are cumulative, so it is important to understand the function of each before using more than one type of blanking in a single assay. Pre-read blanking, plate blanking, Ref, and template blanking are applied to the raw data acquired from the instrument, whereas group blanks are applied to the reduced number. Group blank subtraction is only visible in the Plate section/CuvetteSet section when the reduced number is displayed. Figure 4.31 shows the last two types of blanks in the Template Editor.
Chapter 4: Reading Microplates and Cuvettes Using Absorbance Instruments

Figure 4.31: Template Editor Showing Plate Blank and Group-Associated Blank Wells

In the figure above, note that the plate blank in the upper left appears as a separate group named “Blank” and individual samples within this group are named “BL.” The group-associated blank wells, shown in the upper right, are not a separate group—the samples, also named “BL,” are contained within the boundaries of the large group called “Unknowns” and are the same color as that group.

NOTE: In order to save changes you have made to the template in the Windows version of the Template Editor, be sure to click the [OK] button to close the window rather than clicking the Control Menu box. Clicking the Control Menu box (located in the upper left of the window) performs the same function as the [Cancel] button: the window will close but any changes you have made to the template will not be saved.

Copying and Pasting Templates

Copying Complete Template Information

Two template actions—Copy and Paste—can only be activated from the Plate or CuvetteSet menu (when a Plate section or CuvetteSet section is active) rather than from the Template Editor. If you have created a template in a Plate section or CuvetteSet section and wish to use it in another Plate section or CuvetteSet section, you may copy that template and paste it into the new section. The results of copying and pasting a template depend upon whether the action is performed within the same experiment or between experiment sections.

Copying and Pasting within the Same Experiment Section

To copy a template, make the section containing that template active and choose Copy Template from either the Plate or CuvetteSet menu (the menu name changes to reflect the type of active section). Then activate the destination Plate section or CuvetteSet section and choose Paste Template from the Plate or CuvetteSet menu.
Figure 4.32: Copy Template and Paste Template Commands in the Plate and CuvetteSet Menus

The group names and sample names of the pasted template are identical to those of the source template. In effect, the destination template is considered an extension of the original template and all wells on the destination plate are considered replicates of the wells on the source plate (same group and sample names). Any changes made to the template on the destination plate will also be made on the source plate. Data from the two Plate sections/CuvetteSet sections will be analyzed together.

Copying and Pasting between Different Experiment Sections

To copy a template, make the section containing that template active and choose Copy Template from either the Plate or CuvetteSet menu (the menu name changes to reflect the type of active section). Then activate the destination Plate section or CuvetteSet section and choose Paste Template from the Plate or CuvetteSet menu.

The group names and sample names of the pasted template will be identical to those of the source template but, since they are in different experiments, the full name will be different (for example: group@experiment#2 instead of group@experiment#1). Any changes made to the template of the destination Plate section/CuvetteSet section will not affect the source section. Data from the two Plate sections/CuvetteSet sections will not be analyzed together.

Copying and Pasting Template Regions

Contiguous regions of templates can be copied and pasted to other regions of templates (within the same or to a different experiment). All template settings are pasted into the new template except the group name: the new group is given the name “Group#X” where X is the next greater number than that used already for group names.

To copy a region of a template, highlight the region and then select Copy from the Edit menu or press ⌘C (Macintosh) or CTRL-C (Windows). Only the highlighted wells will be copied.

To paste the region into another area of a template, highlight the region and select Paste from the Edit menu or press ⌘V (Macintosh) or CTRL-V (Windows).

Only the highlighted wells will have template information pasted into them. Data is pasted using row priority: all wells in a row of highlighted wells have
information pasted into them before proceeding to the next row, from left to right. If fewer wells are highlighted for pasting than were copied, the data will be pasted until all paste-highlighted wells are filled. If more wells are highlighted for pasting than were highlighted for copying, the extra wells are left empty.

SpectraMax Gemini fluorescence readers only: If you try to paste template information between Plate sections having different plate format settings, an error will result. Plates must be of the same type to copy and paste template information.

Exporting and Importing Templates

Templates can be exported or imported by opening the Plate section and choosing the appropriate command on the Plate or CuvetteSet menu.

![Figure 4.33: Export and Import Template Commands in the Plate and CuvetteSet Menus](image)

Template files can be prepared “outside of” SoftMax Pro and then imported as needed when ready to run samples. How your particular templates should appear depends on the type of samples you will run, whether or not you will run them in replicate, etc. An example template, containing two wells with blanks, one column of standards, and the rest of the wells containing unknowns with replicates and serial dilutions, is shown below as it would appear in SoftMax Pro followed by a portion of the exported version of the same template as seen in a spreadsheet program.
Figure 4.34: Template Example Showing Two Blanks, One Column of Standards, and the Rest Unknowns Run with Replicates and with Serial Dilution.

Figure 4.35: Export of the Template Example Shown in the Previous Figure.
Templates can be set up in many different ways. If replicates are used, as with the example above, they can be set up horizontally from left to right (as this example shows) or right to left, or vertically from top to bottom or bottom to top. If you are generating template data by means of import from a bar code reader or other source, noting the manner in which the data is imported will be helpful in determining the best manner to set up the template.

Figure 4.35, above, shows the first part of the exported data from the template shown in Figure 4.34. In this spreadsheet, the first column

![Figure 4.35](image1.png)

Examining the exported information from your individual template files will help you determine the best method for template creation outside of SoftMax Pro in order for the data to be acquired in the correct manner.

**Reading a Microplate or a Cuvette**

When you read a microplate using any MDC Microplate System instrument or when you read a cuvette using the SpectraMax Plus or Plus384, the information sent by the instrument to SoftMax Pro is absorbance (optical density) data.

Optical density is defined as:

\[ \log \left( \frac{I_0}{I} \right) \]

where:

- \( I \) = the light intensity after it passes through the sample,
- \( I_0 \) = initial light intensity (generally light traveling through air).

When reading a microplate, there are two ways in which the MDC Microplate System instrument can obtain an \( I_0 \) value: with the air reference information programmed into the NVRAM (non-volatile memory) of the instrument, or through instrument autocalibration (a reading of an air reference prior to reading samples). In early versions of SoftMax and SoftMax Pro, a selection was available in the Instrument Settings dialog box to turn autocalibration on.
or off. In SoftMax Pro version 2.4 and above but prior to version 3.0, autocalibration could not be enabled or disabled by the user. Instead, the software made the determination regarding whether or not to autocalibrate. Version 3.0 again made it possible to choose whether or not autocalibration will occur (via a choice on the Instrument Settings dialog box). See page 4-18 for more information.

When reading a cuvette, the SpectraMax Plus or Plus³⁸⁴ uses the REF value (typically a reading on the appropriate buffer) as $I_0$. If no reference reading is taken, the instrument uses the air reference information programmed into the NVRAM of the instrument.

**Reading a Microplate**

You can start a reading at any time after defining instrument settings. It is not necessary to define groups and assign wells within the Template Editor first. The values received from the MDC Microplate System instrument are raw absorbance readings and are not affected by settings in the Template Editor. Only instrument settings must be defined prior to reading a microplate.

To read a microplate, open the drawer of the MDC Microplate System instrument (click the drawer button in the status bar, or choose **Open Drawer** from the **Control** menu) and insert the prepared microplate. Then simply click the **[Read]** button in the status bar or choose **Read** from the **Command** menu.

If you have created more than one Plate or CuvetteSet section, and no Plate or CuvetteSet section is active, choosing the **Read** command will cause a dialog box to appear asking you to choose which section to read (see Figure 4.37). Select the correct section and then click **[OK]** to close the dialog box. If a Plate or CuvetteSet section is active, choosing the **Read** command will read that plate or cuvette set.

![Select Section Dialog Box](image)

**Figure 4.37: Select Section Dialog Box**
*The screen on the right shows the choices available when two Plate sections and one CuvetteSet section have been created in one experiment.*

A similar dialog box will appear if you have chosen to pre-read the plate for blanking. At the bottom of this dialog box, however, are two option (radio) buttons, allowing you to proceed with the pre-read plate blank or to override this and read the “normal” plate. After reading the blank plate, you must start the read process again for the normal plate. The same dialog box will appear, but the default option button choice will be “Normal.”
Chapter 4: Reading Microplates and Cuvettes Using Absorbance Instruments

Figure 4.38: Select Plate Dialog Box for Pre-Read Plate Blanking

If you select a Plate section that already contains data and choose to Read again, an alert appears, asking you to confirm replacing data in the destination plate (see Figure 4.39). If you select Replace, the reading will proceed and the previous data will be replaced with new data.

Figure 4.39: Alert Regarding Replacing Data for Plate Section

Reading a Cuvette (SpectraMax Plus and Plus384 only)

With the SpectraMax Plus series instruments, two types of readings are possible using a cuvette: a reference and a sample reading.

Reference Reading

As in a spectrophotometer, taking a reference reading can be done either on air or using a cuvette containing the buffer of your sample. The reading taken using Ref (using the button in the CuvetteSet section tool bar or the Reference command from the Control menu) will be used as I₀ to calculate the absorbance of the sample. If no reference reading is taken, the SpectraMax Plus or Plus384 will use the I₀ values stored in the NVRAM of the instrument.

A reference reading of the cuvette in the SpectraMax Plus or Plus384 can be made at any time by choosing Reference from the Control menu or from the CuvetteSet section status bar. The Reference button is available when the active section is a CuvetteSet section. It is not visible when the active section is not a CuvetteSet section or if multiple sections are selected.

If no reference has been taken in a CuvetteSet section and you then read a reference, SoftMax Pro assumes that this reference will be used with all cuvettes in the CuvetteSet section. Therefore, the time and date of the reading are displayed under each cuvette in the section (three cuvettes per row and one cuvette per row displays only). The reference will also be applied to any new cuvettes created in that section. The reference may be read before or after reading samples.

You may have more than one reference per CuvetteSet section. If you have a single cuvette to which you want to apply a different reference, highlight that cuvette in the CuvetteSet section, place the second reference in the cuvette
port, and click [Ref]. The time/date stamp of the reference for that cuvette (and only that cuvette in the set) will change.

**NOTE:** Any new cuvettes created in the CuvetteSet section after reading a second reference will use that new reference reading.

When a reference is read, the system assumes that it will be used with all empty samples. Therefore, the date and time of the reference reading are displayed with each empty sample (including the destination sample) currently in the CuvetteSet section. If you wish to use a different reference reading with one or more cuvettes in a section, click (or shift-click) the cuvette(s) and then click the [Ref] button. A dialog will appear, asking if you wish to replace the reference reading for the cuvette(s). Choosing [OK] will enable a new reference reading to be used for those cuvette(s).

The reference read is automatically applied to the normal read. The reference value is not displayed in SoftMax Pro. If you wish to see the reference value, you can choose one of the following procedures:

**Procedure 1:**
1) Create a cuvette in the CuvetteSet section and [Ref] on air (empty cuvette port).
2) Read a cuvette containing the blanking solution.
   If you wish to have both reference and read values available, do the following:
   1) Create a cuvette in the CuvetteSet section and [Ref] on air (empty cuvette port).
   2) Define a template blank in the CuvetteSet section.
   3) Place buffer in the cuvette and [Read].
   4) [Read] the remaining samples.

The optical density of the cuvette designated as the template blank will be subtracted from the optical density of all the other cuvettes in the CuvetteSet section.

**Procedure 2:**
1) Create a cuvette set with as many cuvettes as you wish (up to the maximum of 96).
2) Reference and read the cuvette.
3) Create a template with the appropriate groups.
4) Create a column in each Group table with the formula !wellpreread!Lm1.

**NOTE:** If you have a multiple-wavelength reading and wish to see the reference at each wavelength, create additional columns with the formula !wellpreread!Lx where “x” is 2, 3, or 4, corresponding to the wavelength for which you want to see a reference.

The optical density with the reference subtracted will be displayed in the Values column. The reference value for each sample will be displayed in the custom column you have created.
Reading a Cuvette

You can highlight any cuvette in the CuvetteSet section and choose to read it. If you select more than one cuvette, the software looks for the leftmost-selected cuvette that does not contain sample read data. When one is found, the reading begins with that cuvette.

If you select a cuvette that already contains data and choose to Read again, an alert appears, asking you to confirm replacing data in the destination sample (see left side, Figure 4.40). Similarly, if you choose Reference while a sample that has already had a reference reading performed is selected, the alert shown on the right side of Figure 4.40 appears. A similar alert is shown if you choose either read function with more than one cuvette selected (asking if you wish to replace the data or reference for all cuvettes).

Figure 4.40: Alert Regarding Replacing Data for CuvetteSet Section
Note: the alert box presented depends on the number of cuvettes in the CuvetteSet section and whether or not one or more are selected at the time you choose to read again.

For Kinetic and Spectrum modes, the raw data plot is automatically displayed as a graph in the cuvette. You can also enlarge the view of selected samples by double-clicking, by using the Well Graph button on the CuvetteSet section tool bar, or by choosing Graph... from the CuvetteSet menu.

The instrument settings table shown on the right of a CuvetteSet section is similar to the one in a Plate section. Automix is not available for cuvettes. Instrument settings must be the same for all cuvettes in a CuvetteSet section.

CuvetteSet sections have a limit of 96 cuvettes. Should this limit be reached, the New Sample sub-menu of the CuvetteSet menu and the corresponding tool bar button will become unavailable (dimmed) and it will be necessary to create a new CuvetteSet section.

General Information about a Reading

After beginning a reading, the status bar will show the actions that are occurring in the MDC Microplate System instrument, along with a box showing the elapsed time for each action in minutes and seconds. The [Read] button will change to [Stop], allowing you to terminate a reading, if necessary. An example of the appearance of the status bar at the start of a Kinetic reading of a microplate using a SpectraMax instrument is shown below.

Figure 4.41: Status Bar during a Kinetic Reading (SpectraMax)
Chapter 4: Reading Microplates and Cuvettes Using Absorbance Instruments

**Calibration (SpectraMax Plus, Plus 190, 340PC, and VersaMax)**

When the instrument is connected to a SpectraMax Plus, Plus 190, 340PC, or VersaMax (or when one of those instruments is chosen in the Reader preferences), a **Calibration** command is available in the **Control** menu. Choosing this command opens the Calibration dialog box. Either a Plate section, a CuvetteSet section, or both can be selected for calibration. The dialog box also shows the date of the most recent calibration.

---

**Figure 4.42: Calibration Dialog Box (SpectraMax Plus or Plus 190/340PC)**

Instrument calibration performs an air reading at all available wavelengths and stores those values in the non-volatile instrument memory (NVRAM). For plate readings, these air calibration values are used whenever a Spectrum reading is performed using the Speed Read option, thus reducing the time it takes to complete a Spectrum reading. For cuvette readings, the air calibration values are used whenever a reference reading has not been taken or when the cuvette is read using the control panel of either the SpectraMax Plus or SpectraMax Plus 384.

**NOTE:** Molecular Devices recommends that you update the air reference information that is stored in NVRAM periodically. This is particularly important if you are using Speed Read, reading cuvettes without a reference, or running Kinetics in microplates with read intervals that are too short to allow autocalibration.

**Column vs. Wavelength Priority During a Reading**

Depending upon the type of instrument connected to the computer or chosen in the Reader Preferences, a priority is given to reading by “column” or “wavelength.” It is most important to understand this priority with multi-wavelength readings.

In column priority, an instrument will read the entire microplate (or chosen number of strips) at the first wavelength, and will then go back and read the microplate at the second and subsequent wavelengths.
In wavelength priority, the instrument will read all wavelengths for the first column of wells in the microplate, and will then read all wavelengths for the second column, etc.

The table below shows the priority settings by MDC Microplate System instrument for the different read modes.

**Table 4.3: Column vs. Wavelength Priority**

<table>
<thead>
<tr>
<th></th>
<th>Endpoint</th>
<th>Kinetic</th>
<th>Spectrum</th>
</tr>
</thead>
<tbody>
<tr>
<td>SpectraMax Plus,</td>
<td>User choice¹</td>
<td>Wavelength</td>
<td>Column</td>
</tr>
<tr>
<td>VersaMax Plus,</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SpectraMax Plus³⁸⁴</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SpectraMax 190, 190PC,</td>
<td>Column</td>
<td>Wavelength</td>
<td>Column</td>
</tr>
<tr>
<td>SpectraMax 340PC, 340PC³⁸⁴</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SpectraMax 250,</td>
<td>Column</td>
<td>Column</td>
<td>Column</td>
</tr>
<tr>
<td>SpectraMax 340</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>VersaMax, ThermoMax,</td>
<td>Column</td>
<td>Column</td>
<td></td>
</tr>
<tr>
<td>UVmax, Vmax</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Emax</td>
<td>Column</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

¹ You can choose between wavelength and column (default) priority readings in the Instrument Settings dialog box.

**Data Display During a Reading**

The values read by the MDC Microplate System instrument will appear in the data display of the Plate section or CuvetteSet section as they are received from the instrument (in real time). Depending upon the read mode (Endpoint, Kinetic, or Spectrum), the number of wavelengths, the plate type, and the display options selected, the data display will show one or more numbers or plots.

You can enlarge the display of one or more wells while the a Kinetic or Spectrum reading is in progress. Double-click a single well to enlarge its display to a Well Graph or hold the Shift key while selecting more than one well, and then choose Graph... from the Plate menu or click the graph button on the tool bar to display the data from multiple wells in one enlarged Well Graph. The data in the enlarged Well Graph will update to show new data points as they are received from the MDC Microplate System instrument.

Other choices and settings within SoftMax Pro affect the way in which data is displayed—the type of reduction, specific time settings, and so on. These settings are discussed in Chapter 7, “Displaying and Analyzing Data Using Absorbance Instruments.”
Chapter 5: Reading Using Fluorescence or Luminescence Instruments

Introduction ............................................................. 5-3
Instrument Settings ................................................... 5-4
   Instrument Settings Options ................................. 5-10
Template Editor ....................................................... 5-19
   Selecting Wells in the Template Editor .................. 5-21
   The Template Editor Tool Bar .............................. 5-21
   Blanking ........................................................... 5-30
   Copying and Pasting Templates ......................... 5-33
Reading a Microplate ............................................... 5-34
   General Information about a Reading ................... 5-35
Reading Microplates Using the FlexStation Instrument in
   FLEX Mode ..................................................... 5-36
Instrument Settings .................................................. 5-38
   Read Mode ....................................................... 5-40
   Settings for FLEX Mode .................................... 5-41
Template Editor ....................................................... 5-51
Reading a Microplate ............................................... 5-51
   General Information about a Reading ................... 5-52
Chapter 5: Reading Using Fluorescence or Luminescence Instruments

Introduction

Reading a microplate using SoftMax Pro is a three-part process:

• Prepare SoftMax Pro to collect data;
• Prepare the microplate(s) to be read; and
• Read the microplate(s)

Before reading a microplate, you must create the Plate section(s) and define the instrument settings for the reading. **Instrument Settings MUST be defined prior to collecting data and may NOT be changed after data is collected.** In addition, it is recommended that you define a template and set the reduction and display parameters prior to reading the microplate, since these parameters determine how data is displayed and analyzed, but these last parameters may be set up and/or modified after data collection.

A typical process for preparing, collecting, and analyzing data is as follows:

1) Start SoftMax Pro.
2) Create Plate section(s) as needed.
3) Define instrument settings (use buttons in the Plate section tool bar or the **Control** menu).
4) Define the template, reduction parameters, and display parameters.
5) Prepare the microplate(s) to be read and place them in the instrument. If using a FlexStation, also prepare any compounds to be used and load the pipette tips.
6) Initiate the reading.
7) Save the data file.
8) Modify the template, reduction parameters, or display parameters as you wish (or, if you didn’t set them up in Step 4, do so now).
9) Save the data file.
10) Analyze the data using the Group section tables and Graph sections.
11) Save the data file when you are finished.

This chapter discusses how to define instrument settings, create a template, and initiate a reading using fluorescence or luminescence instruments.
Instrument Settings

**NOTE:** Only the settings that pertain to the instrument that is connected to the computer or the one chosen in the Preferences will be shown in the Instrument Settings dialog box.

You must specify the instrument settings prior to actually reading a microplate. These settings include:

- The read mode—Endpoint, Kinetic, Spectrum, Well Scan, or FLEX mode.
- Wavelength(s) used with Endpoint, Kinetic, and Well Scan modes or the wavelength range for Spectrum mode.
- Timing for Kinetic and FLEX mode runs.
- Cutoff filters.
- PMT sensitivity and number of readings.
- Read type: fluorescence, luminescence, or time-resolved fluorescence for most instruments; fluorescence only and the choice for bottom read with the FlexStation instrument only.
- Assay plate type: number of wells.
- Automix.
- Wells to read.
- Autocalibration.

Settings for the reading are made in the Instrument Settings dialog box, which can be accessed in three ways:

1) Choose **Instrument Setup...** from the **Control** menu;
2) Click the **Setup** button in the tool bar of the active, expanded Plate section; or
3) Double-click anywhere in the settings box (located to the right of the well grid) in the active, expanded Plate section.

**NOTE:** You may create more than one Plate section in a single experiment, and the instrument settings associated with each Plate section can be different. **Instrument Setup...** can only be chosen while a Plate section is active, and the settings you choose will affect only that section. A new Plate section that is created in an experiment that contains an active Plate section will contain the same instrument settings found in the previously active section. The settings for the new section can be modified as desired.
Table 5.1 lists all possible instrument settings choices based on instrument type. When you have defined the instrument settings, click the [OK] button to close the Instrument Settings dialog box. After closing, a summary of the instrument settings will appear in the box to the right of the data display in the Plate section. The instrument will use these settings to read the plate.

Table 5.1: Features Available in the Instrument Settings Dialog Box for Fluorescence Instruments

<table>
<thead>
<tr>
<th>SpectraMax Gemini Fluorescence Readers*</th>
<th>Wavelength, Sensitivity, Readings, AutoCalibrate, Assay Plate Type, Wells to Read, AutoRead</th>
<th>Read Type</th>
<th>Timing</th>
<th>PMT Sensitivity</th>
<th>Cutoffs</th>
<th>Well Scan Editor</th>
<th>Bottom Read</th>
<th>Compound Source/Transfer, Pipette Tips Layout, Compound &amp; Tip Column</th>
</tr>
</thead>
<tbody>
<tr>
<td>Endpoint:</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Fluorescence</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Luminescence</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Time-Resolved Fluorescence*</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Kinetic:</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Fluorescence</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Luminescence</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Time-Resolved Fluorescence</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Spectrum:</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Fluorescence</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Luminescence</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Time-Resolved Fluorescence</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Well Scan:</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Fluorescence</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Luminescence</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Time-Resolved Fluorescence</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>FlexStation</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Endpoint:</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Fluorescence</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Luminescence</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Time-Resolved Fluorescence</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Kinetic:</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Fluorescence</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Luminescence</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Time-Resolved Fluorescence</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Spectrum:</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Fluorescence</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Luminescence</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Time-Resolved Fluorescence</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Well Scan:</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Fluorescence</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Luminescence</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Time-Resolved Fluorescence</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>FLEX:</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Fluorescence</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

1 No Automatic setting.
2 No Automatic setting; default is no cutoff filter.
3 Default is no cutoff filter.
4 The SpectraMax Gemini EM can perform bottom-reads but does not support Time-Resolved Fluorescence mode.
5 Fluorescence is the only read mode available with the FlexStation (no “Reader” choice available); no top read choice is available in FLEX mode.

NOTE: Incubator control is an instrument setup parameter that is not found in the Instrument Settings dialog box.
Figure 5.1: Instrument Settings Dialog Boxes for Endpoint Mode
Figure 5.2: Instrument Settings Dialog Boxes for Kinetic Mode
Figure 5.3: Instrument Settings Dialog Boxes for Spectrum Mode
Figure 5.4: Instrument Settings Dialog Boxes for Well Scan Mode
Instrument Settings Options

Read Mode

Choices for the read mode are Endpoint, Kinetic, Spectrum, or Well Scan. To select a read mode, click the appropriate section in the Instrument Settings dialog box.

Endpoint

A single reading of the microplate can be taken at a single or multiple wavelength(s). Values reported are relative fluorescence units (RFU) or relative luminescence units (RLU). The default reduced value is !Lm1 (or !Lm2-!Lm4 if multiple wavelengths were chosen).

Figure 5.5: Instrument Settings for an Endpoint Reading
You can choose up to four wavelengths.
Kinetic

Data is collected over time with multiple readings taken at regular intervals. The default reduced values calculated for Kinetic data are Vmax per Sec (RFU/Sec or RLU/Sec), Time to Vmax (seconds), Onset Time (seconds), Time at Minimum, Time at Maximum, Time at 1/2 Maximum, Slope, and Area Under Curve.

Figure 5.6: Instrument Settings for a Kinetic Reading.

Timing—When Kinetic mode is chosen, the Timing area becomes active, allowing you to enter the total Kinetic run time and the time interval between readings. A default value will be shown for the run time; to change this value, click in the box. Up and down arrows will appear, enabling you to increase or decrease the value shown. Highlight the hours, minutes, or seconds shown and then click the up or down arrow until the desired value is reached. Alternatively, you can type over an existing value using the keyboard.

After choosing a total run time and an interval between readings, the total number of readings that will result is shown below the run time. If you set the interval time to be shorter than the instrument’s minimum read interval, the program will alert you with a warning message. An interval that is too short will cause a warning message to appear telling you that no calibration can occur between reads.

The minimum read interval is determined by the instrument that is connected to the computer or, if no instrument is connected, by which instrument has been chosen in the Reader section of the Preferences dialog box and the particular settings chosen for that instrument. The minimum interval depends on the number of wavelengths, the Automix status, the wells to read, and the distance the monochromator and filter wheel of the instrument must move.

NOTE: If you are writing a protocol that will be used with an instrument other than the one connected to the computer or chosen in the Reader preferences, you can disregard the alert and save the setup. However, if you attempt a reading using a protocol which has settings that are
not correct for the particular instrument you are using, an error message will instruct you to change the setting that is out of range before you can initiate a reading.

**NOTE:** To achieve the shortest possible interval for Kinetic readings using the SpectraMax Gemini fluorescence readers or FlexStation instruments, choose wavelengths in *ascending* order.

### Spectrum

Measures relative fluorescence or luminescence units across a Spectrum of wavelengths. The default reduced value reported for each well is the wavelength of maximum fluorescence or luminescence, depending on the read type chosen.

![Instrument Settings](image)

**Figure 5.7: Instrument Settings for a Spectrum Reading**

All Spectrum readings are made using the scanning monochromator of the SpectraMax Gemini fluorescence readers or FlexStation instruments.
**Well Scan**

One or more readings of a single well of a microplate can be taken at a single or multiple wavelength(s). Values reported are relative fluorescence units (RFU) or relative luminescence units (RLU). The default reduced value is !Lm1 (or !Lm2:!Lm4 if multiple wavelengths were chosen).

![Figure 5.8: Instrument Settings for a Well Scan Reading](image)

You can choose up to four wavelengths.

**Read Type**

Choices for the read type are fluorescence, luminescence, or time-resolved fluorescence. Also included in this group of settings is bottom read. To select a read type, click the appropriate section in the Instrument Settings dialog box. All read modes are available for all read types.

Two types of scans are possible when either fluorescence or time-resolved fluorescence read type is chosen: you can select a fixed wavelength for excitation and scan emission or vice versa. More about this can be found in the following section, “Wavelengths.”

**Fluorescence**

The light emitted by certain substances resulting from the absorption of incident radiation. To measure fluorescence accurately, it is necessary to reduce light scatter. The governing equation for fluorescence is:

\[
\text{Fluorescence} = \text{extinction coefficient} \times \text{concentration} \times \text{quantum yield} \times \text{excitation intensity} \times \text{pathlength} \times \text{emission collection efficiency}
\]

**Luminescence**

The emission of light by processes that derive energy from essentially non-thermal changes, the motion of subatomic particles, or the excitation of an atomic system by radiation.

**Time-Resolved Fluorescence**

Most fluorescence substances are not suitable for this type of reading. However, the fluorescence emitted by lanthanide dyes is delayed long enough to
measure fluorescence after the lamp is turned off. Time-resolved fluorescence is used to reduce the amount of background noise which interferes with fluorescence. The excitation lamp flashes and, after it is off, the delayed emission is collected for a set period of time before the lamp is flashed again.

**Bottom Read (FlexStation Instruments Only)**

When a FlexStation instrument is connected to the computer or chosen in the Preferences, below the Read Type choices is a checkbox next to “Bottom Read.” When selected, Bottom Read allows the FlexStation instrument to read through the bottom of clear-bottom microplates. By default, this setting is enabled for Well Scan and FLEX modes and off for the others. This setting is dimmed if a plate type having an opaque bottom is chosen.

**Wavelengths**

**For Endpoint, Kinetic, or Well Scan Readings**

Choose the number of different wavelengths to be read. At least one wavelength must always be specified. Selecting more than one wavelength will cause a corresponding number of wavelength setting boxes to appear (maximum four wavelengths).

![Figure 5.9: Wavelength Settings](image)

*Figure 5.9: Wavelength Settings*

The wavelengths specified previously (or the defaults) will be shown in the boxes. You can choose a wavelength from the choices in the pull-down menu or simply type any wavelength (within the available range of the scanning monochromator in the instrument) over an existing setting. The pull-down menu will show common monochromator settings.
For Spectrum Readings

When Spectrum is selected, the Wavelengths section of the dialog box changes to request a wavelength scanning range and a wavelength increment (Step) between the start and stop settings (see Figure 5.10).

![Figure 5.10: Wavelength Selection for a Spectrum Reading](image)

The minimum selectable increment is 1 nm.

For fluorescence and time-resolved fluorescence readings, you must also choose whether to read excitation at a fixed wavelength and scan emission wavelengths, or vice versa within the range of the instrument (250-850 nm). A procedure to optimize excitation and emission wavelengths for a given assay is outlined in the instrument manuals for the SpectraMax Gemini fluorescence readers and FlexStation instruments. Please see those manuals for more information.

When luminescence is chosen, you must also select a start and end wavelength and a step (minimum step increment is 1 nm).

Cutoffs

The choices in this portion of the Wavelengths setting depend upon the selections for read mode (Endpoint, Kinetic, Spectrum, or Well Scan) and read type (fluorescence, luminescence, or time-resolved fluorescence). The term “cutoff” refers to filters used to condition the light entering or exiting the monochromators in order to reduce stray light and minimize background interference.

![Figure 5.11: Cutoff Settings Window](image)

The choices you see depend upon the setting for the read mode.

No emission cutoff filter is used when luminescence is selected. With other read types, choices are to enable or disable “Auto Cutoff” with specific filter settings available if it is disabled (manual cutoff selection). When Auto Cutoff is enabled,
the instrument sets the cutoffs based upon the wavelength(s) chosen for reading; when Spectrum is selected as the read mode, however, a manual setting for the emission monochromator is required, with the default being no cutoff filter.

Determining a manual setting for a cutoff filter is done based upon the known value of the “Stokes shift”: the difference between the wavelengths of the excitation and emission maxima. If the Stokes shift is small, it may be advisable to choose an excitation wavelength that is as far as possible from the emission maximum while still being capable of exciting the fluorophore. Doing this causes less of the excited light to overlap the emission Spectrum, allowing better selection and quantitation of the emitted light. See the instrument manual for the SpectraMax Gemini fluorescence reader or FlexStation instrument for more information regarding cutoff filter settings.

### Sensitivity

#### Readings

This setting determines the number of readings that will be performed on each well of the microplate (readings are averaged and the average reading is displayed).

![Figure 5.12: Number of Readings Setting](image)

The left shows the default setting for fluorescence; the right shows changing this setting for more precision with a greater number of readings per well.

The default number of readings per well varies with the read type: for fluorescence, the default is 6; for luminescence, the default is 30; for time-resolved fluorescence, the default is 20. The number of readings is variable from 1 to 30.

**NOTE:** With the luminescence read mode, the integration time is directly proportional to the number of readings per well determined by this setting. Each reading per well is equal to 3.2 milliseconds of integration time.

#### PMT Sensitivity

The PMT (photomultiplier tube) is a vacuum tube that detects light, especially from dim sources, through the use of photoemission and successive instances of secondary emission to produce enough electrons to generate a useful current.
Chapter 5: Reading Using Fluorescence or Luminescence Instruments

Figure 5.13: PMT Sensitivity Setting (SpectraMax Gemini fluorescence readers)
Clicking in the box causes a menu of choices to appear. Automatic is present only when Endpoint mode is chosen. Otherwise, settings are manual and limited to High, Medium, or Low.

The voltage of the photomultiplier tube may be set to low (for samples having a higher concentration), medium, or high (samples having lower concentration) in all read modes. In Endpoint mode (and also Spectrum mode when using the SpectraMax Gemini XS or EM), an additional setting, automatic, is available. This setting allows the instrument to adjust the PMT voltage automatically for varying concentrations of sample in the plate.

Automix

The Automix function is a patented feature that allows you to set automated shaking of the microplate. The options available for Automix depend on the read mode chosen and the type of instrument connected or chosen in the Preferences.

Figure 5.14: Automix Settings Box

Before First Read

This setting can be used with any read mode. Click the checkbox next to “Before First Read” to shake the microplate before the first reading. Whether you read at a single wavelength or at multiple wavelengths, enabling Automix for “Before First Read” will shake the plate for the set amount of time before the first wavelength reading only. You can accept the default value shown for the amount of time to shake the plate or enter a different value (up to 999 seconds) in the box to the right.

Between Reads

This option is applicable only to Kinetic readings and will be displayed only when Kinetic mode is selected. To enable automatic mixing of the microplate between readings during a Kinetic assay, click the checkbox next to this setting. For readings at a single wavelength, “Between Reads” will shake the plate for the set amount of time prior to each reading at that wavelength. For readings at multiple wavelengths, enabling “Between Reads” will shake the plate for the set amount of time before each reading at the first wavelength only. You can accept the default value shown for the amount of time to shake the plate or enter a different value (up to 999 seconds) in the box to the right.
**AutoCalibrate**

This checkbox allows you to disable or enable automatic calibration. The default setting is checked (enabled). Turning AutoCalibrate off allows the instrument to complete readings more quickly or to begin the first reading of a Kinetic plate faster. However, you should allow the instrument to perform autocalibration of at least one plate prior to disabling this function: calibration settings for the last plate which included an autocalibration are maintained in the instrument memory (NVRAM) until another autocalibration is performed.

**Assay Plate Type**

This setting determines the display of wells in the microplate—it should be set to match the type and number of wells in the actual microplate that will be read.

![Figure 5.15: Plate Type Setting](image)

Clicking in the box allows you to choose the number of wells and type of microplate you will be reading.

**NOTE:** Changing the Plate Type within a Plate section causes well assignments stored in the previous template to be discarded. The groups created previously remain, however, so you can select new wells and simply apply existing groups to these wells.

**Defining New Plate Types**

The Plate Type list includes entries for microplates with standard dimensions and additional entries for plates that work best with custom settings. For both 96- and 384-well plates, the Standard plate should be used unless a custom setting is shown for the microplate you are using.

**Wells to Read**

You may choose to read the entire plate or only certain wells in the microplate. Partial-plate reading is available for all read modes, and the time required for some readings may be significantly reduced using this setting since the instrument does not have to read the entire plate.

To configure the settings for a partial-plate read, choose the Wells to Read setting.
Highlight the wells to be read. Wells must be contiguous but can be located anywhere in the microplate. If you enable a partial-plate reading, only the wells to be read will be visible in the data display, indicating that no data will be collected for the other wells (all wells will be visible in the Template Editor, however).

**AutoRead**

This feature enables the automatic reading of subsequent Plate sections in the order in which they appear within an experiment. You can set intervals (delay time) between the plate readings, if desired.

**Template Editor**

The Template Editor is used to describe the location of samples in the wells of the microplate, providing the link between the raw data and the analysis groups.

When you first open the Template Editor for a new Plate section, the grid or display is empty. The number of wells shown depends upon the type of plate selected in the Instrument Settings. After selecting wells, you can assign groups, and indicate the type of samples the wells will contain.

Depending upon the default protocol you are using, certain group names (and associated sample descriptions) may have been created. You can use these predefined groups and/or create new groups to suit your needs. When creating new groups, you may enter any name you wish. Once entered, this name will be available for use in that experiment thereafter. New groups can be created independently from selecting or assigning any wells in the Template Editor.

Each well designated as being part of a group has associated with it a group name, a sample name (or replicate ID), a sample descriptor (optional), and a default column format (group type, such as Standards, for example). When a group is applied to selected wells, the group name is displayed in bold type over the wells and the well bear the same color.
Groups are always visible, both in the Template and in the data display of the Plate section. Even though they are grouped, single wells are still selectable in either the Template Editor or the data display.

Samples and groups may exist across multiple Plate sections as well as within a single Plate section.

Each template is built upon a hierarchy as follows: the template is composed of samples and groups. A set of one or more replicate wells makes up a sample. A set of related samples forms a group. For example, you may have a group named Standards that consists of seven samples named STD01, STD02 ... STD07. Group names may be up to 32 characters long, while sample names may be 300+ characters long. Samples may be assigned one at a time using the [Assign] button or several at the same time using the [Series] button.

If you create a group in the Template Editor but do not assign any wells to the group, a section for that group will still be created automatically when you close the template. You can remove the group (both its section in the window and its group name in the template) by making that Group section active and choosing Delete Groupname (where “Groupname” is the name assigned to that group in the template) from the Edit menu. Using the Macintosh, you can also delete the selected Group by pressing `/command; within Windows, you can press CTRL+- . Note that deleting the wells assigned to a group from the template does not delete the corresponding Group name from the drop-down list. The only way to remove a group name from this list in the Template Editor is to delete the corresponding Group section from the experiment.
Selecting Wells in the Template Editor

In the Template Editor for a Plate section, you can select one or more wells by clicking or dragging on the grid. Multiple (contiguous) wells can be selected by dragging across them. Non-contiguous selections can be made by holding down the Shift key and clicking individual wells. Clicking a row label will select the entire row; clicking a column label will select the entire column. Contiguous columns or rows (1-12 or A-H, for a 96-well plate, for example) can also be selected by dragging. Non-contiguous columns or rows can be selected by holding the ⌘ (command) key on the Macintosh or the CTRL key in Windows and clicking in labels.

- Double-clicking anywhere within a group will select the entire group.
- To deselect all wells quickly, click in the empty border around the Template.
- When you leave the Template Editor (by clicking the [OK] button), the Plate section will show the boundaries of the groups created in the template. Group labels and sample descriptors will not be visible—you can see them by holding down the ⌘+Shift keys. When you release the key(s), the original view of the Plate section will return.

The Template Editor Tool Bar

The tool bar will appear differently depending upon what type of group is selected in the Group drop-down list. The following illustration shows how the tool bar will appear under various circumstances.

![Figure 5.18: The Appearance of the Template Editor Tool Bar under Different Circumstances](image-url)
The tool bar is divided into three areas: the Group area, the Sample area, and the Assign area.

**The Group Area**

The Group area contains the Group drop-down list which allows you to assign wells to existing groups, create new groups, or modify (using the [Edit] button) existing groups. In addition, it contains the [Clear] button which allows you to clear well assignments in the template.

**Group Drop-Down List**

This drop-down list consists of two areas, divided by a horizontal gray line. The two items below the gray line (Blank and New) are always available. Items above the gray line are custom groups that may be created as you wish.

The Group drop-down list will appear differently depending upon the custom groups that have been created (by default or by the user). The figure below shows two different instances of the appearance of the Group list.

![No custom groups created](image1.png)  ![Example of custom groups created by a user](image2.png)

**Figure 5.19: The Group Drop-Down List**

**NOTE** Depending on the default template used when opening SoftMax Pro, initially no groups may appear above the gray line. As you create new groups, they will be positioned above the line.

- **Blank**—Creates a plate blank in the Plate section. Note: the name “blank” is reserved for use by the SoftMax Pro program and should not be used when creating custom groups.

- **New**—Creates a new group. The Group Settings dialog box will appear (see Figure 5.20) showing default settings. This dialog box allows you to define the name for a group of related samples, what type of descriptor will be associated with these samples, and the initial column format for the Group section. Whenever a new group is created (whether or not wells are selected in the template), a Group section (table) will also be created. To delete a group, you must delete the Group section. Simply clearing a group from the Template Editor will remove the assignment of wells to that group name, but the name will still show in the group pull-down menu and the Group section will still exist.
Name: Use either the default name, “Group#X,” where “X” is an integer that is initially set to “1” and increments (i.e., “1,” “2,” “3,” etc.) as other groups are created, or enter a custom name (up to 32 characters in length).

In the **Sample Descriptor** area of the Group Settings dialog box, you can enable the application of the sample descriptor, if appropriate by clicking the checkbox. You may also choose the units used for the sample descriptor by selecting an option from the **Units** drop-down list or by typing the units you wish to use into the list box.

The Sample Descriptor is automatically enabled when either the Standards or Unknowns (Dilution) column format (see below) is selected. The descriptor defaults to Concentration with the Standards column format and to Dilution with the Unknowns (Dilution) column format. The Sample Descriptor may also be used for time or fraction number information.

**NOTE:** No sample descriptor is assigned automatically for the Basic or Unknowns column format. You may assign a sample descriptor to these column formats manually but, if you choose to do this, the information will not appear automatically in the Group section. To see it, you will need to create a new column containing the formula ![SampleDescriptor]. For more information about creating columns, see “Adding Columns” on page 8-42.

**Column Format** defines the default column types that will be created for a new group or shows the original column format setting that was used to create the group you are editing.

Four selections are offered: Basic, Standard, Unknowns, and Unknowns (Dilution). Different types of columns will be created for a new group, or changed in an existing group, depending on which of these column format settings you select. Table 5.2 shows the default columns created with each selection type.
If you are creating a new group for unknowns that have a dilution factor, use the Unknowns(dilution) column format as a base rather than the Unknowns group included in the default protocol.

### Table 5.2: Columns Created and Their Formulas

<table>
<thead>
<tr>
<th>Name</th>
<th>Basic</th>
<th>Standard</th>
<th>Unknown</th>
<th>Unknown(Dilution)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Sample</td>
<td>Sample</td>
<td>Sample</td>
<td>Sample</td>
</tr>
<tr>
<td>Formula</td>
<td>!SampleNames</td>
<td>!SampleNames</td>
<td>!SampleNames</td>
<td>!SampleNames</td>
</tr>
<tr>
<td>Name</td>
<td>Wells</td>
<td>Wells</td>
<td>Wells</td>
<td>Wells</td>
</tr>
<tr>
<td>Formula</td>
<td>!WellIDs</td>
<td>!WellIDs</td>
<td>!WellIDs</td>
<td>!WellIDs</td>
</tr>
<tr>
<td>Name</td>
<td>Sample#</td>
<td>Concentration</td>
<td>Values</td>
<td>Values</td>
</tr>
<tr>
<td>Formula</td>
<td>Index</td>
<td>!Concentration*</td>
<td>!WellValues</td>
<td>!WellValues</td>
</tr>
<tr>
<td>Name</td>
<td>Values</td>
<td>Values</td>
<td>R (Outside Standard Range)</td>
<td>R (Outside Standard Range)</td>
</tr>
<tr>
<td>Formula</td>
<td>!WellValues</td>
<td>!WellValues</td>
<td>If(Values)(\geq)‘MinStd@ Standards’ and Values(\leq)‘Max-Std@Standards’, ‘’, ‘R’</td>
<td>If(Values)(\geq)‘MinStd@ Standards’ and Values(\leq) ‘MaxStd@Standards’, ‘’, ‘R’</td>
</tr>
<tr>
<td>Name</td>
<td>Mean Value</td>
<td>MeanValue</td>
<td>Result</td>
<td>Result</td>
</tr>
<tr>
<td>Formula</td>
<td>Average(Values)</td>
<td>Average(Values)</td>
<td>InterpX(STD@StandardCurve,Values)</td>
<td>InterpX(STD@StandardCurve,Values)</td>
</tr>
<tr>
<td>Name</td>
<td>Std.Dev.</td>
<td>MeanResult</td>
<td>MeanResult</td>
<td>MeanResult</td>
</tr>
<tr>
<td>Formula</td>
<td>Stdev(Values)</td>
<td>Average(Result)</td>
<td>Average(Result)</td>
<td>Average(Result)</td>
</tr>
<tr>
<td>Name</td>
<td>CV%</td>
<td>Std.Dev.</td>
<td>Std.Dev.</td>
<td>Std.Dev.</td>
</tr>
<tr>
<td>Formula</td>
<td>Cv(Values)</td>
<td>Stdev(Result)</td>
<td>Stdev(Result)</td>
<td>Stdev(Result)</td>
</tr>
<tr>
<td>Name</td>
<td></td>
<td>CV%</td>
<td>CV%</td>
<td>CV%</td>
</tr>
<tr>
<td>Formula</td>
<td></td>
<td>Cv(Result)</td>
<td>Cv(Result)</td>
<td>Cv(Result)</td>
</tr>
<tr>
<td>Name</td>
<td></td>
<td></td>
<td></td>
<td>Dilution</td>
</tr>
<tr>
<td>Formula</td>
<td></td>
<td></td>
<td></td>
<td>!Factor*</td>
</tr>
<tr>
<td>Name</td>
<td></td>
<td></td>
<td></td>
<td>Adj.Result</td>
</tr>
<tr>
<td>Formula</td>
<td></td>
<td></td>
<td></td>
<td>MeanResult*!Factor</td>
</tr>
</tbody>
</table>

*!Concentration and !Factor are from SoftMax Pro version 1.x. !Concentration, !Factor, and !SampleDescriptor return identical information.*
The **Edit** Button

When you click the **Edit** button, the Group Settings dialog box will appear, reflecting the settings for the active group (currently visible in the group drop-down list). If you wish to edit a group that is not currently active, first choose the group from the drop-down list and then click the **Edit** button. The figure below shows the Group Settings dialog box for the active group called “Patient#1.”

![Group Settings Dialog Box](image)

**Figure 5.21: Group Settings Dialog Box for the Group Named “Patient#1”**

The name, sample descriptors, and column format can be changed for the group that you are editing.

When you edit a group, you will notice that the information shown for the Column Format in the Group Settings dialog box changes to show the name of the original group used to define the group columns (see Figure 5.22).

![Group Settings Dialog Box](image)

When you are editing Group Settings (rather than creating a new group), the word “original” precedes the Column Format.

**Figure 5.22: Groups Settings Dialog Box Showing Original Column Format**
Chapter 5: Reading Using Fluorescence or Luminescence Instruments

⚠️ CAUTION: Changing the column format setting will cause the columns in the group to revert to their original defaults as shown in Table 5.2 on page 5-24. If you have added columns or changed column information within the existing section for the group you are editing, these changes will be removed.

The Clear Button
Allows you to deselect, or clear, wells in the map of the microplate. Highlight the wells you wish to clear and then click the Clear button.

The Sample Area
The Sample area contains the Sample drop-down list and sample descriptor values (active if defined in the Group Settings dialog box or if assigned automatically by SoftMax Pro).

⚠️ CAUTION: When selecting wells to change sample names or descriptors, be sure all wells are replicates of the same sample and group or that you want them to become replicates of the same sample and group. SoftMax Pro does not prohibit selecting individual wells from different samples and/or groups, for example, and changing their descriptions—and they will change to become the same.

Sample Drop-Down List
The sample drop-down list consists of two areas divided by a horizontal gray line. Before other sample names have been defined, a single, pre-defined name ("BL") appears below the gray line (the sample name "BL" is the name reserved by SoftMax Pro for group-associated blanks). The item above the gray line is the sample ready to be or currently being assigned. After being assigned, it will be shown below "BL" below the gray line.

⚠️ CAUTION: When this list first appears, the only selection shown below the dividing line is "BL"; the active sample name that is ready to be assigned appears above the line.

When samples are assigned to a group, the default name is the first 3 letters of the group name followed by a number. For a group called "Standard," for example, the default sample names would be Sta01, Sta02, Sta03, and so on.
Sample names can be 300+ characters long; however, only the first five or six characters will be displayed in the template and in the Plate section.

NOTE: You can type a sample name directly into the box next to the arrow for the drop-down list by highlighting and typing over the existing sample name. If one or more wells were highlighted, typing a different name will replace the sample name shown in the template with the name you have typed and, if the name is new, will add this name to those that can be chosen in the drop-down list.

When wells have been selected in the template and sample names have been defined, the sample menu will look like the one below. The checkmark indicates the sample that is currently being named.

![Sample Drop-Down List — Sample Names Defined and Wells Selected](image)

**Sample Descriptor Field**

The field associated with the sample descriptor only appears in the Template Editor toolbar if the group column type that has been selected requires this type of information. Generally the information entered in this field is a dilution or concentration. Position the cursor in this field and enter a number. The label and units assigned to the sample descriptor in the Group Settings dialog box are shown on either side of the field.

**Assign Area**

The Assign area contains the \[Series\] and \[Assign\] buttons.

![Assign Area of the Template Editor Tool Bar](image)

**Assign Button and Function**

Click this button to apply a sample name to one or more wells that have been selected in the template. You may also perform this operation by using the Enter key on your keyboard.

**Series Button and Function**

This button is used to define several samples as a series, allowing you to easily enter incremental sample descriptors (for example, dilutions or concentrations) and sample names to the template as long as the increment can be expressed as a mathematical operation.

**Replicate Samples and Samples in a Series**

You can assign the same group or sample definition (same sample name and description within a group) to multiple wells to create replicates. For example, you might want to read standards in replicate to ensure that anomalies can be
excluded prior to generating a standard curve. Replicates can be created using the Assign button or with the series function.

Creating a series is faster than assigning replicates individually. The series option can be used as long as the replicate values conform to a pattern that can be described by a mathematical operator (multiply by 2 or add 5, for example).

A series is defined in one direction (starting from left, right, top, or bottom) and therefore samples must be arranged sequentially in either ascending or descending order.

To create a series, do the following:

1) In the Template Editor, highlight the wells to be part of the series. The wells must be in the shape of a rectangle.

2) Click the Series button to open the Series dialog box.

3) Specify the name of the first sample in the series in the box (or accept the default provided by SoftMax Pro). Subsequent replicates use this name as a base and either increment the number within the name or append a number to it. In the example above, the sample name provided by SoftMax Pro describes the first sample (“01”) in a group named “Standard,” here shortened to “Sta.”
4) The information shown in the box labeled Sample Descriptor is derived from the information entered in the Group Settings dialog box. If the information for sample descriptor or units is not correct, you may change it here. If you did not already do so, specify the starting value for the first sample in the series. Values for subsequent samples are calculated from this starting value.

5) Choose the operator for the series (+, -, *, or /) from the Step by: dropdown list. Enter the starting value for the series in the Starting value: box. The increment is entered in the box to the right of the Step by: box and below the Starting value: box. Figure 5.28 shows a starting value of “.5” with the operator being division (“/”) and the increment being “2.” Thus the series will start with a value of “.5” and divide each subsequent sample by 2 to produce the following series values: .5, .25, .125, etc.

6) You must assign a fill direction (from the top, bottom, left, or right—to describe how the series will fill the wells) and a number of replicates. Various options are diagrammed in Figure 5.29 using a 4 x 4 block of wells (for more information about replicates, see “Replicate Samples and Samples in a Series” on page 5-27). The maximum number of replicates depends on the selection of wells: if you are filling down from the top, for example, and you have chosen a block of wells that is 4 wells wide by 8 wells high, the maximum number of replicates will be four; with the same block of wells selected, filling from the left would allow eight replicates. If the number of replicates you choose does not divide evenly into the number of rows or columns you select, depending on the filling direction, the remaining wells that cannot contain replicates will be labeled as additional individual wells in the series. For example, if you fill a block of 4 x 4 wells from the top, and choose three replicates, then the first three columns will contain the replicates and the last column will contain the additional wells in the series (see the last diagram in Figure 5.29). This replicate feature allows you to quickly define the number of replicates and, in cases where the series has more samples than a single row or column, to name them simultaneously. To create a series with all 96 samples, highlight all the wells in the plate, select the fill direction, and set the replicates to 1.
Chapter 5: Reading Using Fluorescence or Luminescence Instruments

5-30 SoftMax Pro User’s Manual

Figure 5.29: Fill Options and Replicate Settings

7) Click [OK] to save the series and close the dialog box. While still in the Template Editor, you can view the value assigned to any well by clicking that well. The value will be displayed at the top of the Template Editor. Holding down the Ctrl+Shift keys will display the values for all wells.

NOTE: Sometimes you may wish the names of a series of samples to increment but may not have a concentration or dilution factor that you wish to enter, or you want the concentration or dilution factor to remain constant. This can be done using the [Series] button, setting the starting value to 1 or another constant value, and either multiplying by 1 or dividing by 1. In this way, the names will increment but the value of concentration or dilution will not change. If you don’t have a concentration or dilution factor, simply deselect the sample descriptor checkbox if it is selected.

NOTE: If sample names are set to increment automatically using the Series function, be aware that SoftMax Pro will automatically truncate the sample name to three or four characters, including the incrementing number if the sample name starts with letters. If the sample name is entirely numeric, it will not be truncated. If sample names are very long, and they must be kept long for reference, you will have to set up your replicates manually and will not be able to use the series function.

Blanking

Two types of blanking are available in SoftMax Pro for fluorescence instruments. Understanding the differences between the types of blanking functions will enable you to choose the type of blanking that is appropriate for your assay. Note that blanks can be used in combination and have cumulative effects.

The types of blanking that are defined in SoftMax Pro are:
• Plate blank
• Group blank

Plate Blanks (Plate section only)

Wells can be assigned to a “Blank” group in the Template Editor. The average value of all the wells in a plate blank group is subtracted from all individual well values obtained during the reading of microplates. Plate Blank is applied to raw data. Plate Blank subtraction may be turned off in the Reduction dialog box so that the data may be seen with or without plate blank subtraction.

NOTE Plate blanks are only subtracted from wells on the same plate to which they are assigned. The checkbox for Plate Blank subtraction only appears in the Reduction dialog box after data has been collected.

For Kinetic and Spectrum data, the blank value is averaged and subtracted on a point-by-point basis. The example below shows a graphic representation of original and average plate blank data, followed by the resulting data with average subtracted.

Group-Associated Blanks

Blank wells can be assigned within any group (other than the “Blank” group) in the Template Editor. The average reduced value of the blank wells within that group will be subtracted from individual reduced values within that group only. This blanking function uses the reduced number (example: !Lm1-!Lm2, Vmax, etc.) only—it does not subtract on a point-by-point basis. When a group blank has been assigned, it is automatically subtracted. To see the reduced number without the group blank subtracted, mask the group blank wells.

Group blanks apply to all wells in a group and thus may be subtracted from wells in more than one Plate section.

Blanks in Combination

It is possible to use blanking functions in combination. You could assign a blank group in the template and also include blank wells within different groups. The effects of the different blanking functions are cumulative, so it is important to understand the function of each before using more than one type of blanking in a single assay. Plate blanking is applied to the raw data.
acquired from the instrument, whereas group blanks are applied to the reduced number. Group blank subtraction is only visible in the Plate section when the reduced number is displayed. Figure 5.31 shows the two types of blanks in the Template Editor.

![Figure 5.31: Template Editor Showing Plate Blank and Group-Associated Blank Wells](image)

In the figure above, note that the plate blank in the upper left appears as a separate group named “Blank” and individual samples within this group are named “BL.” The group-associated blank wells, shown in the upper right, are not a separate group—the samples, also named “BL,” are contained within the boundaries of the large group called “Unknowns” and are the same color as that group.

**NOTE:** In order to save changes you have made to the template in the Windows version of the Template Editor, be sure to click the [OK] button to close the window rather than clicking the Control Menu box. Clicking the Control Menu box (located in the upper left of the window) performs the same function as the [Cancel] button: the window will close but any changes you have made to the template will not be saved.
Copying and Pasting Templates

Copying Complete Template Information

Two template actions—Copy and Paste—can only be activated from the Plate menu (when a Plate section is active) rather than from the Template Editor. If you have created a template in one Plate section and wish to use it in another Plate section, you may copy that template and paste it into the new section. The results of copying and pasting a template depend upon whether the action is performed within the same experiment or between experiment sections.

Copying and Pasting within the Same Experiment Section

To copy a template, make the section containing that template active and choose Copy Template from the Plate menu (the menu name changes to reflect the type of active section). Then activate the destination Plate section and choose Paste Template from the Plate menu.

![Figure 5.32: Copy Template and Paste Template Commands in the Plate Menu](image)

The group names and sample names of the pasted template are identical to those of the source template. In effect, the destination template is considered an extension of the original template and all wells on the destination plate are considered replicates of the wells on the source plate (same group and sample names). Any changes made to the template on the destination plate will also be made on the source plate. Data from the two Plate sections will be analyzed together.

Copying and Pasting between Different Experiment Sections

To copy a template, make the section containing that template active and choose Copy Template from the Plate menu (the menu name changes to reflect the type of active section). Then activate the destination Plate section and choose Paste Template from the Plate menu.

The group names and sample names of the pasted template will be identical to those of the source template but, since they are in different experiments, the full name will be different (for example: group@experiment#2 instead of group@experiment#1). Any changes made to the template of the destination Plate section will not affect the source section. Data from the two Plate sections will not be analyzed together.
Copying and Pasting Template Regions

Contiguous regions of templates can be copied and pasted to other regions of templates (within the same or to a different experiment). All template settings are pasted into the new template except the group name: the new group is given the name “Group#X” where X is the next greater number than that used already for group names.

To copy a region of a template, highlight the region and then select **Copy** from the **Edit** menu or press **⌘C** (Macintosh) or **CTRL-C** (Windows). Only the highlighted wells will be copied.

To paste the region into another area of a template, highlight the region and select **Paste** from the **Edit** menu or press **⌘V** (Macintosh) or **CTRL-V** (Windows).

Only the highlighted wells will have template information pasted into them. Data is pasted using row priority: all wells in a row of highlighted wells have information pasted into them before proceeding to the next row, from left to right. If fewer wells are highlighted for pasting than were copied, the data will be pasted until all paste-highlighted wells are filled. If more wells are highlighted for pasting than were highlighted for copying, the extra wells are left empty.

If you try to paste template information between Plate sections having different plate format settings, an error will result. Plates must be of the same type to copy and paste template information.

Reading a Microplate

Fluorescence is defined as the measurement of light that is emitted after absorption or excitation from radiant activation of a compound.

Luminescence is the measurement of light given off by a chemical or biochemical reaction.

When reading a microplate, the SpectraMax Gemini fluorescence readers perform autocalibration (if enabled in the Instrument Settings) by reading from an internal reference chip in order to determine the appropriate scaling for RFU or RLU.

You can start a reading at any time after defining instrument settings. It is not necessary to define groups and assign wells within the Template Editor first. The values received from the instrument are raw fluorescence, luminescence, or time-resolved fluorescence readings and are not affected by settings in the Template Editor. Only instrument settings must be defined prior to reading a microplate.

To read a microplate, open the drawer of the instrument (click the drawer button in the status bar, or choose **Open Drawer** from the **Control** menu) and insert the prepared microplate. Then simply click the **Read** button in the status bar or choose **Read** from the **Command** menu.

If you have created more than one Plate section, and no Plate section is active, choosing the **Read** command will cause a dialog box to appear asking you to choose which section to read (see Figure 5.33). Select the correct section and
then click [OK] to close the dialog box. If a Plate section is active, choosing the Read command will read that plate.

![Select Section Dialog Box](image)

**Figure 5.33: Select Section Dialog Box.**

If you select a Plate section that already contains data and choose to Read again, an alert appears, asking you to confirm replacing data in the destination plate (see Figure 5.34). If you select [Replace], the reading will proceed and the previous data will be replaced with new data.

![Alert Regarding Replacing Data for Plate Section](image)

**Figure 5.34: Alert Regarding Replacing Data for Plate Section**

### General Information about a Reading

After beginning a reading, the status bar will show the actions that are occurring in the instrument, along with a box showing the elapsed time for each action in minutes and seconds. The [Read] button will change to [Stop], allowing you to terminate a reading, if necessary. An example of the appearance of the status bar at the start of a Kinetic reading of a microplate is shown below.

![Status Bar during a Kinetic Reading](image)

**Figure 5.35: Status Bar during a Kinetic Reading (SpectraMax)**

### Column vs. Wavelength Priority During a Reading

Depending upon the type of instrument connected to the computer or chosen in the Reader Preferences, a priority is given to reading by “column” or “wavelength.” It is most important to understand this priority with multi-wavelength readings.

In column priority, an instrument will read the entire microplate (or chosen number of strips) at the first wavelength, and will then go back and read the microplate at the second and subsequent wavelengths.

In wavelength priority, the instrument will read all wavelengths for the first column of wells in the microplate, and will then read all wavelengths for the second column, etc.
The table below shows the priority settings by instrument for the different read modes.

**Table 5.3: Column vs. Wavelength Priority**

<table>
<thead>
<tr>
<th></th>
<th>Endpoint</th>
<th>Kinetic</th>
<th>Spectrum</th>
</tr>
</thead>
<tbody>
<tr>
<td>SpectraMax Gemini Fluorescence Readers</td>
<td>Column</td>
<td>Wavelength</td>
<td>Column</td>
</tr>
</tbody>
</table>

**Data Display During a Reading**

The values read by the instrument will appear in the data display of the Plate section as they are received from the instrument (in real time). Depending upon the read mode (Endpoint, Kinetic, Spectrum, or Well Scan), the number of wavelengths, the plate type, and the display options selected, the data display will show one or more numbers or plots.

You can enlarge the display of one or more wells while the a Kinetic or Spectrum reading is in progress. Double-click a single well to enlarge its display to a Well Graph or hold the Shift key while selecting more than one well, and then choose Graph... from the Plate menu or click the graph button on the tool bar to display the data from multiple wells in one enlarged Well Graph. The data in the enlarged Well Graph will update to show new data points as they are received from the instrument.

Other choices and settings within SoftMax Pro affect the way in which data is displayed—the type of reduction, specific time settings, and so on. These settings are discussed in Chapter 8, “Displaying and Analyzing Data Using Fluorescence or Luminescence Instruments.”

**Reading Microplates Using the FlexStation Instrument in FLEX Mode**

Reading a microplate using SoftMax Pro using the FlexStation instrument in FLEX mode is a three-part process:

- Prepare SoftMax Pro to collect data;
- Prepare and load the microplate(s) to be read, along with any other solutions or pipette tips needed; and
- Read the microplate(s)

Before reading a microplate, you must create the Plate section(s) and define the instrument settings for the reading. **Instrument Settings must be defined prior to collecting data and may NOT be changed after data is collected.** In addition, it is recommended that you define a template and set the reduction and display parameters prior to reading the microplate, since these parameters determine how data is displayed and analyzed, but these last parameters may be set up and/or modified after data collection.
A typical process for preparing, collecting, and analyzing data is as follows:

1) Start SoftMax Pro.
2) Create Plate section(s) as needed.
3) Define instrument settings (use buttons in the Plate section tool bar or the Control menu).
4) Define the template, reduction parameters, and display parameters.
5) Prepare the microplate(s) to be read and place them in the instrument. Prepare any additional compounds to be used and load the required pipette tips.
6) Initiate the reading.
7) Save the data file.
8) Modify the template, reduction parameters, or display parameters as you wish (or, if you didn’t set them up in Step 4, do so now).
9) Save the data file.
10) Analyze the data using the Group section tables and Graph sections.
11) Save the data file when you are finished.
Instrument Settings

**NOTE:** Only the settings that pertain to the instrument that is connected to the computer or the one chosen in the Preferences will be shown in the Instrument Settings dialog box.

You must specify the instrument settings prior to actually reading a microplate. These settings include:

- The read mode—FLEX
- Timing
- PMT sensitivity and number of readings
- Read type: fluorescence and also bottom read
- Assay plate type: manufacturer and number of wells
- Automix
- Wells to read
- Compound source
- Compound transfer
- Triturate
- Pipette tips layout
- Compound and tips columns
- AutoRead

**NOTE:** No information is provided here regarding operation of the FlexStation instrument. If you need information about the function of the instrument itself and how to set it up for a reading, consult the manual that accompanied the instrument. Information here concerns only the SoftMax Pro interface and how to use the software to perform a reading.

Settings for the reading are made in the Instrument Settings dialog box, which can be accessed in three ways:

1) Choose **Instrument Setup...** from the **Control** menu;
2) Click the **Setup** button in the tool bar of the active, expanded Plate section; or
3) Double-click anywhere in the settings box (located to the right of the well grid) in the active, expanded Plate section.

**NOTE:** You may create more than one Plate section in a single experiment, and the instrument settings associated with each Plate section can be different. **Instrument Setup...** can only be chosen while a Plate section is active, and the settings you choose will affect only that section. A new Plate section that is created in an experiment that contains an active Plate section will contain the same instrument settings found in the previously active section. The settings for the new section can be modified as desired.

**NOTE:** Incubator control is an instrument setup parameter that is not found in the Instrument Settings dialog box.
Figure 5.36: Instrument Settings Dialog Boxes for FLEX Mode
Read Mode

To select FLEX read mode, click the appropriate button along the top of the Instrument Settings dialog box.

**FLEX**

This read mode provides access to all of the fluidic capabilities of the FlexStation instrument. When this read mode is chosen, several other choices are enabled in the Instrument Settings dialog box.

⚠️ **CAUTION:** Molecular Devices recommends that you follow the order of the settings choices from top to bottom when working in FLEX mode since some choices determine the settings that will be available in subsequent choices. Following the settings in order is also recommended to avoid problems that could potentially damage the instrument. Especially important are the settings for the Pipette Tips Layout and Compound & Tip Columns settings. If you change earlier settings after choosing the parameters for either of these, make sure to check the settings in these tabs to ensure that the changes are reflected there.

Choices available within FLEX mode are:

- Wavelengths
- Sensitivity
- Timing
- Automix
- AutoCalibrate
Chapter 5: Reading Using Fluorescence or Luminescence Instruments

Settings for FLEX Mode

It is essential that the settings for compound sources and dispensing are correct for the operation of the instrument. In particular, when a plate is selected for a compound source, the selected wells must cover an area that is appropriate for the dispensation. Also, selections for Assay Plate Types, Compound Source plates, and Pipette Tips Layout must correlate.

SoftMax Pro will crosscheck these settings when you click OK to close the Instrument Settings dialog box. If the settings do not correlate, a warning message will be shown and you must correct the settings before you will be allowed to proceed and close the Instrument Settings.

The FlexStation performs readings using fluorescence, the light emitted by certain substances resulting from the absorption of incident radiation. To measure fluorescence accurately, it is necessary to reduce light scatter. The governing equation for fluorescence is:

\[
\text{Fluorescence} = \text{extinction coefficient} \times \text{concentration} \times \text{quantum yield} \times \text{excitation intensity} \times \text{pathlength} \times \text{emission collection efficiency}
\]

Two types of scans are possible: you can select a fixed wavelength for excitation and scan emission or vice versa. More about this can be found in the following section, “Wavelengths.”

The FlexStation instrument automatically reads up through the bottom of clear-bottom microplates.

Wavelengths

Choose the number of different wavelengths to be read. At least one wavelength must always be specified. Selecting more than one wavelength will cause a corresponding number of wavelength setting boxes to appear (maximum four wavelengths).
Chapter 5: Reading Using Fluorescence or Luminescence Instruments

Figure 5.38: Wavelength Settings

The wavelengths specified previously (or the defaults) will be shown in the boxes. You can choose a wavelength from the choices in the pull-down menu or simply type any wavelength (within the available range of the scanning monochromator in the FlexStation instrument) over an existing setting. The pull-down menu will show common monochromator settings.

Sensitivity

Readings

This setting determines the number of readings that will be performed on each well of the microplate (readings are averaged and the average reading is displayed).

Figure 5.39: Readings Setting

The illustration on the left shows the default setting for fluorescence; the right shows changing this setting for more precision with a greater number of readings per well.

The default number of readings per well varies with the read type: for fluorescence, the default is 6; for luminescence, the default is 30; for time-resolved fluorescence, the default is 20. The number of readings is variable from 1 to 30.

NOTE: With the luminescence read mode, the integration time is directly proportional to the number of readings per well determined by this setting. Each reading per well is equal to 3.2 milliseconds of integration time.
PMT Sensitivity

The PMT (photomultiplier tube) is a vacuum tube that detects light, especially from dim sources, through the use of photoemission and successive instances of secondary emission to produce enough electrons to generate a useful current.

![Figure 5.40: PMT Sensitivity Setting](image)

Clicking in the box causes a menu of choices to appear. Settings are manual and limited to High, Medium, or Low.

The voltage of the photomultiplier tube may be set to low (for samples having a higher concentration), medium, or high (samples having lower concentration) in all read modes.

AutoCalibrate

This checkbox allows you to disable or enable automatic calibration. The default setting is checked (enabled). Turning Autocalibrate off allows the instrument to complete readings more quickly or to begin the first reading of a plate faster. However, you should allow the instrument to perform autocalibration of at least one plate prior to disabling this function: calibration settings for the last plate which included an autocalibration are maintained in the instrument memory (NVRAM) until another autocalibration is performed.

Wells to Read

You may choose to read only certain wells or groups of wells in the microplate or to read the entire plate. Partial-plate reading is available for all read modes. The time required for a number of different types of readings may be significantly reduced using this setting since the instrument does not have to read the entire plate.

To configure the settings for a partial-plate read, choose the Wells to Read setting.
Figure 5.41: Wells to Read Section of the Instrument Settings with Wells Selected

Highlight the wells to be read. Wells must be contiguous but do not need to start with strip “1” and do not need to be complete rows or columns (and a single well may be chosen, if desired). If you enable a partial-plate reading, only the wells to be read will be visible in the data display, indicating that no data will be collected for the other wells (all wells will be present in the Template Editor, however).

**Timing**

Enter the total run time and the time interval between readings. A default value will be shown for the run time; to change this value, click in the box and type a new value using the keyboard. Acceptable ranges are from 0.1 to 1000 seconds. The minimum interval for FLEX mode is dependent on the Compound Transfer settings and the number of wells to be read per column.

![Timing](image)

Figure 5.42: FLEX Timing Settings Box

When you have made the choices above, the total number of readings that will result is shown below the run time. If you set the interval time to be shorter than the instrument’s minimum read interval, a warning message will appear, requiring that you choose a different interval.

**Automix**

The Automix function is a patented feature that allows you to set automated shaking of the microplate. The options available for Automix depend on the read mode chosen and the type of instrument connected or chosen in the Preferences.
Chapter 5: Reading Using Fluorescence or Luminescence Instruments

Figure 5.43: Automix Settings Box

Before First Read
Click the checkbox next to “Before First Read” to shake the microplate before the first reading. Enabling Automix will shake the plate for the set amount of time before the first wavelength reading only. You can accept the value shown for the amount of time to shake the plate or enter a different value (from 1 to 999 seconds) in the box to the right.

Between Reads
To shake the microplate between readings, click the checkbox next to this setting. For readings at a single wavelength, “Between Reads” will shake the plate for the set amount of time prior to each reading at that wavelength. For readings at multiple wavelengths, enabling “Between Reads” will shake the plate for the set amount of time before each reading at the first wavelength only. You can accept the value shown for the amount of time to shake the plate or enter a different value (from 1 to 999 seconds) in the box to the right.

Compound Source
This allows you to select from various types of plates used to store fluid compounds that can be withdrawn and then injected into plate wells during the run. The type of plate that is chosen for this setting should match the actual plate used in the Compound Source drawer and the number of wells selected in the Assay Plate Type.

Figure 5.44: Compound Source Settings Box
**Compound Transfer**

![Figure 5.45: Compound Transfer Settings Box]

**Assay Plate Fluid**

The entry in this box should be equal to the largest initial volume for any well in the plate. SoftMax Pro assumes all wells hold the same initial volume. This setting is used to compute the total volume that will result in each well after all fluids have been dispensed. This calculation is made in order to warn you regarding potential overflow of fluid from the wells.

The initial volume entry has an integer range of 0 to 999 in microliters. You are not required to enter anything in this field. Any value entered is saved with the file but the value is not displayed anywhere except in the Compound Transfer Tab setting.

**Transfers**

You may enable up to three compound transfers during a reading (or choose none).

When transfers are enabled, color-coded transfer buttons appear on the Instrument Settings dialog box. Selecting one of these buttons allows you to set the parameters for that transfer. Settings for each transfer include:

- **Pipette Height**—from 1 to 999 µL
  
  This setting determines the amount of fluid (in microliters, measured from the bottom of the microplate well) above which the tip of the pipette will remain. This setting helps to ensure that the tip of the pipette does not engage the fluid in the well to avoid cross-contamination and to allow re-use of tips. Note that subsequent transfers will require that you calculate the amount of fluid added and set the pipette height accordingly higher to avoid touching the fluid in the well.

- **Rate**—from 1 to 8
  
  This setting determines the rate at which the fluid is pipetted into the well of the microplate. A setting of 1 is equal to 26 microliters/second and each subsequent number increases in increments of 26 microliters. Therefore, a setting of 2 is equal to 52 microliters, etc. A setting of 3 to 4 may help to minimize cell damage or splashing.
• **Volume**—from 1 to 200 µL
  This setting determines the volume of material that will be pipetted from
  the source to each individual well chosen to receive that transfer.

• **Time Point**—from 5 to 9999 seconds
  This setting determines the time after the start of the run when the fluid is
  scheduled to be dispensed.

• **Minimum time**—This information line lists the minimum time required
  before a pipetting event can occur. The “Time Point” setting above cannot
  be set to a number of seconds smaller than this value.
  This minimum time value is *cumulative (not an interval between pipetting
  events).* The value is the minimum number of seconds of elapsed time from
  the beginning of the read. It takes into account the mechanical speed of the
  pipetter head, the time needed to aspirate and dispense fluids, trituration,
  and Automixing.
  The minimum time for the second pipetting event depends on when the
  first pipetting event occurred. The calculation for the second event starts
  at the end of the first event and adds to that the total time that will be nec-
  essary to perform actions prior to aspirating new fluids from the com-
  pound plate and dispense them into the assay plate.

The Compound Transfer setting works in conjunction with the Compound &
Tip Columns setting described below. Until well assignments are made in the
Compound & Tip Columns setting, the Compound Transfer setting will show
“No targets assigned.”

**Triturate**

**NOTE:** The choices shown in this section are derived from the number
of compound transfers specified. If no transfers are enabled, no triturate
settings are possible.

This setting is used to enable a “mixing” of the contents of the wells in either
or both the compound source and assay plates. You can set the volume of
fluid to be withdrawn from the well and the number of times (cycles) it will
be pipetted back into that well. With the Assay Plate setting, you are also
asked to enter a value for the height at which the transfer occurs. The height
setting should take into account the amount of fluid currently in the well in
order for the pipette tip to either remain out of contact with the fluid in the
well (to avoid cross-contamination) or to engage the fluid.

![Figure 5.46: Triturate Settings Box](image-url)
**Pipette Tips Layout**

Molecular Devices recommends that you always use a full rack of tips (the default). If you use less than a full rack of tips, it is imperative that you change this setting to match the correct number and positions of the actual tips inserted in the tips drawer (see the Caution below).

![Figure 5.47: Pipette Tips Layout Settings Box](image)

If you change the Assay Plate Type setting from a 96-well plate type or vice versa after making selections in the Pipette Tips Layout tab, the selection of pipette tips will need to be redone as it will no longer match. The Assay Plate setting takes precedence over all other fluidics module settings.

⚠️ **CAUTION:** Molecular Devices recommends that you use a full rack of tips each time you perform a transfer of fluid in FLEX mode since this prevents potentially serious errors from occurring when partial tip racks are used. For example, if you should mistakenly enable a pipetting function from a tip that is not present, or if you enable more or fewer tips than are actually available, the instrument can malfunction, potentially causing serious damage. While it is possible to use a partial rack of tips and to choose which tips are available in the Pipette Tips Layout setting, do so with caution, ensuring that the layout described in the software matches the actual tips inserted in the tip drawer.

**Compound & Tip Columns**

The choices in this window depend upon the number of transfers chosen in the Compound Transfer tab. When one or more transfers are enabled, these settings allow you to choose the tips and compounds that will be used for transfers.
Figure 5.48: Compound & Tip Columns Settings Box

SoftMax Pro automatically enters information in the Compound and Tip Columns tab using a best-fit algorithm that uses the number of transfers, the Wells to Read section, and the Pipette Tips Layout selected area. The algorithm assumes fluid will be aspirated from the compound plate starting with the first available column indicated in the Pipette Tip Layout. That fluid will then be dispensed to the first available column indicated in the Wells to Read selection.

The algorithm assumes:

- All columns in the Wells to Read selection should receive fluid;
- The fluids are dispensed from left to right;
- The fluid transfer targets are cumulative from transfer to transfer (that is, the second transfer’s targets start with the next available clean tip and untargeted compound column rather than reusing tips and compound columns targeted by the preceding fluid transfer); and
- Each fluid transfer will use a new tip.

The algorithm assumes that all of the columns in the Wells to Read area will receive fluid during the initial transfer so the Tips target grid will be filled from left to right starting with the first available tip column and incrementing the Tip target by one until all columns in the Wells to Read selection have been filled.

In the illustration above, the Wells to Read selection includes columns 1 through 4 with an 8-column compound plate and a full rack of tips. From those settings, SoftMax Pro derives the first transfer’s Tips and Compound targets at 1-4. The second transfer targets the first unused Tips and Compound columns used during the first transfer, and the third transfer targets the first unused Tips and Compound columns used during the second transfer. So, in this example, the second transfer event’s targets for both Tips and Compound are 5-8, the third transfer’s events are 9-12.
When the number of columns in the Wells to Read area is the same or greater than the number of columns of both Tips and Columns, the algorithm fills the Tips and Columns targets as before (that is, each assay plate column is targeted with a new tip column and new compound column until all tips and columns have been targeted). SoftMax Pro does not fill beyond the limitations of the available Tips and Compound columns. Once all available tips and compound columns have been assigned, SoftMax Pro simply stops assigning targets.

This tab section will show one, two, or three transfers (with blue, pink, and green color-coded tips to match the setting made in the Compound Transfer tab) and two pop-up menus: Tips Column and Compound Column. The Tips Column menu will show a sequence of numbers that match the selected columns in the Pipette Tips tab. The Compound Column menu will show numbers from 1 through the number of columns of the compound plate or the number of troughs selected in the Compound Source tab.

A Tips or Compound row will have potentially 12 columns to represent the number of columns in a 96-well assay plate. The actual number of columns and their placement further depends on the number of columns and their locations as selected in the Wells to Read tab.

To assign a tip to an assay plate well, highlight one or more tip cells and select one of the items available in the Tips pop-up menu. The tip column selected in the pop-up menu will be shown as a number in the selected Tip row(s). Choosing the “Fill” option at the top of the menu will fill the selected cells with the tip numbers that correspond to the same column numbers (tip 3 with column 3, etc.). Note that “Fill” does not take into account the actual tips that are available if less than a full rack is used, whereas the choices in the menu beneath “Fill” represent the actual tip numbers that are listed as being available in the Pipette Tips Layout tab.

Similarly, to assign a compound, highlight one or more compound cells and select one of the items from the Compound pop-up menu.

The wells shown in this tab setting convey graphically the volumes of liquid in the assay plate for each pipetting event. Using the color associated with each event, the compound settings will display the dispensed compound volume as a percentage of the total assay well volume. If you entered an initial volume (on the Compound Transfer tab setting), that will be shown as a gray fill. As the liquids are cumulative, the first event’s volume is shown above the initial liquid volume (if any), the second event’s volume will be shown above the first, and the third event’s volume above the second.

To deselect a tip or compound assignment, first select the appropriate cell(s) and then press Backspace on the PC or Delete on the Macintosh. To change an assignment, select the well(s) and choose new values or type a value on the keyboard. Note that, if you have multiple wells selected and you type a value, that value will be shown in the first selected well and subsequent wells will increment to the next higher value. Again, this does NOT take into account the actual pipette tips shown to be available in the Pipette Tips Layout selection.
**AutoRead**

This feature enables the automatic reading of subsequent Plate sections in the order in which they appear within an experiment. You can set intervals (delay time) between the plate readings, if desired.

**Template Editor**

Use of the Template Editor with the FlexStation instrument is the same, regardless of read mode, and is described in the previous chapter on page 5-19 and following.

**Reading a Microplate**

The FlexStation instrument sends fluorescence data to SoftMax Pro. Fluorescence is defined as the measurement of light that is emitted after absorption or excitation from radiant activation of a compound.

You can start a reading at any time after defining instrument settings. It is not necessary to define groups and assign wells within the Template Editor first. The values received from the instrument are raw absorbance, fluorescence, luminescence, or time-resolved fluorescence readings and are not affected by settings in the Template Editor. Only instrument settings must be defined prior to reading a microplate.

To read a microplate, open the microplate drawer of the instrument (click the drawer button in the status bar, or choose **Open Drawer** from the **Control** menu) and insert the prepared microplate. Then simply click the **Read** button in the status bar or choose **Read** from the **Command** menu.

If you have created more than one Plate section, and no Plate section is active, choosing the **Read** command will cause a dialog box to appear asking you to choose which section to read (see Figure 5.49). Select the correct section and then click **[OK]** to close the dialog box. If a Plate section is active, choosing the **Read** command will read that plate.

![Select Section Dialog Box](image)

*Figure 5.49: Select Section Dialog Box.*

If you select a Plate section that already contains data and choose to **Read** again, an alert appears, asking you to confirm replacing data in the destination plate (see Figure 5.50). If you select **[Replace]**, the reading will proceed and the previous data will be replaced with new data.
General Information about a Reading

After beginning a reading, the status bar will show the actions that are occurring in the instrument, along with a box showing the elapsed time for each action in minutes and seconds. The [Read] button will change to [Stop], allowing you to terminate a reading, if necessary. An example of the appearance of the status bar during a FLEX reading is shown below.

Data Display During a Reading

The values read by the instrument will appear in the data display of the Plate section as they are received from the instrument (in real time). Depending upon the read mode, the number of wavelengths, the plate type, and the display options selected, the data display will show one or more numbers or plots.

You can enlarge the display of one or more wells while the a Kinetic or Spectrum reading is in progress. Double-click a single well to enlarge its display to a Well Graph or hold the Shift key while selecting more than one well, and then choose Graph... from the Plate menu or click the graph button on the tool bar to display the data from multiple wells in one enlarged Well Graph. The data in the enlarged Well Graph will update to show new data points as they are received from the instrument.

Other choices and settings within SoftMax Pro affect the way in which data is displayed—the type of reduction, specific time settings, and so on. These settings are discussed in Chapter 8, “Displaying and Analyzing Data Using Fluorescence or Luminescence Instruments.”
Chapter 6: SoftMax Pro Enterprise Edition and Enterprise Administrator

Enterprise ......................................................... 6-2
General Information ............................................. 6-2
Enterprise Administrator ....................................... 6-3
  Preinstallation Checklist ..................................... 6-3
  Pre-Installation Information ................................. 6-5
  General Information about Enterprise Administrator .... 6-6
How Enterprise Administrator and the Enterprise Edition of SoftMax Pro Work Together ................................................. 6-6
Installation ....................................................... 6-7
Administrator Login and Database .......................... 6-8
Users ............................................................. 6-14
Privileges ....................................................... 6-16
Remove a User .................................................. 6-18
Add Software .................................................... 6-19
Delete Software ............................................... 6-19
Change Password .............................................. 6-20
Users ............................................................. 6-21
Report ............................................................ 6-23
Audit Trail ....................................................... 6-25
License ........................................................... 6-26
Enterprise Edition of SoftMax Pro .......................... 6-28
Security Menu .................................................. 6-28
E-Statements .................................................... 6-29
Enterprise

General Information

The Enterprise Edition of SoftMax Pro contains features from both the Life Science and Drug Discovery editions. Unlike those editions, however, the Enterprise Edition links with a separate software package, Enterprise Administrator. This program allows an administrator to create a database in which users’ electronic signature and privilege information is stored. Once linked to SoftMax Pro Enterprise Edition by the administrator, the database in Enterprise Administrator is referenced to validate the user name entered in SoftMax Pro and password entered and to retrieve privilege information for that user.

The combined capability of these software programs provides a full audit trail that lists all user activities. User privileges set within Enterprise Administrator determine the extent of user activity (which menu choices are available, etc.) for that user within SoftMax Pro Enterprise Edition. A user who has not been added to the database may log in to the Enterprise Edition as a “guest.” Guests may open and view existing files but may not modify them.

Within the Enterprise Edition, a privileged user may add an Electronic Statements section to an experiment. Electronic statements provide a means of designating that an experiment has been approved, reviewed, or verified. Privileged users may also apply electronic signatures to these statements. Once a statement has been signed, the file may not be modified.

Electronic statements and signatures are saved with data files, but signatures are NOT saved with protocols. Only one Statement with signatures is allowed per file. The Statement section is always located as the first item of the Experiment (before any Notes section).

Files created in the Enterprise Edition of SoftMax Pro will show the filename extensions of “.epr” for protocol files or “.eda” for data files and can be opened only by the Enterprise Edition. Files saved from other editions of SoftMax Pro (.ppr and .pda files) can be opened by the Enterprise Edition but will not have an audit trail associated with them.

General Information about Enterprise Administrator

Enterprise Administrator software is designed to be used with various software packages from Molecular Devices that have electronic signature and audit trail functions. Enterprise Administrator software allows an administrator to create a database in which users’ electronic signature and privilege information can be stored. This database can then be used by other Molecular Devices software programs to validate the user’s name and to retrieve associated privilege information. This information determines the extent of the user’s activities within the Molecular Devices software.

⚠️ CAUTION: Molecular Devices has prepared some pre-installation information in this chapter and strongly suggests that you read it prior to using Enterprise Administrator software.

Enterprise Administrator has the following major functions:
• User Information – The administrator may add new users, modify a user's properties, and remove existing users. After a new user is added, that user can be allowed to use more than one Molecular Devices software program.

• Template – A set of privileges can be created to make assignment to users easier.

• Report – The administrator may export user information and privileges to a text file and view an audit trail of administrator activities.

• License – The administrator may add new licensing information to Enterprise Administrator. This information will be used by Enterprise Administrator to control the number of users registered to use Molecular Devices software programs.

The person chosen to administer this program may also set certain global options to make Molecular Devices software more secure (these options are described on page 6-14).

How Enterprise Administrator and the Enterprise Edition of SoftMax Pro Work Together

• The administrator installs Enterprise Administrator software (Windows only) on his/her PC. The administrator adds SoftMax Pro Enterprise Edition user names to Enterprise Administrator to create a user database. Each user is assigned permissions that determine the activities that will be available that user within SoftMax Pro.

• The administrator then installs SoftMax Pro Enterprise Edition (Mac or Windows) on individual PCs (belonging to users or set up with an instrument) and connects SoftMax Pro to the Enterprise Administrator database.

• A Guest (a user not in the database) can open and view files and can print those files. The Guest privilege facilitates FDA review of a file, if needed.

The following privileges set in Enterprise Administrator determine the options available to users of SoftMax Pro Enterprise Edition:

• Overwrite existing files
• Add E-signatures
• Add / modify E-statements
• Clear audit trail
• Change Autosave parameters
• Change Group table and template parameters
• Change reduction settings
• Mask/unmask wells
• Read once
• Delete data
• Remove E-signatures

More information about these options can be found on page 6-12.
NOTE: The administrator does not have access to user passwords. Passwords require a minimum of 6 characters and an alphabetic and numeric combination. The administrator may change a user’s password, however.
### SoftMax Pro Permission in Enterprise Administrator

<table>
<thead>
<tr>
<th>User Name</th>
<th>User ID</th>
<th>User Privileges (A-M)</th>
</tr>
</thead>
</table>

- **A** Save files and protocols
- **B** Sign e-statements
- **C** Create and modify e-statements
- **D** Clear Audit Trail
- **E** Change Auto-save parameters
- **F** Change Group Table and Template settings
- **G** Change Data Reduction Settings
- **H** Change Instrument Settings
- **I** Change Notes Text
- **J** Mask/UnMask Wells
- **K** Read Empty Plate and Cuvette Sections
- **L** Overwrite Plate and Cuvette Data
- **M** Remove signatures from e-statements
Enterprise Administrator

**NOTE:** Your MDC Representative will not be able to install SoftMax Pro Enterprise Edition or Enterprise Administrator software since this can be done only by the administrator.

**Pre-Installation Information**

Prior to installing Enterprise Administrator, your group or lab must designate an administrator who will install the software and manage the SoftMax Pro users. We recommend that this administrator be someone who understands SoftMax Pro well or who is willing to learn SoftMax Pro extensively, since the administrator will manage and activate/change permissions that control what all of the users can do in SoftMax Pro. The “administrator” can also be a team (for example, a member from your IT group working together with a person who understands SoftMax Pro). Your company may need to create an operating procedure allowing a backup person to act as administrator in case the administrator is unavailable for an extended period of time.

⚠️ **CAUTION:** If someone tries to log in 3 times using an incorrect User ID–Password combination, a security feature in SoftMax Pro will invalidate the file path linking SoftMax Pro and the Enterprise Administrator software. It will not be possible to work with SoftMax Pro or use it to operate a microplate reader until the administrator logs in correctly, physically locates the user’s PC, and resets the path. In order to reconnect, the administrator must enter the correct user ID and password.

The administrator has a high degree of responsibility. This person will manage the audit trail in case it is necessary to trace issues. The administrator manages all SoftMax Pro user permissions, including the permission granted to certain individuals to sign E-statements (which allow for electronic signing of documents to approve, verify, or authorize them). All E-signatures made in SoftMax Pro are legally binding provided the customer has the correct operating procedures in place.

Your lab/group must understand which permissions will be granted to which SoftMax Pro users. These permissions are set in the Enterprise Administrator software. The permissions that are set allow levels of functionality in SoftMax Pro.

The administrator performs these tasks:

- Installs the Enterprise Administrator software
- Assumes the role of administrator within the software and create a database
- Adds individual SoftMax Pro users to the database and grant them specific permissions
- Installs SoftMax Pro on individual users’ PCs and link the database file path location to their SoftMax Pro program
- Sets the Autosave file path in SoftMax Pro so that data files are saved automatically in a pre-determined location

**NOTE:** In Windows version 4.3 of SoftMax Pro Enterprise Edition, the software preferences are saved in the user’s folder of Windows under
that user name. In previous Windows versions, the preferences were saved in the Windows system directory.

**Preinstallation Checklist**

- Your company’s FDA 21 CFR Part 11 team must select a person (or team of people) to act as the SoftMax Pro Administrator.
- It will be necessary to know the following information:
  - How many Molecular Devices microplate readers will be connected to computers using SoftMax Pro Enterprise Edition?
  - How many users will analyze data on computers not connected to a Molecular Devices microplate reader?
  - How many users will need to review, authorize, and approve data files?
  - Does your site license(s) cover the number of computers (you will need this many SoftMax Pro Enterprise licenses) and people (your Enterprise Administrator license must allow for this many users) who will be using SoftMax Pro Enterprise Edition?
- Create a list of user names and determine the permissions you will assign to each of them using the sheet provided below. This completed sheet may be used as a guide when creating the Enterprise Administrator database and adding users.
- You may wish to add users after setting up *templates* (sets of permissions) for groups of users. When the same set of permissions will be assigned to multiple users, it saves time to create the template of permissions first and then assign a single template of permissions to users. Examples of groups of users who might benefit from having templates of permissions defined are:
  - Lab Assistant user group with permission to change instrument settings and read plate only;
  - Method Creator user group with required permissions to create protocols;
  - Data Analysis user group with permissions to change reduction settings;
  - Approval user group with permission to sign e-statements.
- After determining the assignment of permissions, you will be ready to add users to the Enterprise Administrator database.

You may find it useful to make copies of the following sheet to record permissions for the users in your group(s).

**Installation**

*NOTE:* Enterprise Administrator is available only for Windows-based computers.

*NOTE:* If you are not the administrator, no installation of Enterprise Administrator is necessary.

Follow these instructions to install Enterprise Administrator:

1) Insert the Enterprise Administrator CD into the CD-ROM drive.
2) Open “My Computer” and then double-click the CD-ROM drive icon to display its contents.

3) Double-click the Setup icon and follow the screen prompts.

4) The “Welcome” screen suggests that you close all other programs before beginning installation of Enterprise Administrator software. It is also recommended that you disable any virus protection software you may have running before installing Enterprise Administrator. Click [Cancel] to exit the installer and close any programs and/or disable virus protection and then start the installer again from step 3 above. To continue with installation, click [Next].

5) The screen named “Choose Destination Location” asks you to select the drive where the software will be installed. A default location will be shown on the screen. If you have more than one hard drive in your computer, you may change the destination to the disk drive where you wish Enterprise Administrator to reside or accept the default location.

Once the software has been installed, the administrator must create a database and add user information.

The Database Name text box displays the name of the database to which the administrator last logged on successfully. If the database has been moved to another location, click the [...] button to browse for it. After entering the Admin User ID and Admin Password, click the [OK] button to log in.

The Administrator’s dialog box will open, providing the options to make all additions or changes to the database.
Figure 6.1: Administrator’s Dialog Box -- Users Tab shown

Options available from this dialog box are described below.

Users Page

Password Aging – The administrator may enable Password Aging by specifying the duration of the password expiration period (months). Once enabled, each user’s password will expire after the specified duration. Each user will be warned of the expiration 15 days prior to the actual expiration date.

Idle Time-out – The administrator may enable the Idle Timeout by specifying a time in minutes. When enabled, the software program will lock itself after the specified period of inactivity and the user will have to log in again in order to use the software.

Lock software after three logon attempts – When this option is enabled, if a user enters the wrong password three times in succession, the software will lock. A message will appear explaining that the program is locked and that the administrator must enable the path to the database again.

Template Page

Figure 6.2: Template Page
Defining templates can save time when assigning privileges, especially when the number of users is large. Templates are sets of privileges that can be assigned quickly.

**Add New Template** – Clicking this button opens a dialog box asking that you name the template, provide a description of it, if desired, and then choose the privileges that will be associated with that template.

**Delete Template** – After selecting a Template from the list, clicking this button asks you to confirm that you wish to delete the template. Choosing [OK] will remove the template from the database.

**Edit Template** – Clicking this button allows you to make changes to the privileges associated with the selected template.

![Figure 6.3: User Privileges Page in Add New User Wizard](image)

The **Registered software** drop-down box shows available software programs from Molecular Devices. The list box displays user privileges that are available with the selected software. This list refreshes each time the software program selection is changed.

Checking the checkboxes before items in the list box allows the administrator to assign specific privileges to the new user. The privileges can be changed later from the Modify User dialog box.
After assigning user privileges, click the [Finish] button. The new user will be displayed immediately in the registered user list box on the Users property page.

Note that the [Modify User] and [Remove User] buttons are both disabled. These buttons are enabled only if a user is selected (highlighted) in the Users list box on the Users property page.
Privileges

When adding a new user to an Enterprise Administrator database, after defining a user name and password, the administrator will be prompted to define privileges for each user.

![User Privileges Dialog Box](image)

*Figure 6.4: User Privileges Dialog Box*

**Choose Group**

Using groups, pre-defined settings can be applied quickly and easily to a new user. Defining a group is not required -- privileges may be set individually.

**Save files and protocols**

Allows a user to save SoftMax Pro EE files to disk.

**Sign e-statements**

A user can e-sign statements within SoftMax Pro EE.

**Create and modify e-statements**

Allows a user to create and modify statements in an experiment.
Clear Audit Trail
Allows a user to erase the Audit Trail window that displays all activity within the SoftMax Pro EE program since the program started.

Change Autosave parameters
Allows a user to modify the Autosave features of SoftMax Pro EE.

Change Group Table and Template settings
Gives a user the ability to access and edit the features of the Template... option of the Plate menu.

Change Data Reduction Settings
Gives a user the ability to access and edit the features of the Reduction... option of the Plate menu.

Change Instrument Settings
Allows the user to edit the settings for the instrument through Instrument Setup... in the Control menu or by clicking the Setup button on the plate section.

Change Notes Text
Allows the user to modify or add to the text contained in the Notes section of an experiment.

Mask/UnMask Wells
In the template editor, a user can select which wells will be excluded from analysis.

Read Empty Plate and Cuvette Sections
Allows a user to perform a reading if a plate does not contain data.

Overwrite Plate and Cuvette Data
Allows a user to perform a read that replaces data that is already present in a plate section.

Remove signatures from e-statements
Allows a user to remove the signatures from a statement, making that experiment editable again.

Modify User
To modify a user, select that user from the Users list box on the Users property page and then click the Modify User button. The Modify User dialog box will open.

Remove a User
To remove a user, select that user from the Users list box in the Users property page and then click the Remove User button. The following warning message will appear, asking for confirmation from the administrator to prevent accidental removal of a user.
Chapter 6: SoftMax Pro Enterprise Edition and Enterprise Administrator

Figure 6.5: Remove User Warning Message

If the user really should be removed, click the [OK] button. The removal of a user is immediate and that user will disappear from the Users list box in the Users property page.

Change Password

The administrator may change the user’s password. This step doesn’t require entering the old password. The administrator may simply assign a new password as shown below.

Figure 6.6: New Password Dialog Box

The new password must be at least six characters long and must contain at least one numeric and one alphabetic character.

Global options appear in the lower left corner of the Users property page: Password Aging and Idle Time-out. These options are disabled if their checkboxes are empty. If checked, the administrator must enter either the duration of password aging or the desired idle time-out period.

Global Options Pane

Figure 6.7: Global Options Pane
Password Aging indicates the period of time (in months) after which users must change their passwords. When a user logs on within 15 days of password expiration, notification of the need to change the password will appear. If the password is not changed before the expiration date, it will expire and the user will be unable to log on. The administrator must then reset the password.

Idle Time-out indicates the duration of inactive time (in minutes) after which the software application, such as SoftMax Pro, will automatically log out.

Lock software after three logon attempts – When this option is enabled, if a user enters the wrong password three times in succession, the software will lock. A message will appear explaining that the program is locked and that the administrator must enable the path to the database again.
Enterprise Edition of SoftMax Pro

Security Menu

The Security menu provides the initial connection from SoftMax Pro Enterprise Edition to the Enterprise Administrator database.

<table>
<thead>
<tr>
<th>Security</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Set Administrative Group…</td>
<td></td>
</tr>
<tr>
<td>Log On…</td>
<td>Ctrl+L</td>
</tr>
<tr>
<td>Log Out…</td>
<td></td>
</tr>
<tr>
<td>Change Password…</td>
<td></td>
</tr>
<tr>
<td>Show Audit Trail</td>
<td></td>
</tr>
<tr>
<td>Clear Audit Trail</td>
<td></td>
</tr>
<tr>
<td>Show Admin Info…</td>
<td></td>
</tr>
</tbody>
</table>

*Figure 6.8: Security Menu in SoftMax Pro Enterprise Edition*

**Set Administrative Group…**
Displays the Open dialog box used to select the Enterprise Administrator database file that contains the user and password information for SoftMax Pro Enterprise Edition.

**Log On…**
Prompts a user to enter his/her assigned user name and chosen password.

**Log Out…**
Terminates the user’s connection to the SoftMax Pro Enterprise Edition program.

**Change Password…**
Opens a dialog box allowing the current user to change his/her password.

**Show Audit Trail**
Displays a list of all user activities performed on the current file.

**Clear Audit Trail**
Erases all information shown within the Audit Trail window.

**Show Admin Info…**
Displays the privileges set for the current user.
Chapter 6: SoftMax Pro Enterprise Edition and Enterprise Administrator

Figure 6.9: User Information Dialog Box

E-Statements

Add Statements

A Statement is a section within SoftMax Pro (Enterprise Edition only) that provides a location for statements regarding authorization, review, and validation of data files. After a statement is created, it can be “signed”—a process that locks the file, preventing further changes.

Add Statements is located under the Experiment menu.

Selecting Add Statements will open the “Electronic Statement Setup” dialog box. This dialog box allows a user to enter a title for the Statement and to enter text describing its purpose. The Statements section is the first section a Document—it will appear as the first section in the first experiment.

NOTE: The user must have permission to create/modify electronic statements to add a statement.
Figure 6.10: Electronic Statement Setup Dialog Box

This dialog box allows a user to enter a title for the Statement and to enter text describing its purpose.

After a Statement has been created, new statements may be added using the Add Statement button on the Statements section title bar or by selecting “Add Statement...” in the Statements Menu.

Figure 6.11: Statement Section in SoftMax Pro Enterprise Edition
Chapter 6: SoftMax Pro Enterprise Edition and Enterprise Administrator

Statements Menu

![Statements Menu](image)

**Figure 6.12: Statements Menu in SoftMax Pro Enterprise Edition**

Once a Statement section has been added to the document in the Experiment menu, the Statements menu appears (it replaces the other “section” menus such as “Plate,” “Notes,” etc.). The Statements menu allows the active user to create or modify statements in the current experiment.

**Add Statement...** (Button equivalent: ![Add Statement](image))

Allows the current user to create a new statement (if that privilege is available to the current user).

Available only to users with permission to create/modify e-statements. Can only be performed on unsigned Statements.

**Modify Statement...** (Button equivalent: double-click the statement)

Opens the Electronic Statement Setup dialog box, allowing the current user to change the title and text of the active statement.

Available only to users with permission to create/modify e-statements. Can only be performed on unsigned Statements.

**Remove All Signatures...**

If a statement has been signed, a user with this privilege can remove all signatures from the active statement. When all signatures have been removed, the file becomes editable once more.

**Copy Statement**

Copies the title and body of the statement onto the clipboard. Does not copy information added to a signed statement.

**Paste Statement**

Inserts the clipboard contents into a Statement section of the current experiment.

Available only to users with permission to create/modify e-statements. Can only be performed on unsigned Statements.

**Sign Statement...** (Button equivalent: ![Sign Statement](image))

Displays the Sign Statement dialog box.
Figure 6.13: Sign Statement Dialog Box

_Disagree_  
Cancels the signature process and closes the dialog box.

_Add A Note_  
Allows the user to add a note to the statement prior to signing it.

_Agree_  
Prompts the user for a his/her password and then, upon proper entry, signs the document with the user name, date, and time.

**NOTE:** Once a statement is signed, the Experiment will be locked and cannot be edited unless signatures are removed. Unsigned statements may be signed, but no further changes can be made. Multiple signatures may appear on one statement. Signatures are saved with data files but are not saved with protocols.

Figure 6.14: Signed Statement Section
Chapter 7: Displaying and Analyzing Data Using Absorbance Instruments

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Introduction</td>
<td>7-3</td>
</tr>
<tr>
<td>Initial Data Display and Reduction: Plate/CuvetteSet Section</td>
<td>7-4</td>
</tr>
<tr>
<td>The Data Display</td>
<td>7-5</td>
</tr>
<tr>
<td>The Display Dialog Box</td>
<td>7-6</td>
</tr>
<tr>
<td>Graphing Wells</td>
<td>7-18</td>
</tr>
<tr>
<td>Masking Wells or Cuvettes</td>
<td>7-22</td>
</tr>
<tr>
<td>Data Reduction</td>
<td>7-23</td>
</tr>
<tr>
<td>Plate Section</td>
<td>7-23</td>
</tr>
<tr>
<td>CuvetteSet Section</td>
<td>7-23</td>
</tr>
<tr>
<td>Endpoint</td>
<td>7-27</td>
</tr>
<tr>
<td>Kinetic</td>
<td>7-28</td>
</tr>
<tr>
<td>Spectrum (SpectraMax Instruments Only)</td>
<td>7-36</td>
</tr>
<tr>
<td>Data Mode (%Transmittance/Absorbance)</td>
<td>7-37</td>
</tr>
<tr>
<td>Custom Reduction Formulas</td>
<td>7-38</td>
</tr>
<tr>
<td>Recalculation Options</td>
<td>7-40</td>
</tr>
<tr>
<td>Displaying Data in Group, Graph, and Notes Sections</td>
<td>7-41</td>
</tr>
<tr>
<td>Group Sections</td>
<td>7-41</td>
</tr>
<tr>
<td>Notes Sections</td>
<td>7-47</td>
</tr>
<tr>
<td>Graph Section</td>
<td>7-47</td>
</tr>
<tr>
<td>Formulas in SoftMax Pro</td>
<td>7-67</td>
</tr>
</tbody>
</table>
Introduction

Initial display and reduction of the data received from the MDC Microplate System instrument is performed in the Plate section or CuvetteSet section in which the data has been collected. Display and reduction parameters can be set up either prior to or after collecting data. The display and reduction parameters may be modified at any time.

Data analysis and the display of analyzed data is also performed in the Group sections (created when wells/cuvettes are assigned to groups in the Template Editor) and the Graph section(s).

Notes sections may be used in conjunction with any other section to provide text commentary and/or a display of data through the use of summaries. Notes sections are used most commonly to provide an introduction to or summary of results for a data file.

All data files have a minimum of one Plate section or one CuvetteSet section with data in it. Multiple Plate sections and/or CuvetteSet sections may be present. Most files will have a template and Group, Graph, and Notes sections. However, depending upon the assay and how you wish to report the data, only some of these sections may be (or need to be) present in every file. Some simple assays, such as reading the absorbance of proteins at 280 nm in a cuvette (or in a microplate with PathCheck), allow you to calculate concentration in the Plate or CuvetteSet sections. In such an example, Group and Graph sections are necessary only if you wish to display the data graphically.

Many common assays consist of data acquired in a Plate section or CuvetteSet section. Standards and unknowns are defined in a template. Unknowns are then interpolated from a standard curve. The following diagram shows the relationship between the different sections in SoftMax Pro:

![Relationship of Sections](image)

**Figure 7.1: Relationship of Sections**

This chapter discusses the initial display and reduction of data in the Plate section first, followed by display and data analysis in the Group, Graph, and Notes sections.
Initial Data Display and Reduction: Plate/CuvetteSet Section

The manner in which data is displayed in a Plate section or CuvetteSet section depends on the type of reading that was performed (Endpoint, Kinetic, or Spectrum), but can be customized by choices made in the data display and reduction settings. Depending on the type of reading performed, display options include:

• Number or plot displays for raw OD or %T (with or without reduced number).

  **NOTE**: The number format (use of commas or periods in numeric notation) chosen for the computer operating system in general is reflected in the way that SoftMax Pro displays data.

• Number, Plot, Threshold, Ranged, or Grayscale (with or without reduced number)

• Display as one or three samples per row or display as microplate layout (CuvetteSet section only)

• (SpectraMax Plus 384 or 340PC 384 only): If you have chosen 384-well plates from the Instrument Settings, you can display the wells in different ways: Normal, Vertical, Rotated, Large, or Interleaved.

Default displays are shown automatically unless you choose a different display option.

Reduction options allow you to display the raw data received from the MDC Microplate System instrument in a reduced (analyzed) form. Which reduction options are available depend on the read mode, instrument, and read type used; custom settings, using formulas you create, are available for all read modes, instruments, and read types.

Reduction settings do not affect the raw data but simply cause it to be displayed differently, allowing you to change reduction settings without affecting the raw data from the plate or cuvette reading in any way.

Custom reduction formulas require the use of accessors and operators that are understood by SoftMax Pro. A list of such accessors and operators can be found in *The Formula Reference Guide*. 
The Data Display

After a plate or cuvette has been read, the information sent from the MDC Microplate System instrument is shown in the data display in the active Plate or CuvetteSet section. The default display for data from Endpoint readings is raw OD numeric values. Data from Kinetic or Spectrum readings is displayed in plots format (raw OD values with respect to time or wavelength). While a Kinetic or Spectrum reading is in progress, the display updates dynamically to show the data collected so far. If the instrument is reading more than one wavelength in Kinetic mode, plots for the different wavelengths are overlaid in each well.

All choices except those defined in the Instrument Settings affect only the manner in which the data is displayed—the raw data is not changed—permitting you to optimize the display after data is collected.

**NOTE:** Data reduction changes the way in which data is displayed and also affects the values used in calculations within SoftMax Pro. While the raw values remain unchanged, calculations will use reduced values, if any, and are, therefore, affected by settings chosen in the Reduction dialog box. For more information, see “Data Reduction” on page 7-23.

**NOTE:** With the SpectraMax Plus, Plus³⁸⁴, 190, 340PC, and the VersaMax, data comes from the instrument to SoftMax Pro with four digits to the right of the decimal point (instead of three digits for all other instruments). Only three of the four digits are displayed in the Plate section or CuvetteSet section for Endpoint data, however: the fourth digit is rounded up or down (0.0045 rounds up to 0.005; 0.0044 rounds down to 0.004, for example). You can view all four digits of data, if desired, by displaying the raw OD in a Group section table and increasing the number of decimal places showing.
The Display Dialog Box

Before or after a plate or cuvette has been read, you can click the Display button to open the Display dialog box which allows you to change the way the data is presented. Choices available in this dialog box depend on whether a Plate section or CuvetteSet section is currently active, which instrument is chosen in the Preferences or is connected to the computer, and which read mode you have chosen (for example, the choice for “Plots” is not shown if Endpoint mode is selected). Figure 7.2 shows the default Display dialog boxes for the different read modes for Plate sections; Figure 7.3 shows the default Display dialog boxes for the three possible read modes for CuvetteSet sections.

The Display dialog box is divided into two parts (left and right): the default display, “Raw OD” is shown to the left of a dividing line; the choices for reduced data displays are shown to the right of the dividing line. Note: data reduction itself is performed separately; settings here simply determine how the reduced data will be displayed in the Plate or CuvetteSet section.

An additional set of choices in the CuvetteSet section Display dialog box determines how an array of cuvettes will be displayed in the CuvetteSet section: one cuvette per row, three cuvettes per row, or in a microplate layout.

The dialog boxes below show the default display choices for the three modes:

- raw optical density values (numbers) for Endpoint;
- the change in raw OD values over time for Kinetic; and
- raw OD values for the range of wavelengths, displayed as a plot, for Spectrum.

Other choices available in this dialog box include displaying the data as a single reduced value (number), in threshold, ranged, or gray scale formats, or any combination of display choices with the reduced number (the reduced number display choice cannot be used with the reduced number checkbox).
Chapter 7: Displaying and Analyzing Data Using Absorbance Instruments

Endpoint

![Endpoint Display Dialog Box]

Kinetic

![Kinetic Display Dialog Box]

Spectrum

![Spectrum Display Dialog Box]

Figure 7.2: Plate Section: Endpoint, Kinetic, and Spectrum Display Dialog Boxes
Chapter 7: Displaying and Analyzing Data Using Absorbance Instruments

Figure 7.3: CuvetteSet Section: Endpoint, Kinetic, and Spectrum Display Dialog Boxes

- **Endpoint**
  - Raw OD (default)
  - Reduced Display Choices
  - Choices for Cuvette Layout (CuvetteSet Section)

- **Kinetic**
  - Raw Data Plot
  - OD vs. Time (default)

- **Spectrum**
  - Raw Data Plot
  - OD vs. Wavelength (default)
Data in the Plate section is displayed in a grid array (microplate format). With all plates other than 384-well plates, the display is always shown as a standard microplate, with well A1 in the top left corner. If you are reading 384-well plates using the SpectraMax 340PC\textsuperscript{384} or Plus\textsuperscript{384}, additional display options can be chosen (see Figure 7.4) to make the display of data more clear:

- **Normal**: shows the data in standard left-to-right format, with well A1 in the upper left corner. Columns 1 through 24 are along the top and rows A through P are shown from top to bottom. The wells are smaller and data is shown with fewer digits (less precision).

- **Vertical**: the plate is shown in the same orientation as Normal except that columns 1 through 12 (all rows) are shown above columns 13 through 24 (all rows).

- **Rotated**: Same as the Normal view except that it is rotated 90 degrees clockwise (well A1 is in the upper right corner).

- **Large**: Same as the Normal view except larger. This display can be seen in its entirety only if you have the page size set for legal paper (8.5 x 14 inches) in landscape orientation (set this in Page Setup or Preferences under the File menu). In the example in Figure 7.4, the display is shown as it appears if you do not change the page size from letter-size to legal.

- **Interleaved**: In this display, the wells are shown in a format that “skips” every other well as follows: all odd columns and rows begin in the upper left corner of the plate display and are followed by all even columns and rows. So well A1 is still in the upper left corner, but it is followed horizontally by well A3, A5, ... A23, A2, A4, etc., and vertically by well C1, E1, ... O1, B1, D1, etc. This display is most useful when the 384-well plate is composed of 4 daughter plates of 96 wells each.
Figure 7.4: Plate Section for the SpectraMax Gemini or Gemini XS
Choices for a 384-well plate display are shown: Normal, Vertical, Rotated, Large, and Interleaved.
The CuvetteSet section offers three display choices:

- 1 cuvette per row
- 3 cuvettes per row (default)
- Microplate format (8 × 12 array)

Figure 7.5: CuvetteSet Display Options
From top to bottom: one cuvette per row, three cuvettes per row, and microplate format.

The height of the cuvettes in the 1- and 3-cuvette per row displays may be changed by highlighting any cuvette in the CuvetteSet section, placing the mouse on the bottom of the cuvette (the pointer will turn into a cross-hair cursor with vertical arrows), and dragging down.

**NOTE:** Resizing in this way will affect the display of all cuvettes in the CuvetteSet section.
Figure 7.6: Resizing Cuvettes in the CuvetteSet Section
A: Cuvette at original size. B: When the mouse pointer is positioned over bottom line of cuvette display, it changes to show a crosshair cursor with vertical arrows.
C: Dragging the cursor down shows the bounding box, displaying where the boundary for the cuvette will be when the mouse is released (D).

Resizing a cuvette display is different from enlarging the cuvette to a graph (by double-clicking the cuvette or clicking the Graph button or choosing Graph... from the CuvetteSet menu), which shows an enlarged display of either Kinetic or Spectrum data in a separate window. Resizing the cuvette in the CuvetteSet section provides an enlarged view of the data in the same window (note also that the resizing is saved with the file so the modification to the size will be retained when you reopen the file at a later time).

Figures 7.7 (Plate section) and 7.8 (CuvetteSet section) show the default displays for Endpoint, Kinetic, and Spectrum modes. The default display for Endpoint mode is raw optical density collected from the microplate reader. For Kinetic and Spectrum modes, the default display is raw OD shown in plot format: OD vs. time for Kinetics and OD vs. wavelength for Spectrum scans. Data for most instruments may also be viewed as %T (%Transmittance) instead of OD (optical density) by choosing %T in the Reduction dialog box.
Figure 7.7: Default Displays for a Plate Section
Chapter 7: Displaying and Analyzing Data Using Absorbance Instruments

Figure 7.8: Default Displays for a CuvetteSet Section (Endpoint, Kinetic, and Spectrum Modes)

Reduced Number

The reduced number is based on the settings defined in the Reduction dialog box. It is a combination of blank subtraction (pre-read and/or plate blank in the Plate section and ref and/or template blank in the CuvetteSet section), wavelength reduction, and Spectrum scan or Kinetic reduction. The information acquired from the microplate reader is reduced to a single number or value. The reduced number will be reported in the Group section when a template has been defined.

To view by reduced number alone, select the Number option (the first choice to the right of the default, just after the dividing line); to see a reduced number as well as another type of display, click the box next to the option that says “With reduced number” in the lower left of the dialog box to enable it. Changing the reduction parameters after choosing a reduced data display mode will cause the display to update accordingly. More information about reduction formulas and how to customize them follows later in this chapter.
Threshold, Ranged, and Gray Scale

To display Threshold, Ranged, or Gray Scale data, high and low values must be entered. When you choose one of these display options, SoftMax Pro provides default values for the high and low limits by means of an autoranging function (encompassing all the data from lowest to highest value). You can change the high and low limits by highlighting the existing value and entering a new value. An example of the Display dialog box for a Kinetic reading (Plate section) with the Threshold display option chosen is shown in Figure 7.9.

![Display Dialog Box for Kinetic Threshold Display](image)

**Figure 7.9: Display Dialog Box for Kinetic Threshold Display**

**Threshold**

The Threshold display shows the raw data as a plus (+) for values above the high limit, an asterisk (*) for values within the limits, and a minus (-) for values below the low limit. Figure 7.10 shows an Endpoint reading displayed using the Threshold option along with the reduced number.
When the Ranged display is chosen, raw data that falls between the high and low limits is assigned proportionally to integer values from 0 through 9. Values above the high limit are displayed as a plus (+) and values below the low limit are displayed as a minus (-). Figure 7.11 shows reduced Kinetic data displayed in Ranged format.

Figure 7.11: Kinetic Data (Reduced) Displayed as Ranged
Gray Scale

The Gray Scale option presents the raw data in eight shades of gray, changing from light (for values less than or equal to the low limit) to dark (for values greater than or equal to the high limit). Figure 7.12 shows reduced Endpoint data displayed as Gray Scale.

![Gray Scale Diagram]

*Figure 7.12: Endpoint Data (Reduced) Displayed as Gray Scale*
Graphing Wells

You can enlarge the display of the wells shown with Kinetic, Spectrum, or well scan modes to get a close-up view of the data. This is done by either double-clicking the particular well or cuvette in the data display or by selecting the well or cuvette and then clicking the Well Graph button in the Plate section or CuvetteSet section tool bar.

Kinetic and Spectrum Well Graphs

Well Graphs plot the data for the individual wells in a microplate or for individual cuvettes and show the well ID and reduction information, including the goodness of fit (R^2 value), if appropriate. The default display for the X-axis shows time for Kinetic plots and wavelength for Spectrum plots; OD or %T is displayed on the Y-axis for both plots.

Positioning the cursor within a Well Graph shows X and Y values for the cursor location, allowing you to determine more precisely the location of data points.

Well Graph Options

Along the bottom of each Well Graph dialog box are eight buttons (five when using well scan mode) that perform the following functions:

- **[Print]**
  Opens the Print dialog box.

- **[Reduction]**
  Opens the Reduction dialog box.

  By default, the ranges on the enlarged plot are set to the limits defined in the Reduction dialog box, and the information included near the bottom of the window is based on the reduction settings currently in use. You may change these settings (wavelength combination and type of reduction used, minimum and maximum OD limits, lag time and end time, and number of Vmax Points; for a cuvette, whether or not to use a template blank, absolute values, or to show the data as absorbance or percent transmittance). More information about the reduction options can be found later in this chapter.

  **NOTE:** Changes to the reduction settings made within well graphs will be applied to all wells or cuvettes in the Plate or CuvetteSet section.

  When viewing Raw data, you can scale the graph to see data outside the reduction limits [line(s) are included on the graph indicating the limits and the area outside of them will be shaded slightly]. This view should assist you in determining the best limits for the reduced data.

- **Show Raw/Show Reduced**
  This button toggles the Well Graph between views of raw and reduced data. When the Well Graph is opened, the initial view depends on the Display settings for the Plate section. If raw data is being displayed in the Plate, the initial view in the Well Graph will be raw data and the button will be set to “Show Reduced.” If reduced data is being displayed in the Plate section, the initial view in the Well Graph will be reduced data and the button will be set to “Show Raw.”
• **Scale to Data/Scale to Limits button**

This button toggles between a view of the data within the reduction limits and a view of the entire data set. Switching between these views helps to visualize how the limit settings affect data reduction. If raw data is being viewed in the Plate section, the display in the Well Graph is set initially to show the plot scaled to the reduction limits. If reduced data is being viewed in the Plate section, the Well Graph display is set initially to show the plot scaled to the data.

**NOTE:** If you are viewing raw data and click the **Scale to Limits** or **Scale to Data** button, only the display of raw data in the Well Graph will be affected (the button will not affect the view of reduced data). The same is true if you click this button while viewing reduced data. To produce comparable scaling of both raw and reduced displays, this button must be set to either Scale to Limits or Scale to Data for both raw and reduced views of the Well Graph.

• **Graph Options button**

Opens the Well Graph Options dialog box which allows you to enable or disable connected points or plotted symbols the graph.

![Graph Options Dialog](image)

**Figure 7.13: Graph Options Dialog**

• **X-Axis Settings button**

• **Y-Axis Settings button**

Opens the Well Graph Axis Settings dialog box for the particular axis, allowing you to set Auto Range parameters, choose the minimum and maximum values for the selected axis, cause the axis to be auto-ranged, add or remove gridlines, and add or remove axis tick marks. When a Well Graph is opened, the default settings are to show the reduction limits for that axis with Auto Ranging off and gridlines and tick marks selected. Only the Well Graph being viewed is affected by changes in these dialog boxes.

• **[Done]**

Closes the Well Graph dialog box.
Multiple wells from the same Plate section or cuvettes from the same Cuvette-Set section can be graphed together in one enlarged window. Select the well(s) or cuvette(s) in the data display (hold the Shift key if you are selecting non-contiguous wells or cuvettes; you can drag across contiguous wells) and then click the Graph button or double-click in one of the selected wells or cuvettes.

**Figure 7.14:** Well Graph for a Single Kinetic Microplate Well (Raw Data)

**Figure 7.15:** Well Graph for a Single Kinetic Cuvette (Reduced Data)
The choices you make for viewing the data in the Plate or CuvetteSet section also affect the way the Well Graph appears. Figures 7.14 and 7.16 show Well Graphs for raw data displays. If you display one of the reduced options (reduced number, Threshold, Ranged, or Gray Scale), the Well Graph will show the plot with an indicator of the reduced value and will include the word “Reduced” in the window title (see Figure 7.15 which shows the Well Graph for a single Kinetic cuvette viewed in a reduced plots format).

**Zoom Box**

You can enlarge the Well Graph even further by clicking the zoom box in the upper right-hand corner of the window (the center box of three in the upper right corner in Windows). Clicking the zoom box once will cause the window to fill the total display on your monitor; clicking the zoom box again will return the window to its previous size.

**Size Box**

Clicking and dragging the size box located in the lower-right corner (Macintosh) or clicking and dragging the lower right corner of the window (Windows) allows you to make the Well Graph any size desired.

**Printing the Well Graph**

You can print the Well Graph window, if desired, by clicking the [Print] button at the bottom left corner of the dialog box.

**NOTE:** If you enlarge the Well Graph to greater than 12 inches, the graph will not fit on an 8.5- by 11-inch page and the printout will be truncated.
Masking Wells or Cuvettes

If you find data in certain wells or cuvettes (outliers) that should be excluded from the calculations to be performed by data reduction, you can mask these wells or cuvettes. Select the well(s) or cuvette(s) to be masked and then click the Mask button in the Plate section or CuvetteSet section tool bar or choose Mask... from the Plate or CuvetteSet menu. Masked wells/cuvettes are shown with an overlay of diagonal lines.

The masking function can be used as a “what if?” tool. For example, you could suppress or enable certain functional groups within the experiment. Suppose you have included a group blank in the template and want to see the data with and without the blank. Masking the group blank wells would suppress the blanking function; unmasking them would enable it again.

Figure 7.17: Masked Wells in a Plate Section and a CuvetteSet Section

To remove masking from one or more wells, highlight the masked well(s) and click the Mask button in the Plate section tool bar (toggles masking on and off) or choose Mask... from the Plate or CuvetteSet menu again. The diagonal lines covering those wells (and masking function) will be removed.
Data Reduction

Raw data received from the MDC Microplate System instrument can be displayed in an analyzed (or reduced) form. The reduction process within SoftMax Pro is based on formulas that reduce the raw data to show a single number for each well or cuvette. Further analysis of this reduced number then takes place in the Group and Graph sections.

SoftMax Pro performs calculations hierarchically when reducing the optical density information collected from the instrument. Calculations in the Plate section or CuvetteSet section are performed in the order shown below. If an option has either not been selected in the Instrument Settings dialog box, is not available for the instrument you are using, or has not been defined in the template and/or Reduction dialog box, SoftMax Pro starts/continues with the next listed calculation.

Plate Section

1) Convert OD to %T (and vice versa)
2) Pre-read plate blank or plate background constant subtraction (or division for %T)
3) PathCheck pathlength correction (different equations for OD and %T)—available with SpectraMax Plus, Plus384, 190, and 340PC only
4) Plate blank subtraction
5) Wavelength reduction
6) Kinetic or Spectrum reduction
7) Group blank subtraction

CuvetteSet Section

1) Convert OD to %T (and vice versa)
2) Reference is subtracted from the reading (optical density mode) or the read data is divided by the reference (%T mode—see Caution below)
3) Template blank subtraction
4) Wavelength reduction
5) Kinetic or Spectrum reduction
6) Group blank subtraction
CAUTION: Separate mathematical calculations are used for handling OD and %T calculations for Pre-read plate blanking, PathCheck, and Reference because OD calculations are performed on a linear scale, whereas %T calculations are performed on a logarithmic scale. Other calculations, however, are not calculated differently by SoftMax Pro for absorbance and %T modes. Because of this, Molecular Devices recommends that %T be used only for raw OD, raw OD with Pre-read plate blank subtraction, or PathCheck-corrected raw OD readings. Use caution when using %T on reduced numbers or any readings that apply other calculations since the data may not accurately reflect proper calculations.

You can access the Reduction dialog box in several ways: by clicking the [Reduction] button in the tool bar of the active plate/cuvette section, by choosing Reduction from the Plate/CuvetteSet menu, or by clicking the [Reduction] button in the Well Graph display. The appearance of the Reduction dialog box will be different depending on the type of read mode you have chosen, and the options you have chosen in the Instrument Settings dialog box. Figures 7.18 and 7.19 show the Reduction dialog boxes for a Plate section and a CuvetteSet section, respectively, in Endpoint, Kinetic, and Spectrum modes, along with the default reductions for each of those modes.
Figure 7.18: Reduction Dialog Boxes for Endpoint, Kinetic, and Spectrum Modes (Plate Section).
The PathCheck (for those instruments that support this function) and pre-read plate reduction parameter checkboxes will not be displayed in the Plate section Reduction dialog box unless they have been selected in the Instrument Settings dialog box. Figure 7.20 shows how the Reduction dialog box looks with the “Use plate blank,” “Use pre-read plate,” “Switch normal and pre-read,” and “Apply PathCheck” options available.

Figure 7.19: Reduction Dialog Boxes for Endpoint, Kinetic, and Spectrum Modes (CuvetteSet Section)
All of the read modes offer one or more predefined choices for reduction. The predefined reductions are described below under the appropriate read mode heading. In addition, with any read mode, you can create a custom reduction formula to better suit your needs. Since all custom reduction formulas are defined the same way, regardless of read mode, they are described together after the individual read mode sections.

**Endpoint**

**Wavelength Combination**

The default reductions for Endpoint readings are !Lm1, !Pathlength, and Custom for all MDC Microplate System instruments when you read at a single wavelength or if you choose “1-Ref” (for all instruments except SpectraMax and VersaMax). The !Pathlength reduction reports the pathlength in each well. With all SpectraMax instruments, additional wavelength combinations become available depending on the number of wavelengths chosen. For any MDC Microplate System instrument, you can choose Custom and create different reduction formulas. The wavelength combinations available in the drop-down menu show the correct format of the formulas that produce these reductions.

**PathCheck (SpectraMax Plus, Plus\textsuperscript{384}, 190, 190PC, 340PC, and 340PC\textsuperscript{384} only)**

Pathlength correction allows microplate data in Endpoint mode (for those instruments that support PathCheck) to be normalized to a 1 cm pathlength. When PathCheck is turned on in the Instrument Settings dialog box for the plate, “Apply PathCheck” appears in the associated Reduction dialog box.

---

1. The !Pathlength option is only applicable to Plate or CuvetteSet sections when using the SpectraMax 190, 190PC, 340PC, 340PC\textsuperscript{384}, Plus, or Plus\textsuperscript{384}, however, the wavelength reduction display is not instrument-dependent in SoftMax Pro, so this choice is always shown, regardless of which instrument is connected or chosen in the Preferences. Choosing !Pathlength with any other instrument or for CuvetteSet sections in the SpectraMax Plus or Plus\textsuperscript{384} will cause an error. The Plate section will not display a reduced number and, consequently, no values will be reported in the Group section table.
Kinetic

Wavelength Combination

The default wavelength combination for Kinetic readings is !Lm1 and is the only choice (besides Custom) for all MDC Microplate System instruments except the SpectraMax and VersaMax. For the SpectraMax, the choices depend on the number of wavelengths chosen (for example, if you will read at two wavelengths, choices default to !Lm1 and !Lm2, along with Custom). With the VersaMax, choices depend on whether you are reading the plate at either one or two wavelengths. For any MDC Microplate System instrument, if you do not wish to use the default reduction, you can choose Custom and create a different reduction formula.

Kinetic Limits

The Limits settings for the display of Kinetic data are MaxOD, MinOD, Lag Time, and End Time.

**NOTE:** The display of OD values is shown relative to the first point measured for each well. Negative Kinetic values decrease with time, and limits should be set accordingly (below 0) to view negative Kinetic data. Limits define the data that will be viewed and included in data reduction, but do not affect data collection. If you alter a limit to show less data, you can always display the “hidden” data again by changing the limit.

MaxOD

The limit for the maximum value you wish to report. Any values from the reading that are above this limit will not be shown and will be excluded from data reduction. The default for MaxOD is 1.0.

The MaxOD reduction parameter can be used to exclude the non-linear portion of the reaction from data analysis. This type of data reduction is most useful in reactions where the initial portion of the data is linear. You might also adjust the End Time setting to remove a non-linear portion after a certain time point in the reaction. Using MaxOD allows the use of the maximum number of linear points to calculate the slope of the line and, thus, to determine the rate for each well.
Both of the Well Graphs shown above display different reductions of the same data (these examples use optical density readings). In the figure on the top, the MaxOD is set to 2.0 for the display of wells B4, C6, and D8. In the figure on the bottom, the MaxOD has been reset to 0.5. Alternatively, you could leave the Maximum OD and decrease the number of Vmax Points used to determine the slope of the line.

Figure 7.21: Different Reductions of the Same Data Using Different MaxOD Points
MinOD
The limit for the minimum value you wish to report. Any values from the reading that are under this limit will not be shown and will be excluded from data reduction. The default is 0 OD. To display negative Kinetics, the value should be set below 0 (zero).

Lag Time
Specifies how many initial data points are excluded from the calculation of Vmax Rate. Lag Time truncates the data used in the calculation. It does not prevent data from being collected. The Kinetic plots will not display the data collected prior to the set Lag Time. The value for Lag Time can be changed after the plate is read. The default is 0.

Figure 7.22: Different Lag Time Settings
In the figure on the top left, well C5 has a lag time: the data is not linear until approximately 80 seconds after the start of data collection. Thus, the linear curve fit is not good and the slope of the line does not reflect the maximal rate. In the figure on the bottom right, a lag time of 80 seconds has been set and the linear curve fit for both wells is good, allowing the slope of the lines to reflect the maximal rate in each well. Alternatively, you could leave the Lag Time and decrease the number of Vmax Points used to determine the slope of the line.
End Time
This setting specifies the time at which you wish to stop showing data in the display. Any values occurring after this limit will not be reported in the display. The default setting is the total assay time. The value for end time may not be greater than the total assay time.

Absolute Values
This setting causes the plots shown in the data display to be drawn at their absolute OD as opposed to the default (with the box unchecked) which offsets the first point to the (0,0) coordinate. Enabling Absolute Values may cause some data points that do not fall within the default limits for the plots to “disappear” (see Figure 7.23).

Figure 7.23: Kinetic Reduction with Absolute Values Enabled
Note that the limits in this example (MinOD=0, MaxOD=0.5) do not allow all of the data to be visible.

To see more data, yet still display absolute values, increase the limits for MinOD and/or MaxOD found in the Reduction dialog box (Figure 7.24).
If you increase the MaxOD setting to be at least as large as the largest absorbance value expected, most or all of the data plots should appear in the data display. In the example shown in Figure 7.23, if the MaxOD value is increased from 0.5 to 2.0, the plots then appear as shown in Figure 7.25.

Figure 7.24: Limits in Reduction Dialog Box

Figure 7.25: Kinetic Reduction with Absolute Values Enabled and MaxOD Value Increased
Kinetic Reduction

Kinetic reductions are applied to the list of numbers (the value at each time-point) after the wavelength combination formula is applied. Vmax per min and Vmax per sec reductions are available for all instruments that are capable of Kinetics; the default Kinetic reduction is Vmax. Other reductions available from the pop-up menu are Time to Vmax, Onset Time, Time at Minimum, Time at Maximum, Time at 1/2 Maximum, Slope, Area Under Curve, or you can choose Custom and then create a different reduction formula.

Vmax

The maximum slope of the Kinetic display of optical density versus time. The default value displayed is in milli-optical density units per minute (mOD/min). The rate is calculated with the use of Vmax Points (see below) which determines the number of contiguous points over which Vmax is calculated. The number of Vmax Points defaults to the maximum taken during the reading; you can change this number in the Reduction dialog box if desired.

NOTE: Vmax = Vmax/sec • 60,000

A linear regression is performed to determine the slope of the line using the equation:

\[ y = m \times X + B \]

where m is the slope of the line.

The reaction rate is reported in milliOD/min (color change in milliOD per minute of reaction time).

Vmax Points

This setting defines the maximum size of the line segment used to determine the slope of the line used in calculating the rate of the reaction. The default is the total number of points taken in the reading, with the data normalized to a starting point of 0,0 (as opposed to starting from the optical density of the first time point). The first slope is calculated for a line drawn beginning at the first reading as defined by Lag Time (described below) and ending at a total number of readings equal to the Vmax Points setting. The second and any subsequent slopes are calculated beginning at the second time point and ending at a total number of readings equal to Vmax Points. The steepest slope is reported as Vmax Rate. If the data plot displays fewer time points (data points) than the number of time points chosen for Vmax Points, then all of the time points will be used to determine the slope of the data.
Table 7.1: Using Vmax Points (Example)

<table>
<thead>
<tr>
<th>Well 1</th>
<th>Well 2</th>
<th>Well 3</th>
</tr>
</thead>
<tbody>
<tr>
<td>Time points visible in the well (data plot)</td>
<td>25</td>
<td>10</td>
</tr>
</tbody>
</table>

Number of Points Used for Data Analysis:

<table>
<thead>
<tr>
<th>Vmax Points set to 25/25 (default)</th>
<th>Overlapping 5-point line segments*</th>
<th>Overlapping 5-point line segments*</th>
<th>2</th>
</tr>
</thead>
</table>

* SoftMax Pro will perform a linear regression on as many overlapping 5-point line segments as possible in the analysis window. The slope will be determined for each line segment and then the steepest slope will be reported as the reaction rate. Thus, in well 2 of the example in Table 7.1, above, the slope will be determined for line segments consisting of time points 1 to 5, 2 to 6, 3 to 7, 4 to 8, 5 to 9, and 6 to 10, and then the slope of the line segment with the steepest slope will be reported as the Vmax Rate.

The progressive slope calculations are repeated until the last included data point is reached (as defined by the End Time or MaxOD — see below). The maximum positive or negative slope is reported as Vmax (mOD/min). Vmax Points can be set from 2 to the total number of points in the curve. The number of Vmax Points can be set before the plate is read and can be changed after the plate is read. The data display will update automatically each time. The Vmax Points setting does not affect data collection.

**NOTE:** The height of the Y axis in the raw data plots or plate display is controlled using MinOD and MaxOD. The default settings are:

- MinOD = 0
- MaxOD = 1.0

The width of the X-axis in the raw data plots or plate display is controlled using Lag Time and End Time. If either the MaxOD or End Time setting excludes points such that a total number of readings equal to Vmax Points cannot be used, then the maximum included points will be used.

**Time to Vmax**

This is an alternative method for analyzing non-linear Kinetic reactions which reports the elapsed time until the maximum reaction rate is reached, rather than reporting the maximum rate itself. Used in conjunction with Vmax Points, Time to Vmax is the time to the midpoint of the line defined by Vmax Points and used to calculate Vmax. This elapsed time data is useful for applications including coagulation chemistry where the changing concentration of the reagents does not change Vmax, but rather will change the time at which the reaction reaches the maximum rate.
**Onset Time**
This is another method for analyzing non-linear Kinetic reactions. Onset Time reports the time required for a Kinetic reaction to change by a specified optical density (onset OD above the initial OD reading for the well). This elapsed time data is useful for cascade reactions including clot formation (endotoxin testing, for example) and clot lysis applications where the change in reagent concentration does not affect the maximum optical density change but changes the time required for the reaction to reach completion.

**Time at Minimum**
This setting reports the time at the minimum OD or %T that falls within the reduction limits.

**Time at Maximum**
This setting reports the time at the maximum OD or %T that falls within the reduction limits.

**Time at 1/2 Maximum**
This setting reports the time at the half of the maximum OD or %T that falls within the reduction limits. To calculate this reduction, SoftMax Pro first determines the Kinetic point (within the reduction limits) that has the maximum signal level (OD or %T). It then scans the Kinetic plot from left to right until it finds two points having signals that bracket half of that value. A linear interpolation between these two points is used to estimate the Time at 1/2 Maximum.

**Slope**
This setting determines the slope of the combined plot (i.e., the slope of the line using linear regression after the wavelength combination reduction). This setting uses all visible timepoints in the reduction window. Slope is the same as Vmax Rate when Vmax Rate is set to the same number of points as the run (i.e., the default). Slope is not the same as Vmax Rate if you have modified the Vmax Points.

**Area Under Curve**
This reduction estimates the area under the curve as defined by the data plots in wells and cuvettes (within the reduction limits). The data plots are treated as a series of trapezoids with vertices at successive data points and at the X-axis coordinates of the data points. The areas defined by each of the trapezoids are then computed and summed.
Chapter 7: Displaying and Analyzing Data Using Absorbance Instruments

### Spectrum (SpectraMax Instruments Only)

#### Spectrum Limits

The Limits settings for the display of Spectrum data are MaxOD, MinOD, Starting Wavelength in nm, and Ending Wavelength in nm.

**NOTE:** The display of values is shown relative to the first point measured for each well. Limits define the data that will be viewed and included in data reduction, but do not affect data collection. If you alter a limit to show less data, you can always display the “hidden” data again by changing the limit.

**MinOD**

The limit for the minimum value you wish to report. Any values from the reading that are under this limit will not be shown and will be excluded from data reduction. The default is 0 OD.

**MaxOD**

The limit for the maximum value you wish to report. Any values from the reading that are above this limit will not be shown and will be excluded from data reduction. The default is 1.0 OD.

**Start (Wavelength) nm**

Specifies the limit for the minimum wavelength setting you wish to report. Any values from the reading that are under this limit will not be shown and will be excluded from data reduction.

**End (Wavelength) nm**

Specifies the limit for the maximum wavelength setting you wish to report. Any values from the reading that are above this limit will not be shown and will be excluded from data reduction.

**NOTE:** The settings for the Start and End wavelength settings cannot be below the lowest wavelength or above the highest wavelength entered in the Instrument Settings for the Spectrum reading.

#### Spectrum Reduction

The Spectrum reduction formula is applied to the list of numbers in each well (values at each wavelength) after the wavelength combination formula is applied. The default reduction for Spectrum readings is Lambda at Maximum. You can choose Lambda at Minimum, Maximum, Minimum, or Area Under Curve instead from the pop-up menu, or you can choose Custom and create a different reduction formula.

**Maximum**

Reports the maximum absorbance (optical density) or percent transmittance (%T) (within the reduction parameters of MinOD and MaxOD).

**Minimum**

Reports the minimum absorbance (optical density) or percent transmittance (%T) (within the reduction parameters of MinOD and MaxOD).
Lambda at Maximum
Reports the wavelength at which maximum absorbance (optical density) or percent transmittance (%T) (within the reduction parameters of MinOD and MaxOD).

Lambda at Minimum
Reports the wavelength of minimum absorbance (optical density) or percent transmittance (%T) (within the reduction parameters of MinOD and MaxOD).

Area Under Curve
This reduction estimates the area under the curve as defined by the data plots in wells and cuvettes (within the reduction limits). The data plots are treated as a series of trapezoids with vertices at successive data points and at the X-axis coordinates of the data points. The areas defined by each of the trapezoids are then computed and summed.

Data Mode (% Transmittance/Absorbance)
For all read modes, you can choose whether to view data as %Transmittance or Absorbance (OD). As with all reduction or display options, these choices do not affect the raw data acquired from the instrument but rather only how it is shown in SoftMax Pro. If %T is chosen, all values including raw data are displayed in %T.

⚠️ CAUTION: When the data mode is switched from %T to Absorbance or vice versa, SoftMax Pro recalculates all of the values based upon the new data mode. Separate mathematical calculations are used for handling OD and %T calculations for Pre-read plate blanking, and Path-Check because OD calculations are performed on a linear scale, whereas %T calculations are performed on a logarithmic scale. However, other calculations are not calculated differently by SoftMax Pro for absorbance and %T modes. Therefore, switching from %T to Absorbance or vice versa is not recommended. Additionally, Molecular Devices recommends that %T be used only for raw OD, raw OD with Pre-read plate blank subtraction, or PathCheck-corrected raw OD readings. Use caution when using %T on reduced numbers or any readings that apply other calculations since the data may not accurately reflect proper calculations.

NOTE: If you switch from one mode to the other, note that settings for the two modes are not “linked”—settings chosen for one mode are not reflected if you switch to the other mode. For example, if data from a Spectrum scan is displayed with a MinOD of 0 and a MaxOD of 1 (absorbance), and you then switch to %Transmittance and change the limits to 0 and 50%, respectively, switching back to absorbance will not change the limits set previously (the Min- and MaxOD limits will still be 0 and 1).
Custom Reduction Formulas

If the predefined reduction formulas do not meet your needs, you can create one or more different reduction formulas for any or all read modes (Endpoint, Kinetic, Spectrum, or well scan). Choosing “Custom” from any of the menus or dialog boxes causes a Formula button to appear (an example of this button in an Endpoint Reduction dialog box is shown in Figure 7.26). Custom reduction formulas may contain other operators and terms in addition to wavelengths.

![Figure 7.26: “Custom” Selected Showing Formula Button (Endpoint)]

Clicking the Formula button opens the Calculation dialog box in which you can name and define a new reduction formula.

![Figure 7.27: Wavelength Calculation Dialog Box (Endpoint)]

Examples of some formulas that might be used when combining multiple wavelengths in the Calculation dialog box are given in Table 7.2.
For Emax, Vmax, UVmax, or ThermoMax instruments, the choice available for reading at two wavelengths is designated “1-Ref.” While the instrument performs a reading at the two wavelengths you designate (one for the measurement and one for the reference), data regarding these individual wavelength readings is automatically reduced to a single value in the data display: the value obtained from the reading at the reference wavelength is subtracted from the reading at the measurement wavelength and only the resulting value is displayed. When you choose 1-Ref, you cannot view the data associated with the readings at the individual measurement or reference wavelengths.

NOTE: For Emax, Vmax, UVmax, or ThermoMax instruments, the choice available for reading at two wavelengths is designated “1-Ref.” While the instrument performs a reading at the two wavelengths you designate (one for the measurement and one for the reference), data regarding these individual wavelength readings is automatically reduced to a single value in the data display: the value obtained from the reading at the reference wavelength is subtracted from the reading at the measurement wavelength and only the resulting value is displayed. When you choose 1-Ref, you cannot view the data associated with the readings at the individual measurement or reference wavelengths.

**Table 7.2: Wavelength Reduction Formula Examples**

<table>
<thead>
<tr>
<th>Formula</th>
<th>2 λ</th>
<th>3 λ</th>
<th>4 λ to 6 λ</th>
</tr>
</thead>
<tbody>
<tr>
<td>!Lm1 + !Lm2</td>
<td>!Lm1 + !Lm2 + !Lm3</td>
<td>!Lm1 + !Lm2 + ... + !Lmn</td>
<td></td>
</tr>
<tr>
<td>!Lm1 - !Lm2</td>
<td>(!Lm1 - !Lm3) / (!Lm2 - !Lm3)</td>
<td>(!Lm1 - !Lm6) / (!Lm2 - !Lm5) / (!Lm3 - !Lm4)</td>
<td></td>
</tr>
<tr>
<td>!Lm1 / !Lm2</td>
<td>!Lm1 / !Lm3</td>
<td>!Lm1 / !Lmn</td>
<td></td>
</tr>
<tr>
<td>!Lm1 * !Lm2</td>
<td>!Lm1 * !Lm3</td>
<td>!Lm1 * !Lmn</td>
<td></td>
</tr>
<tr>
<td>Log10(!Lm1 / !Lm2)</td>
<td>Log10(!Lm1 / !Lm3)</td>
<td>Log10(!Lm1 / !Lmn)</td>
<td></td>
</tr>
<tr>
<td>!Pathlength</td>
<td>!Pathlength</td>
<td>!Pathlength</td>
<td></td>
</tr>
<tr>
<td>!Lmx/constant</td>
<td>For example, Lm1 / 1.44 for quantitating a polyclonal antibody by measuring the absorbance at A280 in a SpectraMax Plus or Plus384 with PathCheck on.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Average(!allvalues)</td>
<td>This formula will average together the optical densities for multiple readings at the same wavelength (for example, if you read the well six times at 280 nm).</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Min(!allvalues)</td>
<td>This formula will report the minimum OD recorded for multiple wavelength readings in each well.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Max(!allvalues)</td>
<td>This formula will report the maximum OD recorded for multiple wavelength readings in each well.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>If(!Lmz&lt;A,makeerr(118),(if(!Lmx&gt;B,makeerr(117),!Lm1)))</td>
<td>This formula will report “low” for any well with an OD less than A, “high” for any OD greater than B, and the OD of any well that lies between A and B.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**NOTE** For Emax, Vmax, UVmax, or ThermoMax instruments, the choice available for reading at two wavelengths is designated “1-Ref.” While the instrument performs a reading at the two wavelengths you designate (one for the measurement and one for the reference), data regarding these individual wavelength readings is automatically reduced to a single value in the data display: the value obtained from the reading at the reference wavelength is subtracted from the reading at the measurement wavelength and only the resulting value is displayed. When you choose 1-Ref, you cannot view the data associated with the readings at the individual measurement or reference wavelengths.
Custom reduction formulas utilizing mathematical operators or terms can be used to obtain specific types of data. Table 7.3 provides some examples of such formulas for Kinetic and Spectrum readings.

**Table 7.3: Kinetic and Spectrum Reduction Formula Examples**

<table>
<thead>
<tr>
<th>Kinetic</th>
<th>Spectrum or Kinetic</th>
</tr>
</thead>
<tbody>
<tr>
<td>Vmaxcorr(!combinedplot, !vmaxpoints,!readinterval)</td>
<td>Reports Vmax correlation coefficient for plots in all 96 wells.</td>
</tr>
<tr>
<td>Vmax(Delta(!combinedplot), !vmaxpoints,!readinterval)</td>
<td>Will report the Vmax Rate of the delta between each time point.</td>
</tr>
<tr>
<td>Nthitem(!Lm1,X)</td>
<td>Will report the optical density at item X in the list of readings. For example, if you have a Kinetic run with 20 time points and X is 10, it will report the OD of the 10th time point. Similarly, if you have a Spectrum scan with 20 measurements and X is 10, it will report the OD of the 10th wavelength measured.</td>
</tr>
</tbody>
</table>

For a full discussion of custom formulas, see the *Formula Reference Guide*. When you finish your entry in the Calculation dialog box and click [OK], the formula you have entered then appears to the right of the word “Custom” and becomes the default selection for the Custom option. You may subsequently edit this formula or enter a new one by clicking the Formula button again.

**Recalculation Options**

By default, SoftMax Pro performs continuous recalculation of the data when you read plates, create or change formulas, and so on. At certain times, it would be useful to disable the recalculation feature so that you can make alterations to the experiment without waiting for individual recalculations to be completed. Two commands are available in the Edit menu that allow you to modify the way in which SoftMax Pro performs recalculation: **Suspend Recalculation** and **Recalculate Now** (⌘ + ).

Choosing **Suspend Recalculation** disables the automatic recalculation feature of the program and places a checkmark to the left of the command in the menu to indicate that it has been selected. While this function is enabled, no recalculation will occur, regardless of what you may change, add, or delete from the experiment. This is especially useful when creating or changing column formulas within Group sections, for example, as it can speed up the process greatly.

When recalculation has been suspended, you may wish to see the results of the changes you have made but may still not wish to enable continuous recalculation. Choosing **Recalculate Now** (⌘ + ) from the Edit menu will cause SoftMax Pro to examine all elements of the experiment and perform complete recalculation of the data. Choosing this command does not enable continuous recalculation but simply causes the program to perform recalculation once.
To return to continuous recalculation, choose **Suspend Recalculation** again. The checkmark next to the command will disappear, indicating that the function is no longer in use.

**NOTE**: **Recalculate Now** (⌘ =; CTRL+=) can be used to see intermediate results during long Kinetic readings. At any time, you can choose **Suspend Recalculation** to delay calculations until a later time.

---

**Displaying Data in Group, Graph, and Notes Sections**

### Group Sections

The manner in which data is displayed in a Group section depends on the type of reading that was performed (Endpoint, Kinetic, Spectrum, or well scan), but can be customized by choices made in the data display, reduction settings, and the **Edit** menu.

- Resizing/hiding columns
- Adding/deleting columns
- Showing/editing column formulas
- Adding/editing summaries
- Changing text style

Default displays for Group sections are shown automatically unless you choose a different display option.

The particular font to be used in a Group section table, as well as its size and style, can be changed by first selecting one or more columns in the Group section table and then choosing the **Text** command from the **Edit** menu and making the desired choices from the dialog box that appears.

### Settings from the Plate/CuvetteSet Section Affect Data Display in Group Section Tables

Reduction options in the Plate/CuvetteSet section allow you to display the raw data received from the MDC Microplate System instrument in a reduced (analyzed) form. Which reduction options are available depend on the read mode used and reduction settings chosen. Reduced number from the Plate/CuvetteSet section is displayed in the Values column of the Group section tables by default.

**Reduction settings do not affect the raw data but simply cause it to be displayed differently.** You can change reduction settings without affecting the raw data from the plate or cuvette reading in any way.

Custom reduction formulas require the use of accessors and operators that are understood by SoftMax Pro. A list of these accessors and operators is given at the end of this chapter.
Resizing and Hiding Columns

The columns in a Group section can be resized in several ways. One of the simplest methods is to drag the line dividing the columns to another position (moving it horizontally). When you point to a line between columns, the cursor changes to a double arrow with a vertical line through it, showing that it is ready to move left or right (see Figure 7.28).

![Figure 7.28: Cursor Positioned on a Line between Columns](image)

Reduction Column Size and Hiding Columns

You can reduce a column to a size smaller than the width of its title, in which case the title will not be completely visible. You can also hide a column by reducing its size completely (drag one edge of the column on top of the other) or by selecting that column and choosing **Hide** from the **Group** menu.

**NOTE:** If you hide a column in this way and then wish to view it again, use the **Show All** command in the **Group** menu. All columns that were hidden will again be visible. There is no way to show only one hidden column.

Enlarging Column Size

You can enlarge the width of columns to any size. Increasing the size of columns may make the width of the Group section increase beyond the page width boundary. If this occurs, the columns will “disappear” off the edge of the screen but are really still there. To bring these columns back into view, reduce the width of the columns that are still visible until the others reappear.

![Figure 7.29: Dragging a Column Divider Line](image)
If the width of a section extends beyond the page width boundary, the portion that is not visible will not be printed.

To size two or more columns to the same width, highlight those columns and then drag one of the dividing lines to the desired width. The width of all highlighted columns will be sized the same as the column to the left of the dividing line you are moving.

Columns can also be resized to the minimum amount of space required by choosing **Autosize** from the **Group** menu. By highlighting the entire table or individual columns and then choosing **Autosize**, the amount of space each column requires will be reduced to the minimum size required by the largest piece of text in that column.

Double-clicking the line dividing two columns causes the single column to the left of the divider to be sized according to the largest amount of text in that column.

**Showing and Editing Existing Column Formulas**

When group sections are first created, the formulas used to calculate the data are not displayed.

These formulas can be shown (until you choose to hide them again) by making a Group section active and then choosing **Show Formulas** from the **Group** menu. (Note that the command in the menu changes to **Hide Formulas** after they are shown.)

![Figure 7.30: The “Show Formulas” Command in the Group Menu](image)

Choosing this option causes an additional row to appear (beneath the heading for each column) which shows the formula used to calculate the data in each column. To see formulas briefly, hold down the shift and control (Ctrl) keys.
Modifying Column Formulas

To modify the formula for an existing column, double-click the column or click the column once and then click the formula button in the section tool bar. The dialog box associated with the column formula will open, allowing you to edit the formula (and the name) associated with the column.

For a complete discussion, see the accompanying Formula Reference Guide.
Adding Columns

You can add a new column to a Group section by clicking the Create Column button in the Group tool bar or by choosing Create Column from the Group menu which will open the Column Formula dialog box.

![Column Formula Dialog Box](image)

**Figure 7.33: Column Formula Dialog Box**

In the Column Formula dialog box, you can change the name of the new column (from the default which simply lists the column by number) to reflect the data that it will contain.

If no existing column is selected when you click the Create Column button, the new column will be created to the right of all existing ones. If you select (highlight) a column and then add a new column, it will be positioned to the right of the one you selected. If the table is currently as wide as the sheet of paper specified in Page Setup when a new column is added, the columns will “disappear” off the right side of the window but are still there. To bring these columns back into view, resize visible columns smaller.

New columns can contain references to other columns, both in the current section or in a different one within the same experiment. For example, if you wanted to subtract the mean values in one group from those in another, you could create a new column (in either group) to do this. If the two groups were named “Group 1” and “Group 2,” for example, and both groups contained a column entitled “Mean,” you could create a column within “Group 1” that would subtract the mean values in “Group 2” from those in “Group 1.” The column formula needed to do this would be:

\[ \text{Mean} - \text{Mean@Group2} \]

Numerous possibilities exist for creating and editing column formulas to display the data you desire. For a complete discussion of formulas and operators, see the accompanying Formula Reference Guide.

**NOTE:** To delete a column, highlight it and press the Delete key or choose Cut from the Edit menu.
Adding or Editing a Summary in a Group Section

To add a summary at the bottom of a Group section, click the Create Summary button in the tool bar or choose Create Summary from the Group menu. The Calculation dialog box will appear, allowing you to change the name of the summary or hide the name, if desired, as well as to enter a description of the summary and to create a formula for it (including the number of decimal places for the result, if appropriate). Double-clicking an existing summary causes the same dialog box to appear, allowing you to modify summary information.

Information entered in this dialog box will be placed at the bottom of the Group section as follows:

Name = Description     Formula Result

You can click the checkbox next to Hide Name which will change the way the summary appears to show:

Description     Formula Result

NOTE: The name assigned to a summary is important since you can reference the summary by name in other formulas (building one upon another). The summary name can be referenced even if it is hidden.

If you wish to see the formulas associated with summaries without opening the Calculation dialog box for each one, you can choose Show Formulas from the Group menu. To see these formulas only briefly, hold down the shift and control (Ctrl) keys while that Group section is active. The summaries will “expand” to show the complete formula along with the title. They will resume their previous appearance when you release the option key.

Summaries in Group sections can be moved horizontally, if desired, by dragging them left or right. When you position the pointer over a Group summary, the cursor changes to show a double-headed horizontal arrow. Clicking once highlights the summary; dragging and then releasing the summary leaves it in the position where the mouse button was released.

To have summaries line up with particular columns in the Group, hold down the control (Ctrl) key while dragging the summary. When you release the control (Ctrl) key, the summary will “snap back” so that it begins flush to the left side of the column under which it was released. Each summary can be positioned in a different place in the Group section, if desired.
To delete a summary, highlight it and press the Delete key or choose Cut from the Edit menu. A summary can also be copied or cut and then pasted in a different location.

You can also change the format of the text in Group section columns and/or summaries. By selecting the column or summary and then choosing Edit and then Text Style (Ctrl+T), you can change the font, size, and/or style of the text.

**Notes Sections**

The Notes section allows you to enter text describing the experiment and one or more summary lines that contain formulas. To create a summary, click the Create Summary button in the tool bar or choose Create Summary... from the Notes menu.

The Calculation dialog box that appears (see Figure 7.34) allows you to enter a description of the summary, accept the default title for the summary, change it or hide it, and enter a formula (including the number of decimal places the reduction should show, if appropriate). Detailed information regarding operators and accessors can be found in the Formula Reference Guide.

If you wish to see the formulas associated with the summaries without calling up the Calculation dialog box for each one, you can choose Show Formulas from the Notes menu. To see these formulas only briefly, hold down the shift and control (Ctrl) keys while that Notes section is active. The summaries will “expand” to show the complete formula along with the other summary information. They will resume their previous appearance when you release the option key.

**Graph Section**

*The Plot#X Dialog Box*

Whenever you create a new Graph section or add a plot to an existing graph, the Plot#X dialog box opens automatically (“X” starts with “1” and increments each time a new plot is added to a Graph section). In this dialog box, you can rename the plot, assign specific information to be plotted on the X- and Y-axes, and choose which icon and color will be used. If you rename the plot, the title of the dialog box will change to show the new plot name.

All groups that have been created or assigned within the file are listed on the left side of the “Source:” field in the Plot#X dialog box. The first group in the file is automatically selected. Other groups can be selected by highlighting them. When a group is selected, the pull-down menus in the X-axis and Y-axis subfields change to show the group columns that are available for graphing. Group columns can be assigned for both the values to be plotted and any error bars to be included for both axes.

Summaries and user-defined formulas can also be graphed. Pushing the button for either the X-axis or Y-axis opens a dialog box which allows you to enter formulas. To plot a summary, enter the summary name in this dialog box. Formulas can be plotted for comparison with other data. For example, if the data is assumed to follow a specific model, the model formula can be entered as a plot and then the data can be chosen for another plot within the same graph. You can also use this feature to plot Kinetic or Spectrum data in...
Graph sections. For example, to plot Kinetic data from well A1 in a Graph section, you can enter the formula !A1Lm1 for the Y-Axis and the !TimeRun accessor for the X-axis. The entered formulas are also shown in the “Source:” field of this dialog box.

The size, color, and style of the icon used for a plot can be selected on the right side of this dialog box. Four sizes, nine colors, and nine styles are available from drop-down menus.

**The Graph Options Dialog Box**

The Graph Options dialog box allows you to change the name of the Graph section, change the height of a graph, select the type of graph to be displayed, change the fonts used on the title, legend, and axes, access the Plot#X dialog box for editing plots, entering new plots, and/or to delete plots. This dialog box is opened after pressing [OK] in the Plot#X dialog box when a new Graph section is being created. This dialog can also be accessed by pressing the Graph Options button on the Graph section toolbar or by choosing Graph Options from the Graph menu.

Scatter plots, cluster bar charts and stack bar charts can be created. Error bars can be used with all graph types. You can also choose whether to connect the points and/or plot the symbols in the graph.

Each of the plots that have been created for the Graph section are listed. Choosing any of these plots shows the data that will be used for the X- and Y-axis data points and whether or not error bars will be used. Plots can be deleted by highlighting the plot name and clicking the [Delete] button. Clicking the [New] button opens the Plot#X dialog box, allowing you to create a new plot for the graph. Existing plots can be edited by highlighting the plot name and clicking the [Edit] button which opens the Plot#X dialog box containing all the information for the selected plot.

When creating a new Graph section, the Graph Options dialog box opens after choosing either [OK] or [Cancel] in the Plot#X dialog. The new Graph section is not created, however, until you click [OK] in the Graph Options dialog box.
Chapter 7: Displaying and Analyzing Data Using Absorbance Instruments

Creating Multiple Plots

SoftMax Pro makes it possible to create multiple plots within a graph. Each plot will represent data from a group that has been created in the Template Editor or data from a summary or custom formula. You may plot data from any group or from several groups on a graph, even if the groups are in separate experiments. It is possible, for example, to plot multiple dilution series of an unknown, to graph together a series of patient samples, or to plot several controls that have been run over time.

Following is a summary of the steps required to create multiple plots within a single graph, after which is an example that provides more detail.

Multiple Plots Step Summary

- Create all required groups in the Template Editor.
- Read the microplate or cuvette to obtain data.
- Create a graph section.
- Add plots to the graph and choose the group and the X and Y values to be shown for each plot.

Example of Creating Multiple Plots

This example shows how three groups, all of which are Standards, were plotted on the same graph.

1) Groups are created in the Template Editor. For this example, four groups are created: three for standards (Standard1, Standard2, and Standard3) and one for Unknowns (Unknown1).
2) The associated Group sections are created using the Standards column format which, by default, generates columns for concentration and optical density values. The example below shows the Group section for Standard2.

![Figure 7.36: Standards and Unknowns Groups Created](image)

3) A new Graph section is created by selecting New Graph from the Experiment menu. This causes the Plots dialog box to open automatically. The default name for the first plot, “Plot#1,” is then changed (by typing a new name over it) to “Standard#1.” Clicking [OK] opens the Graph Options dialog box which allows you to choose the graph type, modify the fonts used for the graph, and so on. Choices should be made as follows: Standard1 for the group to be plotted, the concentration of Standard1 for the X-axis, and values of Standard1 for the Y-axis. No error bars are added.

![Figure 7.37: Standard2 Group Section](image)
Figure 7.38: Graph Options Dialog Box with Plot Name Changed to “Standard#1”

4) A second plot is added to this graph by clicking the [New] button in the Graph Options dialog box. After clicking [New], a dialog labeled Plot #2 is opened. The second plot name defaults to “Plot#1,” which now shows beneath the first plot. Change this second plot name to “Standard#2,” choose Standard2 for the group, and change the X- and Y-axes to show concentration and values, respectively, for Standard2.

Figure 7.39: Graph Options Dialog Box with Second Plot Added for Standard#2

5) This process is repeated for a third plot, labeled “Standard#3.”
6) Now that all plots information is complete, clicking [OK] in the Graph Option dialog box will close it, and the resulting graph will show the three plots created.

![Figure 7.40: Graph Displaying Three Standards Plots](image)

You can add as many plots to a graph as you wish, and these can be of the same or different types of groups. If you create a graph and later wish to add one or more plots to it, simply click the [Graph Options] button on the Graph section toolbar and then click the [New] button. This will reopen the Plots dialog box, allowing you to add or modify the plot information.
Error Bars
When data is displayed as a scatter or bar graph, you can choose to display error bars for the plot of the data for the X- and/or Y-axis. Error bars are lines that extend beyond a plotted value in either or both directions and graphically represent some amount of error in plotted data.

![Figure 7.41: Plot Showing Error Bars](image)

Choices for displaying error bars relative to a particular axis are the same as those available for displaying data on that axis: any column from that group that contains numerical information (not columns with text). To display error bars, click and hold the box next to “Error Bars” in the Plot#X dialog and drag to select one of the choices in the menu. To disable error bars, choose “No Error” for the X- and/or Y-axis.

Error bars show both positive and negative error. Depending on the range settings for the graph, portions of the error bars may not be visible.

Curve Fitting
When you first create a graph of the data, it does not have a fit associated with it. The graph might appear something like this:

![Figure 7.42: Graph with No Fit](image)
You can fit any plot to one of nine curve-fitting algorithms: Linear, Semi-Log, Log-Log, Quadratic, 4-Parameter (logistic), Log-Logit, Point-to-Point, Exponential, and Cubic Spline. These selections are shown in the Fits pop-up menu in the Graph section toolbar (click on the box next to “Fit”).

Typically, a standard curve refers to the curve fitted to the plot of concentration versus mean value for the Standard group.

Once you have selected a Fit type, SoftMax Pro determines the parameter values that best fit the data. The function with these parameters is then drawn on the graph. Ideally, the type of fit used should be determined by the underlying chemistry of the assay and could be set before data is read.


When a fit is chosen, the Graph section is updated to show the coefficients describing the fit when applicable. These values are displayed in the legend at the bottom of the graph. Figures 7.43 through 7.50 show the same graph with the different fit algorithms applied. Note that the legend information changes (along with the formula for the fit) at the bottom of each Graph section for each different fit.

**NOTE:** All plots on a graph must have the same type of fit.

When a curve fit is chosen, the values for the coefficients of the equation (A, B, C, etc.) will be shown as will the square of the correlation coefficient (R²). The correlation coefficient describes how well a change in x values correlates with a change in the y values. Please see “Judging a Good Curve Fit” on page 7-64 for more information. The R² value should only be used for curve fits having linear axes.
Linear
The linear function fits the best straight line to the data. The equation for this fit has the form of:

\[ Y = A + (B \times X) \]

where A is the y-intercept of the line and B is the slope. A linear fit should be used whenever the values appear to lie on or scattered around a straight line. This equation is shown on the screen as:

\[ y = A + Bx \]

A linear fit should be used whenever the standard values appear to lie on or are scattered around a straight line. Figure 7.43 shows an example of a linear fit.

Figure 7.43: Graph with Linear Fit
Semi-Log

The semi-log function fits the best straight line to a set of data for log(X) plotted against Y. The resulting curve displayed will be a straight line with the X-axis drawn in logarithmic scale. The equation for a semi-log fit is:

\[ Y = A + [B \cdot \log_{10}(X)] \]

and is shown on the screen as:

\[ y = A + B \cdot \log(x) \]

where A is the y-intercept of the line and B is the slope (note: log in this equation is the common or base-10 logarithm).

![Figure 7.44: Graph with Semi-Log Fit](image)
Log-Log
The log-log function fits the best straight line to the set of data which consists
of the logarithm of the readings on the Y-axis (the response) and the logarithm
of the dose on the X-axis. The resulting display will be a straight line with
both axes drawn in logarithmic scale. The equation for the log-log fit is:

\[ \log_{10}(Y) = A + [B \cdot \log_{10}(X)] \]

and is shown on the screen as:

\[ \log(y) = A + B \cdot \log(x) \]

where A is the \( \log_{10} \) Y-intercept of the line for \( \log_{10}(X) = 0 \) and B is the slope
(note: log in this equation is the common or base-10 logarithm).

![Figure 7.45: Graph with Log-Log Fit](image)

Log\(_{10}\)(Y) = A + B \cdot \log(x)

<table>
<thead>
<tr>
<th>STD (Standard: Concentration vs Mean Value)</th>
<th>A</th>
<th>B</th>
<th>R^2</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>-0.401</td>
<td>-0.289</td>
<td>1</td>
</tr>
</tbody>
</table>
Quadratic

The quadratic function fits the best parabola to the data. The parabola is a curved line based on the equation:

\[ y = A + (B \times x) + (C \times x^2) \]

which is shown on the screen as:

\[ y = A + Bx + Cx^2 \]

where A is the intercept, B is the slope of the curve at the intercept, and C is the measure of the curvature of the parabola.

The quadratic fit is most appropriate when the standard curve has a tendency to curve up or down. An example of a quadratic fit is shown in Figure 7.46.

![Graph with Quadratic Fit](image-url)

*Figure 7.46: Graph with Quadratic Fit*
4-Parameter Logistic and Log-Logit

If the standard curve has a sigmoidal shape when plotted on the semi-log axes, it may be appropriate to use either the log-logit or 4-parameter fit. Both fits are based on the equation:

\[ y = \frac{A - D}{1 + \left(\frac{x}{C}\right)^B} + D \]

where D is the Y-value corresponding to the asymptote (i.e., the flat part of the curve) at high values of the X-axis and A is the Y-value corresponding to the asymptote at low values of the X-axis. The coefficient C is the X-value corresponding to the midpoint between A and D. The coefficient B describes how rapidly the curve makes its transition from the asymptotes in the center of the curve. A large value of B describes a sharper transition. Typically, B has a magnitude of about 1.

Both the log-logit and 4-parameter equations are shown on the screen as:

\[ y = \frac{(A - D)}{(1 + (x / C)^B)} + D \]

![Graph with 4-Parameter Fit](image)

**Figure 7.47: Graph with 4-Parameter Fit**
Some publications show the log-logit equation in another form:

$$\log_{10} \frac{y}{1-y} = b x - b \log_{10} c$$

where

$$y = \frac{y - A}{D - A} \quad x = \log_{10} x$$

A different algebraic expression of these is:

$$y = \frac{A - D}{1 - (x/C)^B} + D$$

The difference between the log-logit fit and the 4-parameter fit are in the way the coefficients A and D are calculated. For the log-logit method, the standard values for the lowest and highest values of x are used. The corresponding y values are assigned to A and D, respectively. Based on these fixed values for A and D, the algorithm then computes values for B and C. This technique works well if there are standard points along the upper and lower asymptotes. If this is not true, the log-logit fit should be avoided in favor of the 4-parameter logistic.

In SoftMax Pro 2.x, the 4-parameter logistic curve fit uses 2000 iterations. If the fit does not converge in this number of iterations, the program will report a fit error.

Point-to-Point

A linear equation is fit to each pair of data points. Fit parameters are not given. The point-to-point curve fit is a linear fit composed of pieces that assume a linear relationship between each pair of data points. The line segment defined by each pair is used to interpolate data between those points. Since there are multiple line segments, fit parameters are not shown on the graph.

*Figure 7.49: Graph with Point-to-Point Fit*
Cubic Spline
This curve fit generates a fit to a cubic equation between each pair of data points. The general form of a cubic equation is:

\[ y = A + Bx + Cx^2 + Dx^3 \]

The equations are computed with the requirement that the first and second derivatives of the equations are continuous throughout the range of the data. As multiple curve fits are performed with this routine, fit parameters are not shown with the graph.

**Figure 7.50: Graph with Cubic Spline Fit**

![Graph with Cubic Spline Fit](image)
Exponential

The exponential function used to generate this curve fit is:

\[ y = A + B \times (1 - \exp(-x / C)) \]

**Figure 7.51: Graph with Exponential Fit**

**NOTE:** SoftMax Pro does not plot samples with descriptor values of zero (0) on a log axis. Curve fits affected by this are the semi-log, log-log, log-logit, and 4-parameter curve fits.
**Minimum Number of Standards**

The number of standards used in a standard curve depends on the particular curve fit selected and on the judgment of the operator. The table below gives the minimum number of standards required mathematically by each of the curve fitting algorithms.

**Table 7.4: Minimum Number of Standards Required for Curve Fits**

<table>
<thead>
<tr>
<th>Curve</th>
<th>Minimum Number of Standards</th>
</tr>
</thead>
<tbody>
<tr>
<td>Linear</td>
<td>2</td>
</tr>
<tr>
<td>Quadratic</td>
<td>3</td>
</tr>
<tr>
<td>Semi-Log</td>
<td>2</td>
</tr>
<tr>
<td>Log-Log</td>
<td>2</td>
</tr>
<tr>
<td>Log-Logit</td>
<td>4</td>
</tr>
<tr>
<td>4-Parameter</td>
<td>4</td>
</tr>
<tr>
<td>Point-to-Point</td>
<td>2</td>
</tr>
<tr>
<td>Exponential</td>
<td>3</td>
</tr>
<tr>
<td>Cubic Spline</td>
<td>4</td>
</tr>
</tbody>
</table>

For optimal results, you should always exceed the minimum number of standards required for any given fit.

There are other requirements on the standards for the log-logit and 4-parameter logistic curves. The fits for the 4-parameter logistic curve are based on the assumption that the curve has a high and a low asymptote and a certain “steepness” for the linear portion around the inflection point between the asymptotes. If a sufficient number of points do not define the inflection point and the asymptotes, you will receive a “no fit” error message or an inappropriate fit. For best results, make sure that the 4-parameter fit is appropriate for your assay and that the entire range of the assay is represented in your standards.

If your standards do not clearly define both a high and low asymptote, the spline fit may be more appropriate for your assay.

**Judging a Good Curve Fit**

The correlation coefficient is also known as the goodness of fit value because it shows how good a fit exists between the computer curve and the standard data points. It measures the degree to which the points fall on the computer curve and may give an indication as to what residuals are to be expected. The correlation coefficient is popularly known as R and is between -1 and 1, inclusive. When the data points lie on a perfectly straight line with negative slope, then R = -1. If the correlation coefficient is not suitably close to 1 or -1 (a perfect fit), you can simply apply one of the other types of curves without having to reread the plate or cuvette.

For nonlinear curve fits, SoftMax Pro performs transformations that cause the curve to become more linear. The correlation coefficients are derived from
that transformed data. Because of this, you should be cautious about using correlation coefficients as an indicator of goodness of fit. Do not let this single value for goodness of fit sway your intuition about which fit is best. Some curve fits may seemingly give a good fit (e.g., fit values close to 1) but, when inspected by eye, show a poor fit along a major portion of the plot.

**Graph Options**

Graphs can be customized further through the Graph Options dialog box which is accessed by choosing **Graph Type...** from the **Graph** menu or by clicking the Graph button ( ).

### Figure 7.52: Graph Options Dialog Box

The default options are shown in Figure 7.52, but you can alter these as desired: you may change the font and type size used for the title, legend, and / or axes of the graph, and you can choose the color and type of symbol used on a scatter graph to show the plot. The graphs shown in preceding Figures reflect the default graph options. Connecting the points of a scatter graph can be useful in determining the closeness of the fit. Figure 7.53, below, shows a scatter graph with points connected compared to a linear fit.

**NOTE:** The Connect Points option connects the points in order of appearance by sample name—not the appearance of points from left to right on the graph.
Figure 7.53: Scatter Graph with Points Connected (Linear Fit Applied)

Other options in this dialog box allow you to plot the data as a bar graph with data shown in clusters or stacked. Figure 7.54 shows both of these bar graph options.

Figure 7.54: Bar Graphs — Cluster and Stack

**NOTE**: Bar graph options for *multiple plot graphs* are only available when each plot contains the same number of data points and has matching X-axis coordinates.

**NOTE**: When choosing the Connect Points option, the order in which points are connected is sample name dependent.
Chapter 7: Displaying and Analyzing Data Using Absorbance Instruments

Axes Options

Double-clicking either graph axis, clicking the X-axis or Y-axis button in the Graph section toolbar, or selecting either X-axis... or Y-axis... from the Graph menu opens a dialog box concerning the configuration of that axis. Figure 7.55 shows the dialog box for the X-axis.

![X-Axis Dialog Box]

The default settings are shown in the Figure above. You can change these as desired for either or both axes.

Axis Settings

Enabling the Auto-range option causes the graph to be drawn such that all data points are shown (by automatically adjusting the minimum and maximum range settings to encompass the data). You can disable the Auto-range function by clicking the checkbox or by changing either or both values for the Min and/or Max settings.

Formulas in SoftMax Pro

You can enter custom calculations in several places within SoftMax Pro to provide the information you desire:

- In Plate and CuvetteSet sections, you can specify formulas to be used for wavelength reduction and Kinetic/Spectrum reductions.
- In the Group table sections, you can view and edit the formulas associated with the various columns or create new columns containing new formulas. The data shown in columns from one group can relate to or contain information derived from columns in another group. You can also create summaries which consist of formulas and text.
- Notes sections allow you to enter summaries which consist of formulas and related text.

Use of formulas in SoftMax Pro is described in a separate manual, The SoftMax Pro Formula Guide.
Chapter 8: Displaying and Analyzing Data Using Fluorescence or Luminescence Instruments

Introduction .........................................................8-3
Initial Data Display and Reduction ...............................8-4
The Data Display ..................................................8-5
  The Display Dialog Box .......................................8-6
  Graphing Wells .................................................8-14
  Masking Wells ..................................................8-18
Data Reduction ..................................................8-19
  Endpoint .........................................................8-21
  Kinetic ..........................................................8-21
  Spectrum .........................................................8-29
  Well Scan .......................................................8-30
  FLEX ............................................................8-31
  Custom Reduction Formulas .................................8-35
  Recalculation Options ......................................8-37
Displaying Data in Group, Graph, and Notes Sections ....8-38
  Group Sections ................................................8-38
  Notes Sections ...............................................8-45
  Graph Section ................................................8-45
Formulas in SoftMax Pro .......................................8-64
Introduction

Initial display and reduction of the data received from the FlexStation instrument is performed in the Plate section in which the data has been collected. Display and reduction parameters can be set up either prior to or after collecting data. The display and reduction parameters may be modified at any time. Data analysis and the display of analyzed data is also performed in the Group sections (created when wells are assigned to groups in the Template Editor) and the Graph section(s).

Notes sections may be used in conjunction with any other section to provide text commentary and/or a summation of data through the use of summaries. Notes sections are used most commonly to provide an introduction to or summary of results for a data file.

All data files have a minimum of one Plate section with data in it. Multiple Plate sections may be present. Most files will have a template and Group, Graph, and Notes sections. However, depending upon the particular assay and how you wish to report the data, only some of these sections may be (or need to be) present in every file. For example, some simple assays allow you to calculate concentration in the Plate sections. In such cases, Group and Graph sections are necessary only if you wish to display the data graphically.

The following diagram shows the relationship between the different sections in SoftMax Pro:

![Diagram showing the relationship between different sections in SoftMax Pro]

**Figure 8.1: Relationship of Sections**

This chapter discusses the initial display and reduction of data in the Plate section first, followed by display and data analysis in the Group, Graph, and Notes sections.
Initial Data Display and Reduction

The manner in which data is displayed in a Plate section depends on the type of reading that was performed (Endpoint, Kinetic, Spectrum, Well Scan, or FLEX), but can be customized by choices made in the data display and reduction settings. Depending on the type of reading performed, display options include:

- Number or plot displays for raw RFU (relative fluorescence units) or RLU (relative luminescence units), depending on which was chosen as a read type, with or without reduced number. With the SpectraMax Gemini and Gemini XS, you also have the option to view raw data in 1000s (e.g., “20,000” would be shown as “20” to make numbers in wells more easily visible).

**NOTE:** The number format (use of commas or periods in numeric notation) chosen for the computer operating system in general is reflected in the way that SoftMax Pro displays data.

- Number, Plot, Threshold, Ranged, or Grayscale (with or without reduced number)

- If you have chosen 384-well plates from the Instrument Settings, you can display the wells in different ways: Normal, Vertical, Rotated, Large, or Interleaved.

- When FLEX mode is selected, the Reduction dialog box will show all of the settings included for Kinetic mode but with the minimum kinetic interval of less than one second and have the settings for the fluidic (pipetting) events. With FLEX mode, the Reduction dialog box also includes a section titled Display Options which includes settings for “Absolute,” “Zero Baseline,” and “Percent Increase.” These options are discussed in detail later in this chapter.

Default displays are shown automatically unless you choose a different display option.

Reduction options allow you to display the raw data received from fluorescence instruments in a reduced (analyzed) form. Which reduction options are available depend on the read mode and read type used; custom settings, using formulas you create, are available for all read modes and read types.

Reduction settings do not affect the raw data but simply cause it to be displayed differently, so you may change reduction settings without affecting the raw data in any way.

Custom reduction formulas require the use of accessors and operators that are understood by SoftMax Pro. A list of such accessors and operators can be found in The Formula Reference Guide.
The Data Display

After a plate has been read, the information sent from the fluorescence instrument is shown in the data display in the active Plate section. The default display for data from Endpoint readings raw RFU/RLU numeric values. Data from Kinetic, Spectrum, Well Scan, or FLEX readings is displayed in plots format (raw RFU/RLU values with respect to time or wavelength) and the display updates dynamically to show the data collected so far. If the instrument is reading more than one wavelength, plots for the different wavelengths are overlaid in each well.

All choices except those defined in the Instrument Settings affect only the manner in which the data is displayed—the raw data is not changed—permitting you to optimize the display after data is collected.

NOTE: Data reduction changes the way in which data is displayed and also affects the values used in calculations within SoftMax Pro. While the raw values remain unchanged, calculations will use reduced values, if any, and are, therefore, affected by settings chosen in the Reduction dialog box. For more information, see “Data Reduction” on page 8-19.

NOTE: Data comes from the instrument to SoftMax Pro with four digits to the right of the decimal point. Only three of the four digits are displayed in the Plate section for Endpoint data, however: the fourth digit is rounded up or down (0.0045 rounds up to 0.005; 0.0044 rounds down to 0.004, for example). You can view all four digits of data, if desired, by displaying the raw values in a Group section table and increasing the number of decimal places showing.
The Display Dialog Box

Before or after a plate has been read, you can click the [Display] button to open the Display dialog box which allows you to change the way the data is presented. Choices available in this dialog box depend on whether a Plate section is currently active and which read mode you have chosen (for example, the choice for “Plots” is not shown if Endpoint mode is selected). Figure 8.2 shows the default Display dialog boxes for the different read modes.

The Display dialog box is divided into two parts (left and right): the default display, “Raw RFU” or “Raw RLU,” is shown to the left of a dividing line; the choices for reduced data displays are shown to the right of the dividing line. Note: data reduction itself is performed separately; settings here simply determine how the reduced data will be displayed in the Plate section.

The dialog boxes below show the default display choices for the three modes:

- Raw fluorescence or luminescence values (numbers) for Endpoint;
- The change in raw RFU/RLU values over time for Kinetic;
- Raw RFU/RLU values for the range of wavelengths, displayed as a plot, for Spectrum;
- Raw RFU/RLU values as shades of gray for Well Scan;
- The change in raw RFU/RLU values over time for FlexStation.

Other choices available in this dialog box include displaying the data as a single reduced value (number), in threshold, ranged, or gray scale formats, or any combination of display choices with the reduced number (the reduced number display choice cannot be used with the reduced number checkbox).
Figure 8.2: Plate Section: Endpoint, Kinetic, Spectrum, Well Scan, and FlexStation Display Dialog Boxes.
Data in the Plate section is displayed in a grid array (microplate format). With all plates other than 384-well plates, the display is always shown as a standard microplate, with well A1 in the top left corner. If you are reading 384-well plates, additional display options can be chosen (see Figure 8.3) to make the display of data more clear:

- Normal: shows the data in standard left-to-right format, with well A1 in the upper left corner. Columns 1 through 24 are along the top and rows A through P are shown from top to bottom. The wells are smaller and data is shown with fewer digits (less precision).
- Vertical: the plate is shown in the same orientation as Normal except that columns 1 through 12 (all rows) are shown above columns 13 through 24 (all rows).
- Rotated: Same as the Normal view except that it is rotated 90 degrees clockwise (well A1 is in the upper right corner).
- Large: Same as the Normal view except larger. This display can be seen in its entirety only if you have the page size set for legal paper (8.5 x 14 inches) in landscape orientation (set this in Page Setup or Preferences under the File menu). In the example in Figure 8.3, the display is shown as it appears if you do not change the page size from letter-size to legal.
- Interleaved: In this display, the wells are shown in a format that “skips” every other well as follows: all odd columns and rows begin in the upper left corner of the plate display and are followed by all even columns and rows. So well A1 is still in the upper left corner, but it is followed horizontally by well A3, A5, ... A23, A2, A4, etc., and vertically by well C1, E1, ... O1, B1, D1, etc. This display is most useful when the 384-well plate is composed of 4 daughter plates of 96 wells each.

Figure 8.4 shows the default displays for Endpoint, Kinetic, and Spectrum modes. The default display for Endpoint mode is the raw fluorescence/luminescence. For Kinetic, Spectrum, and FLEX modes, the default display is raw RFU/RLU shown in plot format: RFU/RLU vs. time for Kinetic and fluidics, and RFU/RLU vs. wavelength for Spectrum scans. Well scan data defaults to a display as shades of gray.

**Reduced Number**

The reduced number is based on the settings defined in the Reduction dialog box. It is a combination of plate blank subtraction in the Plate section, wavelength reduction, and either a Spectrum or Well scan, or a Kinetic or FLEX reduction. The information acquired from the instrument is reduced to a single number or value. The reduced number will be reported in the Group section when a template has been defined.

To view by reduced number alone, select the Number option (the first choice to the right of the default, just after the dividing line); to see a reduced number as well as another type of display, click the box next to the option that says “With reduced number” in the lower left of the dialog box to enable it. Changing the reduction parameters after choosing a reduced data display mode will cause the display to update accordingly. More information about reduction formulas and how to customize them follows later in this chapter.
Figure 8.3: Choices for a 384-Well Plate Display: Normal, Vertical, Rotated, Large, and Interleaved
Figure 8.4: Default Displays for a Plate Section
**Threshold, Ranged, and Gray Scale**

To display Threshold, Ranged, or Gray Scale data, high and low values must be entered. When you choose one of these display options, SoftMax Pro provides default values for the high and low limits by means of an autoranging function (encompassing all the data from lowest to highest value). You can change the high and low limits by highlighting the existing value and entering a new value. An example of the Display dialog box for a Kinetic reading (Plate section) with the Threshold display option chosen is shown in Figure 8.5.

![Display Dialog Box for Kinetic Threshold Display](image)

**Figure 8.5: Display Dialog Box for Kinetic Threshold Display**

**Threshold**

The Threshold display shows the raw data as a plus (+) for values above the high limit, an asterisk (*) for values within the limits, and a minus (-) for values below the low limit. Figure 8.6 shows an Endpoint reading displayed using the Threshold option along with the reduced number.
Figure 8.6: Kinetic Data Displayed as Threshold with Reduced Number

**Ranged**

When the **Ranged** display is chosen, raw data that falls between the high and low limits is assigned proportionally to integer values from 0 through 9. Values above the high limit are displayed as a plus (+) and values below the low limit are displayed as a minus (-). Figure 8.7 shows reduced Kinetic data displayed in Ranged format.
### Figure 8.7: Kinetic Data (Reduced) Displayed as Ranged

<table>
<thead>
<tr>
<th>Well</th>
<th>1</th>
<th>2</th>
<th>3</th>
<th>4</th>
<th>5</th>
<th>6</th>
<th>7</th>
<th>8</th>
<th>9</th>
<th>10</th>
<th>11</th>
<th>12</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>-</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>2</td>
<td>2</td>
<td>3</td>
</tr>
<tr>
<td>B</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>2</td>
<td>2</td>
<td>3</td>
<td>3</td>
<td>4</td>
</tr>
<tr>
<td>C</td>
<td>0</td>
<td>0</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>2</td>
<td>2</td>
<td>3</td>
<td>3</td>
<td>4</td>
<td>4</td>
<td>5</td>
</tr>
<tr>
<td>D</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>2</td>
<td>2</td>
<td>3</td>
<td>3</td>
<td>4</td>
<td>5</td>
<td>6</td>
<td>6</td>
<td>6</td>
</tr>
<tr>
<td>E</td>
<td>1</td>
<td>2</td>
<td>2</td>
<td>3</td>
<td>3</td>
<td>4</td>
<td>4</td>
<td>5</td>
<td>6</td>
<td>6</td>
<td>7</td>
<td>8</td>
</tr>
<tr>
<td>F</td>
<td>2</td>
<td>3</td>
<td>3</td>
<td>4</td>
<td>4</td>
<td>5</td>
<td>6</td>
<td>6</td>
<td>7</td>
<td>7</td>
<td>7</td>
<td>7</td>
</tr>
<tr>
<td>G</td>
<td>3</td>
<td>4</td>
<td>4</td>
<td>5</td>
<td>6</td>
<td>6</td>
<td>6</td>
<td>7</td>
<td>8</td>
<td>8</td>
<td>8</td>
<td>8</td>
</tr>
<tr>
<td>H</td>
<td>4</td>
<td>5</td>
<td>6</td>
<td>6</td>
<td>6</td>
<td>7</td>
<td>7</td>
<td>8</td>
<td>8</td>
<td>9</td>
<td>9</td>
<td>+</td>
</tr>
</tbody>
</table>

**Wavelength Combination:** Lm1

**Kinetics**
- **Time:** 8:00
- **Interval:** 0:20
- **Reads:** 14

**Fluorescence**
- **Excitation:** 485 nm
- **Emission:** 530 nm

**Auto-Calc**

**Reads/Well:** 6

**Log Time:** 0:00
- **End Time:** 0:00
- **RFU Min:** 0
- **RFU Max:** 20000
- **Vinmax:** 14/14

**Rate Last Read:** 4:23 PM 2/5/2001

- < 0.7  0 < 14  1 < 20  2 < 25  3 < 31  4 < 37
- 5 < 45  6 < 48  7 < 54  8 < 60  9 <= 65  + > 85
Chapter 8: Displaying and Analyzing Data Using Fluorescence or Luminescence Instruments

Gray Scale
The Gray Scale option presents the raw data in eight shades of gray, changing from light (for values less than or equal to the low limit) to dark (for values greater than or equal to the high limit). Figure 8.8 shows reduced Endpoint data displayed as Gray Scale.

Graphing Wells

You can enlarge the display of the wells shown with Kinetic, Spectrum, Well Scan, or FLEX modes to get a close-up view of the data. This is done by either double-clicking the particular well in the data display or by selecting the well and then clicking the Well Graph button in the Plate section tool bar.

Kinetic, Spectrum, and FLEX Well Graphs
Well Graphs plot the data for the individual wells in a microplate and show the well ID and reduction information, including the goodness of fit (R^2 value), if appropriate. The default display for the X-axis shows time for Kinetic and FLEX plots and wavelength for Spectrum plots.

Positioning the cursor within a Well Graph shows X and Y values for the cursor location, allowing you to determine more precisely the location of data points.

Well Scan Well Graphs
Well Graphs in Well Scan mode default to displaying raw data in a grayscale plot. The manner in which the data is displayed in a Well Graph for a Well Scan depends on the reduction options that have been chosen, the display options (raw or reduced, for example), the number of points read, and whether the Well Graph is scaled to the data or to the limits of the entire plate.
Well Graph Options

Along the bottom of each Well Graph dialog box are eight buttons (five when using Well Scan mode) that perform the following functions:

- **Print**
  Opens the Print dialog box.

- **Reduction**
  Opens the Reduction dialog box.
  By default, the ranges on the enlarged plot are set to the limits defined in the Reduction dialog box, and the information included near the bottom of the window is based on the reduction settings currently in use. You may change these settings (wavelength combination and type of reduction used, minimum and maximum value limits, lag time and end time, and number of Vmax Points). More information about the reduction options can be found later in this chapter.

**NOTE:** Changes to the reduction settings made within well graphs will be applied to all wells in the Plate section. When viewing Raw data, you can scale the graph to see data outside the reduction limits [line(s) are included on the graph indicating the limits and the area outside of them will be shaded slightly]. This view should assist you in determining the best limits for the reduced data.

- **Show Raw/Show Reduced button**
  This button toggles the Well Graph between views of raw and reduced data. When the Well Graph is opened, the initial view depends on the Display settings for the Plate section. If raw data is being displayed in the Plate, the initial view in the Well Graph will be raw data and the button will be set to “Show Reduced.” If reduced data is being displayed in the Plate section, the initial view in the Well Graph will be reduced data and the button will be set to “Show Raw.”

- **Scale to Data/Scale to Limits button**
  This button toggles between a view of the data within the reduction limits and a view of the entire data set. Switching between these views helps to visualize how the limit settings affect data reduction. If raw data is being viewed in the Plate section, the display in the Well Graph is set initially to show the plot scaled to the reduction limits. If reduced data is being viewed in the Plate section, the Well Graph display is set initially to show the plot scaled to the data.

**NOTE:** If you are viewing raw data and click the **Scale to Limits** or the **Scale to Data** button, only the display of raw data in the Well Graph will be affected (the button will not affect the view of reduced data). The same is true if you click this button while viewing reduced data. To produce comparable scaling of both raw and reduced displays, this button must be set to either Scale to Limits or Scale to Data for both raw and reduced views of the Well Graph.
• **Graph Options button** *(not found in Well Scan mode)*
  Opens the Well Graph Options dialog box which allows you to enable or disable connected points or plotted symbols the graph.

![Graph Options Dialog](image)

*Figure 8.9: Graph Options Dialog*

• **X-Axis Settings button** *(not found in Well Scan mode)*
• **Y-Axis Settings button** *(not found in Well Scan mode)*

Opens the Well Graph Axis Settings dialog box for the particular axis, allowing you to set Auto Range parameters, choose the minimum and maximum values for the selected axis, cause the axis to be auto-ranged, add or remove gridlines, and add or remove axis tick marks. When a Well Graph is opened, the default settings are to show the reduction limits for that axis with Auto Ranging off and gridlines and tick marks selected. Only the Well Graph being viewed is affected by changes in these dialog boxes.

• **[Done]**
  Closes the Well Graph dialog box.

![Well Graph](image)

*Figure 8.10: Well Graph for a Single Kinetic Microplate Well (Raw Data)*

Multiple wells from the same Plate section can be graphed together in one enlarged window. Select the well(s) in the data display (hold the Shift key if you are selecting non-contiguous wells; you can drag across contiguous...
wells) and then click the Graph button or double-click in one of the selected wells.

Figure 8.11: Well Graph for Three Kinetic Wells of a Microplate (Raw Data)

The choices you make for viewing the data in the Plate section also affect the way the Well Graph appears. Figures 8.10 and 8.11 show Well Graphs for raw data displays. If you display one of the reduced options (reduced number, Threshold, Ranged, or Gray Scale), the Well Graph will show the plot with an indicator of the reduced value and will include the word “Reduced” in the window title.

Zoom Box

You can enlarge the Well Graph even further by clicking the zoom box in the upper right-hand corner of the window (the center box of three in the upper right corner in Windows). Clicking the zoom box once will cause the window to fill the total display on your monitor; clicking the zoom box again will return the window to its previous size.

Size Box

Clicking and dragging the size box located in the lower-right corner (Macintosh) or clicking and dragging the lower right corner of the window (Windows) allows you to make the Well Graph any size desired.

Printing the Well Graph

You can print the Well Graph window, if desired, by clicking the [Print] button at the bottom left corner of the dialog box.

NOTE: If you enlarge the Well Graph to greater than 12 inches, the graph will not fit on an 8.5- by 11-inch page and the printout will be truncated.
Masking Wells

If you find data in certain wells (outliers) that should be excluded from the calculations to be performed by data reduction, you can mask these wells. Select the well(s) to be masked and then click the Mask button in the Plate section tool bar or choose Mask... from the Plate menu. Masked wells are shown with an overlay of diagonal lines.

The masking function can be used as a “what if?” tool. For example, you could suppress or enable certain functional groups within the experiment. Suppose you have included a group blank in the template and want to see the data with and without the blank. Masking the group blank wells would suppress the blanking function; unmasking them would enable it again.

Figure 8.12: Masked Wells in a Plate Section

To remove masking from one or more wells, highlight the masked well(s) and click the Mask button in the Plate section tool bar (toggles masking on and off) or choose Mask... from the Plate menu again. The diagonal lines covering those wells (and masking function) will be removed.
Data Reduction

Raw data received from the fluorescence instruments can be displayed in an analyzed (or reduced) form. The reduction process within SoftMax Pro is based on formulas that reduce the raw data to show a single number for each well. Further analysis of this reduced number then takes place in the Group and Graph sections.

SoftMax Pro performs calculations hierarchically when reducing the information collected from the instrument. Calculations in the Plate section are performed in the order shown below. If an option has either not been selected in the Instrument Settings dialog box, is not available for the instrument you are using, or has not been defined in the template and/or Reduction dialog box, SoftMax Pro starts/continues with the next listed calculation.

1) Wavelength reduction
2) Kinetic or Spectrum reduction
3) Group blank subtraction

You can access the Reduction dialog box in several ways: by clicking the Reduction button in the tool bar of the active plate section, by choosing Reduction from the Plate menu, or by clicking the Reduction button in the Well Graph display. The appearance of the Reduction dialog box will be different depending on the type of read mode you have chosen, and the options you have chosen in the Instrument Settings dialog box. Figure 8.13 shows the Reduction dialog boxes for a Plate section in Endpoint, Kinetic, Spectrum, Well Scan, and FLEX modes, along with the default reductions for each of those modes.
Figure 8.13: Reduction Dialog Boxes for All Modes.
All of the read modes offer one or more predefined choices for reduction. The predefined reductions are described below under the appropriate read mode heading. In addition, with any read mode, you can create a custom reduction formula to better suit your needs. Since all custom reduction formulas are defined the same way, regardless of read mode, they are described together after the individual read mode sections.

**Endpoint**

**Wavelength Combination**

The default reductions for Endpoint readings are !Lm1 and Custom for all fluorescence instruments when you read at a single wavelength. Additional wavelength combinations become available depending on the number of wavelengths chosen. You can choose Custom and create different reduction formulas. The wavelength combinations available in the drop-down menu show the correct format of the formulas that produce these reductions.

**Kinetic**

**Wavelength Combination**

The default wavelength combination for Kinetic readings is !Lm1. Other selections depend on the number of wavelengths chosen (for example, if you will read at two wavelengths, choices default to !Lm1 and !Lm2, along with Custom). If you do not wish to use the default reduction, you can choose Custom and create a different reduction formula.

**Kinetic Limits**

The Limits settings for the display of Kinetic data are MaxRFU/RLU, MinRFU/RLU, Lag Time, and End Time.

**NOTE:** The display of RFU/RLU values is shown relative to the first point measured for each well. Negative Kinetic values decrease with time, and limits should be set accordingly (below 0) to view negative Kinetic data. Limits define the data that will be viewed and included in data reduction, but do not affect data collection. If you alter a limit to show less data, you can always display the “hidden” data again by changing the limit.

**MaxRFU/MaxRLU**

The limit for the maximum value you wish to report. Any values from the reading that are above this limit will not be shown and will be excluded from data reduction. The default is 20,000 for RFU/RLU.

The MaxRFU/RLU reduction parameter can be used to exclude the non-linear portion of the reaction from data analysis. This type of data reduction is most useful in reactions where the initial portion of the data is linear. You might also adjust the End Time setting to remove a non-linear portion after a certain time point in the reaction. Using MaxRFU/RLU allows the use of the maximum number of linear points to calculate the slope of the line and, thus, to determine the rate for each well.
Both of the Well Graphs shown above display different reductions of the same Kinetic data. In the figure on the top, the MaxRFU is set to 20,000 for the display of wells C4, D6, and E6. In the figure on the bottom, the MaxRFU has been reset to 10,000. Alternatively, you could leave the Maximum RFU and change the number of Vmax Points used to determine the slope of the line.

**MinRFU/MinRLU**

The limit for the minimum value you wish to report. Any values from the reading that are under this limit will not be shown and will be excluded from data reduction. The default is 0 RFU/RLU. To display negative Kinetics, the value should be set below 0 (zero).
Lag Time
Specifies how many initial data points are excluded from the calculation of Vmax Rate. Lag Time truncates the data used in the calculation. It does not prevent data from being collected. The Kinetic plots will not display the data collected prior to the set Lag Time. The value for Lag Time can be changed after the plate is read. The default is 0.

![Figure 8.15: Different Lag Time Settings](image)

In the figure on the top left, well C5 has a lag time: the data is not linear until approximately 80 seconds after the start of data collection. Thus, the linear curve fit is not good and the slope of the line does not reflect the maximal rate. In the figure on the bottom right, a lag time of 80 seconds has been set and the linear curve fit for both wells is good, allowing the slope of the lines to reflect the maximal rate in each well. Alternatively, you could leave the Lag Time and decrease the number of Vmax Points used to determine the slope of the line.

End Time
This setting specifies the time at which you wish to stop showing data in the display. Any values occurring after this limit will not be reported in the display. The default setting is the total assay time. The value for end time may not be greater than the total assay time.
Absolute Values
This setting causes the plots shown in the data display to be drawn at their absolute RFU/RLU as opposed to the default (with the box unchecked) which offsets the first point to the (0,0) coordinate. Enabling Absolute Values may cause some data points that do not fall within the default limits for the plots to “disappear” (see Figure 8.16).

Figure 8.16: Kinetic Reduction with Absolute Values Enabled
Note that the limits in this example (MinRFU=0, MaxRFU=10,000) do not allow all of the data to be visible.

To see more data, yet still display absolute values, enlarge the limits for MinRFU/RLU and/or MaxRFU/RLU found in the Reduction dialog box (Figure 8.17).
If you increase the MaxRFU/RLU setting to be at least as large as the largest fluorescence/luminescence value expected, most or all of the data plots should appear in the data display. In the example shown in Figure 8.16, if the MaxRLU value is increased from 10,000 to 20,000, the plots then appear as shown in Figure 8.18.
**Kinetic Reduction**

Kinetic reductions are applied to the list of numbers (the value at each time-point) after the wavelength combination formula is applied. Vmax per min and Vmax per sec reductions are available for all instruments that are capable of Kinetics; the default Kinetic reduction is Vmax (units per sec). Other reductions available from the pop-up menu are Time to Vmax, Onset Time, Time at Minimum, Time at Maximum, Time at 1/2 Maximum, Slope, Area Under Curve, or you can choose Custom and then create a different reduction formula.

**Vmax**

The maximum slope of the Kinetic plot of relative fluorescence/luminescence units versus time. The default value displayed is in relative fluorescence units (RFU) per second or relative luminescence units (RLU) per second. The rate is calculated with the use of Vmax Points (see below) which determines the number of contiguous points over which Vmax is calculated. The number of Vmax Points defaults to the maximum taken during the reading for all instruments except the FlexStation which defaults to 5 points. You can change this number in the Reduction dialog box.

**NOTE:**  
Vmax = Vmax/sec \* 60,000

A linear regression is performed to determine the slope of the line using the equation:

\[ y = m \* X + B \]

where m is the slope of the line.

The reaction rate is reported in RFU/RLU units/sec.

**Vmax Points**

This setting defines the maximum size of the line segment used to determine the slope of the line used in calculating the rate of the reaction. The default is the total number of points taken in the reading, with the data normalized to a starting point of 0,0 (as opposed to starting with the first time point). The first slope is calculated for a line drawn beginning at the first reading as defined by Lag Time (described below) and ending at a total number of readings equal to the Vmax Points setting. The second and any subsequent slopes are calculated beginning at the second time point and ending at a total number of readings equal to Vmax Points. The steepest slope is reported as Vmax Rate. If the data plot displays fewer time points (data points) than the number of time points chosen for Vmax Points, then all of the time points will be used to determine the slope of the data.
**Table 8.1: Using Vmax Points (Example)**

<table>
<thead>
<tr>
<th></th>
<th>Well 1</th>
<th>Well 2</th>
<th>Well 3</th>
</tr>
</thead>
<tbody>
<tr>
<td>Time points visible in the well (data plot)</td>
<td>25</td>
<td>10</td>
<td>2</td>
</tr>
<tr>
<td>Number of Points Used for Data Analysis:</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Vmax Points set to 25/25 (default)</td>
<td>25</td>
<td>10</td>
<td>2</td>
</tr>
<tr>
<td>Vmax Points set to 5/25</td>
<td>Overlapping 5-point line segments*</td>
<td>Overlapping 5-point line segments*</td>
<td>2</td>
</tr>
</tbody>
</table>

* SoftMax Pro will perform a linear regression on as many overlapping 5-point line segments as possible in the analysis window. The slope will be determined for each line segment and then the steepest slope will be reported as the reaction rate. Thus, in well 2 of the example in Table 8.1, above, the slope will be determined for line segments consisting of time points 1 to 5, 2 to 6, 3 to 7, 4 to 8, 5 to 9, and 6 to 10, and then the slope of the line segment with the steepest slope will be reported as the Vmax Rate.

The progressive slope calculations are repeated until the last included data point is reached (as defined by the End Time or MaxRFU/MaxRLU — see below). The maximum positive or negative slope is reported as Vmax (RFU/sec or RLU/sec). Vmax Points can be set from 2 to the total number of points in the curve. The number of Vmax Points can be set before the plate is read and can be changed after the plate is read. The data display will update automatically each time. The Vmax Points setting does not affect data collection.

**NOTE:** The height of the Y axis in the raw data plots or plate display is controlled using MinRFU/RLU and MaxRFU/RLU. The default settings are:
- MinRFU/RLU = 0
- MaxRFU/RLU = 20,000

The width of the X-axis in the raw data plots or plate display is controlled using Lag Time and End Time. If either the MaxRFU/RLU or End Time setting excludes points such that a total number of readings equal to Vmax Points cannot be used, then the maximum included points will be used.

**Time to Vmax**

This is an alternative method for analyzing non-linear Kinetic readings that reports the elapsed time until the maximum reaction rate is reached, rather than reporting the maximum rate itself. Used in conjunction with Vmax Points, Time to Vmax is the time to the midpoint of the line defined by Vmax Points and used to calculate Vmax. This elapsed time data is useful for applications including coagulation chemistry where the changing concentration of the reagents does not change Vmax, but rather will change the time at which the reaction reaches the maximum rate.
**Onset Time**
This is another method for analyzing non-linear Kinetic readings. Onset Time reports the time required for a Kinetic reaction to change by a specified amount (onset RFU/RLU above the initial RFU/RLU reading for the well). This elapsed time data is useful for cascade reactions including clot formation (endotoxin testing, for example) or clot lysis applications where the change in reagent concentration does not affect the maximum optical density change but changes the time required for the reaction to reach completion.

**Time at Minimum**
This setting reports the time at the minimum RFU or RLU that falls within the reduction limits.

**Time at Maximum**
This setting reports the time at the maximum RFU or RLU that falls within the reduction limits.

**Time at 1/2 Maximum**
This setting reports the time at the half of the maximum RFU or RLU that falls within the reduction limits. To calculate this reduction, SoftMax Pro first determines the point (within the reduction limits) that has the maximum signal level (RFU or RLU). It then scans the plot from left to right until it finds two points having signals that bracket half of that value. A linear interpolation between these two points is used to estimate the Time at 1/2 Maximum.

**Slope**
This setting determines the slope of the combined plot (i.e., the slope of the line using linear regression after the wavelength combination reduction). This setting uses all visible timepoints in the reduction window. Slope is the same as Vmax Rate when Vmax Rate is set to the same number of points as the run (i.e., the default). Slope is not the same as Vmax Rate if you have modified the Vmax Points.

**Area Under Curve**
This reduction estimates the area under the curve as defined by the data plots in wells (within the reduction limits). The data plots are treated as a series of trapezoids with vertices at successive data points and at the X-axis coordinates of the data points. The areas defined by each of the trapezoids are then computed and summed.

**Absolute Values**
Choosing this option shows the raw data without any smoothing or other changes in the way it is graphed.
Chapter 8: Displaying and Analyzing Data Using Fluorescence or Luminescence Instruments

Spectrum

Spectrum Limits

The Limits settings for the display of Spectrum data are MaxRFU/RLU, MinRFU/RLU, Starting Wavelength in RFU/RLU, and Ending Wavelength in RFU/RLU.

- **NOTE:** The display of values is shown relative to the first point measured for each well. Limits define the data that will be *viewed and included in data reduction*, but do not affect data collection. If you alter a limit to show less data, you can always display the “hidden” data again by changing the limit.

MinRFU/MinRLU

The limit for the minimum value you wish to report. Any values from the reading that are under this limit will not be shown and will be excluded from data reduction. The default is 0 RFU/RLU.

Max RFU/MaxRLU

The limit for the maximum value you wish to report. Any values from the reading that are above this limit will not be shown and will be excluded from data reduction. The default is 20,000 RFU/RLU.

Start (Wavelength) nm

Specifies the limit for the minimum wavelength setting you wish to report. Any values from the reading that are under this limit will not be shown and will be excluded from data reduction.

End (Wavelength) nm

Specifies the limit for the maximum wavelength setting you wish to report. Any values from the reading that are above this limit will not be shown and will be excluded from data reduction.

- **NOTE:** The settings for the Start and End wavelength settings cannot be below the lowest wavelength or above the highest wavelength entered in the Instrument Settings for the Spectrum reading.

Spectrum Reduction

The Spectrum reduction formula is applied to the list of numbers in each well (values at each wavelength) after the wavelength combination formula is applied. The default reduction for Spectrum readings is Lambda at Maximum. You can choose Lambda at Minimum, Maximum, Minimum, or Area Under Curve instead from the pop-up menu, or you can choose Custom and create a different reduction formula.

- **Maximum**
  
  Reports the maximum relative fluorescence or relative luminescence (within reduction parameters of MinRFU/RLU and MaxRFU/RLU).

- **Minimum**
  
  Reports the minimum relative fluorescence or relative luminescence (within reduction parameters of MinRFU/RLU and MaxRFU/RLU).
Lambda at Maximum
Reports the wavelength at which maximum relative fluorescence or luminescence is achieved (within reduction parameters of MinRFU/RLU and MaxRFU/RLU).

Lambda at Minimum
Reports the wavelength of minimum relative fluorescence or luminescence is achieved (within reduction parameters of MinRFU/RLU and MaxRFU/RLU).

Area Under Curve
This reduction estimates the area under the curve as defined by the data plots in wells (within the reduction limits). The data plots are treated as a series of trapezoids with vertices at successive data points and at the X-axis coordinates of the data points. The areas defined by each of the trapezoids are then computed and summed.

Well Scan

Wavelength Combination
The default wavelength combination for Well Scan readings is !Lm1 and is the only choice besides Custom which can be used to create a different reduction formula.

Well Scan Reduction
Choices are Maximum, Minimum, Average (default), and Custom. Average provides the average value for all points in the Well Scan.
Chapter 8: Displaying and Analyzing Data Using Fluorescence or Luminescence Instruments

FLEX

**Vmax**
The maximum slope of the FLEX plot of relative fluorescence units versus time. The default value displayed is in relative fluorescence units (RFU) per second. The rate is calculated with the use of Vmax Points (see below) which determines the number of contiguous points over which Vmax is calculated. The number of Vmax Points defaults to the maximum taken during the reading for all instruments except the FlexStation which defaults to 5 points. You can change this number in the Reduction dialog box.

**NOTE:** \( V_{\text{max}} = \frac{V_{\text{max}}}{{\text{sec}}} \times 60,000 \)

A linear regression is performed to determine the slope of the line using the equation:
\[
y = m \times x + B
\]
where \( m \) is the slope of the line.
The reaction rate is reported in RFU/sec.

**Vmax Points**
This setting defines the maximum size of the line segment used to determine the slope of the line used in calculating the rate of the reaction. The default is the total number of points taken in the reading, with the data normalized to a starting point of 0,0 (as opposed to starting from the optical density of the first time point). The first slope is calculated for a line drawn beginning at the first reading as defined by Lag Time (described below) and ending at a total number of readings equal to the Vmax Points setting. The second and any subsequent slopes are calculated beginning at the second time point and ending at a total number of readings equal to Vmax Points. The steepest slope is reported as Vmax Rate. If the data plot displays fewer time points (data points) than the number of time points chosen for Vmax Points, then all of the time points will be used to determine the slope of the data.

**Table 8.2: Using Vmax Points (Example)**

<table>
<thead>
<tr>
<th></th>
<th>Well 1</th>
<th>Well 2</th>
<th>Well 3</th>
</tr>
</thead>
<tbody>
<tr>
<td>Time points visible in the well (data plot)</td>
<td>25</td>
<td>10</td>
<td>2</td>
</tr>
</tbody>
</table>

Number of Points Used for Data Analysis:

<table>
<thead>
<tr>
<th></th>
<th>Well 1</th>
<th>Well 2</th>
<th>Well 3</th>
</tr>
</thead>
<tbody>
<tr>
<td>Vmax Points set to 25/25 (default)</td>
<td>25</td>
<td>10</td>
<td>2</td>
</tr>
<tr>
<td>Vmax Points set to 5/25</td>
<td>Overlapping 5-point line segments*</td>
<td>Overlapping 5-point line segments*</td>
<td>2</td>
</tr>
</tbody>
</table>

* SoftMax Pro will perform a linear regression on as many overlapping 5-point line segments as possible in the analysis window. The slope will be determined for each line segment and then the steepest slope will be reported.
as the reaction rate. Thus, in well 2 of the example in Table 8.1, above, the slope will be determined for line segments consisting of time points 1 to 5, 2 to 6, 3 to 7, 4 to 8, 5 to 9, and 6 to 10, and then the slope of the line segment with the steepest slope will be reported as the Vmax Rate.

The progressive slope calculations are repeated until the last included data point is reached (as defined by the End Time or MaxRFU — see below). The maximum positive or negative slope is reported as Vmax (RFU/sec). Vmax Points can be set from 2 to the total number of points in the curve. The number of Vmax Points can be set before the plate is read and can be changed after the plate is read. The data display will update automatically each time. The Vmax Points setting does not affect data collection.

**NOTE:** The height of the Y axis in the raw data plots or plate display is controlled using MinRFU and MaxRFU. The default settings are:

- MinRFU = 0
- MaxRFU = 20,000

The width of the X-axis in the raw data plots or plate display is controlled using Lag Time and End Time. If either the MaxRFU or End Time setting excludes points such that a total number of readings equal to Vmax Points cannot be used, then the maximum included points will be used.

**Time to Vmax**

This is an alternative method for analyzing non-linear FLEX readings that reports the elapsed time until the maximum reaction rate is reached, rather than reporting the maximum rate itself. Used in conjunction with Vmax Points, Time to Vmax is the time to the midpoint of the line defined by Vmax Points and used to calculate Vmax. This elapsed time data is useful for applications including coagulation chemistry where the changing concentration of the reagents does not change Vmax, but rather will change the time at which the reaction reaches the maximum rate.

**Onset Time**

This is another method for analyzing non-linear FLEX readings. Onset Time reports the time required for a FLEX reading to change by a specified amount (onset RFU above the initial RFU reading for the well).

**Time at Minimum**

This setting reports the time at the minimum RFU that falls within the reduction limits.

**Time at Maximum**

This setting reports the time at the maximum RFU that falls within the reduction limits.

**Time at 1/2 Maximum**

This setting reports the time at the half of the maximum RFU that falls within the reduction limits. To calculate this reduction, SoftMax Pro first determines the point (within the reduction limits) that has the maximum signal level (RFU). It then scans the plot from left to right until it finds two points having signals that bracket half of that value. A linear interpolation between these two points is used to estimate the Time at 1/2 Maximum.
Peak
This setting reports the maximum RFU value. It will be adjusted for different smoothing options.

Max - Min
This setting represents the difference between the maximum and minimum RFU values. If the minimum RFU value is below zero, it will be adjusted so that the minimum is always zero.

Slope
This setting determines the slope of the combined plot (i.e., the slope of the line using linear regression after the wavelength combination reduction). This setting uses all visible timepoints in the reduction window. Slope is the same as Vmax Rate when Vmax Rate is set to the same number of points as the run (i.e., the default). Slope is not the same as Vmax Rate if you have modified the Vmax Points.

Area Under Curve
This reduction estimates the area under the curve as defined by the data plots in wells (within the reduction limits). The data plots are treated as a series of trapezoids with vertices at successive data points and at the X-axis coordinates of the data points. The areas defined by each of the trapezoids are then computed and summed.

Mean
This setting takes the average of all data points and returns that value.

Smoothing

Figure 8.19: FLEX Mode Reduction Dialog Box — Smoothing Setting
Smoothing is used to reduce noise in FLEX readings. This setting takes the moving average of the raw data and displays the FLEX plot using these averaged values.

The default is no smoothing (setting of 1 “averaged” point). A setting of “3” provides the least amount of smoothing: the value of the center point is added to the values of the points on either side; the sum of these points is then divided by three and the resulting value is substituted for the center point. A setting of “9” would average the center point with the four points on each side.

When multiple wavelengths are read, it is important to note that smoothing is performed before performing wavelength combination calculations such as ratios or multiplication. For example, if you read at two wavelengths and choose to take a ratio of those wavelengths, smoothing would be performed on each individual wavelength and the wavelength ratio would be calculated using smoothed data.
Reduction Baseline Options
Three choices that are available within this section of the Reduction dialog box affect the way that the data is graphed:

- **Absolute**: Shows the raw data without any change in the way it is graphed. Raw data is used in subsequent reduction calculations.
- **Zero Baseline**: This option reduces this interference by offsetting the graph slightly.
- **% Baseline with Multiplier**: This option has been added to make FLEX data look more like FLIPR data. FLIPR data can be imported into SoftMax Pro and this option modifies the plot and reduction calculations to make FLEX data comparable to the FLIPR data.

This method averages the first number of points you specify (the upper box), divides the raw data by this average value, and then multiplies by 100 (%). The “Multiplier” section allows you to enter a number from 0.0001 to 9999 which is then used to multiply the % Baseline value.

This calculation also is performed only on the reduced data and only after any wavelength combinations are calculated. To see the modified plot, you must choose the [Reduced Plot] button in the Display dialog box or click the [Show Reduced] button in a zoomed well graph window.

Interpolate Raw Data Checkbox

Each individual raw data point has a corresponding read time associated with it. In FLEX mode, each data value is logged with its own individual read time which can make it difficult to perform wavelength combination calculations correctly. For example, if you desired to take a ratio of two different
wavelengths in a single well, it would be necessary to take a ratio \((L_{m1}/L_{m2})\) of values that have been read at two different points in time. To solve this problem, you may select the “Interpolate Raw Data” checkbox in the Reduction dialog box. [Note that this checkbox is shown only when two or more wavelengths are present in the reading.]

Enabling this checkbox causes SoftMax Pro to use quadratic interpolation to calculate the interpolated values. This results in the loss of one point at each end of the plot. Prior to beginning the calculation, SoftMax Pro determines the starting point by averaging the initial data points of the separate wavelengths. For example, if the first data points of the two wavelengths have time values of 0.3 and 0.5 seconds, SoftMax Pro will average these and use 0.4 seconds as its initial point for interpolation.

Figure 8.22: Top: Raw Data without Interpolation; Bottom: Interpolated Data.

**Custom Reduction Formulas**

If the predefined reduction formulas do not meet your needs, you can create one or more different reduction formulas for any or all read modes (Endpoint, Kinetic, Spectrum, Well Scan, or FLEX). Choosing “Custom” from any of the menus or dialog boxes causes a Formula button to appear (an example of this
button in an Endpoint Reduction dialog box is shown in Figure 8.23). Custom reduction formulas may contain other operators and terms in addition to wavelengths.

![Formula Button](Image)

**Figure 8.23:** “Custom” Selected Showing Formula Button (Endpoint)

Clicking the Formula button opens the Calculation dialog box in which you can name and define a new reduction formula.

![Calculation Dialog Box](Image)

**Figure 8.24:** Wavelength Calculation Dialog Box (Endpoint)

Examples of some formulas that might be used when combining multiple wavelengths in the Calculation dialog box are given in Table 8.3.

**Table 8.3: Wavelength Reduction Formula Examples**

<table>
<thead>
<tr>
<th>Formula</th>
<th>2 ( \lambda )</th>
<th>3 ( \lambda )</th>
<th>4 ( \lambda ) to 6 ( \lambda )</th>
</tr>
</thead>
<tbody>
<tr>
<td>( !Lm1 + !Lm2 )</td>
<td>( !Lm1 + !Lm2 + !Lm3 )</td>
<td>( !Lm1 + !Lm2 + ... + !Lmn )</td>
<td></td>
</tr>
<tr>
<td>( !Lm1 - !Lm2 )</td>
<td>( (!Lm1 - !Lm3) / (!Lm2 - !Lm3) )</td>
<td>( (!Lm1 - !Lm6) / (!Lm2 - !Lm5) / (!Lm3 - !Lm4) )</td>
<td></td>
</tr>
<tr>
<td>( !Lm1 / !Lm2 )</td>
<td>( !Lm1 / !Lm3 )</td>
<td>( !Lm1 / !Lmn )</td>
<td></td>
</tr>
<tr>
<td>( !Lm1 * !Lm2 )</td>
<td>( !Lm1 * !Lm3 )</td>
<td>( !Lm1 * !Lmn )</td>
<td></td>
</tr>
<tr>
<td>( \log_{10}(Lm1/Lm2) )</td>
<td>( \log_{10}(Lm1/Lm3) )</td>
<td>( \log_{10}(Lm1/Lmn) )</td>
<td></td>
</tr>
<tr>
<td>( !Lmx/constant )</td>
<td>For example, ( Lm1/1.44 )</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Average(!allvalues)</td>
<td>This formula will average together the relative fluorescence/luminescence units for multiple readings at the same wavelength (for example, if you read the well six times at a single wavelength).</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Custom reduction formulas utilizing mathematical operators or terms can be used to obtain specific types of data. Table 8.4 provides some examples of such formulas for Kinetic and Spectrum readings.

**Table 8.3: Wavelength Reduction Formula Examples**

<table>
<thead>
<tr>
<th></th>
<th>2 λ</th>
<th>3 λ</th>
<th>4 λ to 6 λ</th>
</tr>
</thead>
<tbody>
<tr>
<td>Min(!allvalues)</td>
<td>This formula will report the minimum RFU/RLU recorded for multiple wavelength readings in each well.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Max(!allvalues)</td>
<td>This formula will report the maximum RFU/RLU recorded for multiple wavelength readings in each well.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>If(!Lmz&lt;A,makeerr(118),(if(!Lmx&gt;B,makeerr(117),!Lm1)))</td>
<td>This formula will report “low” for any well with an RFU/RLU less than A, “high” for any RFU/RLU greater than B, and the RFU/RLU of any well that lies between A and B.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Table 8.4: Kinetic and Spectrum Reduction Formula Examples**

<table>
<thead>
<tr>
<th>Kinetic</th>
<th>Spectrum or Kinetic</th>
</tr>
</thead>
<tbody>
<tr>
<td>Vmaxcorr(!combinedplot, !vmaxpoints,!readinterval)</td>
<td>Reports Vmax correlation coefficient for plots in all 96 wells.</td>
</tr>
<tr>
<td>Vmax(Delta(!combinedplot), !vmaxpoints,!readinterval)</td>
<td>Will report the Vmax Rate of the delta between each time point.</td>
</tr>
<tr>
<td>Nthitem(!Lm1,X)</td>
<td>Will report the RFU/RLU at item X in the list of readings. For example, if you have a Kinetic run with 20 time points and X is 10, it will report the RFU/RLU of the 10th time point. Similarly, if you have a Spectrum scan with 20 measurements and X is 10, it will report the RFU/RLU of the 10th wavelength measured.</td>
</tr>
</tbody>
</table>

A list of accessors and operators that may be used in custom reduction formulas can be found in the *Formula Reference Guide*.

When you finish your entry in the Calculation dialog box and click [OK], the formula you have entered then appears to the right of the word “Custom” and becomes the default selection for the Custom option. You may subsequently edit this formula or enter a new one by clicking the Formula button again.

**Recalculation Options**

By default, SoftMax Pro performs continuous recalculation of the data when you read plates, create or change formulas, and so on. At certain times, it would be useful to disable the recalculation feature so that you can make alterations to the experiment without waiting for individual recalculations to be completed. Two commands are available in the Edit menu that allow you to modify the way in which SoftMax Pro performs recalculation: *Suspend Recalculation* and *Recalculate Now* (§; CTRL+=).
Choosing **Suspend Recalculation** disables the automatic recalculation feature of the program and places a checkmark to the left of the command in the menu to indicate that it has been selected. While this function is enabled, no recalculation will occur, regardless of what you may change, add, or delete from the experiment. This is especially useful when creating or changing column formulas within Group sections, for example, as it can speed up the process greatly.

When recalculation has been suspended, you may wish to see the results of the changes you have made but may still not wish to enable continuous recalculation. Choosing **Recalculate Now** (⌘; CTRL+=) from the **Edit** menu will cause SoftMax Pro to examine all elements of the experiment and perform complete recalculation of the data. Choosing this command does not enable continuous recalculation but simply causes the program to perform recalculation once.

To return to continuous recalculation, choose **Suspend Recalculation** again. The checkmark next to the command will disappear, indicating that the function is no longer in use.

**NOTE** Recalculate Now (⌘; CTRL+=) can be used to see intermediate results during long Kinetic readings. At any time, you can choose **Suspend Recalculation** to delay calculations until a later time.

---

**Displaying Data in Group, Graph, and Notes Sections**

**Group Sections**

The manner in which data is displayed in a Group section depends on the type of reading that was performed (Endpoint, Kinetic, Spectrum, Well Scan, or FLEX), but can be customized by choices made in the data display, reduction settings, and the **Edit** menu.

- Resizing/hiding columns
- Adding/deleting columns
- Showing/editing column formulas
- Adding/editing summaries
- Changing text style

Default displays for Group sections are shown automatically unless you choose a different display option.

The particular font to be used in a Group section table, as well as its size and style, can be changed by first selecting one or more columns in the Group section table and then choosing the **Text** command from the **Edit** menu and making the desired choices from the dialog box that appears.

**Settings from the Plate Section Affect Data Display in Group Section Tables**

Reduction options in the Plate section allow you to display the raw data received from the FlexStation instrument in a reduced (analyzed) form. Which reduction options are available depend on the read mode used and...
reduction settings chosen. Reduced number from the Plate section is displayed in the Values column of the Group section tables by default.

Reduction settings do not affect the raw data but simply cause it to be displayed differently. You can change reduction settings without affecting the raw data from the plate reading in any way.

Custom reduction formulas require the use of accessors and operators that are understood by SoftMax Pro. A list of these accessors and operators is given at the end of this chapter.

Resizing and Hiding Columns

The columns in a Group section can be resized in several ways. One of the simplest is to drag the line dividing the columns to another position (moving it horizontally). When you point to a line between columns, the cursor changes to a double arrow with a vertical line through it, showing that it is ready to move left or right (see Figure 8.25).

![Figure 8.25: Cursor Positioned on a Line between Columns](image)

Reducing Column Size and Hiding Columns

You can reduce a column to a size smaller than the width of its title, in which case the title will not be completely visible. You can also hide a column by reducing its size completely (drag one edge of the column on top of the other) or by selecting that column and choosing Hide from the Group menu.

**NOTE:** If you hide a column in this way and then wish to view it again, use the Show All command in the Group menu. All columns that were hidden will again be visible. There is no way to show only one hidden column.

Enlarging Column Size

You can enlarge the width of columns to any size. Increasing the size of columns may make the width of the Group section increase beyond the page width boundary. If this occurs, the columns will “disappear” off the edge of the screen but are really still there. To bring these columns back into view, reduce the width of the columns that are still visible until the others reappear.
If the width of a section extends beyond the page width boundary, the portion that is not visible will not be printed.

To size two or more columns to the same width, highlight those columns and then drag one of the dividing lines to the desired width. The width of all highlighted columns will be sized the same as the column to the left of the dividing line you are moving.

Columns can also be resized to the minimum amount of space required by choosing **Autosize** from the **Group** menu. By highlighting the entire table or individual columns and then choosing **Autosize**, the amount of space each column requires will be reduced to the minimum size required by the largest piece of text in that column.

Double-clicking the line dividing two columns causes the single column to the left of the divider to be sized according to the largest amount of text in that column.

### Showing and Editing Existing Column Formulas

When group sections are first created, the formulas used to calculate the data are not displayed.

These formulas can be shown (until you choose to hide them again) by making a Group section active and then choosing **Show Formulas** from the **Group** menu. (Note that the command in the menu changes to **Hide Formulas** after they are shown.)
Choosing this option causes an additional row to appear (beneath the heading for each column) which shows the formula used to calculate the data in each column. To see formulas briefly, hold down the shift and control (Ctrl) keys.

### Figure 8.28: Formulas Shown in Group Columns

**Modifying Column Formulas**

To modify the formula for an existing column, double-click the column or click the column once and then click the formula button in the section tool bar. The dialog box associated with the column formula will open, allowing you to edit the formula (and the name) associated with the column.
Adding Columns

You can add a new column to a Group section by clicking the Create Column button in the Group tool bar or by choosing Create Column from the Group menu which will open the Column Formula dialog box.

In the Column Formula dialog box, you can change the name of the new column (from the default which simply lists the column by number) to reflect the data that it will contain.

If no existing column is selected when you click the Create Column button, the new column will be created to the right of all existing ones. If you select (highlight) a column and then add a new column, it will be positioned to the right of the one you selected. If the table is currently as wide as the sheet of paper specified in Page Setup when a new column is added, the columns will “disappear” off the right side of the window but are still there. To bring these columns back into view, resize visible columns smaller.
New columns can contain references to other columns, both in the current section or in a different one within the same experiment. For example, if you wanted to subtract the mean values in one group from those in another, you could create a new column (in either group) to do this. If the two groups were named “Group 1” and “Group 2,” for example, and both groups contained a column entitled “Mean,” you could create a column within “Group 1” that would subtract the mean values in “Group 2” from those in “Group 1.” The column formula needed to do this would be:

`Mean-Mean@Group2`

Numerous possibilities exist for creating and editing column formulas to display the data you desire. For a complete discussion of formulas and operators, see the accompanying *Formula Reference Guide.*

**NOTE:** To delete a column, highlight it and press the Delete key or choose **Cut** from the **Edit** menu.
Adding or Editing a Summary in a Group Section

To add a summary at the bottom of a Group section, click the Create Summary button in the tool bar or choose Create Summary from the Group menu. The Calculation dialog box will appear, allowing you to change the name of the summary or hide the name, if desired, as well as to enter a description of the summary and to create a formula for it (including the number of decimal places for the result, if appropriate). Double-clicking an existing summary causes the same dialog box to appear, allowing you to modify summary information.

![Calculation Dialog Box]

**Figure 8.31: Calculation Dialog Box**

Information entered in this dialog box will be placed at the bottom of the Group section as follows:

Name = Description     Formula Result

You can click the checkbox next to Hide Name which will change the way the summary appears to show:

Description     Formula Result

**NOTE:** The name assigned to a summary is important since you can reference the summary by name in other formulas (building one upon another). The summary name can be referenced even if it is hidden.

If you wish to see the formulas associated with summaries without opening the Calculation dialog box for each one, you can choose Show Formulas from the Group menu. To see these formulas only briefly, hold down the shift and control (Ctrl) keys while that Group section is active. The summaries will “expand” to show the complete formula along with the title. They will resume their previous appearance when you release the option key.

Summaries in Group sections can be moved horizontally, if desired, by dragging them left or right. When you position the pointer over a Group summary, the cursor changes to show a double-headed horizontal arrow. Clicking once highlights the summary; dragging and then releasing the summary leaves it in the position where the mouse button was released.

To have summaries line up with particular columns in the Group, hold down the control (Ctrl) key while dragging the summary. When you release the control (Ctrl) key, the summary will “snap back” so that it begins flush to the left side of the column under which it was released. Each summary can be positioned in a different place in the Group section, if desired.
To delete a summary, highlight it and press the Delete key or choose Cut from the Edit menu. A summary can also be copied or cut and then pasted in a different location.

You can also change the format of the text in Group section columns and/or summaries. By selecting the column or summary and then choosing Edit and then Text Style (Ctrl+T), you can change the font, size, and/or style of the text.

Notes Sections

The Notes section allows you to enter text describing the experiment and one or more summary lines that contain formulas. To create a summary, click the Create Summary button in the tool bar or choose Create Summary... from the Notes menu.

The Calculation dialog box that appears (see Figure 8.31) allows you to enter a description of the summary, accept the default title for the summary, change it or hide it, and enter a formula (including the number of decimal places the reduction should show, if appropriate). Detailed information regarding operators and accessors can be found in the Formula Reference Guide.

If you wish to see the formulas associated with the summaries without calling up the Calculation dialog box for each one, you can choose Show Formulas from the Notes menu. To see these formulas only briefly, hold down the shift and control (Ctrl) keys while that Notes section is active. The summaries will “expand” to show the complete formula along with the other summary information. They will resume their previous appearance when you release the option key.

Graph Section

The Plot#X Dialog Box

Whenever you create a new Graph section or add a plot to an existing graph, the Plot#X dialog box opens automatically (“X” starts with “1” and increments each time a new plot is added to a Graph section). In this dialog box, you can rename the plot, assign specific information to be plotted on the X- and Y- axes, and choose which icon and color will be used. If you rename the plot, the title of the dialog box will change to show the new plot name.

All groups that have been created or assigned within the file are listed on the left side of the “Source:” field in the Plot#X dialog box. The first group in the file is automatically selected. Other groups can be selected by highlighting them. When a group is selected, the pull-down menus in the X-axis and Y-axis subfields change to show the group columns that are available for graphing. Group columns can be assigned for both the values to be plotted and any error bars to be included for both axes.

Summaries and user-defined formulas can also be graphed. Pushing the button for either the X-axis or Y-axis opens a dialog box which allows you to enter formulas. To plot a summary, enter the summary name in this dialog box. Formulas can be plotted for comparison with other data. For example, if the data is assumed to follow a specific model, the model formula can be entered as a plot and then the data can be chosen for another plot within the same graph. You can also use this feature to plot Kinetic or Spectrum data in
Graph sections. For example, to plot Kinetic data from well A1 in a Graph section, you can enter the formula !A1Lm1 for the Y-Axis and the !TimeRun accessor for the X-axis. The entered formulas are also shown in the “Source:” field of this dialog box.

The size, color, and style of the icon used for a plot can be selected on the right side of this dialog box. Four sizes, nine colors, and nine styles are available from drop-down menus.

The Graph Options Dialog Box

The Graph Options dialog box allows you to change the name of the Graph section, change the height of a graph, select the type of graph to be displayed, change the fonts used on the title, legend, and axes, access the Plot#X dialog box for editing plots, entering new plots, and/or to delete plots. This dialog box is opened after pressing [OK] in the Plot#X dialog box when a new Graph section is being created. This dialog can also be accessed by pressing the Graph Options button on the Graph section toolbar or by choosing Graph Options from the Graph menu.

Scatter plots, cluster bar charts and stack bar charts can be created. Error bars can be used with all graph types. You can also choose whether to connect the points and/or plot the symbols in the graph.

Each of the plots that have been created for this Graph section are listed in the “Plots:” field of this dialog box. Choosing any of these plots provides an indication of the data to be used for the X- and Y-axis data points and error bars on the right side of this field. Plots can be deleted by highlighting the plot name and clicking the [Delete] button. Clicking the [New] button opens the Plot#X dialog box, allowing you to create a new plot for the graph. Existing plots can be edited by highlighting the plot name and clicking the [Edit] button which opens the Plot#X dialog box containing all the information for the selected plot.

When creating a new Graph section, the Graph Options dialog box opens after choosing either [OK] or [Cancel] in the Plot#X dialog. The new Graph section is not created, however, until you click [OK] in the Graph Options dialog box.
Chapter 8: Displaying and Analyzing Data Using Fluorescence or Luminescence Instruments

Creating Multiple Plots

SoftMax Pro makes it possible to create multiple plots within a graph. Each plot will represent data from a group that has been created in the Template Editor or data from a summary or custom formula. You may plot data from any group or from several groups on a graph, even if the groups are in separate experiments. It is possible, for example, to plot multiple dilution series of an unknown, to graph together a series of patient samples, or to plot several controls that have been run over time.

Following is a summary of the steps required to create multiple plots within a single graph, after which is an example that provides more detail.

Multiple Plots Step Summary

- Create all required groups in the Template Editor.
- Read the microplate to obtain data.
- Create a graph section.
- Add plots to the graph and choose the group and the X and Y values to be shown for each plot.

Example of Creating Multiple Plots

This example shows how three groups, all of which are Standards, were plotted on the same graph.

1) Groups are created in the Template Editor. For this example, four groups are created: three for standards (Standard1, Standard2, and Standard3) and one for Unknowns (Unknown1).
Figure 8.33: Standards and Unknowns Groups Created

2) The associated Group sections are created using the Standards column format which, by default, generates columns for concentration and optical density values. The example below shows the Group section for Standard2.

Figure 8.34: Standard2 Group Section

3) A new Graph section is created by selecting New Graph from the Experiment menu. This causes the Plots dialog box to open automatically. The default name for the first plot, “Plot#1,” is then changed (by typing a new name over it) to “Standard#1.” Clicking [OK] opens the Graph Options dialog box which allows you to choose the graph type, modify the fonts used for the graph, and so on. Choices should be made as follows: Standard1 for the group to be plotted, the concentration of Standard1 for the X-axis, and values of Standard1 for the Y-axis. No error bars are added.
4) A second plot is added to this graph by clicking the [New] button in the Graph Options dialog box. After clicking [New], a dialog labeled Plot #2 is opened. The second plot name defaults to “Plot#1,” which now shows beneath the first plot. Change this second plot name to “Standard#2,” choose Standard2 for the group, and change the X- and Y-axes to show concentration and values, respectively, for Standard2.

5) This process is repeated for a third plot, labeled “Standard#3.”
6) Now that all plots information is complete, clicking [OK] in the Graph Option dialog box will close it, and the resulting graph will show the three plots created.

![Figure 8.37: Graph Displaying Three Standards Plots](image)

You can add as many plots to a graph as you wish, and these can be of the same or different types of groups. If you create a graph and later wish to add one or more plots to it, simply click the [Graph Options] button on the Graph section tool bar and then click the [New] button. This will reopen the Plots dialog box, allowing you to add or modify the plot information.
**Error Bars**

When data is displayed as a scatter or bar graph, you can choose to display error bars for the plot of the data for the X- and/or Y-axis. Error bars are lines that extend beyond a plotted value in either or both directions and graphically represent some amount of error in plotted data.

*Figure 8.38: Plot Showing Error Bars*

Choices for displaying error bars relative to a particular axis are the same as those available for displaying data on that axis: any column from that group that contains numerical information (not columns with text). To display error bars, click and hold the box next to “Error Bars” in the Plot#X dialog and drag to select one of the choices in the menu. To disable error bars, choose “No Error” for the X- and/or Y-axis.

Error bars show both positive and negative error. Depending on the range settings for the graph, portions of the error bars may not be visible.

**Curve Fitting**

When you first create a graph of the data, it does not have a fit associated with it. The graph might appear something like this:

*Figure 8.39: Graph with No Fit*
You can fit any plot to one of nine curve-fitting algorithms: Linear, Semi-Log, Log-Log, Quadratic, 4-Parameter (logistic), Log-Logit, Point-to-Point, Exponential, and Cubic Spline. These selections are shown in the Fits pop-up menu in the Graph section toolbar (click on the box next to “Fit”).

Typically, a standard curve refers to the curve fitted to the plot of concentration versus mean value for the Standard group.

Once you have selected a Fit type, SoftMax Pro determines the parameter values that best fit the data. The function with these parameters is then drawn on the graph. Ideally, the type of fit used should be determined by the underlying chemistry of the assay and could be set before data is read.


When a fit is chosen, the Graph section is updated to show the coefficients describing the fit when applicable. These values are displayed in the legend at the bottom of the graph. Figures 8.40 through 8.47 show the same graph with the different fit algorithms applied. Note that the legend information changes (along with the formula for the fit) at the bottom of each Graph section for each different fit.

NOTE: All plots on a graph must have the same type of fit.

When a curve fit is chosen, the values for the coefficients of the equation (A, B, C, etc.) will be shown as will the square of the correlation coefficient (R^2). The correlation coefficient describes how well a change in x values correlates with a change in the y values. Please see “Judging a Good Curve Fit” on page 8-61 for more information. The R^2 value should only be used for curve fits having linear axes.
**Linear**

The linear function fits the best straight line to the data. The equation for this fit has the form of:

\[ Y = A + (B \times X) \]

where \( A \) is the y-intercept of the line and \( B \) is the slope. A linear fit should be used whenever the values appear to lie on or scattered around a straight line. This equation is shown on the screen as:

\[ y = A + Bx \]

A linear fit should be used whenever the standard values appear to lie on or are scattered around a straight line. Figure 8.40 shows an example of a linear fit.

*Figure 8.40: Graph with Linear Fit*
Semi-Log
The semi-log function fits the best straight line to a set of data for log(X) plotted against Y. The resulting curve displayed will be a straight line with the X-axis drawn in logarithmic scale. The equation for a semi-log fit is:

\[ Y = A + [B \cdot \log_{10}(X)] \]

and is shown on the screen as:

\[ y = A + B \cdot \log(x) \]

where A is the y-intercept of the line and B is the slope (note: log in this equation is the common or base-10 logarithm).

Figure 8.41: Graph with Semi-Log Fit
Log-Log
The log-log function fits the best straight line to the set of data which consists of the logarithm of the readings on the Y-axis (the response) and the logarithm of the dose on the X-axis. The resulting display will be a straight line with both axes drawn in logarithmic scale. The equation for the log-log fit is:

\[ \log_{10}(Y) = A + [B \cdot \log_{10}(X)] \]

and is shown on the screen as:

\[ \log(y) = A + B \cdot \log(x) \]

where A is the \( \log_{10} \) Y-intercept of the line for \( \log_{10}(X) = 0 \) and B is the slope (note: \( \log \) in this equation is the common or base-10 logarithm).

Figure 8.42: Graph with Log-Log Fit
**Quadratic**

The quadratic function fits the best parabola to the data. The parabola is a curved line based on the equation:

\[ y = A + (B \times x) + (C \times x^2) \]

which is shown on the screen as:

\[ y = A + Bx + Cx^2 \]

where \( A \) is the intercept, \( B \) is the slope of the curve at the intercept, and \( C \) is the measure of the curvature of the parabola.

The quadratic fit is most appropriate when the standard curve has a tendency to curve up or down. An example of a quadratic fit is shown in Figure 8.43.

*Figure 8.43: Graph with Quadratic Fit*
4-Parameter Logistic and Log-Logit

If the standard curve has a sigmoidal shape when plotted on the semi-log axes, it may be appropriate to use either the log-logit or 4-parameter fit. Both fits are based on the equation:

\[ y = \frac{A - D}{1 + \left(\frac{x}{C}\right)^B} + D \]

where \(D\) is the Y-value corresponding to the asymptote (i.e., the flat part of the curve) at high values of the X-axis and \(A\) is the Y-value corresponding to the asymptote at low values of the X-axis. The coefficient \(C\) is the X-value corresponding to the midpoint between \(A\) and \(D\). The coefficient \(B\) describes how rapidly the curve makes its transition from the asymptotes in the center of the curve. A large value of \(B\) describes a sharper transition. Typically, \(B\) has a magnitude of about 1.

Both the log-logit and 4-parameter equations are shown on the screen as:

\[ y = \frac{A - D}{1 + (x / C)^B} + D \]

Figure 8.44: Graph with 4-Parameter Fit
Some publications show the log-logit equation in another form:

\[
\log_{10} \frac{y}{1 - y} = b \log_{10} x - c
\]

where

\[
y = \frac{y - A}{D - A} \quad x = \log_{10} x
\]

A different algebraic expression of these is:

\[
y = \frac{A - D}{1 - (x/C)^b} + D
\]

The difference between the log-logit fit and the 4-parameter fit are in the way the coefficients A and D are calculated. For the log-logit method, the standard values for the lowest and highest values of x are used. The corresponding y values are assigned to A and D, respectively. Based on these fixed values for A and D, the algorithm then computes values for B and C. This technique works well if there are standard points along the upper and lower asymptotes. If this is not true, the log-logit fit should be avoided in favor of the 4-parameter logistic.

In SoftMax Pro 2.x, the 4-parameter logistic curve fit uses 2000 iterations. If the fit does not converge in this number of iterations, the program will report a fit error.

**Point-to-Point**
A linear equation is fit to each pair of data points. Fit parameters are not given. The point-to-point curve fit is a linear fit composed of pieces that assume a linear relationship between each pair of data points. The line segment defined by each pair is used to interpolate data between those points. Since there are multiple line segments, fit parameters are not shown on the graph.

![Graph with Point-to-Point Fit](image)

**Cubic Spline**
This curve fit generates a fit to a cubic equation between each pair of data points. The general form of a cubic equation is:

\[ y = A + Bx + Cx^2 + Dx^3 \]

The equations are computed with the requirement that the first and second derivatives of the equations are continuous throughout the range of the data. As multiple curve fits are performed with this routine, fit parameters are not shown with the graph.

![Graph with Cubic Spline Fit](image)
Exponential
The exponential function used to generate this curve fit is:

\[ y = A + B \cdot (1 - \exp^{(x / C)}) \]

Figure 8.48: Graph with Exponential Fit

**NOTE:** SoftMax Pro does not plot samples with descriptor values of zero (0) on a log axis. Curve fits affected by this are the semi-log, log-log, log-logit, and 4-parameter curve fits.
Minimum Number of Standards

The number of standards used in a standard curve depends on the particular curve fit selected and on the judgment of the operator. The table below gives the minimum number of standards required mathematically by each of the curve fitting algorithms.

Table 8.5: Minimum Number of Standards Required for Curve Fits

<table>
<thead>
<tr>
<th>Curve</th>
<th>Minimum Number of Standards</th>
</tr>
</thead>
<tbody>
<tr>
<td>Linear</td>
<td>2</td>
</tr>
<tr>
<td>Quadratic</td>
<td>3</td>
</tr>
<tr>
<td>Semi-Log</td>
<td>2</td>
</tr>
<tr>
<td>Log-Log</td>
<td>2</td>
</tr>
<tr>
<td>Log-Logit</td>
<td>4</td>
</tr>
<tr>
<td>4-Parameter</td>
<td>4</td>
</tr>
<tr>
<td>Point-to-Point</td>
<td>2</td>
</tr>
<tr>
<td>Exponential</td>
<td>3</td>
</tr>
<tr>
<td>Cubic Spline</td>
<td>4</td>
</tr>
</tbody>
</table>

For optimal results, you should always exceed the minimum number of standards required for any given fit.

There are other requirements on the standards for the log-logit and 4-parameter logistic curves. The fits for the 4-parameter logistic curve are based on the assumption that the curve has a high and a low asymptote and a certain “steepness” for the linear portion around the inflection point between the asymptotes. If a sufficient number of points do not define the inflection point and the asymptotes, you will receive a “no fit” error message or an inappropriate fit. For best results, make sure that the 4-parameter fit is appropriate for your assay and that the entire range of the assay is represented in your standards.

If your standards do not clearly define both a high and low asymptote, the spline fit may be more appropriate for your assay.

Judging a Good Curve Fit

The correlation coefficient is also known as the goodness of fit value because it shows how good a fit exists between the computer curve and the standard data points. It measures the degree to which the points fall on the computer curve and may give an indication as to what residuals are to be expected. The correlation coefficient is popularly known as R and is between -1 and 1, inclusive. When the data points lie on a perfectly straight line with negative slope, then R = -1. If the correlation coefficient is not suitably close to 1 or -1 (a perfect fit), you can simply apply one of the other types of curves without having to reread the plate.

For nonlinear curve fits, SoftMax Pro performs transformations that cause the curve to become more linear. The correlation coefficients are derived from
that transformed data. Because of this, you should be cautious about using correlation coefficients as an indicator of goodness of fit. Do not let this single value for goodness of fit sway your intuition about which fit is best. Some curve fits may seemingly give a good fit (e.g., fit values close to 1) but, when inspected by eye, show a poor fit along a major portion of the plot.

**Graph Options**

Graphs can be customized further through the Graph Options dialog box which is accessed by choosing Graph Type... from the Graph menu or by clicking the Graph button ( ) in the section tool bar.

![Graph Options Dialog Box](image)

*Figure 8.49: Graph Options Dialog Box*

The default options are shown in Figure 8.49, but you can alter these as desired: you may change the font and type size used for the title, legend, and/or axes of the graph, and you can choose the color and type of symbol used on a scatter graph to show the plot. The graphs shown in preceding Figures reflect the default graph options. Connecting the points of a scatter graph can be useful in determining the closeness of the fit. Figure 8.50, below, shows a scatter graph with points connected compared to a linear fit.

**NOTE:** The Connect Points option connects the points in order of appearance by sample name—not the appearance of points from left to right on the graph.
Figure 8.50: Scatter Graph with Points Connected (Linear Fit Applied)

Other options in this dialog box allow you to plot the data as a bar graph with data shown in clusters or stacked. Figure 8.51 shows both of these bar graph options.

Figure 8.51: Bar Graphs — Cluster and Stack

**NOTE:** Bar graph options for multiple plot graphs are only available when each plot contains the same number of data points and has matching X-axis coordinates.

**NOTE:** When choosing the Connect Points option, the order in which points are connected is sample name dependent.
Chapter 8: Displaying and Analyzing Data Using Fluorescence or Luminescence Instruments

Axes Options

Double-clicking either graph axis, clicking the X-axis or Y-axis button in the Graph section toolbar, or selecting either X-axis... or Y-axis... from the Graph menu opens a dialog box concerning the configuration of that axis. Figure 8.52 shows the dialog box for the X-axis.

![X-Axis Settings](image)

Figure 8.52: X-Axis Dialog Box

The default settings are shown in the Figure above. You can change these as desired for either or both axes.

Axis Settings

Enabling the Auto-range option causes the graph to be drawn such that all data points are shown (by automatically adjusting the minimum and maximum range settings to encompass the data). You can disable the Auto-range function by clicking the checkbox or by changing either or both values for the Min and/or Max settings.

Formulas in SoftMax Pro

You can enter custom calculations in several places within SoftMax Pro to provide the information you desire:

- In Plate sections, you can specify formulas to be used for wavelength reduction and Kinetic/Spectrum reduction.
- In the Group table sections, you can view and edit the formulas associated with the various columns or create new columns containing new formulas. The data shown in columns from one group can relate to or contain information derived from columns in another group. You can also create summaries which consist of formulas and text.
- Notes sections allow you to enter summaries which consist of formulas and related text.

Use of formulas in SoftMax Pro is described in a separate manual, The SoftMax Pro Formula Guide.
Chapter 9: File Management and Printing

File Creation and Management ........................................... 9-3
  Default Protocol ....................................................... 9-3
  Locating Protocol and Data Files ................................. 9-5
  Creating New Files ................................................... 9-5
  Opening Files ........................................................... 9-6
  Saving Files Manually ................................................ 9-8
  Autosave ................................................................. 9-9

Printing ................................................................. 9-11
  The Printed Report .................................................... 9-12
  Customizing the Report .............................................. 9-12
  The Print Dialog Box ................................................ 9-14

Exporting/Importing Information ................................. 9-16
  Exporting Data ........................................................ 9-16
  Importing Data from Analyst, Acquest, ScreenStation, and FLIPR .............................................. 9-21
  Importing and Exporting Templates ............................ 9-24
  Exporting Graphs ...................................................... 9-25
  Copying and Pasting .................................................. 9-25

File Protection ......................................................... 9-29
  Password Protection.................................................. 9-29
File Creation and Management

During routine use of SoftMax Pro, you will create, open, and save numerous files. You may wish to create file folders that will make it easy to locate particular files. It is also important to understand the way in which SoftMax Pro finds and uses protocol files to enable certain assay options automatically.

Default Protocol

When you install SoftMax Pro, certain files and folders/directories are created on your computer’s hard disk. One of these files is known as the “Default Protocol” (so named on the Macintosh; called “DEFAULT.PPR” in Windows). The Default Protocol file is automatically used as a “template” for new files you create. You can, however, create one or more different “template” protocol files.

When first installed, SoftMax Pro looks for the Default Protocol file in the same folder or subdirectory as the SoftMax Pro program file. You can instruct SoftMax Pro to look in a different location, however, through the Assays menu. Suppose, for example, that you create a folder/subdirectory called “MYASSAYS” and that you create a new protocol file (called “Default Protocol” for Macintosh or “Default Protocol.ppr” for Windows) within this folder. The Assays menu shows two sections: at the top, a command entitled Set Folder... which allows you to choose the folder within which SoftMax Pro will look to find the Default Protocol file when creating a new experiment. At the bottom of this menu, beneath the dividing line, is a list of all protocol files contained in the currently chosen folder.

**Figure 9.1: The Assays Menu**

To have SoftMax Pro look in a different folder for the Default Protocol file, choose Set Folder.... A dialog box will open, allowing you to locate and set a different default folder. Figure 9.2 shows the dialog box that appears for the Macintosh and Figure 9.3 shows the dialog box that appears for the Windows environment.

**Figure 9.2: Set Folder Dialog Box—Macintosh**
Select the folder you wish to use and then click the large button at the bottom of the dialog box to set this folder as the default. The name shown in this button will change to reflect the name of the selected folder.

**NOTE:** Molecular Devices recommends that you have only one default protocol.

![Select Directory](image)

**Figure 9.3: Select Folder Dialog Box—Windows**

Locate and highlight the folder you wish to use and then click the [Select] button at the right of the dialog box to set this folder as the default.

**NOTE:** The Assays menu will also include sub-menus for all subdirectories in the default directory that contain protocols. Subdirectories are only shown one level deep. A subdirectory that contains other subdirectories will not be translated into a cascade of sub-menus. Only the first subdirectory name will appear in the Assays menu.

### Opening Other Protocol Files

The bottom half of the **Assays** menu provides a “shortcut” for opening other protocol files contained in the set folder. These usually consist of protocols you or others create for repeated use. To choose a different protocol file, click the protocol file you wish to use. An untitled copy of that protocol file will open in a new window.
Locating Protocol and Data Files

You may find it useful to create separate folders/subdirectories to store the data files that SoftMax Pro creates. In addition, you may want to create and save various protocol files for use as “templates” for later readings. In a multi-user environment, it might be helpful to create a folder/subdirectory for each SoftMax Pro user or to create separate folders/subdirectories for different types of experiments. We recommend that you consider the way in which you will organize your files before creating too many of them—otherwise you may find that locating a particular file among the many that fill your hard disk difficult and/or time consuming.

Creating New Files

Selecting New (⌘N; CTRL+N) from the File menu causes a new, untitled file to open, creating a new window on the screen. The initial contents of this window are based on the default protocol file chosen in the Preferences dialog box.

NOTE: You can create and/or open more than one SoftMax Pro file at a time. Subsequently opened files will appear in separate windows in a cascading, diagonal order.

New files can be saved as protocol files at any time, either before or after data is acquired. To create a new protocol file, enter all the instrument settings for the reading and then choose Save or Save as... from the File menu. The dialog box that appears presents the option of saving a file as either a protocol or a data file (the default). On the Macintosh, choose “SoftMax Pro Protocol” from the choices in the drop-down menu next to “Format:” and enter a name for the file in the text box (type over “Untitled”). In Windows, choose the appropriate format from the list in the box under the heading, “Save File as Type:.” Also remember to choose the folder or subdirectory in which to save this file. When you have entered all the information, click [Save] or [OK].

NOTE: SoftMax Pro limits the number of characters that can be used in a file name. On the Macintosh, file names are limited to 31 characters; on the PC, the limit is 59-characters for the actual name of the file (plus a period and 3-letter extension for a total of 63 characters). Using a PC, it is possible to make a file name longer than this by manually changing it in a directory listing or by using the Save As command in the software. A file with a name longer than this limit will no longer be able to be read by SoftMax Pro and will return an error when you attempt to open it. File names that are made too long using the Save As command will show corrupted characters (such as “ÿ,” “ü,” etc.) for any letters that fall after the 63rd.

NOTE: If you are creating a protocol file from a file containing data, first save the file as a data file (if you wish to save the data) and then perform a second save as a protocol file. Data is not saved with a protocol file.

Protocol files are stationery pad files—when you choose to open a protocol file, you are actually presented with a copy of the file, which appears as an untitled file.
Opening Files

You can open a SoftMax Pro file by selecting **Open...** (⌘O; **CTRL**+**O**) from the **File** menu within SoftMax Pro or by double-clicking on the file name or icon when you are in the Finder (Macintosh) or in the File Manager (Windows). Note that you can open SoftMax Pro files using either platform regardless of whether they were created using Macintosh or Windows (see “Cross-Platform Files,” below, for more information).

Opening SoftMax/SoftMax Pro Files (Earlier Versions)

SoftMax Pro allows you to open files from previous versions of SoftMax Pro as well as from SoftMax. From within SoftMax Pro, select the **Open** (**⌘**O; **CTRL**+**O**) command from the **File** menu. The file will open and will function in the same way as a SoftMax Pro file. If you wish, you can save the file in SoftMax Pro format by selecting **Save As...** from the **File** menu. If you do not change the name of the file and save it to the same location, a message box will appear, asking whether or not you want to replace the existing SoftMax file with the new SoftMax Pro version. If you do not, you can either choose a different location or rename the file.
While SoftMax files can be opened using SoftMax Pro, two items do not translate completely across the programs: sample blanks and auto range limits (in graph sections). The data for sample blanks obtained using SoftMax will be available when these files are opened in SoftMax Pro, but no calculations are performed automatically using this data. Auto range limits are not available when SoftMax files are opened using SoftMax Pro, so limits for the display of information in graphs must be entered manually.

**Cross-Platform Files**

If you have SoftMax or SoftMax Pro files that were created on a platform other than the one you are currently using, you can transfer these files to your computer and use them, provided you have the required software and/or hardware to do so.

**Transferring Macintosh Files to the PC**

Third-party software is available for the Windows-compatible PC that allows the insertion and reading of Macintosh 3-1/2-inch diskettes (if your Macintosh is equipped with a floppy disk drive). If you need to transfer files between Macintosh and PC platforms and do not have such software for the Windows-compatible PC, you can use PC floppy disks, Zip disks, or other storage media for both platforms since the Macintosh will be able to read them.

Macintosh computers are equipped with software that allows you to “read” and transfer files from PC disks. Make sure that File Exchange is available in the Control Panels. The process of using File Exchange is described below.

1) If you have not yet enabled File Exchange on your Macintosh, select Control Panels from the Apple () menu. From within the Control Panels, choose the Extensions Manager and turn File Exchange on by placing a checkmark next to it. Restart your computer—File Exchange will now be enabled.

2) Rename the Macintosh files you want to transfer to PC disks so that their names conform to the DOS file naming conventions: no more than eight characters, no spaces, and a three-letter extension preceded by a period. Table 9.1, below, describes the three-letter extensions that are associated with data and protocol files from SoftMax and SoftMax Pro.

3) Insert a PC-formatted disk into the Macintosh floppy drive. It will appear as an icon on the Macintosh desktop.

<table>
<thead>
<tr>
<th>Type of File</th>
<th>3-Letter Extension</th>
<th>Macintosh Document Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>SoftMax Pro Protocol File</td>
<td>.PPR</td>
<td>sPFd</td>
</tr>
<tr>
<td>SoftMax Pro Data File</td>
<td>.PDA</td>
<td>SPFd</td>
</tr>
<tr>
<td>SoftMax Protocol File</td>
<td>.Pro</td>
<td>sPFd</td>
</tr>
<tr>
<td>SoftMax Data File</td>
<td>.DAT</td>
<td>SPFd</td>
</tr>
</tbody>
</table>

**Table 9.1: PC File Name Extensions and Macintosh Document Types**
4) Drag the renamed files onto the PC disk icon to copy the files to the disk. Drag the disk to the trash to eject it.

**NOTE:** Certain special characters will not translate accurately across platforms. Characters that are created on the Macintosh using the option key, such as ®, ©, ℃, ™, or •, for example, will be shown on the PC as other letters or characters. Also, if you align items using spaces, these may or may not align when viewed on a different platform since fonts on the different platforms have different character widths.

**Transferring PC Files to a Macintosh**

Third-party software is available for the Windows-compatible PC that allows the insertion and reading of Macintosh 3-1/2-inch diskettes (if your Macintosh is equipped with a floppy disk drive). If you need to transfer files between Macintosh and PC platforms and do not have such software for the Windows-compatible PC, you can use PC diskettes or Zip disks for both platforms since the Macintosh will be able to read them.

Macintosh computers are equipped with software that allows you to “read” and transfer files from PC disks. PC files can be opened directly within SoftMax Pro as follows:

1) Choose **Open** from the **File** menu. The dialog box that appears has a drop-down menu to select the file type. The last item on this menu, “All Documents,” allows you to see all text documents with standard SoftMax Pro for Windows extensions. When selected, the file is first given a MacOS look and feel, and is then opened in SoftMax Pro.

2) Repeat steps 3 through 5 for other PC file name extensions with which you will be working.

**Saving Files Manually**

SoftMax Pro provides several ways to save files manually. If the current file has not been saved (is “Untitled”), it can be saved under any name. If you have opened and modified an existing file, you can save it under the same name (overwriting the old information) or under a different name. You can also save the file in the same or in a different location on your hard disk (in a different folder or subdirectory).

**Saving Files under the Same Name**

If you have made changes to a file and want to save these changes, thereby updating the same file, select **Save** (⌘S; CTRL+S) or **Save As...** from the **File** menu. If you select **Save** (⌘S; CTRL+S), the current version of the file will replace the old one (without notification). If you select **Save As...**, an alert box will appear, asking if you want to replace the previous file by that name. If you are intentionally replacing the file, click [Replace] or [Yes]. The new information will be written over the old information under the same file name.

**Saving Files under a Different Name or in a Different Folder**

If you have made changes to a file and want to save these changes as a new file, or if you wish to save the file to a different location, select **Save As...** from the **File** menu. A dialog box will open allowing you to enter a new name.
and/or a new location for the file. To choose a different location for the file, use the pull-down menu at the top of the dialog box to select a different folder. To change the name, overtype the existing file name. Click [OK] when you have entered all the necessary information and you are ready to save the file.

**NOTE** SoftMax Pro limits the number of characters that can be used in a file name. On the Macintosh, file names are limited to 31 characters; on the PC, the limit is 59-characters for the actual name of the file (plus a period and 3-letter extension for a total of 63 characters). Using a PC, it is possible to make a file name longer than this by manually changing it in a directory listing or by using the Save As command in the software. A file with a name longer than this limit will no longer be able to be read by SoftMax Pro and will return an error when you attempt to open it. File names that are made too long using the Save As command will show corrupted characters (such as “ÿ,” “ü,” etc.) for any letters that fall after the 63rd.

## Autosave

SoftMax Pro can be configured to save a copy of your data file automatically (Autosave) after a reading. This function is enabled in the Preferences dialog box (choose Preferences... from the Edit menu).

![Preferences Dialog Box](Figure 9.6: Preferences Dialog Box)

When you enable the Autosave function (by clicking its checkbox in the Preferences dialog box), the textbox below it becomes active, allowing you to accept or change the defaults for saving data files. The default location is the folder containing the SoftMax Pro program. You may accept or change the default file prefix and file type, and you may choose to append the date and/or time after the prefix as part of the saved file name.

The prefix for an Autosaved file can be a maximum of 15 characters. This limitation is imposed in order to ensure that the addition of either or both time and date do not extend the length of the file name beyond 31 characters (standardized at this number because it is the maximum allowable length for the...
Macintosh; for more information regarding the maximum length of file names on the PC, see the NOTE on page 9-9).

The file type for Autosaved files can be either SoftMax Pro file or ASCII text file. If you select the Text file option, you can then choose either the “Create a new file” or “Append to file” option.

You may choose to append the date and/or time to the autosaved file name. Appending the date will include the date after the prefix (e.g., “Data 8-14-01”). Choosing to include the time after the prefix will append the time that the file was saved, in hhmmss format, to the file prefix (e.g., “Data 042136”). Including both date and time will create a file name that looks something like “Data 8-14-01 042136.” If you do not append the time and perform multiple runs, either on the same day or with just a file prefix enabled, SoftMax Pro will append an index to the file name, starting with “1” and increasing by 1 with each successive reading.

Including the date and time ensure that the file will not be overwritten accidentally by another autosaved data file. Additionally, appending the time may shorten the time required for Autosaving since the software will not have to search for the next number in the index series. The recommended setting for Autosaving files is to use both the date and time if all files are being saved to the same folder; alternatively, saving files to a separate folder for each day’s runs may be useful.

**NOTE:** When Autosave is enabled in SoftMax Pro file mode for files containing multiple experiment sections, each experiment section will be autosaved to a separate file.

**NOTE:** If you are using SoftMax Pro with ROBOmax, you must deselect the Autosave and Autoprint functions. ROBOmax software automatically saves the SoftMax Pro data file after the plate is read.
Printing

Five printing options are available for an experiment:

1) You can print a report at any time by choosing Print... (⌘ P; CTRL+P) from the File menu. You can determine which sections (or whether all sections) will be printed in this report (see “The Printed Report,” below).

2) A copy of the template can be printed while you are in the Template Editor by clicking the [Print] button in the bottom left corner.

3) A report can be printed automatically at the end of a reading. To enable this function, choose Preferences... from the Edit menu and select “Autoprint.”

4) You can print the active section or selection. This option is available within the File menu. If only one section is selected, the name shown in the menu will reflect the name of the active section. For example, if the active section is named “Plate #1,” the topmost print command in the File menu would be Print ‘Plate #1’. If more than one section is selected, the menu will show Print Selection. You can select multiple sections to be printed by holding down the Shift key and clicking on the section tool bars to make them active.

5) Enlarged displays (well graphs) of Kinetic, Spectrum, or FLEX data can be printed by clicking the [Print] button in the Well Graph window. The size of the printout is dependent on the size of the well graph.

NOTE: If you enlarge the well graph to greater than 12 inches, the printout will be truncated.

Regardless of which print option you select, make sure the printer is connected properly to the computer and that it is turned on prior to sending the print request.

If Autoprint is enabled, make sure the printer is connected and that it is turned on prior to starting a reading.

If you are using a Macintosh, you can check the Chooser for the currently selected (connected) printer.

If you are using Windows, you can select a printer by choosing Print Setup from the File menu. In the Print Setup dialog box, choose the default printer or select from any other printers have been configured for use with Windows. See your Windows documentation for further information.
The Printed Report

You can create customized reports by including or excluding experiments and individual sections, changing the order in which sections will print, and adding text describing each experiment in Notes sections. You can also create summaries (consisting of reduction formulas and associated text) in Notes and Group sections. The size and content of Group sections can also be changed.

Including or Excluding Sections

When sections are created, they default to being included in the printed report. You can exclude sections from printing by clicking the print setting button on the tool bar of that section (it is a toggle, so it will change from enabled to disabled or vice versa).

Changing the print setting option for the experiment will change the state of all sections within that experiment. Changing the print setting option for one or more sections within an experiment will cause the print setting button for the experiment to change to reflect an “undecided” status with regard to the sections within it ( ). Toggling the experiment’s print setting button will override any changes made to individual sections and set all of them to printing.

When Print is chosen from the File menu, selecting Print All will override the print settings made to sections or experiments.

Customizing the Report

In addition to choosing which sections will print in the report by toggling their print status, you can choose to print all items in a file or to print only the report from the Print dialog box that appears when you choose Print from the File menu.

![Print Dialog Box](image)

Figure 9.7: Print Dialog Box

Other options regarding the appearance of the printed report can be chosen in this dialog box: you can add text to be included in the header on every page.
of the report (maximum of 100 characters in a single row), and you can include or exclude the experiment title (the name of the experiment in the file) as well as the name(s) of sections, and you can include the date and time of printing, as well as add page numbers to the report which are printed at the bottom right corner of each page. These are all enabled, by default, until you disable them by clicking in the box with the checkbox next to each option (which will deselect that option).

**NOTE:** If a Notes section is longer than can be printed on one page, a line may be cut off (not printed) at the bottom of the first page. To fix this problem, insert a carriage return in the appropriate place (above the page break) in the Notes section and print again.

### Changing the Section Order

When sections are created (either automatically by SoftMax Pro or by you), their order may not be optimal for either viewing or printing. The order of sections in the window determines how they will print in the report, and you may find that changing the order of sections makes it easier to view the data.

When you create a new section, it is positioned directly after the currently active section. To change the order of a section, first make it active by clicking on it, then click in its tool bar and drag it to a new position (on top of the section you want it to precede). Sections may be open or closed during this procedure.

---

**Figure 9.8: Moving a Section Upward**

Click in the tool bar of the active section and drag upward.
Changing the Text Format

The text in Notes and Group sections can be formatted to change its appearance. The Format Text dialog box, accessible by choosing Text Style... (⌘T; CTRL+T) from the Edit menu, provides a number of different options (see Figure 9.9).

![Format Text Dialog Box (Macintosh)]

First highlight the text you wish to format. Then choose Text Style... (⌘T; CTRL+T) and select the options you wish to apply to the selected text. You can click on the Apply button to see the result of the selections you have made, allowing you to select more or different options before finally setting the options by clicking on OK.

The Print Dialog Box

Choosing any of the Print... commands brings up a dialog box. The contents of this box will vary depending upon the type of printer you have selected or the particular printing option you have chosen, but the basic elements are the same. The dialog boxes shown below represent those displayed when you choose the Print... command from the Macintosh and from Windows.

![Print Dialog Box for the Macintosh]

You can choose to print all of the sections, regardless of whether they are included in the report, by clicking the option button next to “Print all” at the bottom left of the Print dialog box.
Figure 9.11: Print Dialog Box for Windows (Epson Stylus 800 Shown)

NOTE: If more than one printer is available to your computer, make sure you select the desired printer prior to selecting one of the Print options in the File menu. If you start to print and discover the wrong printer is selected, choose Cancel to exit from the Print dialog box. Select the correct printer (using the Chooser for the Macintosh or the Print Setup dialog box for Windows) and then repeat the print process.

Additional information regarding the general print functions available in these dialog boxes can be found in the documentation that accompanies your computer and/or printer.
Exporting/Importing Information

Exporting Data

The Export... command (a sub-menu of Import/Export located in the File menu) creates a file of data from one or more Plate sections, CuvetteSet sections, and/or Group table sections within a SoftMax Pro file. The type of data that is exported depends upon three things:

1) Selections made in the Preferences dialog box regarding the export format. Choose Preferences from the Edit menu.

![Export Format Selection](image)

**Figure 9.12:** Choosing an Export Format from the Preferences Dialog Box

Note that the dialog box above shows preferences available for a FlexStation instrument—with other instruments, the “Interpolate Wells” function is dimmed (not available).

2) Within the Preferences dialog box that appears, choose the settings for the data export that you prefer:

- For Plate sections, you can choose either time-based format, which produces a linear format for the data, or plate-based format, which exports data in a matrix format corresponding to a microplate grid. CuvetteSet sections are automatically exported as time-based data.

- Including labels will affect all data exported, but is most noticeable with Group section data since the column headings in the Group table will be shown, as will any other calculated data in summaries, etc. Labels included with Plate and CuvetteSet sections show “1-12” headers for 96-well Plate section data represented as an 8 x 12 matrix; 384-well plate data will show “1-24” headers; CuvetteSet section labels show “A1,” “A2,” etc., representing the same number of cuvettes shown in the CuvetteSet section.

- The checkbox for Interpolate Wells is available only for the FlexStation instrument. This interpolation is different from the interpolation found in the reduction dialog box (see “Interpolate Raw Data Checkbox” on page 8-34). This checkbox is used to “normalize” the kinetic read times of other wells against the read time of the first well in each column. Because injection occurs at the same time in all wells of a column but the wells are read sequentially, the reaction advances in the other wells while the first is being read. Consequently, the data in the other wells must be interpolated against the amount of time that has elapsed between injection and reading in order to fairly compare data from one well to another (and also to compare data from one run to another). Note that well-interpolated data cannot be reimported into SoftMax Pro.

- Add Filename and Date will include this information with the exported data.
3) Click [OK] to close the dialog box. 

**NOTE:** The preference settings chosen for Export Format also affect how data is copied, pasted, and Autosaved to ASCII text.

4) Display options chosen for the Plate section or CuvetteSet section. Whether raw or reduced data will be exported depends upon the display options. If raw data is displayed, raw data will be exported; if reduced data is displayed, this reduced data will be exported.

Open the Plate section or CuvetteSet section from which you will be exporting data. Click the [Display] button in the tool bar of the Plate section or CuvetteSet section to access the Display dialog box. Choose the elements of the display settings that match the data you would like to export: raw or reduced data, with or without number, and so on. When finished selecting display preferences, click [OK] to close the dialog box.

![Figure 9.13: Display Dialog Box](image)

**NOTE:** When exporting data as tab-delimited ASCII text, all reduced displays will be exported as numbers, regardless of how the data is shown in SoftMax Pro. Choosing Grayscale, Ranged, or Threshold will export the same information as the reduced number display. Choosing “with number” will also not affect the exported data, since only the raw number is exported when raw numbers are displayed and only the reduced number will be exported when reduced data is displayed.

5) Choices made in the Export dialog box.

After choosing Export... from the File menu, a dialog box will appear, asking you to choose which sections you wish to export. You can choose to export Plate and/or CuvetteSet sections (all or selected) and/or Group sections (all or selected). After choosing a name for the exported data file, click [OK] to save the exported data.
Exported tab-delimited ASCII data files have a minimum of five lines and, in most cases, will be considerably longer. An example of an exported tab-delimited file containing Endpoint data collected from a SpectraMax 250 follows. The reading was done at a single wavelength, displayed as raw data in a microplate format with labels:

```
#BLOCKS= 1
Plate: Plate#1 1 PlateFormat Endpoint Absorbance Raw FALSE 1 300 9 350 750 10 1 405 1 12 96
20.80 0.1 0.11052 0.12214 0.13499 0.14918 0.16487 0.18221 0.20138 0.22255 0.24596 0.27183 0.30042
0.12214 0.13499 0.14918 0.16487 0.18221 0.20138 0.22255 0.24596 0.27183 0.30042 0.33201 0.36693
0.14918 0.16487 0.18221 0.20138 0.22255 0.24596 0.27183 0.30042 0.33201 0.36693 0.40552 0.44817
0.18221 0.20138 0.22255 0.24596 0.27183 0.30042 0.33201 0.36693 0.40552 0.44817 0.4953 0.54739
0.22255 0.24596 0.27183 0.30042 0.33201 0.36693 0.40552 0.44817 0.4953 0.54739 0.60496 0.66859
0.27183 0.30042 0.33201 0.36693 0.40552 0.44817 0.4953 0.54739 0.60496 0.66859 0.73891 0.81662
0.33201 0.36693 0.40552 0.44817 0.4953 0.54739 0.60496 0.66859 0.73891 0.81662 0.9025 0.99742
0.40552 0.44817 0.4953 0.54739 0.60496 0.66859 0.73891 0.81662 0.9025 0.99742 1.10232 1.21825
~End
```
An example of an exported file containing Group table data is shown below:

<table>
<thead>
<tr>
<th>Group: Unknowns</th>
<th>1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sample Wells</td>
<td>Sample# Values</td>
</tr>
<tr>
<td>Un01 A1</td>
<td>1</td>
</tr>
<tr>
<td></td>
<td>A2</td>
</tr>
<tr>
<td></td>
<td>B1</td>
</tr>
<tr>
<td></td>
<td>B2</td>
</tr>
<tr>
<td></td>
<td>C1</td>
</tr>
<tr>
<td></td>
<td>C2</td>
</tr>
<tr>
<td></td>
<td>D1</td>
</tr>
<tr>
<td></td>
<td>D2</td>
</tr>
<tr>
<td></td>
<td>E1</td>
</tr>
<tr>
<td></td>
<td>E2</td>
</tr>
<tr>
<td></td>
<td>F1</td>
</tr>
<tr>
<td></td>
<td>F2</td>
</tr>
<tr>
<td></td>
<td>G1</td>
</tr>
<tr>
<td></td>
<td>G2</td>
</tr>
<tr>
<td></td>
<td>H1</td>
</tr>
<tr>
<td></td>
<td>H2</td>
</tr>
</tbody>
</table>

~End

The first line of an exported ASCII data file includes one field indicating the number of data sets in the file. This single field includes the text "##BLOCKS=" followed by a number that equals the number of data sets.

The second line of a file for a Plate or CuvetteSet section includes 19 fields that provide all of the information needed to determine the type of test that was run to measure the first data set. The following table describes each of these fields.
### Table 9.2: ASCII Data File Fields and Descriptors

<table>
<thead>
<tr>
<th>Field</th>
<th>Field Entry</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Section kind</td>
<td>Either Plate: or Cuvette:</td>
</tr>
<tr>
<td>2</td>
<td>Section name</td>
<td>Defined in Section dialog</td>
</tr>
<tr>
<td>3</td>
<td>Export version</td>
<td>Always 1 in SoftMax Pro 2.x (2 if there are headers)</td>
</tr>
<tr>
<td>4</td>
<td>Export format</td>
<td>PlateFormat or TimeFormat, set in Preferences</td>
</tr>
<tr>
<td>5</td>
<td>Read mode</td>
<td>Endpoint, Kinetic, Spectrum, Well Scan, or FLEX</td>
</tr>
<tr>
<td>6</td>
<td>Data mode</td>
<td>For absorbance plates: Absorbance or %Transmittance For others: Fluorescence, Luminescence, or Time-Resolved Fluorescence</td>
</tr>
<tr>
<td>7</td>
<td>Data type</td>
<td>Raw or Reduced</td>
</tr>
<tr>
<td>8</td>
<td>Pre-read included</td>
<td>TRUE or FALSE; always FALSE for Cuvettes</td>
</tr>
<tr>
<td>9</td>
<td>Kinetic points</td>
<td>Reduced plates and Endpoint plates = 1 Kinetic/Spectrum plates: number of reads</td>
</tr>
<tr>
<td>10</td>
<td>Kinetic or FLEX read time; Well Scan read pattern</td>
<td>Kinetic/FLEX read time in seconds or Well Scan read pattern (horizontal, vertical, X, or fill); otherwise blank field</td>
</tr>
<tr>
<td>11</td>
<td>Kinetic or FLEX interval; Well Scan density</td>
<td>Kinetic or FLEX read interval in seconds or Well Scan density; otherwise blank field</td>
</tr>
<tr>
<td>12</td>
<td>Start wavelength</td>
<td>Spectrum start wavelength; otherwise blank field</td>
</tr>
<tr>
<td>13</td>
<td>End wavelength</td>
<td>Spectrum end wavelength; otherwise blank field</td>
</tr>
<tr>
<td>14</td>
<td>Wavelength step</td>
<td>Spectrum wavelength step; otherwise blank field</td>
</tr>
<tr>
<td>15</td>
<td># of wavelengths</td>
<td># of wavelengths in Endpoint, Kinetic, Well Scan, FLEX reads; for Spectrum: blank field</td>
</tr>
<tr>
<td>16</td>
<td>Read wavelengths</td>
<td>For absorbance/luminescence: wavelengths read, separated by a space; for Spectrum: blank field; for fluorescence: emission wavelengths; for Ex/Em sweep: blank field</td>
</tr>
<tr>
<td>17</td>
<td>First column read</td>
<td>First column read (1 to max), always 1 for cuvettes</td>
</tr>
<tr>
<td>18</td>
<td>Number of columns</td>
<td>Last column read (1 to max), always 12 for cuvettes</td>
</tr>
<tr>
<td>19</td>
<td>Number of wells or cuvettes</td>
<td>Number of wells in a plate (24, 96, 384, etc.) or number of cuvettes read for a CuvetteSet</td>
</tr>
</tbody>
</table>

After Field 19, the format splits, depending on the read type. Fields 20-28 are not present for absorbance or transmittance but are included for fluorescence and/or luminescence.

<table>
<thead>
<tr>
<th>Field</th>
<th>Field Entry</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>20</td>
<td>Excitation wavelengths</td>
<td>Excitation wavelengths, separated by spaces For luminescence or sweeps, this is a blank field (the emSweep excitation wavelength is in field 16)</td>
</tr>
<tr>
<td>21</td>
<td>Cutoff option</td>
<td>Manual or Automatic</td>
</tr>
<tr>
<td>22</td>
<td>Cutoff filters</td>
<td>Cutoff filter wavelength values, separated by spaces</td>
</tr>
<tr>
<td>23</td>
<td>Sweep wave option</td>
<td>EmSweep or ExSweep or blank field</td>
</tr>
<tr>
<td>24</td>
<td>Sweep fixed wave</td>
<td>The value for the fixed (em or ex) wavelength</td>
</tr>
<tr>
<td>25</td>
<td>Reads per well</td>
<td>Number of times a well is read for a single reading</td>
</tr>
<tr>
<td>26</td>
<td>PMT setting</td>
<td>Automatic, High, Medium, or Low</td>
</tr>
<tr>
<td>27</td>
<td>Start integration time</td>
<td>Time to start integration for time-resolved fluorescence; otherwise, blank field</td>
</tr>
</tbody>
</table>
Chapter 9: File Management and Printing

The information for the first plate or cuvette section is provided in the lines following the descriptors. The number of lines of data depend on the export format and the type of test that was run. A minimum of one line of data is exported when the Time format is used with a single wavelength Endpoint read.

**NOTE**: If the instrument you are using has a temperature associated with the data (all MDC Microplate System instruments except Emax, Vmax, and UVMax), the temperature at the time of the reading will appear before the first data point in the reading.

The second line of a file for a Group table section includes fields that correspond to the number and types of columns found in that section (they are labeled as the table is labeled and look very much like the table itself.

Following the data, a blank line is included and then a line with a single termination field: ~End.

Each subsequent data set in the file includes the lines described above, a blank line, and a line with the termination field.

### Importing Data from Analyst, Acquest, ScreenStation, and FLIPR

SoftMax Pro imports data in tab-delimited ASCII text format, allowing you to import data collected by the Analyst, Acquest, ScreenStation, or FLIPR instruments into SoftMax Pro. Note that only data that can be displayed in Plate and/or CuvetteSet sections can be imported.

Three choices are available for importing information into SoftMax Pro 4.1

- **Import...** allows you to bring data from a run that was saved previously using a MDC Microplate System instrument.
- **Import Analyst...** allows you to import verbose reports generated using Criterion Host or SCREENPLAY for all instrument modes.
- **Import FLIPR...** allows you to import “FPD” files exported from FLIPR software.

The Tutorial folder contains examples of exported data from these instruments and the Assays menu lists protocols that are specific to these instruments.

**Import...**

Selecting **Import...** from the **Import/Export** menu under **File** causes the Import dialog box to appear.
Figure 9.15: Import Dialog Box

Choose the file you wish to import and click the [Import] button. Note that data to be imported must contain the appropriate header information. A new experiment is created in the open SoftMax Pro file for the imported data. New Plate sections and/or CuvetteSet sections are created for each data set within the file. Plate pre-read and CuvetteSet reference data can also be imported, but data for path-length correction cannot. Note that the time/date stamp for a section containing imported data shows “imported data” rather than a date or time.

Import Analyst...

Choosing Import Analyst... allows you to import data files generated by Analyst System instruments (including Analyst, AD/HT, Acquest, and ScreenStation). Files for import must be generated as “verbose” reports using Criterion Host 2.0 or SCREENPLAY 2.5 for all modes (ABS, FI, FP, Epi ABS, Lum, and the dual method) saved as text (*.txt).

When importing 1536-well data from the Analyst System instrument only, the first quadrant of 1536-well plate data (the top-left section of 24 by 16 wells) can be imported. This data will be displayed in the standard 384-well plate format.

Instrument parameters for each plate in the text file will be imported into a Notes section (as text) and the raw data will be imported into a Plate section. The plate ID from the text file will be used to name both the Plate and the Notes sections and the file name will be used to name the Experiment.

More than one text file can be imported into the same SoftMax Pro file by creating or copying another experiment into an existing file.

Analyst System files can be imported into a predefined protocol/template in the Drug Discovery folder under Assays in SoftMax Pro. All analysis features of SoftMax Pro can be used to analyze the file.

Import FLIPR...

Selecting Import FLIPR... allows you to import *.FPD files that have been generated using FLIPR instrument control software (version 2.0 and above).

Files are exported from the FLIPR software using the Plug Ins > Import/Export > FLIPR import menu selection. In order to import FLIPR files, they must be exported by the FLIPR software into the specific *.FPD format. Standard FLIPR files of the *.FID and *.FWD formats cannot be imported into SoftMax Pro. Files can be imported into a predefined protocol/template in the Drug Discovery
folder under **Assays** in SoftMax Pro. All analysis features of SoftMax Pro can be used to analyze the file.
Importing and Exporting Templates

Template information, saved as a tab-delimited ASCII text file, can be imported to or exported from Plate and/or CuvetteSet sections. A template file consists of seven columns of data separated by tabs. Each line of the file provides information for one well in a plate or one cuvette.

When template information is exported, the information for well/cuvette A1 is written into the first line of the file, information for well/cuvette A2 is written to the second line of the file, and so on, until a line has been created in the export file for each well in a plate or all cuvettes. If no template information exists for a well in a plate or for a cuvette, that line is left blank. The ASCII file terminates with the string “~End”.

The order for importing template information must match the export order. Similarly, blank lines in the file are assigned to a well or cuvette, providing a well/cuvette with no template setting.

Table 9.3 describes the information that is included in each column of the ASCII template file.

<table>
<thead>
<tr>
<th>Column</th>
<th>Column Entry</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Group name</td>
<td>Assigned in the Group Settings dialog box. If this field is missing, the rest of the line is ignored. Any text string can be entered in this field.</td>
</tr>
<tr>
<td>2</td>
<td>Column format</td>
<td>Assigned in the Group Settings dialog box. Five text strings are supported in SoftMax Pro 4.1: Empty, Basic, Standards, Unknowns, and Unknowns[Dilution]. Blank groups have an Empty column format. If this field is empty, the Basic column format is assigned.</td>
</tr>
<tr>
<td>3</td>
<td>Sample name</td>
<td>The sample name is set in the “Sample:” field of the Template Editor dialog box. If this field is left blank, no sample name will be assigned to the well, although the sample name will be included in the group.</td>
</tr>
<tr>
<td>4</td>
<td>Number of descriptors</td>
<td>0 for Empty and Unknown column formats; 1 for other column formats.</td>
</tr>
<tr>
<td>5</td>
<td>Descriptor units</td>
<td>Assigned in the Group Settings dialog box. Supported strings are unit/ml, mg/ml, µg/ml, ng/ml, mg, ng, and ml. If this column is left blank, unit/ml is assigned.</td>
</tr>
<tr>
<td>6</td>
<td>Sample descriptor</td>
<td>Assigned in the Group Settings dialog box. Any text string can be entered in this field or it may be left blank.</td>
</tr>
<tr>
<td>7</td>
<td>Descriptor value</td>
<td>Assigned in the Series dialog box. Can be set to any number or left blank.</td>
</tr>
</tbody>
</table>

The tab-delimited ASCII files are compatible with spreadsheet programs, such as Microsoft Excel, which makes it possible export a template from SoftMax Pro, import it into a spreadsheet, change the template, and then import it into SoftMax Pro (into the same or a different file).

Preparing a template file outside of SoftMax Pro for use with the program is not difficult if you use the parameters given above and if you also take into account the manner in which you wish the plate to be arranged. For example,
Exporting Graphs

Graphs from Graph sections and Well Graphs can be exported in PICT format (Macintosh) and EMF format (Enhanced MetaFile in Windows). Graph sections can be exported by choosing Export Graph from the Graph menu. Well Graphs can be exported by choosing Export Graph from the Plots menu that appears when a Well Graph is opened.

Copying and Pasting

Parts of an experiment can be copied within a SoftMax Pro file, to or from another SoftMax Pro file, or to or from another program using the Copy and Paste commands. Plate section and CuvetteSet section data, and text and summaries in Notes sections can be copied and pasted to other sections within the same or a different experiment within SoftMax Pro or to other programs. Virtually any ASCII-formatted text can be copied and pasted into a Notes section. A graph can be copied and the resulting picture pasted into another application. Template information can be copied and pasted from one part of a template to another (within the same or to different templates and from one experiment to another).

Plate Section and CuvetteSet Section Data and Templates

Copying and Pasting within SoftMax Pro

Data can be copied from one Plate section to another or from one CuvetteSet section to another within SoftMax Pro. Make the source section active by clicking on it and then choose Copy (⌘C; CTRL+C) from the Edit menu. Create a new section, if necessary, and make the destination section active. Choose Paste (⌘V; CTRL+V) from the Edit menu to paste the data into this section.

NOTE: When copying Plate sections, all well data is copied. It is not possible to copy and paste the data from only certain wells. Even if you select only one well prior to choosing the Copy (⌘C; CTRL+C) command, all plate data will be copied and pasting will replace all data in the destination plate (PathCheck data is not copied). It is possible, however, to copy individual cuvettes or groups of cuvettes and paste these into other CuvetteSet sections.

If the Instrument Settings of the target section do not match the settings from the section being copied, the Instrument Settings for the target section will be updated appropriately to match.

Templates can also be copied from one Plate section to another or from one CuvetteSet section to another within SoftMax Pro. However, the effects of this action depend on whether you are pasting the template to another section in the same experiment from which it was copied or to a section in a different experiment. Pasting a template to a section in the same experiment from which it was copied is useful for cross-plate analyses since corresponding wells in each plate will be assigned to the same group and sample.

Pasting a template to a section in a different experiment will create new groups in that experiment if those groups have not previously been created in that experiment. If you are pasting templates between experiments, and groups from the source template do not exist in the destination experiment, pasting a template will create them. Existing groups of the same name will not be changed by the pasting process. For example, if the template being
copied contains the groups “Standard” and “Unknown,” and the group “Standard” already exists in the destination experiment, the group “Unknown” will be created but all information regarding the group “Standard” in the destination experiment will remain unchanged.

Experiments define a naming scope for the sections within them, which is especially important for Group sections: it allows you to have identical groups (name and column format) within two or more different experiments in the same file. Having multiple experiments in the same file also provides you with quick access to different types of information without having to open or refer to multiple files.

If you are copying cuvette data and the target CuvetteSet section does not contain the appropriate cuvettes for the data that is to be pasted, new cuvettes will be created automatically. Please note that pasting cuvette data for only some cuvettes will clear the existing data from all other cuvettes in that section. For example, if cuvettes A2, A4, and A6 are copied from CuvetteSet#1 and you attempt to paste this data into CuvetteSet#2 which contains cuvettes A1 through A12, the data in all twelve cuvettes will be cleared and then cuvettes A2, A4, and A6 will receive the pasted data. An alert box will ask whether or not you wish to replace all the data before proceeding.

Copying from Other Programs

Plate section data, CuvetteSet section data, and Notes section text can be copied from programs other than SoftMax Pro and pasted into a Plate section, CuvetteSet section, or Notes section. For Plate section data, the format of the copied information must match the Instrument Settings of the target Plate section and the settings chosen in the Export Format in the Preferences. Pre-read data cannot be pasted into a Plate section. If there is a mismatch between the data to be pasted and the target section, SoftMax Pro will attempt to paste the data, but if it cannot do so, an error message will result (an example of such an error message for a Plate section is shown in Figure 9.16). After data is pasted into a Plate section, the information to the right of the display will show “imported data.”

![Error Message Generated When Pasting Mismatched Data](image)

**Figure 9.16**: Error Message Generated When Pasting Mismatched Data

**NOTE**: If you have created a template for a Plate section prior to pasting data, numbers will be shown only in the group(s) you have created in the template. Data in other wells will not be reported (but will be available if you alter the template). Clearing the template or assigning groups to all wells in the plate will show the complete data set. Templates for CuvetteSet sections do not change the way the data is shown in the display (all cuvettes will show data, regardless of whether or not the template has only certain cuvettes assigned to groups.
Copying to Other Programs

Plate section, CuvetteSet section, Group table section, and Notes section data can be copied from SoftMax Pro and pasted into another program that will accept the data (such as a spreadsheet or word processing program). No copy or paste features are available for Graph sections or Well Graphs, but these graphs can be exported as either PICT or EMF files (see “Exporting Graphs” on page 9-25 for more information).

Group Columns

You can copy a Group column and paste it within another Group in the same experiment or into a Group of another experiment. The data included in the pasted columns will be appropriate for the target group.

Highlight the column, select **Copy** (⌘C; CTRL+C) from the **Edit** menu; then activate the section into which you want to paste the column and select **Paste** (⌘V; CTRL+V) from the **Edit** menu. If you highlight a column in the destination section, the column you are pasting will appear to the right of the highlighted column. Otherwise it will be appended to the right of all existing columns.

Columns and summaries in Group sections can also be copied and pasted to other programs. Data from other programs cannot be pasted into Group sections within SoftMax Pro, however.

Copying Formulas and Summaries

Formulas are used in Group columns, custom reductions, and summaries. Sometimes it is useful to copy an existing formula, column, or summary from one area of the program to another, or from one experiment to another, rather than taking time to recreate it. Summaries can also be copied and pasted within SoftMax Pro. After pasting, both formulas and summaries can be edited.

**NOTE:** Contiguous column formulas may be copied and pasted together.

**Summaries** must be copied and pasted individually.

To copy a formula or summary, highlight it and then select **Copy** (⌘C; CTRL+C) from the **Edit** menu. Activate the area or section in which you would like to paste it; if necessary, with a formula, access the particular dialog box into which it will be pasted. After placing the cursor in the correct location and highlighting any existing information to overwrite it, select **Paste** (⌘V; CTRL+V) from the **Edit** menu. The pasted formula or summary will appear in the new location.

Formulas and summaries can be deleted by highlighting them and pressing the Delete key or choosing **Cut** from the **Edit** menu.

Duplicate and New

**Duplicate**  

All sections and even complete experiments can be **duplicated** by making the section or experiment active and then selecting **Duplicate** from the **Edit** menu. All of the information in the section or experiment (including data) is copied to the newly created section or experiment. The name of the new section or experiment is the same as that of the original with the addition of the word “Copy” (e.g., “OldName Copy”). Duplicated sections are created at the end of the experiment. Duplicated experiments are created beneath the other experiments.

Duplicating a CuvetteSet section creates a copy of the previous CuvetteSet section, including the last reference that was read.
Group section tables can also be duplicated. When a Group table is duplicated, its name is added to the Template Editor’s list of group names (but the group is not assigned to any wells).

Graph sections that are duplicated include all settings for plots, fit, etc.

Notes sections are duplicated exactly, including any summaries and all text.

**New**

New sections and new experiments can be created by selecting **New** from the **Section** or **Experiment** menu. If an existing section or experiment is active when this command is chosen, all of the information in the section or experiment (except data) is copied to the newly created section or experiment. The name of the new section or experiment is the same as that of the original with the addition of an incrementing number (e.g., “OldName#2”). A new section is created immediately below the active section. A new experiment is created immediately below the active experiment.

Creating a new CuvetteSet section creates a copy of the previous CuvetteSet section, including the template, if any, but this section contains no data.

New Group section tables can also be created but are devoid of any data.

New Graph sections include all settings for plots, fit, etc., but contain no data.

New Notes sections are exact copies of the active Notes section, including any summaries and all text (same as duplicated Notes sections except for the name).

**Table 9.4: New vs. Duplicate within an Experiment**

<table>
<thead>
<tr>
<th>Section</th>
<th>New</th>
<th>Duplicate</th>
</tr>
</thead>
<tbody>
<tr>
<td>Notes</td>
<td>Empty Notes section.</td>
<td>Replicates text and summaries from source Notes section.</td>
</tr>
<tr>
<td>Plate</td>
<td>Replicates Instrument Setup, Reduction,</td>
<td>Replicates Instrument Setup, Reduction, and Display parameters from last Plate section created.</td>
</tr>
<tr>
<td>Cuvette-Set</td>
<td>Replicates Instrument Setup, Reduction,</td>
<td>Replicates Instrument Setup, Reduction, and Display parameters from last CuvetteSet section created. Also copies the last reference that was read and the number of cuvettes defined from the source CuvetteSet section.</td>
</tr>
<tr>
<td>Graph</td>
<td>Creates a new Graph section with default</td>
<td>Replicates all Graph settings, including any plots that were defined in the source Graph section.</td>
</tr>
<tr>
<td>Group</td>
<td>Not available</td>
<td>Creates a replicate of the source Group section table. The new group will be in the template Group drop-down menu but no wells will be assigned to this group.</td>
</tr>
</tbody>
</table>
File Protection

Individual protocol and data files can be protected from changes. Two types of protection are available:

- **Password Protection** avoids changes being made to a protocol or data file by persons who do not know the password and provides an electronic signature with the file;
- **Shielding a File** preserves the integrity of data in a file by prohibiting *any* changes to the file (with the exception of adding or changing text or summaries in a Notes section). Additionally, shielding requires both an author’s and user’s name.

**Password Protection**

When a *protocol* file is password protected, you may read data into the file but may not change it in any other way without entering a password. When a *data* file is password protected, you may view the file but are unable to make changes without entering a password. Password protecting a file requires that you enter an author’s name and password. Table 9.5 shows the actions that are protected when a password is assigned to a SoftMax Pro file.
### Table 9.5: Actions Protected by Password

<table>
<thead>
<tr>
<th>Menus</th>
<th>Tool Bar Buttons</th>
<th>Dialog Boxes</th>
<th>Others</th>
</tr>
</thead>
<tbody>
<tr>
<td>File&gt;Page Setup</td>
<td>Read*</td>
<td>Summary</td>
<td>Moving a formula in a Notes section</td>
</tr>
<tr>
<td>File&gt;Import</td>
<td>Ref.*</td>
<td>Instrument Setup</td>
<td>Resizing columns in a Group</td>
</tr>
<tr>
<td>File&gt;Save</td>
<td></td>
<td>Template Editor</td>
<td>Moving sections and experiments</td>
</tr>
<tr>
<td>File&gt;Save As...</td>
<td></td>
<td>Reduction</td>
<td>Typing in sections (Notes, Plate, and Cuvette-Set)</td>
</tr>
<tr>
<td>Edit&gt;Undo</td>
<td></td>
<td>Display</td>
<td></td>
</tr>
<tr>
<td>Edit&gt;Cut</td>
<td></td>
<td>Mask Well</td>
<td></td>
</tr>
<tr>
<td>Edit&gt;Paste</td>
<td></td>
<td>New Column</td>
<td></td>
</tr>
<tr>
<td>Edit&gt;Clear</td>
<td></td>
<td>Edit Formula</td>
<td></td>
</tr>
<tr>
<td>Edit&gt;Delete Section</td>
<td></td>
<td>Plots</td>
<td></td>
</tr>
<tr>
<td>Edit&gt;Duplicate Section</td>
<td></td>
<td>Graph Options</td>
<td></td>
</tr>
<tr>
<td>Edit&gt;New Experiment</td>
<td></td>
<td>X-Axis/Y-Axis</td>
<td></td>
</tr>
<tr>
<td>Edit&gt;New Section</td>
<td></td>
<td>All Section Settings</td>
<td></td>
</tr>
<tr>
<td>Edit&gt;Text Style</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Control&gt;Instrument Setup</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Notes (all items)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Plate (all items)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Group (all items)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Graph (all items)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Cuvette (all items)</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

* Only if data exists in the section.
Setting and Changing a Password

Choosing *Set Password*... from the **File** menu causes the Password dialog to appear. If the active document is already password protected, the menu command changes to **Change Password**... . Passwords can be from 1 to 8 characters long and can include all characters available from the keyboard. You must also enter an Author Name that will be saved and printed with the data.

![Set Password/Shielding Dialog Box](image)

*Figure 9.17: Set Password/Shielding Dialog Box*

*Left, no password set previously; right, with previously set password.*

This dialog box appears differently depending upon whether or not you are setting a password for the first time or if you are changing/removing a password. If you have not previously set a password, the dialog box will appear like that on the left of Figure 9.17. To set a password, type it in both boxes (first to set it and then to confirm it). After an Author’s name has been entered, this name will appear at the lower left of the Plate or CuvetteSet section. When a file has been password protected, an icon showing a lock will also appear at the top right of the title bar of the SoftMax Pro program ( ).

When changing or removing a password, the dialog box will appear as shown on the right of Figure 9.17. Before you can change or remove the password, you are required to enter the old password in the top text box. After entering the old password, checking the box next to “Remove Password” and typing nothing in the rest of the boxes will clear the password from the file when you click [OK]. Otherwise, entering a new password and confirming it with a second entry will update the password protection.

Be sure to choose a password that you will be able to remember since the file will be locked to changes of nearly any kind should you forget it. If you try to perform an unauthorized action on a password-protected file, a dialog box will appear asking you to enter the password.

⚠️ **CAUTION:** SoftMax Pro provides no means of overriding password protection. If you are concerned that you might forget your password, write it down and store it in a safe place for future reference.
Figure 9.18: Password Required Dialog Box

When this dialog box appears, you must enter the password in order to continue with the action you have chosen. Note the Author’s name shown in the lower-left corner of the Plate section. This Author’s name and the password are tied together in an electronic signature. Once an Author’s name has been entered for a file, it can not be changed unless password protection is removed.

If you do not remove password protection prior to trying to change the file, every attempt to change the file will cause this dialog box to appear. Enabling the Suspend Password option (click the box to check it) will stop this repeat prompting.
Chapter 10  Tutorials

Introduction .................................................. 10-3
Tutorial 1: Quantitative Endpoint Assay Tutorial ...............10-4
  Hard and Soft Parameters .................................10-4
  Description of the Assay Example .......................10-5
  Define the Protocol .....................................10-6
Start SoftMax Pro (Create a New File) ...................... 10-6
  Define the Instrument Settings .........................10-9
  Define the Template ..................................10-12
  Set the Reduction Parameters .........................10-19
  Set the Display Parameters ............................10-20
  Read the Plate .......................................10-22
  Data Analysis—Group Sections .......................10-25
  Data Analysis—Standard Curve .......................10-31
  Print a Report ......................................10-34

Tutorial 2: EC 50 Assay Tutorial (FLEX mode only) ..........10-35
  Hard and Soft Parameters .................................10-35
  Description of the Assay Example ...................10-36
  Define the Protocol ..................................10-37
Start SoftMax Pro (Create a New File) ...................... 10-37
  Define the Instrument Settings .........................10-38
  Define the Template ..................................10-48
  Set the Reduction Parameters .........................10-51
  Set the Display Parameters ............................10-52
  Read the Plate .......................................10-54
  Data Analysis—Group Sections .......................10-57
  Data Analysis—Graph ................................10-64
  Data Analysis—Summary Formula ...................10-65
  Print a Report ......................................10-67
Introduction

The “hands-on” written tutorials included in this chapter are designed to take you through the basic features of the SoftMax Pro program. If you are new to SoftMax Pro, we suggest that you read and follow the steps in one of the tutorials before using SoftMax Pro for the first time since it will help you learn to use the basic features of SoftMax Pro quickly. To learn more about SoftMax Pro, you will want to look through Chapter 3, “SoftMax Pro Overview,” and either Chapter 4 or 5 which describes how to set up for and perform a reading (choose the chapter that is appropriate for the instrument you are using). We also suggest that you read the introduction to the Formula Reference Guide.

NOTE: If you have not yet installed SoftMax Pro, refer to Chapter 2, “Installation,” and follow the steps listed there to install the software before proceeding with the tutorial.
Tutorial 1: Quantitative Endpoint Assay Tutorial

This tutorial section will lead you through the steps required to create and run a quantitative assay utilizing a standard curve. This tutorial is designed to be used by both absorbance and fluorescence instruments. (To learn more about using FLEX mode with the FlexStation instrument, go to Tutorial 2 on page 10-35.)

**Hard and Soft Parameters**

The only settings that must be defined before reading a microplate are the instrument settings (found in the Instrument Setup dialog box). These settings tell the instrument what conditions should be in place in order to collect data. They include the read mode (Endpoint, Kinetic, Spectrum, or Well Scan), the number of wavelengths, specific wavelength settings, and so on. These settings, called “hard” parameters, define the conditions under which the data is obtained. Once a microplate has been read, the instrument settings cannot be changed without deleting the data.

“Soft” parameters include the template definition and data reduction settings. These parameters can be defined prior to reading a microplate, but they are applied only after the plate is read and can be changed at any time.

In this tutorial, you will build a complete protocol (based on the settings found in the Default Protocol file1) which will include both hard and soft parameters. You will save the completed protocol file prior to collecting data (this file could then be used to generate future data files).

**NOTE:** You should ensure that the instrument that is connected to the computer is chosen in the Preferences before proceeding: in the Edit menu, choose Preferences. In the dialog box that appears, choose your instrument (if it is not already chosen) and then close the dialog box.

A synopsis of the steps you will take during this tutorial is given below.

1. Create a new file
2. Instrument setup
3. Template setup
4. Set reduction parameters
5. Set display parameters
6. Save the protocol
7. Read the plate (start the simulator and then open the Tutorial file)
8. Analyze data—Standard Curve
9. Analyze data—Standard section
10. Print the report

---

1: When you install SoftMax Pro, you are asked to choose between absorbance, fluorescence, or FlexStation installation. The choice made at that time will determine the type of default protocol file that is installed. Tutorial 1 pertains to users of either absorbance or fluorescence instruments; Tutorial 2, later in this chapter, deals with the FlexStation instrument.
Description of the Assay Example

Following are the details about the quantitative assay settings we will use to create a protocol file using SoftMax Pro.

**Read Mode:** Endpoint  
**Standards in µg/ml:** 0, 0.1, 0.25, 0.5, 0.75, 1.0, and 1.4 (each standard run in duplicate)  
**Standard Curve Fit:** Linear  
**Blanks:** Plate blank run in duplicate  
**Auto Mix:** On  
**Autocalibrate:** On

**Instrument Settings Specific to Absorbance Instruments:**  
**Wavelengths:** One—405 nm  
**Strips:** Read entire plate

**Instrument Settings Specific to Fluorescence Instruments:**  
**Wavelengths:** One—Excitation: 485; Emission: 538; Auto Cutoff  
**Sensitivity:** 6 readings; Auto PMT  
**Assay Plate Type:** 96 Well Standard  
**Wells to Read:** Read entire plate  
**AutoRead:** Off
Define the Protocol

The following steps will guide you through the process of creating a protocol file for a quantitative assay. Reading an actual plate will not be required—you will use a simulator to “read a plate” and generate data.

Step 1: Start SoftMax Pro (Create a New File)

Double-click the SoftMax Pro icon to start the program. If SoftMax Pro is already running, choose New... from the File menu. You should see a new file labeled “Untitled.” The figure below shows an example of both the absorbance (bottom left) and fluorescence (upper right) Default Protocol file.
Figure 10.1: Default Protocol/Tutorial 1 Notes and Plate#1 Sections Open
If you are using an absorbance instrument, CuvetteSet#1 (shown in the absorbance file above, bottom left) can be deleted since the use of a cuvette is not covered in this tutorial. To delete this section:

1) Click in the title bar of the CuvetteSet#1 section (it will turn gray and the title will become bold). From the Edit menu, choose Delete CuvetteSet#1. A small dialog box will appear, asking you to confirm deletion of this section. Click the Delete button and the section will be deleted.

2) The experiment should now have a Plate section (“Plate#1”), a Graph section (“Graph#1”), and two other group sections (“Controls” and “Unknowns”) that will be used in this tutorial.
Step 2: Define the Instrument Settings

Click the Plate#1 section to make it active (its tool bar will become gray) and then click the [Setup] button in the tool bar to open the Instrument Settings dialog box. At the top of the dialog box, “Endpoint” is selected by default as the read mode; no change is required.

Clicking the setting name (bold heading) on the left side of the Instrument Settings dialog box shows the choices available for that setting in the right pane, allowing you to make changes. The table below shows the settings that should be chosen for this tutorial example for both absorbance and fluorescence instruments. Following the table are instructions regarding how to choose those specific settings.

Table 10.1: Instrument Settings for Absorbance and Fluorescence Instruments

<table>
<thead>
<tr>
<th>For Absorbance Instruments</th>
<th>For Fluorescence Instruments</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Read Type:</strong> Fluorescence is the default and is correct for this tutorial example.</td>
<td></td>
</tr>
<tr>
<td><strong>Wavelengths:</strong> 1 — 450 nm (default)</td>
<td><strong>Wavelengths:</strong> 1 — 485 nm (default)</td>
</tr>
<tr>
<td><strong>Pathcheck:</strong> Off (default) (this setting only available with certain instruments)</td>
<td><strong>Sensitivity:</strong> Readings: 6 (default) PMT: Auto</td>
</tr>
<tr>
<td><strong>Automix and Blanking:</strong></td>
<td><strong>AutoCalibrate:</strong> On (default)</td>
</tr>
<tr>
<td>Automix Before: Off (default)</td>
<td><strong>AutoMix:</strong> Automix Before: Off (default)</td>
</tr>
<tr>
<td>Pre-Read Plate: Off (default)</td>
<td><strong>AutoRead:</strong> Off (default)</td>
</tr>
<tr>
<td><strong>Strips:</strong> Read entire plate (default)</td>
<td><strong>Assay Plate Type:</strong> 96 Well Standard (default)</td>
</tr>
<tr>
<td><strong>AutoRead:</strong> Off (default)</td>
<td><strong>Wells to Read:</strong> Read entire plate (default)</td>
</tr>
</tbody>
</table>
**Read Type (Fluorescence instruments only)**

Choices are fluorescence, luminescence, or time-resolved fluorescence. The default setting, fluorescence, is used in this tutorial so no change is necessary.

**Wavelengths**

Click the word “Wavelengths” on the left side of the Instrument Settings dialog box to make it the active tab. A black bar will appear over the word and the right side of this dialog box will then show the specific settings for the wavelengths selection. If the settings are not correct as shown, click the arrow next to the number of wavelengths and choose “1” from the drop-down list; then click the arrow next to the wavelength shown and choose the appropriate value(s) for your instrument (see Table 10.1 on page 10-9). The figure below shows what the Instrument Settings dialog box might look like at this point (depending upon which instrument is connected to your PC).

![Figure 10.2: Instrument Settings Dialog Box Showing Wavelengths Settings](image)

*Top left: absorbance instrument; bottom right: fluorescence instrument.*

**Sensitivity (Fluorescence instruments only)**

Now check the settings for Sensitivity by clicking that heading on the left side of the dialog box: the defaults shown on the right side (6 Readings, Automatic PMT Sensitivity) are fine and do not need to be changed for this tutorial.

**Automix or Automix and Blanking**

Now check the settings for Automix (fluorescence) or Automix & Blanking (absorbance) by clicking the heading on the left side of the dialog box: on the right, Automix “Before” should be set to “Off”; “Pre-Read Plate” should be set to “Off.” If not, click the appropriate checkbox to turn the setting on or off. When you are finished, the dialog box should look similar to the one shown in Figure 10.3.
The Instrument Settings dialog box for some instruments may show additional choices: PathCheck, AutoCalibrate, Assay Plate Type, Wells To Read, Strips, AutoRead, etc. The online Help index can be used to learn more about these features. For example, to learn about “AutoCalibrate” shown in this dialog box, choose Index from the Help menu. Then type “autocalibrate” in the first field and double-click the result showing “Autocalibrate” in the second field. A description of AutoCalibrate should now be displayed.

Instrument settings are now complete. Click [OK] to accept the settings and close the dialog box.
Step 3: Define the Template

A) Click the **Template** button in the Plate section tool bar. This will open the Template Editor, showing all wells empty. Drag the mouse (or shift-click) to select the first two wells, A1 and A2. Click the **Group** pull-down menu on the Template Editor to see the group selections. Choose Blank. The two selected wells in the template will now be defined as the plate blank.

![Figure 10.4: Template with Plate Blank Wells Assigned](image)

B) Now select the two wells B1 and B2. Select “Standards” from the Group menu. The selected wells will now show the default first sample name for the Standards group, “St01.” The area in the top center of the Template Editor will become active, showing the default values for concentration and units.

![Figure 10.5: Template with First Standards Entered](image)
In this tutorial, the concentration for the first Standard should be set to 0 µg/ml. If a value other than “0” is shown, highlight the existing value and enter 0 in this box. Click the [Assign] key or press either the Tab or Return key on the keyboard to assign this concentration to the selected wells in the template. You can quickly check the concentrations you have assigned to the template by pressing and holding the CTRL+Shift keys (Macintosh or Windows). This causes the display to show only group names and values assigned to specific wells.

Figure 10.6: Template showing First Standards Concentrations

C) Now select wells C1 and C2. “Standards” is still showing as the default group name, but a new sample descriptor is created automatically (St02), so all you need to do is assign a concentration value of 0.1 µg/ml to these wells. After entering the value, click the [Assign] box (or press the Tab or Return key) to assign this value to the selected wells.

D) A total of seven standards will be assigned in duplicate in this template. You can use the Series function to assign the next four standards. Select wells D1/D2 through G1/G2. Click the [Series] button. In the dialog box that appears, leave the default values for the sample descriptor (Std03), starting from the top, and the concentration in µg/ml. Enter 0.25 for the starting value, choose the “Step by” function “+” and enter 0.25 for the increment of the series. These choices will cause the series of wells you have selected to be assigned concentrations of 0.25, 0.5, 0.75, and 1.0 µg/ml, respectively. The choices you have made should look like this:
Chapter 10: Tutorials

Figure 10.7: Series Dialog Box

Click the [OK] button to close the dialog box and return to the Template Editor. The four sets of wells you selected should now be assigned the values entered for the series. You can check the concentrations assigned to these wells by pressing and holding the CTRL+Shift keys.

Figure 10.8: Template with CTRL+Shift Keys Depressed

E) The last standards need to be entered manually. Select wells H1 and H2. A new sample descriptor is created automatically (St07), so all you need to do is assign a concentration value of 1.4 µg/ml to these wells. After entering the value, click the [Assign] box (or press the Tab or Return key) to assign this value to the selected wells.

The template should look like the one in Figure 10.9 when you are finished entering the Standards.
This tutorial example uses seven separate unknown samples, with each unknown being placed in four wells. The unknown samples should be entered on the template as follows:

- Sa01—wells A5 through D5
- Sa02—wells A6 through D6
- Sa03—wells E6 through H6
- Sa04—wells A7 through D7
- Sa05—wells E7 through H7
- Sa06—wells A8 through D8
- Sa07—wells E8 through H8

Start by highlighting wells A5 through D5. Select “Samples” from the Group menu. The selected wells will now show the default first sample name for the Samples group, “Sa01.” The template should look like the one below.
Continue highlighting the wells as described above, assigning new unknown sample descriptors to each subsequent group. When all seven unknown samples have been added to the template, it should look like this:

![Figure 10.11: Samples Added](image1)

G) This tutorial example uses two controls, with each control being placed in three wells. The controls should be entered on the template as follows:

- Co01—wells A9 through C9
- Co02—wells D9 through F9

Start by highlighting wells A9 through C9. Select “Controls” from the Group menu. The selected wells will now show the default first sample name for the Controls group, “Co01.” Do the same for wells D9 through F9, assigning the default second sample name, “Co02” to these wells. The template should look like the one below:

![Figure 10.12: Controls Added](image2)
H) The last items to be added to the template are samples with dilution. To do this, you will need to create a new group. First choose the wells of the template that will contain these samples: A11 through G12. Click the Group pull-down menu and choose “New...” from the bottom of the list. This causes a dialog box to appear, allowing you to choose the attributes for the new group. Name the group “Sam w/dil” and choose “Unknowns (dilution)” for the Column Format. This causes a checkmark to appear in the Sample Descriptor box and puts “Dilution Factor” into the text box automatically. To the right of this text box, define the units by clicking the arrow next to the drop-down menu and choose “µg/ml.” The dialog box should look like the one below.

![Group Settings](image)

*Figure 10.13: Samples with Dilution Added*

When you click the [OK] button to close the dialog box, the template should look similar to the one below.

![Experiment 1: Plate 1](image)

*Figure 10.14: Samples with Dilution Added*

The samples with dilution need to be changed to be part of a series, however, since we really want to include six different samples with replicates. Highlight wells A11 through G12 again and click the [Series] button.
Leave the default direction from the top down and leave the default operator of divided by 1. Enter “10” for the starting dilution. The Series dialog box should look like this:

![Series Dialog Box for Samples with Dilution](image)

**Figure 10.15: Series Dialog Box for Samples with Dilution**

Clicking [OK] in the Series dialog box causes the template to look like this:

![Samples with Dilution Made into a Series](image)

**Figure 10.16: Samples with Dilution Made into a Series**

1) The template is now complete. Click the [OK] button to accept the entries and close the Template Editor. The outlines of the groups you have defined in the Template Editor will now be shown in the Plate section.
Chapter 10: Tutorials

Step 4: Set the Reduction Parameters

Click the [Reduction] button in the Plate section tool bar to open the Reduction dialog box.

The default reduction settings for a single measurement wavelength, “Lm1,” are acceptable and no changes are required. For absorbance instruments, make sure the radio button next to “Absorbance” is chosen and that the checkboxes next to next to the options for using a plate blank, etc., are not checked. Click [OK] to close the dialog box.
Step 5: Set the Display Parameters

Click the [Display] button to open the Display dialog box.

Figure 10.19: Display Dialog Box

The default display for Endpoint readings is raw OD for absorbance instruments and raw RFU for fluorescence instruments. It is not necessary for the purposes of this tutorial to show a reduced number, so make sure the checkboxes next to the options under “Show” are not checked. If you decided later that you would like to view the reduced data, you can change the display options after the reading since this does not affect the actual data—only how it appears on the screen and printout.

Click [OK] to close the dialog box.
Step 6: Save the File

Choose **Save** from the **File** menu. Because the file has not been saved before and is not named, the Save As... dialog box will open.

![Save As... Dialog Box — Macintosh](image)

*Figure 10.20: Save As... Dialog Box — Macintosh*

![Save As... Dialog Box — Windows](image)

*Figure 10.21: Save As... Dialog Box — Windows*

On the Macintosh, click the option button next to “Protocol File.” In Windows, click in the box under “Save File as Type:” and choose “Pro Protocol Files (*.ppr).” Type the name you are giving to the file in the text box (highlighted over “Untitled”). In this example, type **Tutorial**. When you have finished entering information in this dialog box, click **Save** to save a copy of the protocol file to the hard disk.

**NOTE:** The title bar of the window will still show “Untitled,” rather than “Tutorial” after saving. This does not mean the protocol has not been saved. When you create a **protocol** file, SoftMax Pro saves a **copy** of the current file under that file name but does not display the name on the screen. Protocol files are saved as template files (on the Macintosh, these are known as **stationery** files). When you open a protocol file, an
“Untitled” window appears, containing all the protocol information saved previously, so that you can collect data and save the resulting data file under a different name.

Congratulations! You have just created a SoftMax Pro protocol file. Now would be the time to read the plate and then save the data file. In this tutorial example, however, you will not perform an actual plate reading but will use a simulator program built into SoftMax Pro to generate “data” that you will manipulate as if it had been obtained from an actual reading. The same data is also contained in a file provided with the original software from Molecular Devices called “Endtut.pda.” The data in this file was generated using the parameters you have just created in this protocol file.

Step 7: Read the Plate

If you were reading an actual microplate at this time, you would prepare the microplate as it is defined in the Template Editor. (Before an actual reading, you might find it helpful to print a copy of the template to assist in properly filling the plate.) You would then place the filled microplate in the drawer of the MDC Microplate System instrument. Since we are using a simulator, you don’t need to load anything in the instrument. To enable the simulator, hold down the Ctrl and Shift keys and then choose Enable Simulator from the extended menu choices that appear in the Control menu (see the figure below).

![Control Menu](image)

**Figure 10.22: Extended Choices in the Control Menu**

Now that the simulator is active, click the [Read] button in the SoftMax Pro status bar at the top of the screen to initiate the simulated reading.

Values will appear in the data display in the Plate section as if they were being read by the MDC Microplate System instrument (faster than in real time). (Note that these same values are contained in a file called Endtut.pda in the Tutorial folder within the SoftMax Pro folder on your hard drive. If you wish, you can open and use the data in that file instead from this point forward.)

The plate section of either file should look similar to the figure below.
Figure 10.23: Plate Section with Simulated Data (Absorbance instrument example)

The display for each well that is defined by a group boundary shows a raw value. The reduction formula is shown at the bottom of the display: “Wavelength Combination: !Lm1”.

A) Click the [Display] button in the Plate section tool bar. The Display dialog box will open.

Figure 10.24: Display Dialog Box

The current display selection is shown as a depressed button (raw values without a reduced number).
Click the [Reduced] button. The following options will appear:

**Figure 10.25: Display Options for Reduced Displays (Absorbance shown)**
Choose “Grayscale” from the drop-down menu that appears when you click the Display options menu. The dialog box will update to show the low and high limits for grayscale display values (which are automatically set to the minimum and maximum data values).

**Figure 10.26: Display Dialog Box Updated with Low and High Limit Settings (Absorbance shown)**
Click [OK]. The dialog box will close, and the data display in the Plate section will update to show the data represented by shades of gray as shown in Figure 10.27.

![Figure 10.27: Plate Display with Data Displayed as Gray Scale (Absorbance shown)](image)

### Step 8: Data Analysis—Group Sections

Group sections are created automatically by SoftMax Pro when you define groups in the Template Editor. In this tutorial, some groups were already created when you started the new file and a new one was added when you created the new group, Sam w/dil. The content of Group sections changes depending on the wells that are assigned to these groups in the Template Editor. Before a plate is read, these sections show no data for the wells. After a reading, Group sections contain information about the values for the wells contained within the groups.

Scroll down until the Standards Group is visible. It should look similar to this:

![Figure 10.28: The Group Section for Standards (Absorbance shown)](image)

The columns in this group are set up as follows, from left to right:

- **Sample**: the seven sample names assigned for the Standards group
- **Concentration**: the concentrations assigned to each sample in the template
• **BackCalcConc**: Returns the curve fit associated with the plot of Standards from the Standard Curve against the Values column.

• **Values**: raw OD values obtained for each sample

• **MeanValue**: the mean of data from the Value column for each sample

• **StdDev**: standard deviation for each sample value

• **CV%**: coefficient variation percent for each sample value

In the following part of this tutorial, you will view formulas associated with columns and summaries, resize individual columns, autosize all the columns, add a column, and hide replicates.

A) **Viewing Formulas.** To view the formulas associated with all columns in the Standards Group section, hold down the CTRL+Shift keys while this group is active. A second row will appear beneath the column titles, showing the formulas for each column. Depending on the size of the column, all or only part of the formula may be shown.

![Figure 10.29: A Portion of the Standard Group Section with Formulas Shown (by Pressing the CTRL+Shift Keys)](image)

If column formulas are long, as in this tutorial example, they may not be seen in their entirety in the default column size. To see the complete formula for a particular column, click once on a column to highlight it. The formula for that column will be shown in the tool bar.

![Figure 10.30: Standards Group Section with Formula Shown for Highlighted Column (BackCalcConc)](image)

Click the button to modify or change a formula.

B) **Resize and then Autosize a Column.** Position the pointer on the line dividing the columns named “Concentration” and “BackCalcConc.” The pointer will change to a double-headed arrow. Click and drag the line dividing these columns to the right. Figure 10.31 shows these actions and the resulting wider Concentration column.
Figure 10.31: Sizing the Standard Value Column Wider

To shrink this column to the minimum size needed to display the complete title, click once in the Concentration column to highlight it. Then choose Autosize from the Group menu. The column will be reduced in width as shown in Figure 10.32.

**NOTE:** Several columns can be Autosized at one time by highlighting (dragging across) multiple columns in the Group and then choosing Autosize.
Figure 10.32: Columns Before and After Autosize

C) Add a Column. The columns that are created by default with various Group sections may not always meet all the needs of a particular experiment. You can add a column to any Group section and define the purpose of this column in your data analysis. By default, new columns are added to the right of any selected (highlighted) column or, if no columns are selected, after the last column in the Group.

To add a new column to the right side of the Standards Group, make sure this section is active. Then deselect any highlighted columns by clicking outside the column area. Click the Create Column button ( ) or choose Create Column from the Group menu. A dialog box will open, asking you to enter information for the new column.

Figure 10.33: Calculation Dialog Box
In this tutorial example, the new column will show the maximum value obtained for each sample. Type over the default column name, entering **MaxValue** in the box next to “Name.” Now enter **Max(Values)** in the box next to “Formula” and click [OK]. (Be sure to enter the formula exactly as shown.) The dialog box will close and a new column will be shown at the right of the previous columns, showing the maximum value obtained for each sample.

![Figure 10.34: New MaxValue Column Appended to Group Section](image)

**Figure 10.34: New MaxValue Column Appended to Group Section**

**D) View an “If” Statement in a Column Formula.** The Samples section contains a column called “Outliers.” This column is made up of an “If” statement that calls upon data from another Group section to report when data points lie outside the range of the minimum and maximum Standard values.

An “If” statement in a formula defines a condition that, if found to be true, causes a certain result and, if not true, causes a different result. The basic structure of an If statement is:

```
If (condition,result1,result2)
```

Let’s take a closer look at the individual elements that make up the Outliers formula:

```
If(Values>=MinStd@Standards and Values<=MaxStd@Standards,"","Outlier")
```

This statement says that, if the data shown in the Values column is greater than or equal to the calculation of “MinStd” found in the Standards group section and less than or equal to the calculation of “MaxStd” found in the Standards Group section, then show nothing (signified by two quotation marks with nothing between them); otherwise show the word “Outlier.”

Looking at the Standards section, you will not immediately see the MinStd or MaxStd calculations used by this If statement. They are there, but their names are hidden. Look at the bottom of the Standards section and you will see two summaries as shown in the following figure.
Double-click the first summary, “Smallest standard value:”. A Calculation dialog box will appear:

**Figure 10.35: Summaries in the Standards Section**

This dialog box contains a checkbox for “Hide Name” which is currently enabled. Unchecking the box will allow you to view the name of the summary to the left of its text in the Standards section.

The formulas for MinStd and MaxStd are:

Min(MeanValue)  Max(MeanValue)

The MeanValue column is derived from the average of the well values found in the Values column (the Standard replicates). The minimum and maximum values from the MeanValue column in the Standards Group are used to create the summaries which is what the Outliers column formula uses to name its “Outliers.” Such a formula might be useful in finding points that might be better masked (not used in the calculations), for example.

Basic information regarding formulas and the information they can contain can be found in Chapters 7 or 8 (choose the chapter that is appropriate for the instrument you are using). For a complete discussion of writing formulas in SoftMax Pro, as well as detailed examples of formulas and customized protocols, refer to the Formula Reference Guide.
E) **Hide Replicates.** While the Standards section is active, choose **Hide Replicates** from the **Group** menu. The display before and after hiding replicates is shown in Figure 10.37.

![Table showing Standards section before and after hide replicates](image)

**Figure 10.37: Standard Section Before and After Hide Replicates**

More information about modifying group sections can be found in Chapters 7 or 8 (choose the chapter that is appropriate for the instrument you are using).

### Step 9: Data Analysis—Standard Curve

The Default Protocol used to create this tutorial example file contains the predefined groups Standards, Samples, and Controls; during the course of this tutorial, you also created a new group called Sam w/dil (with dilution). In addition, it contains a Graph section which has been created to display a standard curve.

Scroll down within the SoftMax Pro window until you see the section tool bar for “Graph #1.” This section is closed; click the indicator on the left side of the tool bar to open it. This graph contains a single plot as shown in Figure 10.38.
This graph is set to show concentration on the X-axis and mean value on the Y-axis. If you are continuing with simulated data, no fit will have been applied; the Endtut.pdf file has a linear fit applied. With simulated data, apply a linear fit by clicking in the menu next to “Fit:” and choosing Linear. Releasing the mouse button causes SoftMax Pro to redraw the graph based on its evaluation of the fit of the data to the new curve choice. The figures below show a linear fit followed by a 4-parameter fit.

Figure 10.38: Standard Curve Graph Section—No Fit Applied

Figure 10.39: Standard Curve Graph Section with Linear and 4-Parameter Fits Applied
You can also display the data in a bar-graph or another format by clicking the graph options button which opens a dialog box like that shown in the following figure.

![Graph Options Dialog Box](image)

**Figure 10.40: Graph Options Dialog Box**

This dialog box allows you to choose rename the graph, choose the type of graph that will be shown, and to format the text used in the graph. You can add or remove plots (click the New or Delete buttons) and you can also edit existing plots. Chapters 7 or 8 (choose the chapter that is appropriate for the instrument you are using) provide more information regarding the graphing options that are available.
Step 10: Print a Report

SoftMax Pro allows you to print several types of information. In addition to printing a copy of the template, you can print the active section, the sections that have been designated to be included in the report, or all sections.

The default setting in SoftMax Pro is for all sections to be included in the report. You can exclude sections from printing as described in Chapter 9, “File Management and Printing.” Otherwise, choosing Print... from the File menu and choosing “Print report” will print all of the sections that are designated to be included in the report, regardless of whether or not they are open.

A standard Print dialog box will appear (the appearance of this box depends upon the type of computer and printer you are using). Select the appropriate settings for your printer and then click [Print] or [OK].

You have completed this tutorial!—but SoftMax Pro has many other features that you will find useful. The next chapter describes in detail items only briefly discussed up to this point and will provide information regarding customizing and using the rest of the features of SoftMax Pro.
Tutorial 2: EC 50 Assay Tutorial (FLEX mode only)

This tutorial section will lead you through the steps required to create and run an EC50 assay utilizing a graph of concentration vs. RFU. This tutorial is designed to be used with a FlexStation instrument to learn more about using FLEX mode.

Hard and Soft Parameters

The only settings that must be defined before reading a microplate are the instrument settings (found in the Instrument Setup dialog box). These settings tell the instrument what conditions should be in place in order to collect data. They include the read mode (Endpoint, Kinetic, Spectrum, Well Scan, or FLEX), the number of wavelengths, specific wavelength settings, and so on. These settings, called “hard” parameters, define the conditions under which the data is obtained. Once a microplate has been read, the instrument settings cannot be changed without deleting the data.

“Soft” parameters include the template definition and data reduction settings. These parameters can be defined prior to reading a microplate, but they are applied only after the plate is read and can be changed at any time.

In this tutorial, you will build a complete protocol (based on the settings found in the Default Protocol file) which will include both hard and soft parameters. You will save the completed protocol file prior to collecting data (this protocol file could then be used to generate future data files).

A synopsis of the steps you will take during this tutorial is given below.

1. Create a new file
2. Instrument setup
3. Template setup
4. Set reduction parameters
5. Set display parameters
6. Save the protocol
7. Read the plate (you won’t actually do this—instead, open a saved file)
8. Analyze data—graph of concentration vs. RFU
9. Print the report

NOTE: You should ensure that the instrument that is connected to the computer is chosen in the Preferences before proceeding: in the Edit menu, choose Preferences. In the dialog box that appears, choose your instrument (if it is not already chosen) and then close the dialog box.

2 When you install SoftMax Pro, you are asked to choose between absorbance, fluorescence, or FlexStation installation. The choice made at that time will determine the type of default protocol file that is installed. Tutorial 1, found at the start of this chapter, pertains to users of either absorbance or fluorescence instruments; this tutorial (Tutorial 2) deals with the FlexStation instrument only and FLEX mode in particular.
Description of the Assay Example

Following are the details about the EC50 assay settings we will use to create a protocol file using SoftMax Pro.

Samples in units/ml: 0, 0.01, 0.05, 0.5, 1, 5, 10, and 100 (each standard run in duplicate)

Curve Fit: 4-Parameter

Instrument Settings:

Read Mode: FLEX
Wavelengths: One—Excitation: 485 nm; Emission: 525 nm
Auto Cutoff: Enabled at 515
Sensitivity: 3 readings; PMT set to High
Timing: Time: 200 seconds; Interval: 2 seconds

Total number of readings: 101
Minimum interval: 1.28 seconds

Automix: Off
AutoCalibrate: Once
Assay Plate Type: 96 Well Standard clrutm
Wells to Read: A1-H10
Compound Source: Beckman 96 2.3 mL
Compound Transfer: None (initial volume 0 µL)
Triturate: Not Used
Pipette Tips Layout: Full Rack
Compound & Tip Columns: None
Define the Protocol

The following steps will guide you through the process of creating a protocol file for an EC50 assay using FLEX mode. Reading an actual plate will not be required—you will run a simulator program to “create data” and also open a saved data file to compare your file setup and results.

Step 1: Start SoftMax Pro (Create a New File)

Double-click the SoftMax Pro icon to start the program. If SoftMax Pro is already running, choose **New...** from the **File** menu. You should see a new file labeled “Untitled.” The figure below shows an example of the Default Protocol file.

![Default Protocol Tutorial 2](image)

**Default Protocol Tutorial 2**

*If you are new to SOFTmax PRO, follow this tutorial (Tutorial 2) as outlined in Chapter 10 of the SOFTmax PRO User’s Manual. You can also read Chapter 6, “Reading Microplates Using the FLEXstation Instrument,” and Chapter 8, “Displaying and Analyzing Data Using Fluorescence Instruments,” and refer to the Formula Reference Guide to utilize the full potential of SOFTmax PRO.*

Instructions on how to import AnalystAcqquest(Criteria) and FLIPR files for analysis in SOFTmax PRO can be found in Chapter 9 of the User’s Manual.

Protocols for drug discovery analyses can be launched from the Assay menu in the Drug Discovery folder.

**If You Are Familiar with SOFTmax PRO, Customize This Default Protocol:**

1. Delete any sections you do not want.
2. Click the [Template] button and assign any default or new groups as necessary (you can also select replicates these).
3. Select the desired Reduction and Display (Raw vs. Reduced) parameters
4. Save this new protocol with the name **Default Protocol** in the same folder as the SOFTmax PRO application (you will be asked if you wish to replace the existing default protocol—choose Yes). This modified protocol will now launch each time you open SOFTmax PRO. A copy of the original default protocol can be found in the Tutorial folder if needed.

**Tutorial 2 (Please refer to Chapter 10 in the SOFTmax PRO User Manual):**

Determining the EC50 using the Molecular Devices no wash Calcium Assay Kit (FLEXstation or FLIPR).

An associated data file named Tutorial2.xls can be found in the Tutorial folder of SOFTmax PRO.

**MDC Product Number**: R-8333
**Product Name**: FLIPR Calcium Assay Kit

Initial volume: 100μl of Cells
Spiked with 100μl of Agonist
Concentrations that need to be assigned in the Template (increasing concentration from left to right): Column1, 0μM; Column2, 0.01μM; Column3, 0.05μM; Column4, 0.5μM; Column5, 5μM; Column6, 10μM; Column7, 50μM; Column8, 100μM; Column9, 100μM; Column10, 100μM

The calculated EC50 from the Data section:

**EC50%**
The experiment should have a Notes section ("Notes #1"), followed by a Plate section ("Plate#1"), one group section ("Data"), and a Graph section ("Graph#1") that will be used in this tutorial. For this tutorial, you will recreate the settings in this file. To start with a “clean slate,” you must first delete some of the existing sections. Scroll down so that you can see the rest of the sections in the experiment. Hold down the Shift key and click on the “Plate#1,” “Controls,” and “Data” sections. From the Edit menu, choose Delete Selection. A message box will appear, asking you to confirm that you wish to delete these sections. Choose “Delete” and the sections will be removed from the experiment.

Now you must create a new Plate section. Choose New Plate from the Experiment menu. A new section, named “Plate#1,” will be created.

**Step 2: Define the Instrument Settings**

Scroll down and click the Plate#1 section to make it active (its tool bar will become gray). Then click the [Setup] button in the tool bar to open the Instrument Settings dialog box. “Endpoint” is selected by default. This tutorial uses FLEX mode so you must click the FLEX icon button to select that mode.

Clicking the setting name (bold heading) on the left side of the Instrument Settings dialog box shows the choices available for that setting in the right pane, allowing you to make changes. The table below shows the settings that should be chosen for this tutorial example for the FlexStation. Following the table are instructions regarding how to choose those specific settings.
Table 10.2: Instrument Settings for FLEX Mode

<table>
<thead>
<tr>
<th>Options</th>
<th>Settings</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Wavelengths</strong></td>
<td><strong>Excitation: 485</strong></td>
</tr>
<tr>
<td></td>
<td><strong>Emission: 525</strong></td>
</tr>
<tr>
<td></td>
<td><strong>Auto Cutoff enabled (515)</strong></td>
</tr>
<tr>
<td><strong>Sensitivity</strong></td>
<td>Readings: 3</td>
</tr>
<tr>
<td></td>
<td>PMT: High (default)</td>
</tr>
<tr>
<td><strong>Timing</strong></td>
<td>Time: 240 sec</td>
</tr>
<tr>
<td></td>
<td>Interval: 2 sec</td>
</tr>
<tr>
<td></td>
<td>Reads: 10</td>
</tr>
<tr>
<td></td>
<td>Between Interval: 1.28 sec</td>
</tr>
<tr>
<td><strong>Automix</strong></td>
<td>Before: Off</td>
</tr>
<tr>
<td></td>
<td>Between: Off (default)</td>
</tr>
<tr>
<td><strong>AutoCalibrate</strong></td>
<td>Once (default)</td>
</tr>
<tr>
<td><strong>Assay Plate Type</strong></td>
<td>96 Well Standard clrbtm (default)</td>
</tr>
<tr>
<td><strong>Wells To Read</strong></td>
<td>Read area A1-H10</td>
</tr>
<tr>
<td><strong>Compound Source</strong></td>
<td>Beckman 96 2.3 mL (default)</td>
</tr>
<tr>
<td><strong>Compound Transfer</strong></td>
<td>None</td>
</tr>
<tr>
<td><strong>Triturate</strong></td>
<td>Not Used (default)</td>
</tr>
<tr>
<td><strong>Pipette Tips Layout</strong></td>
<td>Full rack (default)</td>
</tr>
<tr>
<td><strong>Compound and Tip Columns</strong></td>
<td>None</td>
</tr>
</tbody>
</table>

**Wavelengths:** 1 — Excitation: 485
Emission: 525
Auto Cutoff enabled (515)

**Sensitivity:** Readings: 3
PMT: High (default)

**Automix:** Automix Before: Off (default); Between: Off (default)

**AutoCalibrate:** Once (default)

**Assay Plate Type:** 96 Well Standard clrbtm (default)

**Wells to Read:** A1-H10

**Compound Source:** Beckman 96 2.3 mL (default)

**Compound Transfer:** None

**Triturate:** Not Used (default)

**Pipette Tips Layout:** Full rack (default)

**Compound and Tip Columns:** None
Wavelengths

Click the word “Wavelengths” on the left side of the Instrument Settings dialog box to make it the active tab. A black bar will appear over the word and the right side of this dialog box will then show the specific settings for the wavelengths selection. If the settings are not correct as shown, click the arrow next to the number of wavelengths and choose “1” from the drop-down list; then click the arrow next to the wavelength shown and choose the appropriate value(s) for the FlexStation (see Table 10.2 on page 10-39). The figure below shows how the Instrument Settings dialog box should appear at this point.

![Figure 10.44: Instrument Settings Dialog Box Showing Wavelengths Settings.](image-url)
**Sensitivity**

Now check the settings for Sensitivity by clicking that heading on the left side of the dialog box: you need to change the default shown on the right side for the number of readings from the default of 6 to our setting of 3. The default setting of High for PMT Sensitivity is fine and does not need to be changed.

![Instrument Settings Dialog Box Showing Sensitivity Settings.](image)

**Timing**

Check the settings for Timing by clicking the heading on the left side of the dialog box. Enter the following data into the text boxes on the right pane:

- Run Time (secs): **200**
- Interval (secs): **2**

The last two items will change to show the “Number of Reads:” as 101 and the “Minimum Interval:” as 1.28 secs. When you are finished, the dialog box should look like the one shown in Figure 10.47.
Figure 10.46: Instrument Settings Dialog Box Showing Timing

Automix

Check the settings for Automix by clicking the heading on the left side of the dialog box: on the right, Automix “Before” should be set to “Off”; “Between Reads” should also be “Off.” If not, click the appropriate checkbox to turn the setting on or off. When you are finished, the dialog box should look like the one shown in Figure 10.47.

Figure 10.47: Instrument Settings Dialog Box Showing Automix
AutoCalibrate
Check the setting for AutoCalibrate: the default ("Once") is fine and does not need to be changed.

Assay Plate Type
The default setting for Assay Plate Type ("96 Well Standard clrbtm") is fine and does not need to be changed.

Wells To Read
In this Tutorial, we will not be reading all the wells in the plate. Click on the "Wells To Read" heading on the left pane to show the grid of wells on the right. Click in well A1 and drag the mouse cursor diagonally to well H10. Columns 1 through 10 should now be highlighted (shown in blue), indicating that these wells will be read by the FlexStation. When you are finished highlighting wells, the dialog box should appear as shown below.

Figure 10.48: Instrument Settings Dialog Box Showing Wells To Read

Compound Source
This setting is used to describe the type of source plate that is used for compound transfers. For this tutorial, choose “Beckman 96-Well 2.3 mL.” When you are finished, the dialog box should appear as shown below.
Figure 10.49: Instrument Settings Dialog Box Showing Compound Source
**Compound Transfer**

The Compound Transfer settings are used to describe the fluid transfers that will occur during the assay. The settings in this portion of the dialog box work in conjunction with those in the Compound Source and Compound & Tip Columns settings.

This tutorial does not make use of compound transfers. Leave this set to “None.”

**Triturate**

Trituration is a “mixing” step that can be set individually for fluids in the compound source plate and the assay plate. Trituration is achieved by aspirating and dispensing fluid out of and back into the same well of a plate. You can set the volume of fluid to be aspirated, the number of times to perform this cycle, and also the height of the pipette tip above the bottom of the well of the assay plate.

It is not necessary to perform trituration during the Tutorial assay, however, so ensure that neither box (for Compound Source or Assay Plate) is checked and proceed to the next item.

**Pipette Tips Layout**

⚠️ **CAUTION:** Molecular Devices recommends that you use a full rack of tips each time you perform a transfer of fluid in FLEX mode since this prevents potentially serious errors from occurring when partial tip racks are used. For example, if you should mistakenly enable a pipetting function from a tip that is not present, or if you enable more or fewer tips than are actually available, the instrument can malfunction, potentially causing serious damage. While it is possible to use a partial rack of tips and to choose which tips are available in the Pipette Tips Layout setting, do so with caution, ensuring that the layout described in the software matches the actual tips inserted in the tip drawer.

This setting allows you to set the location of the pipette tips that will be used for the assay. For this tutorial, a full set of tips will be used (the default), so no change in settings is required.
Figure 10.50: Instrument Settings Dialog Box Pipette Tips Layout (Full Rack Chosen)

**Compound & Tip Columns**

These settings allow you to define the tips that will be used for the transfer of compounds that are also chosen here. However, this tutorial is not making any compound transfers so this setting is not used.

**Final Check of Instrument Settings**

Instrument settings are now complete. Verify that your settings agree with those shown below:
Figure 10.51: Instrument Settings Completed

Click [OK] to accept the settings and close the dialog box.
Step 3: Define the Template

A) Click the [Template] button in the Plate section tool bar. This will open the Template Editor, showing all wells empty. Drag the mouse (or shift-click) to select the first column of wells, A1 through H1. The Group pull-down menu on the Template Editor shows “Blank” as a default and the only other choice is “New...” Choose “New...” to create a new group. In the dialog box that appears, enter “Data” in the highlighted text box to name the new group. Then click the drop-down menu in the “Column Format” section and choose “Unknowns(dilution)” from the list. Doing this will cause a checkmark to appear in the box next to Sample Descriptor and automatically enter the word “Dilution Factor” in the text box below that. The dialog box should appear as shown in Figure 10.52.

![Figure 10.52: Group Settings Dialog Box for “Data” Group](image)

Click [OK] to close the dialog box. The template should now look like the illustration below.

![Figure 10.53: Template with First Samples Entered](image)
The selected wells should now show the default first sample name for the Data group, “Data01.” The area in the top center of the Template Editor will become active, showing the default values for Sample name and Dilution Factor.

In this tutorial, the dilution factor for the first column of samples in the Data group should be set to 0.0 µg/mL (the default value of 0 is correct). Click the [Assign] key or press the Return key on the keyboard to ensure that this concentration is assigned to the selected wells in the template. You can check the concentrations you have assigned to the template by pressing and holding the CTRL+Shift keys (on either Macintosh or Windows). This causes the display to show only group names and values assigned to specific wells.

B) Now select wells A2 through H2. “Data” is still showing as the default group name, but a new sample descriptor is created automatically (Data02), so all you need to do is assign a dilution factor of 0.01 µg/mL to these wells. After entering the value, click the [Assign] box (or press the Return key) to assign this value to the selected wells. The dialog box should now look like the illustration below.

![Figure 10.54: Template showing First Samples ("Data") Concentrations](image)

C) A total of eight samples will be assigned to columns in this template. Continue to highlight subsequent columns of wells and enter the following dilution factors:

- Column A3 through H4: 0.05
- Column A5 through H5: 0.5
- Column A6 through H6: 1
- Column A7 through H7: 5
- Column A8 through H9: 10
- Column A10 through H10: 100

The template should look like the one in Figure 10.55 when you are finished entering the samples.
D) The template is now complete. Click the [OK] button to accept the entries and close the Template Editor. The outlines of the groups you have defined in the Template Editor will now be shown in the Plate section.

Figure 10.55: Template Filled with Samples

Figure 10.56: The Plate Section Showing Group Boundaries
Step 4: Set the Reduction Parameters

Click the Reduction button in the Plate section toolbar to open the Reduction dialog box. The default reduction setting for a single measurement wavelength at the top of the dialog box, "!Lm1," is acceptable. Beneath this is a choice for Kinetic Reduction. Here, the default choice should be changed. Click in the drop-down menu and choose "Max - Min" as shown in the illustration below.

![Reduction Dialog Box](image)

Figure 10.57: Reduction Dialog Box

The other values in this dialog box should be set as follows (see Figure 10.58):

- **Limits:**
  - Min RFU: 0
  - Max RFU: 50000
  - Lag Time: 0
  - End Time: 200

- **Display Options:**
  - Zero Baseline: 3 Pts.

- **Smoothing:** Moving Average 1 point (no smoothing)
Step 5: Set the Display Parameters

Click the [Display] button to open the Display dialog box.

The default display for FLEX readings is raw RFU. This tutorial example shows a reduced number, so make sure the checkbox under “Show” is checked. If you decided later that you would like to view reduced data, you can change the display options after the reading since this does not affect the actual data—only how it appears on the screen and printout.

Click [OK] to close the dialog box.
Step 6: Save the File

Choose **Save** from the **File** menu.

![Save Dialog Box](image)

**Figure 10.60: Save As... Dialog Box — Macintosh**

On the Macintosh, choose “SoftMax Pro Protocol” from the drop-down menu next to “Format:” In Windows, click in the box under “Save File as Type:” and choose “Pro Protocol Files (*.ppr).” Enter the name for the file in the text box (highlighted over “Untitled”): in this example, type **My Tutorial**. Then click **Save** to save a copy of the protocol file on the hard disk.

**NOTE:** The title bar of the window will still show “Untitled,” rather than “My Tutorial” after saving. This does not mean the protocol has not been saved. When you create a protocol file, SoftMax Pro saves a copy of the current file under that file name but does not display the name on the screen. Protocol files are saved as template files (on the Macintosh, these are known as stationery files). When you open a protocol file, an “Untitled” window appears, containing all the protocol information saved previously, so that you can collect data and save the resulting data file under a different name.
Congratulations! You have just created a SoftMax Pro protocol file. Now would be the time to read the plate and then save the data file. In this tutorial example, however, you will not perform an actual plate reading but will open a saved file to generate “data” that you will manipulate as if it had been obtained from an actual reading.

**Step 7: Read the Plate**

If you were reading an actual microplate at this time, you would prepare the microplate as it is defined in the Template Editor. (Before an actual reading, you might find it helpful to print a copy of the template to assist in properly filling the plate.) You would then place that microplate, along with the appropriate compound transfer plate, in the appropriate drawers of the FlexStation. A new set of tips would also be loaded in the tip drawer. Since we are using a saved file, it is not necessary to load anything in the actual instrument.

Instead, choose **Open** from the **File** menu and navigate to the Tutorial folder. Open the file named “Tutorial2.pda.” The data in this file was generated using the parameters you have just created in this protocol file.

After clicking the **[Read]** button, values would begin to appear in the data display in the Plate section as they were read by the instrument.

The plate section of the Tutorial2.pda file should look like the figure below.

![Plate Section with Data from Saved File](image_url)

**Figure 10.62: Plate Section with Data from Saved File**

The display for each well that is defined by a group boundary shows a raw value with a reduced number. The wavelength reduction formula is shown at the bottom of the display: “Wavelength Combination: !Lm1”; the kinetic reduction formula is shown at the top of the Plate section: “Max - Min.”

A) Click the **[Display]** button in the Plate section tool bar. The Display dialog box will open.
The current display selection is shown as a depressed button (raw values with a reduced number).

Click the [Reduced] button. The following options will appear:

Choose “Grayscale” from the drop-down menu that appears when you click the Display options menu. The dialog box will update to show the low and high limits for grayscale display values (which are automatically set to the minimum and maximum data values).
Click [OK]. The dialog box will close, and the data display in the Plate section will update to show the data represented by shades of gray as shown in Figure 10.66.
Step 8: Data Analysis—Group Sections

Group sections are created automatically by SoftMax Pro when you define groups in the Template Editor. In this tutorial, new group sections were added when you created the new groups “Data” and “Control.” The content of Group sections changes depending on the wells that are assigned to these groups in the Template Editor. Before a plate is read, these sections show no data for the wells. After a reading, Group sections contain information about the values for the wells contained within the groups.

Scroll down and click the small triangle on the tool bar of the Data Group (it opens and is active). It should look similar to this:

![Figure 10.67: The Group Section for Data](image)

The columns in this group are set up as follows, from left to right:

- **Sample**: the nine sample names assigned for the Data group
- **Wells**: the wells that are assigned to the individual sample names (these correspond to the individual columns in the template)
- **Concentration**: the concentration assigned to each sample in the template
- **Values**: raw RFU values obtained for each sample
- **MeanValue**: the mean of data from the Value column for each sample
- **% Activation**: sample activation relative to selected control group
- **CV%**: coefficient variation percent for each sample value

A) **Viewing Formulas.** To view the formulas associated with all columns in the Data Group section, hold down the CTRL+Shift keys while this group is active. A second row will appear beneath the column titles, showing the for-
mula for each column. Depending on the size of the column, all or only part of the formula may be shown.

![Figure 10.68: A Portion of the Data Group Section with Formulas Shown (by Pressing the CTRL+Shift Keys)](image)

If column formulas are long, as in this tutorial example, they may not be seen in their entirety in the default column size. To see the complete formula for a particular column, click once on a column to highlight it. The formula for that column will be shown in the tool bar.

![Figure 10.69: Data Group Section with Formula Shown for Highlighted Column (% Activation)](image)

Click the button to modify or change a formula.

Let's look more closely at the formula for “% Activation” to see how it works.

Double-click the % Activation column. A dialog box called “Calculation” will appear showing the formula used to derive the data for this column:

$$\text{MeanValue}/(\text{Summary}#1)*100$$

This formula divides the numbers from the “MeanValue” column by the value of Summary#1, and then multiplies the result by 100 to achieve a percentage. Close this dialog box by clicking either [OK] or [Cancel] and return to the Data section to continue with the Tutorial.

**B) Resize and then Autosize a Column.** Position the pointer on the line dividing the columns named “Concentration” and “Values.” The pointer will change to a double-headed arrow. Click and drag the line dividing these columns to the right. Figure 10.31 shows these actions and the resulting wider Concentration column.
To shrink this column to the minimum size needed to display the complete title, click once in the Concentration column to highlight it. Then choose **Autosize** from the **Group** menu. The column will be reduced in width as shown in Figure 10.32.

**Figure 10.70: Sizing the Data Group’s Concentration Column Wider**

Several columns can be Autosized at one time by highlighting (dragging across) multiple columns in the Group and then choosing **Autosize**.
C) **Add a Column.** The columns that are created by default with various Group sections may not always meet all the needs of a particular experiment. You can add a column to any Group section and define the purpose of this column in your data analysis. By default, new columns are added to the right of any selected (highlighted) column or, if no columns are selected, after the last column in the Group.

To add a new column to the right side of the Standards Group, make sure this section is active. Then deselect any highlighted columns by clicking outside the column area. Click the Create Column button ( ) or choose **Create Column** from the **Group** menu. A dialog box will open, asking you to enter information for the new column.

![Figure 10.71: Columns Before and After Autosize](image)

**Figure 10.71:** Columns Before and After Autosize

To illustrate, let's add a new column labeled **Col#8** to the data set. Click on the cell where you want the new column to be inserted, then enter the formula `=Col#7 / Col#8` in the **Formula** field of the dialog box. This will calculate the ratio of **Col#7** to **Col#8** for each data point. Click **OK** to apply the formula and see the results in the column.

![Figure 10.72: Calculation Dialog Box](image)

**Figure 10.72:** Calculation Dialog Box
In this tutorial example, the new column will show the maximum value obtained for each sample. Type over the default column name, entering `MaxValue` in the box next to “Name.” Now enter `Max(Values)` in the box next to “Formula” and click `[OK]`. (Be sure to enter the formula exactly as shown.) The dialog box will close and a new column will be shown at the right of the previous columns, showing the maximum value obtained for each sample.

<table>
<thead>
<tr>
<th>Concentration</th>
<th>Values</th>
<th>MeanValue</th>
<th>% Activation</th>
<th>CV%</th>
<th>MaxValue</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.010</td>
<td>826.23</td>
<td>875.854</td>
<td>26.435</td>
<td>12.8</td>
<td>1009.7</td>
</tr>
<tr>
<td></td>
<td>679.32</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>1007.56</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>940.25</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>809.84</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>878.73</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>955.24</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>0.050</td>
<td>1919.18</td>
<td>1941.636</td>
<td>58.597</td>
<td>9.3</td>
<td>2112.6</td>
</tr>
<tr>
<td></td>
<td>2112.86</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>2068.96</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>1991.50</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>1630.36</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>2057.65</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Figure 10.73: New MaxValue Column Appended to Group Section**

D) **View an “If” Statement in a Column Formula.**

**NOTE:** No conditional statements are used in the FLEX mode tutorial for the EC 50 analysis. To view and learn about writing an “if” statement, you will be asked to open a different data file. If you do not wish to do this, please skip this section and go on to “Data Analysis—Graph” on page 10-64.

Open the file named “Endtut.pda” located in the Tutorial folder.

The Samples section of this file contains a columns called “Outliers.” This column is made up of an “If” statement that calls upon data from another Group section to report when data points lie outside the range of the minimum and maximum Standard values.

An “If” statement in a formula defines a condition that, if found to be true, causes a certain result and, if not true, causes a different result. The basic structure of an If statement is:

If (condition,result1,result2)

Let’s take a closer look at the individual elements that make up the Outliers formula:

If(Values>=MinStd@Standards and Values<=MaxStd@Standards,””,””Outlier”)

This statement says that, if the data shown in the Values column is greater than or equal to the calculation of “MinStd” found in the Standards group section and less than or equal to the calculation of “MaxStd” found in the Standards Group section, then show nothing (signified by two quotation marks with nothing between them); otherwise show the word “Outlier.”

Looking at the Standards section, you will not immediately see the MinStd or MaxStd calculations used by this If statement. They are there, but their names are hidden. Look at the bottom of the Standards section and you will see two summaries as shown in the following figure.
Double-click the first summary, “Smallest standard value.” A Calculation dialog box will appear:

**Figure 10.75: Calculation Dialog Box from Summary in Standards Section**

This dialog box contains a checkbox for “Hide Name” which is currently enabled. Unchecking the box will allow you to view the name of the summary to the left of its text in the Standards section.

The formulas for MinStd and MaxStd are:

\[
\text{Min}(\text{MeanValue}) \quad \text{Max}(\text{MeanValue})
\]

The MeanValue column is derived from the average of the well values found in the Values column (the Standard replicates). The minimum and maximum values from the MeanValue column in the Standards Group are used to create the summaries which is what the Outliers column formula uses to name its “Outliers.” Such a formula might be useful in finding points that might be better masked (not used in the calculations), for example.

Basic information regarding formulas and the information they can contain can be found in Chapters 7 or 8 (choose the chapter that is appropriate for the instrument you are using). For a complete discussion of writing formulas in SoftMax Pro, as well as detailed examples of formulas and customized protocols, refer to the Formula Reference Guide.
E) Hide Replicates.

**NOTE:** No replicates are used in the FLEX mode tutorial for the EC 50 analysis. To view and learn about showing and hiding replicates, you will be asked to open a different data file. If you do not wish to do this, please skip this section and go on to “Data Analysis—Graph” on page 10-64.

Open the file named “Endtut.pda” located in the Tutorial folder.

Click in the Standards section to make it active. Choose **Hide Replicates** from the **Group** menu. The display before and after hiding replicates is shown in Figure 10.37.

![Figure 10.37: Standards Section Before and After Hide Replicates](image)

More information about modifying group sections can be found in Chapters 7 or 8 (choose the chapter that is appropriate for the instrument you are using).

Close the Endtut.pda file and return to the FLEX tutorial data file you opened earlier.
Chapter 10: Tutorials

Step 9: Data Analysis—Graph

Scroll down within the SoftMax Pro window until you see the section tool bar for “Graph #1.” If this section is closed, click the triangle indicator on the left side of the tool bar to open it. This graph contains a single plot as shown in Figure 10.77.

![Graph#1](image)

**Figure 10.77: Graph Section—4-Parameter Fit Applied**

This graph is set to show concentration on the X-axis and % Activation on the Y-axis. A 4-Parameter curve fit has been applied. You can apply other fits by selecting one in the menu next to “Fit.” Releasing the mouse button causes SoftMax Pro to redraw the graph based on its evaluation of the fit of the data to the new curve choice.

You can also display the data in a bar-graph or another format by clicking the graph options button which opens a dialog box like that shown in the following figure.

![Graph Options](image)

**Figure 10.78: Graph Options Dialog Box**
This dialog box allows you to choose rename the graph, choose the type of graph that will be shown, and to format the text used in the graph. You can add or remove plots (click the [New] or [Delete] buttons) and you can also edit existing plots. Chapters 7 or 8 (choose the chapter that is appropriate for the instrument you are using) provide more information regarding the graphing options that are available.

In this example, choose the option for “Cluster bar” and then click [OK]. The resulting graph should look similar to the one below:

![Cluster Bar Graph Displayed](image)

**Figure 10.79: Cluster Bar Graph Displayed**

**Step 10: Data Analysis—Summary Formula**

Scroll down to the bottom of the “Data” Group section. Shown there in large format type is a summary that states: “Summary #1 = EC 50% 0.03101.” Click this summary to highlight it. If you look up in the gray tool bar at the top of the window, you will see the formula used to create this summary is shown there: “Summary #1 : InterpX(Plot#1@Graph#1,50).” Let’s examine this formula further to understand how it was derived.

Formulas can be simple or quite complex and are composed of elements that perform mathematical operations, statistical analysis functions, and/or refer to other elements contained within SoftMax Pro. Complete information about the possible choices for creating formulas can be found in the Formula Reference Guide.

The formula from the Summary in the Data section of this Tutorial file uses a function, “InterpX,” which interpolates data from the curve fit in the Graph section. The InterpX function returns the X values of the specified plot interpolated using the Y values and curve fit. The complete formula is written in this manner: InterpX(Plot@Graph,Yvalues).

In this particular summary formula, “Plot#1@Graph#1” describes the plot from which the data is derived. Yvalues in this example is “50” which
describes the number to be interpolated. So, looking at the graph, the Y-value at 50% activation appears at an approximate concentration of 0.031.

Figure 10.80: Detail from Graph Section Showing 50% Location on Plot

A summary formula is created by either clicking the summary button in the toolbar or choosing Create Summary from the Group menu. A Calculation dialog box opens, allowing you to enter the formula for the summary and to set the options for how the summary is displayed.

The same Calculation dialog box appears when you edit an existing formula. Double-click the summary at the bottom of the Data section (just above the Graph section). The Calculation dialog box that appears should look like the one below:

![Calculation Dialog Box for EC 50 Summary Formula](image)

Figure 10.81: Calculation Dialog Box for EC 50 Summary Formula

If you wanted to interpolate a value at a different percentage, you could enter a different number at the end of the formula in place of the “50” there. You could also reverse the formula to show the percent activation that is interpolated for a certain concentration (“0.1” in this example) by writing the formula this way:

InterpY(Plot#1@Graph#1,0.1)

The result would be: 69.494 (to three decimal places). The summary can be shown with different accuracy (up to nine decimal places, if desired) by changing the number in the box next to “Decimal Places:” at the bottom of the box.
Step 11: Print a Report

SoftMax Pro allows you to print several types of information. In addition to printing a copy of the template, you can print the active section, the sections that have been designated to be included in the report, or all sections.

The default setting in SoftMax Pro is for all sections to be included in the report. You can exclude sections from printing as described in Chapter 9, “File Management and Printing.” Otherwise, choosing Print... from the File menu and choosing “Print report” will print all of the sections that are designated to be included in the report, regardless of whether or not they are open.

A standard Print dialog box will appear (the appearance of this box depends upon the type of computer and printer you are using). Select the appropriate settings for your printer and then click [Print] or [OK].

Figure 10.82: Print Dialog Box for Macintosh

Figure 10.83: Print Dialog Box for Windows (Epson Stylus COLOR 980 shown)

You have completed this tutorial!—but SoftMax Pro has many other features that you will find useful. The next chapter describes in detail items only briefly discussed up to this point and provides information regarding customizing and using the rest of the features of SoftMax Pro.
Chapter 11  Troubleshooting

Introduction ................................................. 11-3
Message Boxes and Alerts ............................... 11-3
  Alerts in the Instrument Settings ....................... 11-3
  Alerts in SoftMax Pro. .................................... 11-4
Error Message Boxes ...................................... 11-8
Communication Problems .............................. 11-10
Display Problems ........................................ 11-14
Printing Problems ....................................... 11-14
General Problems ....................................... 11-15
Chapter 11 Troubleshooting

Introduction

Alerts, message boxes, or error boxes that appear while you are using SoftMax Pro usually contain a description of the problem but may not be complete enough to help you remedy it. At other times, however, errors that are not directly associated with SoftMax Pro but affect its operation may occur. The information in this chapter is provided to assist you if an error occurs for which you do not have a solution or if you don’t know the source of a problem.

This chapter first presents general information regarding problems you may encounter, followed by specific types of problems grouped by kind: display issues, printing errors, etc. Within each group is general information regarding such problems, sometimes followed by a table containing specific problems and their suggested remedies. If you encounter a problem during operation of SoftMax Pro, first check to see if a table is associated with that type of problem and see if a remedy is listed there. When remedies require more space than the table can allow, a reference to a numbered text section will be listed in the table. Refer to that text section (by number) beneath the table to learn more about solving the problem.

If you need additional assistance or if you encounter a problem with SoftMax Pro that is not listed here, in the U.S., call Molecular Devices Technical Services group at 1-800-635-5577; elsewhere, call your local representative. For problems with an instrument that do not relate to the use of SoftMax Pro, please see the instrument manual for more information.

Message Boxes and Alerts

Message boxes appear to inform you that the action you are attempting needs adjustment in some way. Message boxes contain only an [OK] button that you can click to remove the message after you have read the information.

Alerts inform you that the action you are about to take will have consequences that may not be reversible or may make a significant change within the program. Alerts are indicated by an alert symbol (⚠️). Alerts occurring in the Instrument Settings dialog box generally must be corrected before you are able to close the box and begin the assay. Other alerts may not prevent an action from continuing but may cause errors after the run is started.

Alerts in the Instrument Settings

One example of an alert appears when you are defining instrument settings for a Kinetic assay and the read interval is not long enough to allow the required actions to occur. The message might look like this:

![Read interval is too short. Minimum 9 seconds.]

Figure 11.1: Example of an Alert Message

Setting a longer read interval removes the message and allows you to continue.
Other examples of alert messages that appear in the Instrument Settings dialog box are found with the FlexStation instrument. These are:

- **Possible assay plate overflow. Check fluid dispense volumes.**
- **Possible assay plate underflow. Check fluid dispense volumes.**
- **Fluid dispense time is too short. Check fluid time points.**
- **Transfer scheduled after read has stopped. Check total read time.**

### Alerts in SoftMax Pro

The Alerts that follow are presented alphabetically by first line of the alert message.

#### #Low or #Sat Messages (Plate Section Data)

<table>
<thead>
<tr>
<th>WSat</th>
<th>1872.0</th>
<th>1973.0</th>
<th>2072.8</th>
<th>WSat</th>
<th>2372.8</th>
<th>MLow</th>
<th>2572.8</th>
<th>WSat</th>
<th>2772.8</th>
<th>WSat</th>
<th>3072.8</th>
<th>5472.8</th>
<th>5772.8</th>
</tr>
</thead>
<tbody>
<tr>
<td>2172.8</td>
<td>#Sat</td>
<td>2072.8</td>
<td>MLow</td>
<td>2472.8</td>
<td>#Sat</td>
<td>3172.0</td>
<td>MLow</td>
<td>3472.8</td>
<td>NSat</td>
<td>3572.0</td>
<td>MLow</td>
<td>3572.0</td>
<td>3772.0</td>
</tr>
<tr>
<td>2572.8</td>
<td>#Sat</td>
<td>2072.8</td>
<td>MLow</td>
<td>2472.8</td>
<td>#Sat</td>
<td>3172.0</td>
<td>MLow</td>
<td>3472.8</td>
<td>3972.8</td>
<td>4772.8</td>
<td>5072.8</td>
<td>5772.8</td>
<td>6172.8</td>
</tr>
<tr>
<td>WSat</td>
<td>1872.0</td>
<td>1973.0</td>
<td>2072.8</td>
<td>WSat</td>
<td>2372.8</td>
<td>MLow</td>
<td>2572.8</td>
<td>WSat</td>
<td>2772.8</td>
<td>WSat</td>
<td>3072.8</td>
<td>5472.8</td>
<td>5772.8</td>
</tr>
<tr>
<td>2172.8</td>
<td>#Sat</td>
<td>2072.8</td>
<td>MLow</td>
<td>2472.8</td>
<td>#Sat</td>
<td>3172.0</td>
<td>MLow</td>
<td>3472.8</td>
<td>3972.8</td>
<td>4772.8</td>
<td>5072.8</td>
<td>5772.8</td>
<td>6172.8</td>
</tr>
</tbody>
</table>

#### NOTE

These reports may appear in the Plate section of fluorescent-reading instruments during Endpoint mode.

The error #Sat appears when the well is saturated (i.e., too much signal). Try lowering the PMT setting and re-read the data. If the well is still saturated after the PMT is set to “Low,” try diluting the sample.

The error #Low appears if the flash lamp missed the flash for that well. Reread the affected well(s).
A plate descriptor used by this file is for another instrument.

This error message appears if you have one type of instrument connected to the computer (or chosen in the Preferences) and open a file that was created using a different instrument.

The message alerts you to the fact that a plate descriptor for the instrument that is connected (or chosen) has been used instead of that saved with the file. If you save the file, the new descriptor will be saved instead of the old. If you wish to retain the old descriptor, save the file under a new name.

Checksum: Failed (Plate Section Data)

This report appears in the Plate section of the FlexStation instrument only.

The checksum feature checks for accuracy of data received from the FlexStation instrument.
One or more points may have been lost during this read.

NOTE: This error appears only with the SpectraMax Plus, Plus384, 190, 340PC, Gemini (in Kinetic or Spectrum mode), VersaMax, or FlexStation (in Kinetic, Spectrum, or FLEX mode)—other instruments are unable to continue after generating this error and will simply stop the reading.

A problem may exist with the instrument or the computer, or a communication problem may exist between the instrument and the computer. This error message means that no signal was recorded for a given wavelength in a given well (for an Endpoint or Spectrum scan) or at one or more timepoints for a given well and wavelength (for a Kinetic run). The instrument sent a placeholder ("NAN" — stands for "Not A Number") in lieu of a number and continued to collect data.

Depending on the type of assay(s) conducted, it may be very easy or difficult to see which wells were not read. During a multiple-wavelength Endpoint reading, it might be quite easy to spot a missed data point; finding one during a long Kinetic reading might be quite difficult, however. Follow the instructions below for the type of reading that was performed when the error occurred in order to assist you in finding lost data points.

Lost Data with a Multiple-Wavelength Endpoint Reading
If you get such an error message during a multiple-wavelength Endpoint reading, try displaying raw signal at all wavelengths and visibly inspect the plate data for missing readings.

Lost Data with a Single-Wavelength Kinetic Reading
If the error occurs during a single-wavelength Kinetic run, access the Reduction dialog box (click the Reduction button) for the plate section that was read. Choose "Custom" for the Wavelength reduction and then click the formula button that appears to bring up the Reduction dialog box. For the Kinetic reduction, enter the formula \( \text{lnumpointsread} \) and then close the dialog box. In the Plate section, set the display (click the Display button) to raw data plot with reduced number. Compare the number shown in the Plate display with the number of Vmax Points listed at the right-hand side of the Plate section. The numbers should be the same. If a time point was not collected in a well, the Plate display number will be lower.

Lost Data with a Multiple-Wavelength Kinetic Reading
If the problem occurs during a multiple-wavelength Kinetic run, you can follow the procedure outlined above, changing the wavelength reduction in turn to each of the wavelengths read (Lm1, Lm2, etc.) and then checking the number of points read at each wavelength. Once you know which wells have a missing time point, you can look at a Well Graph with points connected and determine if the missing points will adversely affect data analysis.
One or more points may have been lost during this read. Also, one or more points were reported as saturated.

**NOTE:** This error appears only during Kinetic or Spectrum mode with fluorescence instruments.

This error message appears if a specific timepoint in a given well (for a Kinetic run) or a specific wavelength in a given well (for a Spectrum scan) is saturated and points are also missed (see “One or More Lost Points,” above). Check the individual wells for saturation. If the saturation occurs at the time or wavelength of interest, you will need to reread at a lower PMT setting. If the saturation does not occur in the time segment or wavelength of interest, you may ignore the message and proceed with data analysis.

For points missed, see the earlier section, “One or more points may have been lost during this read.” on page 11-6, for information on how to find lost points.

One or more points were reported as saturated.

**NOTE:** This error appears only with fluorescence instruments during Kinetic or Spectrum mode.

A specific timepoint in a given well (for a Kinetic run) or a specific wavelength in a given well (for a Spectrum scan) is reported as saturated. Check the individual wells for saturation. If the saturation occurs at the time or wavelength of interest, you will need to reread at a lower PMT setting. If the saturation does not occur in the time segment or wavelength of interest, you may ignore the message and proceed with data analysis.
Error Message Boxes

Error messages contain a stop graphic ( or ) and text explaining the error, if the software can report it. Some errors, such as an obstruction of the drawer of the microplate reader, report the problem, allow you to correct it, and then proceed with the assay. Other errors are not recoverable and require that you perform the action or assay again.

Error messages are listed below in alphabetical order (by first line in the message).

**Instrument reported a fatal error.**

![Instrument reported a fatal error message](image)

This error appears when the instrument experiences a hardware failure or if a jam occurs (in the tip box, for example). The run in progress is not recoverable. Call Molecular Devices Technical Support to receive information that is pertinent to the particular situation that led to receiving this error message.

**Pasted text doesn’t match plate settings.**

![Pasted text doesn’t match plate settings message](image)

You have attempted to paste values from an external file containing ASCII tab-delimited data into a Plate section or CuvetteSet section, but the number of fields of data that you have copied does not match those required by the setup of that Plate section or CuvetteSet section. For Plate section data, the format of the copied information must match the Instrument Settings of the target Plate section and the settings chosen in the Export Format in the Preferences. Check that all the required fields are present and that you have highlighted all of these fields prior to copying the data and try pasting again.
**Instrument communication problem. Response too late.**

This error appears when the cable connection between the computer and the instrument is not functioning properly. Clicking [OK] will stop the run. This error appears if the cable has been disconnected, but it could also occur with a bad cable, serial port, or communications board.

**Recover will reset FlexStation.**

This report appears with the FlexStation instrument only. This message appears after you choose Recover from the Control menu. Choosing the Recover command may be necessary after a power failure (or after shutting down a run prematurely) or if a jam should occur with the tips, for example. Detailed instructions regarding the procedure to be followed can be found in the FlexStation Operator’s Manual.
**There is no assay plate.**

You have tried to start a reading without inserting a plate in the microplate drawer. Insert the plate and press the [Read] button again.

### Communication Problems

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Possible Cause/Solution</th>
</tr>
</thead>
</table>
| The instrument icon shown in the upper left corner of the SoftMax Pro window has an “X” through it | 1) Is the MDC Microplate System instrument turned on?  
2) If the icon also has the words “No port selected” through it along with an “X,” open the SoftMax Pro Preferences settings and select the proper communications port (setting should agree with the physical port to which the cable from the instrument is connected to the computer).  
3) Quit SoftMax Pro, turn off power to both the computer and the MDC Microplate System instrument. Check that cable connections between the instrument and computer are secure. Turn both machines on again and restart SoftMax Pro. If an “X” still appears over the icon, it may be that you are using the wrong type of cable. See “Communication #1” (below) for more information.  
4) If you are using a FlexStation in FLEX mode, see “Communication #2” (below) for more information. |
| The Macintosh computer has only one serial port and can’t connect to a MDC Microplate System instrument and printer at the same time. | You can purchase a serial switch that will allow you to choose between communication with the MDC Microplate System instrument or the printer. See “Communication #3” (below) for more information. |

#### Communication #1

**Instrument Icon Shown with an “X”**

If the instrument icon shown in the upper left corner of the SoftMax Pro window has an “X” through it, check whether the MDC Microplate System instrument is turned on. If it is, then check the SoftMax Pro Preferences settings (see Setting Preferences below) to ensure that the proper communications port (modem or printer for the Macintosh; COM1 or COM2, typically, for the PC) is selected. This setting should agree with the physical port to which the cable from the instrument is connected to the computer. If the port...
setting is correct, the instrument is on, and communication is still not functioning properly, quit SoftMax Pro, turn off power to both the computer and the MDC Microplate System instrument, and check that the cable connections between the instrument and computer are secure. Turn both machines on again and restart SoftMax Pro. If an “X” still appears over the icon, it may be that you are using the wrong type of cable.

Communication #2  
**FlexStation Icon Shown with an “X”**

If the FlexStation instrument icon shown in the upper left corner of the SoftMax Pro window has an “X” through it, check whether the FlexStation is turned on. If it is, then check the SoftMax Pro Preferences settings (see Setting Preferences below) to ensure that the proper communications port (modem or printer for the Macintosh; COM1 or COM2, typically, for the PC) is selected. This setting should agree with the physical port to which the cable from the instrument is connected to the computer. If the port setting is correct, the instrument is on, and communication is still not functioning properly, quit SoftMax Pro, turn off power to both the computer and the FlexStation, and check that the cable connections between the instrument and computer are secure. Turn both machines on again and restart SoftMax Pro. If an “X” still appears over the icon, change the setting for the “Serial Comm Speed” found in the Preferences dialog box (choose Edit > Preferences). If the setting is currently “9600,” change it to “57600” or vice-versa.¹

Communication #3  
**Macintosh Computers Having a Single Serial Port**

Some Macintosh computers have only a single 8-pin DIN serial port which serves as both the printer and modem port. Please check to see if your model is listed as compatible hardware on the SoftMax Pro for Macintosh Version System Requirements and Compatible Hardware sheet. If your computer is not listed, the performance of SoftMax Pro version 3.0 for Macintosh cannot be guaranteed when using this model.

When running SoftMax Pro, the single serial port Macintosh can either communicate with the MDC Microplate System instrument or print through the single serial port, but both printer and instrument cannot remain connected to the serial port at the same time. To avoid uncabling the instrument in order to attach the printer, you must either print across a network using the ethernet port of the computer, or the instrument and printer can be connected to an A/B switch box (one 8-pin DIN input port with two 8-pin DIN output ports) available from MacWarehouse (1/800/255-6227, part number BND0199, Din-8 A/B switch box). This switch box can then be attached to the single serial port.

---

¹ FlexStation and SoftMax Pro both boot up using a baud rate of 9600 to communicate over the serial line. SoftMax Pro boosts the baud rate to 57600 when FlexStation is reading in FLEX mode. When the read is finished, SoftMax Pro automatically reduces the baud rate to 9600 again. In order to communicate at different baud rates, SoftMax Pro sends a command to the FlexStation to change its baud rate also. Communication is lost if the baud rates don’t match. Under normal operations, it shouldn’t be necessary to change the communication speed. Should communication be lost and other measures do not restore it, you may attempt to reestablish communication by resetting the baud rate manually using the baud rate pop up menu in the Preferences. The default baud rate shown on the popup menu indicates the current setting for the computer’s serial port. To reestablish a connection, the user must set the serial baud rate of the computer to match the baud rate of FlexStation (either 9600 or 57600; other baud rates are included but should not be used).
port of the computer. The A/B switch of the switch box is used to physically switch the connection between the instrument and the printer. Because of the limitations of the single serial port Macintosh, the Autoprint feature of SoftMax Pro cannot be used unless you use the ethernet port of the computer for printing.

To print from SoftMax Pro for Macintosh using the single serial port Macintosh, connect to an AppleTalk-compatible printer such as the Hewlett-Packard DeskWriter C or 550C using an AppleTalk cable connection and the AppleTalk printer driver. Serial printers such as the Apple StyleWriter which use an Apple 8-pin DIN to 8-pin DIN peripheral cable and a serial printer driver cannot be used with SoftMax Pro for Macintosh on a Macintosh with a single serial port.

Configuration for Reading

The computer, SoftMax Pro for Macintosh, and switch box must be configured as follows in order to establish communication with the MDC Microplate System instrument: AppleTalk Inactive in the Chooser dialog, serial port set to modem in the SoftMax Pro Preferences dialog, and the switch box set to communicate with the MDC Microplate System instrument (to access the Chooser or Preferences dialogs, refer to “To Switch from Printing to Reading,” below).

Configuration for Printing

The computer, SoftMax Pro for Macintosh, and switch box must be configured as follows in order to print from SoftMax Pro: AppleTalk active in the Chooser dialog, serial port set to modem in the SoftMax Pro Preferences dialog, and the switch box set to communicate with the printer (to access the Chooser or Preferences dialogs, refer to “To Switch from Reading to Printing,” below).

Connecting to the Switch Box

These instructions are for connecting to the A/B switch box available from MacWarehouse (800-255-6227, part number BND0199, DIN-8 A/B switch box).

1) Attach one end of the 8-pin DIN to 8-pin DIN serial cable provided with the switch box to the single 8-pin DIN serial port of the computer.
2) Attach the other end of the cable to the input port (I/O) of the A/B switch box.
3) Attach one end of the 8-pin DIN to 8-pin DIN serial cable provided in the SoftMax Pro software package to one of the two output ports (A or B) of the A/B switch box.
4) Attach the other end of the cable to the MDC Microplate System instrument.
5) Attach one end of the 8-pin DIN to 8-pin DIN AppleTalk cable to the remaining output port of the switch box.
6) Attach the other end of the cable to the AppleTalk printer.
7) Place a note on the top of the switch box indicating the identity of each output port.
To Switch from Reading to Printing

1) Configure the computer, SoftMax Pro, and the switch box as described above for reading a microplate.
2) Read the microplate.
3) Set the switch box to communicate with the printer.
4) Quit SoftMax Pro.
5) In the Finder, select Chooser from the Apple menu to bring up the Chooser dialog.
6) Set AppleTalk to active.
7) In the box on the left side of the Chooser dialog, choose the AppleTalk driver for the printer. The printer name should appear in the box on the right side of Chooser dialog.
8) Close the Chooser dialog.
9) Start SoftMax Pro.
10) Print the desired sections.

To Switch from Printing to Reading

1) Configure the computer, SoftMax Pro, and the switch box as described above for printing.
2) Print the desired sections.
3) Select Chooser from the Apple menu to bring up the Chooser dialog.
4) Set AppleTalk to Inactive.
5) Set the switch box to communicate with the instrument.
6) Select Preferences from the Edit menu.
7) Without changing any settings, click OK.
8) Read the microplate.
## Display Problems

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Possible Cause/Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>A large Group section table becomes gray or disappears.</td>
<td>You are attempting to display more than 2500 data points in a group. 1) From the View menu, choose Minimize. Delete the large Group table; then create a new, smaller table. 2) If this does not work, from the View menu, select the large group; then choose Delete groupname from the Edit menu. Save the file; close the file; reopen the file.</td>
</tr>
<tr>
<td>Checkbox for Plate blank subtraction in the reduction dialog box is not visible.</td>
<td>This option is not visible until after data has been collected.</td>
</tr>
<tr>
<td>Y-axis units on a graph (either Well Graph or Graph section) are repeated.</td>
<td>This can occur when the range on the Y-axis is very small. Increase the height of the Y-axis.</td>
</tr>
<tr>
<td>A red “hand” appears in the instrument information portion of a Plate section or CuvetteSet section.</td>
<td>A Visioneer PaperPort extension (Macintosh) is in conflict with SoftMax Pro. Disable or remove the PaperPort extension and restart the computer.</td>
</tr>
<tr>
<td>Text appears “too large” for wells in plate on Windows platform.</td>
<td>In the Windows <strong>Control Panel</strong>, check the settings for <strong>Display</strong>. Ensure that you are using “small fonts.”</td>
</tr>
<tr>
<td>General display problems in Windows</td>
<td>Change the video display settings to 16-bit and high color, or better.</td>
</tr>
</tbody>
</table>

## Printing Problems

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Possible Cause/Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Text in the header field of the print dialog box “disappears” if you press the return or enter key.</td>
<td>The text is still there but is not visible. It will print. If you click in the box and drag the mouse to the left, it will reappear.</td>
</tr>
<tr>
<td>The Notes section is longer than one page. The bottom line of the first page and the top line of the second page are partially printed.</td>
<td>Insert a linefeed into the Notes section at the appropriate place.</td>
</tr>
<tr>
<td>When printing a well graph, part of it is missing.</td>
<td>If you enlarge the well graph to greater than 12 inches, the graph will not fit on an 8.5- by 11-inch page and the printout will be truncated. Reduce the size of the graph and print again.</td>
</tr>
</tbody>
</table>
# General Problems

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Possible Cause/Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data from a CuvetteSet section reference or reading doesn’t seem “right.”</td>
<td>Check that the cuvette is oriented properly in the cuvette port of the instrument: the clear sides of the cuvette must face left and right when you are in front of the instrument. If the cuvette is oriented improperly, remove it, replace it in the correct orientation, and repeat the reference or reading.</td>
</tr>
<tr>
<td>Macintosh “bombs” or gives errors that cause SoftMax Pro to crash.</td>
<td>The amount of memory available in your Macintosh or the amount of memory allocated for SoftMax Pro may be insufficient. See “General Problem #1” below for more information.</td>
</tr>
<tr>
<td>Double-clicking a file with the “.pda” extension launches the Printshop application.</td>
<td>Printshop (from Broderbund) uses the “.pda” extension to identify its files (as does SoftMax Pro). See “General Problem #2” below for more information.</td>
</tr>
<tr>
<td>Files “disappear” from the list of saved data or protocol files or cannot be opened; file name extensions are not saved properly.</td>
<td>On the PC, SoftMax Pro limits file names to 59 characters plus a period and a 3-letter extension for a total of 63 characters. It is possible to make a file name longer than this by manually changing it in a directory listing or by using the Save As command in the software. A file with a name longer than this limit will no longer be able to be read by SoftMax Pro, may not show up on file lists, and will return an error if you attempt to open it. File names that are made too long using the Save As command will show corrupted characters (such as “ÿ,” “ü,” etc.) for any letters that fall after the 63rd.</td>
</tr>
</tbody>
</table>
| SoftMax Pro runs very slowly or or stalls completely.                   | 1) The amount of memory in the computer may not be sufficient or the operating system may not be optimum. Check the amount of RAM and the operating system version to see if they meet the minimum requirements outlined in Chapter 2, “Installation.”  
2) SoftMax Pro may be trying unsuccessfully to communicate with the printer port. If a printer is connected, check that the computer can see and send data to the printer. If a printer is not connected, SoftMax Pro still requires that a printer driver be installed (choose any printer).  
3) SoftMax Pro may be trying unsuccessfully to communicate with a serial port.  
   a) Another device (such as a camera, a handheld PDA device, or another instrument, such as a robot) may be competing for the use of the serial port to which the MDC instrument is connected. Try uninstalling the software for any of these items and/or ensure that they use a different serial port from that used by the Molecular Devices instrument.  
   b) If no instrument is connected to the computer, be sure the serial port setting (Edit > Preferences) in SoftMax Pro is set to “None.”  
4) If your files contain many Plate sections or if you are using a FlexStation protocol, try suspending recalculation (Edit > Suspend Recalculation) to free up resources on your computer. |
General Problem #1

Insufficient Memory in a Macintosh

If errors occur while using SoftMax Pro for the Macintosh, it may be that the amount of memory allocated for the program is insufficient. Two items need to be checked: the amount of memory your Macintosh has available for use, and the amount of memory allocated to SoftMax Pro.

To see the amount of memory available within the Macintosh, first quit all open applications, then go to the Finder, and choose About This Macintosh... from the Apple () menu.

The information box that opens will list the amount of memory used by the System file and the amount of memory remaining (under the heading, “Largest unused block”) that can be assigned to applications (such as SoftMax Pro). The amount of memory available should be equal to or greater than minimum amount required by SoftMax Pro.

Figure 11.2: About This Computer Dialog Box

If you open many files simultaneously, or if you open SoftMax Pro while other applications are open in the background, memory errors can occur. Also, if you make a Kinetic run with a large number of data points, you may not have enough memory with a typical allocation. SoftMax Pro requires a minimum of 7223K (over 7 megabytes) of memory to run, but this is not optimal. The preferred size is 8223K (over 8 megabytes) or larger. Try increasing the amount of memory allocated to the program. To do this, quit SoftMax Pro (if it is running). Then highlight the SoftMax Pro program icon (click it once), and then choose Get Info (I) from the File menu. The dialog box that opens lists suggested and minimum memory allocations (see Figure 11.3).
Figure 11.3: SoftMax Pro Info Dialog Box

The actual dialog box will show a version number.

Enter a larger amount of memory in the box next to “Suggested size”—the amount you enter may be limited by the total amount of memory available. The next time you start SoftMax Pro, it will use the larger memory size you have allocated. You may also enter a different number into either the minimum or preferred size boxes. It is suggested that you do not reduce the number in the “Minimum size” box (you may increase it, however). The “Preferred size” can be as large as you wish, depending on the amount of memory available.
General Problem #2

Printshop Launches instead of SoftMax Pro (Windows only)

Both Printshop (an application from Brøderbund) and SoftMax Pro use the extension “.pda” to identify files. If Printshop is already installed when you install SoftMax Pro on your computer, the “.pda” extension will have already been registered with Windows as a Printshop file, and SoftMax Pro files will appear with the Printshop icon. Double-clicking any file ending with the “.pda” extension will launch Printshop instead of SoftMax Pro.

There are two ways to fix this problem: 1) you can launch the SoftMax Pro program and open the data or protocol file from within the program; 2) you can change the program that starts when you open a file. To perform this second option, do the following:

1) In My Computer or Windows Explorer, click the View menu, and then click Options.
2) Click the File Types tab.
3) In the list of file types, click Printshop. The settings for Printshop will be shown in the File Type Details box (“PDA” will appear as the extension used).
4) Click [Edit].
5) In the actions box, click [Open].
6) Click [Edit], and then specify SoftMax Pro as the program you want to open files that have this extension. To do this, click the [Browse...] button and locate the SoftMax Pro executable file.

Doing this will cause “.pda” files to be associated with SoftMax Pro instead of Printshop. In order to open Printshop files, you will need to open the Printshop application and open “.pda” files relating to Printshop from within that application (double-clicking a “.pda” file will open SoftMax Pro).
Chapter 12  SoftMax Pro Remote Command Language

Introduction ................................................. 12-3
Notes On Queued Processing. ............................. 12-3
Send /Receive Remote Commands ...................... 12-4
Summarizing Remote Commanding ...................... 12-7
Programmer Notes. ........................................ 12-7
Molecular Devices' Position ............................... 12-8
SoftMax Pro Commands .................................... 12-9
Visual Basic (Excel Macro) Example .................... 12-14
MFC C++ Interface to SoftMax Pro Remote Commands
that Return Values ........................................ 12-15
Introduction

SoftMax Pro can be controlled by other Windows applications by means of a simple ASCII string-based messaging system. Using the Win32 “SendMessage” function, SoftMax Pro remote command strings such as “ReturnStatus”, “Read” or “SaveAs:myFile” may be sent as a Windows Message to SoftMax Pro for remote process execution.

Additionally, SoftMax Pro version 4.0.1 or later supports queued processing of remote commands. This feature allows the client process to send a block of remote commands and then pause for completion as opposed to testing for command completion between each command. The user is never blocked (or held up) while sending remote commands. An additional benefit of this option is that, when the client processes the request status, the “ReturnStatus” command is processed immediately even if SoftMax Pro is busy carrying out other tasks.

![Figure 12.1: SoftMax Pro Remote Command Interface](image)

Notes On Queued Processing

- To enable queued processing specify “/R” (for Remote) in the program command line when launching SoftMax Pro. This option is optional in order to maintain compatibility with previous versions that did not include queued processing.

- After sending a block of remote commands, the caller should wait until the commands have been completed by sending the command ReturnStatus which returns the number of remote commands in the queue yet to be executed. When “ReturnStatus” returns the message that there are zero remote commands waiting, the caller should then check that the reader is idle using the Status command. When the queue is empty and the reader is idle, the caller may clear the command queue and send another block of commands.

- The command queue is limited only by the memory capacity of the computer. No SoftMax Pro error will be generated when the user has flooded the software with remote commands which results in overloading memory.
• A special command has been created to clear the queue: **ClearQueue**. This command is processed immediately. See “SoftMax Pro Commands” on page 12-9 for more details.

• The Stop command is not queued and processed immediately. See “SoftMax Pro Commands” on page 12-9 for more details.

### Send/Receive Remote Commands

In SoftMax Pro version 4.0.1 or later, the user may choose between sending remote commands using windows message (1) **WM_SETTEXT** or (2) **WM_COPYDATA**.

1) The **WM_SETTEXT** approach.

• Call the Win32 RegisterWindowMessage function to register a unique message tag. SoftMax Pro uses this tag information when the command is received to distinguish between a Windows generated message and an external command. The tag should be a non-zero value.

    ```c
    UINT tag = RegisterWindowMessage("SOFTMaxProMsg");
    ```

• All messages must be sent to the SoftMax Pro main window. Note that if SoftMax Pro is not currently running, this will return a null value, requiring your program to discontinue until SoftMax Pro is restarted.

    ```c
    HWND hwnd = FindWindow("SOFTMaxProMainWnd", "SoftMax Pro");
    ```

• A complete list of remote commands can be found in “SoftMax Pro Commands” on page 12-9. Do not forget that the tag value, from RegisterWindowMessage above, is sent with the command string. (See Microsoft documentation regarding the **SendMessage** function for more information.)

    ```c
    SendMessage(hwnd, WM_SETTEXT, tag, (LPARAM)remoteCommandString)
    ```

• For example, to send SoftMax Pro a Read command:

    ```c
    SendMessage(hwnd, WM_SETTEXT, tag, (LPARAM) "Read")
    ```

• If return data is expected, such as with remote commands **Return Status**, **Return Timing**, and **ReturnData**, the data is returned to the clipboard. The advantage of this approach is that it may be universally applied to Visual C++ and Visual Basic modules, Excel macros, etc. An example of retrieving clipboard data is shown below, where the string data retrieved is finally stored into a Microsoft CString object.
if ( !::OpenClipboard(NULL) )
    return FALSE; // Error opening clipboard
HANDLE handle = ::GetClipboardData(CF_TEXT);
    if (handle == NULL)
        { 
            ::CloseClipboard();
return FALSE; // Error, no data in clipboard
    }

    // get clipboard data, store in MFC CString object
    CString returnStr = CString ((char *) handle );

    // close the clipboard
    ::CloseClipboard();

2) The WM_COPYDATA approach.
   • Call the Win32 RegisterWindowMessage function to register a unique message tag. SoftMax Pro uses this tag information when the command is received to distinguish between a Windows generated message and an external command. The value returned should be a non-zero value.
      UINT tag = RegisterWindowMessage("SOFTMaxProMsg");
   • Call the Win32 RegisterWindowMessage function to register another unique message tag. Your software will use this tag information when the asynchronous windows message is returned, and will distinguish between a Windows generated message and an external command. The value returned should be a non-zero value.
      UINT replyTag = RegisterWindowMessage("SOFTMaxProReplyMsg");
   • All messages must be sent to the SoftMax Pro main window. Note, if SoftMax Pro is not currently running this will return a null value, thus, requiring your program to discontinue until SoftMax Pro is restarted.
      HWND hwnd = FindWindow("SOFTMaxProMainWnd", "SoftMax Pro");
   • Get your window handle. This is the window to receive the return message.
      HWND MyWnd = GetSafeHwnd()
   • Assign which command you wish to send. Place the command in heap space, which appears to be necessary with older Windows operating systems.
      char *cmdStr = "Read";// Example remote command // to send
      char *msgStr = _strdup(cmdStr); // String duplication, copy
      // command to heap space.

   • Create the Win32 COPYDATASTRUCT message that will be sent. See Microsoft documentation regarding this structure for details.
Chapter 12: SoftMax Pro Remote Command Language

COPYDATASTRUCT cd; /* This struct is defined in Microsoft include file
  * HANDLE to a window receiving return information
  * Length of message string, adding 1 for null terminator
  * String pointer to remote command

• Finally, send the message to SoftMax Pro. A complete list of remote commands can be found in “SoftMax Pro Commands” on page 12-9. Don’t forget that the tag value, from RegisterWindowMessage above, is sent with the command string. (See Microsoft documentation regarding the SendMessage function for more information.)

  SendMessage(hwnd, WM_COPYDATA, tag, (LPARAM) &cd)

• Either a completion message or return data is returned. Remote commands Return Status, Return Timing, and ReturnData return data. In either case, data is received through an asynchronous windows message inside Win32 COPYDATASTRUCT type data packet.

  For example, a typical OnCopyData window callback is shown below, where the string data retrieved is finally stored into a Microsoft CString object. Note the use of variable replyTag, discussed above, which is used to isolate the correct windows message returned.

  BOOL CUserDlg::OnCopyData(CWnd* pWnd, COPYDATASTRUCT* cd)
  {
    ....
    if (cd->dwData == replyTag)
    {
      /* String pointing to status */
      CString retStatus = (char*) cd->lpData;
    }
    ....
  }
Summarizing Remote Commanding

SoftMax Pro has two groups of remote command instructions:

1) Remote commands that DO NOT return data.

Commands that do not receive data are further broken into:

A) The user wishes to receive a completion message after the command has been sent.

   After receiving a remote command that used the WM_COPYDATA message, SoftMax Pro will send a completion message once the command has been executed. An asynchronous window message is returned as a window callback, typically an OnCopyData handler, inside the Win32 COPYDATASTRUCT types data packet. For example, if the “Read” command were sent, an “OKRead” text string will be returned after the read is completed.

B) The user does not wish to receive a completion message.

   Use SendMessage combined with WM_SETTEXT for messages that do not require a completion message. The advantage of this approach is that it may be universally applied to Visual C++ and Visual Basic modules, Excel macros, etc.

2) Remote commands that DO return data.

   There are three remote commands that return data: ReturnStatus, ReturnTiming, and ReturnData. (See “SoftMax Pro Commands” in this chapter for details).

   It the caller has enabled queue operation, the command ReturnStatus is handled immediately, and not queued, as are other remote commands. Data is returned in one of two ways:

   A) After sending the remote command using the WM_COPYDATA message, the caller can look for return data through an asynchronous Windows message inside a Win32 COPYDATASTRUCT type data packet. An asynchronous window message is returned as a window callback, typically an OnCopyData handler.

   B) After sending the remote command using the WM_SETTEXT message, the return data will be available immediately on the clipboard. The advantage of this approach is that it may be universally applied to Visual C++ and Visual Basic modules, Excel macros, etc.

Programmer Notes

- COM ports 1-9 can be used for robotics purposes. Molecular Devices recommends using COM1 or COM2. These are typically the most stable.
- An Autosaved file from the robotics run can be saved as either a text (.txt) or SoftMax Pro data (.pda) file. This selection is made in the Preferences dialog box within SoftMax Pro (choose Edit > Preferences).
- More memory will be needed to run SoftMax Pro using remote commands. Depending on the robotics used and the type of file created with SoftMax Pro, a computer configured with the minimum amount of RAM (see “Computer System Requirements” on page 2-6) will restrict the size of the file that can be generated.

   An experiment with more than one plate of data could adversely affect SoftMax Pro’s efficiency. If increasing the computer’s memory is not an option,
Molecular Devices recommends using only one plate per file and also ensuring that the computer is dedicated to use for SoftMax Pro (i.e., is not being used for other purposes while SoftMax Pro is running).

**Molecular Devices’ Position**

In order to integrate robots from other manufacturers with certain instruments from Molecular Devices Corporation, or to automate the export of data from SoftMax Pro to a desired LIMS package, Molecular Devices has made available in this chapter the commands enabling the remote control of SoftMax Pro. Molecular Devices has tested these commands but does not provide technical support for specific integration needs. Molecular Devices strongly recommends that customers consult a third-party automation company if internal software resources or expertise are not available.

All leading automation vendors have integrated SoftMax Pro and Molecular Devices’ instruments with their systems. A partial list of these vendors includes:

- Beckman Coulter (SAGIAN)
- Zymark Corporation
- CRS Robotics Corporation
- TekCel Corporation
- QIAGEN Inc.
- Hudson Control Group

If you are a robotic vendor or an individual integrator and you need more information, please contact your local Molecular Devices sales representative or send an email (with the message titled “SoftMax Pro”) describing your interest to info@moldev.com.
SoftMax Pro Commands

SoftMax Pro commands are single words. If parameters are required with a command, a colon is used between the command and the parameters.

Commands may be sent using either the `WM_SETTEXT` or `WM_COPYDATA` approach. Completion messages or data are returned directly when commands are sent using the `WM_COPYDATA` method. Completion messages or data are placed in the system clipboard when commands are sent using the `WM_SETTEXT` method.

**ClearQueue**
When queued processing is enabled, this command clears the queue of remote commands that have not yet been executed. This command can be useful when you wish to clear the queue (perhaps during software development). If queued processing is not enabled, this command does nothing.

**Close**
Close the current document.

⚠️ **CAUTION:** If the data has not been saved, the document is closed anyway with no user warning.

**CloseCDrawer**
*FlexStation only* Tell SoftMax Pro to close the compound drawer.

**CloseDrawer**
Tell SoftMax Pro to close the instrument drawer.

**CloseTDrawer**
*FlexStation only* Tell SoftMax Pro to close the tips drawer.

**Copy**
This is equivalent to pressing `CTRL-C` or selecting Copy from the Edit menu.

**Notes:**
- If a plate section has just been read or is the only selected section, the plate data will be copied to the clipboard.
- The data copied will follow the display settings for the current plate (normally Raw Data).
- Other sections such as Groups can also be copied. The `SelectAll` command should be used first.

**ExportAs:XXX**
Tell SoftMax Pro to export data in the standard SoftMax Pro format.

- Attribute available: `-a`

The “ExportAs” command without the “-a” attribute overwrites any existing file without warning. However, you can choose to append export data to the
end of an existing file by specifying the “-a” attribute. In addition, this exported file can then be imported and all data can be viewed as a single document file.

Please note that, when using the attribute “-a,” a single space is required between the attribute and the following directory and file string (XXX).

Example:
Without the attribute— ExportAs:c:\SoftMax Pro\exportfile.txt
With the attribute— ExportAs: -a c:\SoftMax Pro\exportfile.txt

ImportTemplate:XXX
Have SoftMax Pro import a template file. The file should comply with SoftMax Pro’s template file format. A plate section should be selected prior to importing a template.

NameCurSection
This (re)names the current selected section. If no section is selected, nothing happens.

Notes:
• This command is used typically to identify different plates in an automated environment.
• The data copied will follow the display settings for the current plate (normally Raw Data).

Example:
“NameCurSection:Plate#002345”

New
Have SoftMax Pro send a New command. This creates a new document and reads in the values contained in the “Default Protocol.ppr” protocol file.

NewNotes
Tell SoftMax Pro to send a New Notes (section) command. This creates a new Notes section within the current Experiment.

NewPlate
Tell SoftMax Pro to send a New Plate (section) command. This creates a new Plate section within the current Experiment.

OpenAssay:XXX
Have SoftMax Pro open a protocol file. The file should be in SoftMax Pro’s Assays folder which is set using the Assays menu. Protocols can also be stored in subdirectories of the Assays folder.

Notes:
• Only protocol files can be opened.
• SoftMax Pro will append .ppr to any filename passed in.
• If the file is not found, SoftMax Pro does nothing.

Examples:

“OpenAssay:myFile”
“OpenAssay:\mySubDirectory\myFile”

**OpenCDrawer**

*FlexStation only* Tell SoftMax Pro to open the compound drawer.

**OpenDrawer**

Tell SoftMax Pro to open the instrument drawer.

**OpenTDrawer**

*FlexStation only* Tell SoftMax Pro to open the tips drawer.

**ReturnData**

This command asks SoftMax Pro to send data back from the currently selected plate. Generally this is used to send the data directly to the caller instead of using the clipboard. If data is to be returned to the clipboard, this command functions like the SoftMax Pro “Copy” command when a plate is the currently selected section.

**ReturnStatus**

This command returns the current instrument status. Even if queue operation is enabled, this command is not queued and is processed immediately.

The status is an ASCII string that has

• Information about the instrument type and version,
• Whether the instrument is busy or idle,
• The instrument’s current temperature, and
• The state of its drawer.

If queue operation is enabled, the number of remote commands queued is also returned.

The exact format of this response depends on the type of instrument in use.

If SoftMax Pro failed to place data in the clipboard, then no return status will be available.
Example:

\[
\begin{align*}
\text{ReturnStatus:} & \text{tab} \text{cr} \\
\text{ReaderType:} & \text{tab} \text{Version#} \text{cr} \\
\text{State:} & \text{tab} \{\text{Offline, Busy, or Idle}\} \\
\text{Temperature:} & \text{tab} \text{XXX} \\
\text{Drawer:} & \text{tab} \{\text{Open or Closed}\} \\
\text{Que:} & \text{tab} \text{NumberRemoteCmdsInQueue} \\
\end{align*}
\]

ReturnTiming

This command sends back the number of seconds that it would take to read the current plate. For multi-plate documents, the plate to be used is chosen in the same way as described in the “Read” command above.

SaveAs:XXX

Have SoftMax Pro save the current document file. The file will be saved in the current SoftMax Pro Autosave directory which is set in the Preferences dialog accessed through the Edit menu. Data files can also be saved to subdirectories of the Autosave directory.

Notes:

- SoftMax Pro will append .pda to any filename passed in to it.
- If a file with the same name already exists, SoftMax Pro will automatically overwrite the file with NO warning.
- If the subdirectory does not exist, the file will not be saved.

Examples:

```
“SaveAs:myFile”
“SaveAs:\mySubDirectory\myFile”
```

SelectAll

This is equivalent to pressing CTRL-A or choosing Select All from the Edit menu. This can be used to select data in group tables for copying (not needed for copying plate data).

SelectSect

Select a section by name. This can be useful for multi-plate protocols or for selecting Group tables for copying.

Examples:
“SelectSect:Plate#0023499”  
“SelectSect:Group#1”

**SelectSectNum**
Select a section by its order in the document. This can be useful for multi-plate protocols or for selecting Group tables for copying.

Example:

“SelectSectNum:3 ”

**SetFolderAs:XXX**
Set the current protocol directory. You must specify the root directory.

Example:

“SetFolderAs:c:\SoftMaxPro\Basic Protocols”

**SetPort:X**
Tell SoftMax Pro to set a serial COM port.

**SetTemp:XX.X**
Send a command to set the current instrument incubator temperature.

**SetUserName**
Send a command to set the User name prior to opening a protocol file that has been shielded.

The User name is not the same as the Author name—it is the name of the person using a shielded protocol to gather data. The User name is not used to validate an electronic signature for a password-protected file.

**Notes:**
- This command tells SoftMax Pro to save the user’s name internally so that when an “OpenAssay” command is issued for a shielded protocol, SoftMax Pro will assign this User name for the newly created document.
- This user name remains stored within the program until the SoftMax Pro is terminated.
- The user name will be ignored if the currently open data file was not generated from a shielded protocol.

Example:

“SetUserName:John Doe”

**SetUserPassword**
Prepare SoftMax Pro with the protocol password prior to opening a shielded protocol file.

**Notes:**
- This command tells SoftMax Pro to save the protocol password internally so that when an “OpenAssay” command is issued using a shielded protocol, SoftMax Pro will use this password to open the file.
• This protocol password remains in use until the program terminates or another protocol password is sent.
• The password is limited to 8 characters.

Example:

“SetUserPassword:bop-i-do”

Stop

Send SoftMax Pro a command to stop reading. If queue operation is enabled, this command is not queued, the queue is cleared, and the command is processed immediately. This is similar to clicking the Stop button on the SoftMax Pro tool bar except the Stop button does not affect remote command processing or its queue.

This command should be sent before any Close or Quit command if there is a possibility that the instrument is still reading.

⚠️ CAUTION: If the data has not been saved, the application quits anyway with no user warning.

Visual Basic (Excel Macro) Example

' First some housekeeping code:
Private Declare Function FindWindow Lib "user32" Alias "FindWindowA" (ByVal lpClassName As String, ByVal lpWindowName As String) As Long
Private Declare Function SendMessage Lib "user32" Alias "SendMessageA" (ByVal hWnd As Long, ByVal wMsg As Long, ByVal wParam As Long, ByVal lParam As String) As Long
Private Declare Function RegisterWindowMessage Lib "user32" Alias "RegisterWindowMessageA" (ByVal msgName As String) As Long

'-----------------------------------------------------------------------------
Const WM_SETTEXT = 12 ' define a windows message value
Function SendMsgToPro(ByVal msgStr As String) As Long
hWnd = FindWindow("SOFTMaxProMainWnd", "SoftMax Pro")
If hWnd = 0 Then    ' one beep means Pro is not running.
    Beep
Else
    softmaxMsg = RegisterWindowMessage("SOFTMaxProMsg")
    If softmaxMsg = 0 Then
        SendMsgToPro = 0
    Else
        SendMsgToPro = SendMessage(hWnd, WM_SETTEXT, 0, msgStr)
    End If
End If
'-----------------------------------------------------------------------------

CAUTION: If the data has not been saved, the application quits anyway with no user warning.
' This version of Pro does not understand external msgs
    Beep
    Beep
    Else
        SendMessage(hWnd, WM_SETTEXT, softmaxMsg, msgStr)
    End If
End If
End Function
'*----------------------------------------------------------------------------*
'* This is an example of how to use the above routine
Sub SendNewMsgToPro()
    SendMsgToPro("New")
End Sub

MFC C++ Interface to SoftMax Pro Remote Commands that Return Values

Some SoftMax Pro IPC commands return values. By default they put the data in the clipboard, but optionally they will use the WM_COPYDATA mechanism to return data directly to the caller.

In order to have the SoftMax Pro response returned in this fashion, the commands must be sent using WM_COPYDATA so that SoftMax Pro knows what to send the response to.

SoftMax Pro will then reply with another WM_COPYDATA message that contains the response.

MFC Example Code:

......
......
// Global variable used in holding ID determined through RegisterWindowMessage
// This ID is later used to discriminate between WM_COPYDATA messages
// received, to understand which WM_COPYDATA coming back has the
// instrument status.
unsigned int   gExternalReplyMsgID;
...
...

// Entry point for typical MFC windows program
int APIENTRY WinMain(HINSTANCE hInstance,
                     HINSTANCE hPrevInstance,
// Perform this initialization early in the program
    gExternalReplyMsgID=RegisterWindowMessage("SOFTMaxProReplyMsg");

// Callback for processing windows messages received
LRESULT CALLBACK WndProc(HWND hWnd, UINT message, WPARAM wParam, LPARAM lParam)
{
    ...
    ...
    // begin processing incoming window messages
    switch (message)
    {
    case WM_COPYDATA:
        // Windows WM_COPYDATA message received.
        // Check if this message contains status message expected.
        COPYDATASTRUCT *cd;
        cd = (COPYDATASTRUCT*) lParam;
        if (cd->dwData == gExternalReplyMsgID)
            {
            // length of status message string plus 1
            unsigned int len = cd->cbData;

            // instrument status message returned
            char *str = (char*) cd->lpData;

            // Process return data as you wish
            ..............
            }
}
case WM_COMMAND:
    // Windows command to process the application menu selection
    wmld    = LOWORD(wParam);
    wmEvent = HIWORD(wParam);

    // Parse the menu selections:
    switch (wmld)
    {
        // For this example, the user has set up a
        // menu selection to soliciting instrument status from
        // SOFTMaxPro application software.
        // Id IDM_COPYDATA defined in resource.
        case IDM_COPYDATA:
            sendCommand();

            ....
            
            ....

    }

void sendCommand()
{
    // User has selected menu selection to send SoftMaxPro remote
    // command “ReturnStatus”. See SoftMaxPro User’s Manual,
    // chapter 12, Remote Command Language.

    char *cmdStr = “ReturnStatus”;
    char *msgStr = new char[strlen(cmdStr)+1];

    // Place command in heapspace. Note that a run time error may
    // occur unless command is copied to heapspace
    strcpy(msgStr, cmdStr);

    // This struct is defined in MFC include files
    COPYDATASTRUCT cd;
// Handle to a window, type HWND.
cd.dwData = (DWORD) hWnd;

// Length of message string plus 1
cd.cbData = strlen(msgStr)+1;

// Remote command string is in heap space
cd.lpData = msgStr;

// Primary method in sending windows command to SoftMaxPro application.
HWND hwnd = FindWindow("SOFTMaxProMainWnd", "SoftMax Pro");
UINT smaxMsg = RegisterWindowMessage("SOFTMaxProMsg");
SendMessage(hwnd, WM_COPYDATA, (WPARAM)smaxMsg, (LPARAM)&cd);

// Message sent, delete heap space no longer used.
delete msgStr;
Appendix A  SoftMax Pro Version Specifications

Introduction .......................................................... A-3
SoftMax Pro 3.1 Update Specification .......................... A-3
  SpectraMax Plus384 support ................................ A-3
  SpectraMax Gemini XS support ............................... A-3
  Well Scanning Read Mode .................................... A-3
  Apple OS 9 Navigation Services ............................. A-5
  Interprocess Messaging .................................... A-5
  Instrument Settings Changes ............................... A-5
  Password Protection ....................................... A-5
  Minimum Kinetic Interval ................................ A-5
  Autosave Changes ........................................ A-5
  Autoprint Changes ........................................ A-5
SoftMax Pro 3.1.1 Update Specification ....................... A-6
  Correction of Problems in SoftMax Pro 3.1 ................ A-6
  New Interprocess Messaging Features ..................... A-6
SoftMax Pro 3.1.2 Update Specification ....................... A-7
  New and Revised Interprocess Messaging Features ...... A-7
SoftMax Pro 3.2 Update Specification ......................... A-7
  FlexStation Features ................................... A-7
  New Accessors ............................................ A-8
  Checksum ................................................ A-8
  Import/Export .......................................... A-8
  Autoread ................................................ A-8
  Reduction Modifications ................................. A-8
SoftMax Pro 4.0/4.01 Update Specification .................. A-9
  GLP/GMP Support ...................................... A-9
  Criterion Files .......................................... A-9
  FLIPR Files ........................................... A-9
  Robotics ................................................ A-9
  FlexStation Enhancements ............................... A-9
  Well Scan Mode ......................................... A-10
  Export Function Updates ................................ A-10
  Multithreading of Serial Input (PC only) .............. A-10
  Macintosh Communications Toolbox Support .......... A-10
Appendix A: SoftMax Pro Version Specifications

SpectraMax Gemini and Gemini XS Enhancements .......... A-10
Enhanced 4-Parameter Fit .................................. A-10
Documentation & Software Enhancements .................. A-10
Specifications ................................................. A-10
SoftMax Pro 4.1 Specification ................................ A-11
Specifications ................................................. A-11
Appendix A: SoftMax Pro Version Specifications

Introduction

This Appendix lists enhancements and bug fixes made to SoftMax Pro in previous releases.

SoftMax Pro 3.1 Update Specification

SpectraMax Plus\textsuperscript{384} support

The SpectraMax Plus\textsuperscript{384} was added to the Reader list in the Preferences dialog. The Instrument Settings dialog for this new instrument is very similar to that for the SpectraMax Plus with the exception that a Plate Type options was included. The Plate Type selections include a standard 96-well plate and a standard 384-well plate.

SpectraMax Gemini XS support

The SpectraMax Gemini XS was added to the Reader list in the Preferences dialog. The Instrument Settings dialog for this new instrument is very similar to that for the SpectraMax Gemini. A new Plate Type table was provided for this instrument. The Plate Type selections include standard 96-well, 384-well, 48-well, 24-well, 12-well, and 6-well plates. Also, the Automatic setting for PMT Sensitivity is available for Spectrum reads with this instrument.

When performing an excitation scan with this instrument, the user can select to have no excitation filter present or to have the default excitation filter present. This setting defaults to having no filter present.

Well Scanning Read Mode

A new read mode is provided for a Well Scan. This read mode provides the ability to take readings at more than one location within a well. The Well Scan read mode is available for both the SpectraMax Gemini and SpectraMax Gemini XS instruments. In the Instrument Settings dialog, all the options that are included for Endpoint reads are available for Well Scans. One additional option is available, the Well Scan Editor shown in Figure 1.

The Well Scan Editor allows the user to specify how a Well Scan is performed. Four patterns are provided; a horizontal line, a vertical line, a cross (which is a combination of a horizontal and vertical line), and a grid pattern. The user also specifies a density setting, which determines the number of points read in the line patterns or the maximum number of horizontal and vertical points included in the grid pattern. With the grid pattern, points that land too close to the edges of the well are excluded. All points that land within 2.8 mm of an edge are excluded.

Only odd numbers of points are included in density settings. The minimum number of points is 3 for all plate sizes. The maximum number of points depends on the well diameter. To determine the maximum number of points included in density settings, 5.6 mm is subtracted from the well diameter, the remainder is divided by 0.8 mm and the largest odd integer that is less than this number used.
The Well Scan Editor provides information on the number of points to be read, the point spacing and the approximate read time depending on the pattern and density settings. Point spacing is determined by subtracting 5.6 mm from the well diameter and dividing the remainder by the density. The minimum point spacing is 0.8 mm.

![Well Scan Editor option](image)

**Figure A.1 Well Scan Editor option**

In the Display dialog for Well Scan plates, the user can choose between a gray scale display, showing reduced values or showing both. With multiple wavelength pair Well Scans, the user can choose between viewing the data from different wavelengths separately or together. The default reduction is the average of all points in a scan. The minimum value, maximum value, and Custom reductions are included as in the reduction drop-down list.

Plate Sections default to presenting the points read in a Well Scan in gray scale. For multiple wavelength pair Well Scans, the readings from different wavelength pairs are shown in different colors. The first wavelength pair is shown in black. The second wavelength pair is shown in blue. The third wavelength pair is shown in read. The fourth wavelength pair is shown in yellow. For each position in a Well Scan, the color for the wavelength pair with the highest reading is shown. Well scan data can also be viewed in well graphs.

The SoftMax Pro export format has been extended to include Well Scans. Well scan has been added to the read mode field (field 5). The number of points read is reported in field 9. The Well Scan pattern is reported in field 10. The Well Scan density is reported in field 11. The data from each position is output in subsequent rows or plates starting with the top, left point and proceeding with horizontal priority.
Apple OS 9 Navigation Services

The methods for finding, opening, and saving files have changed with OS 9 from Apple. Macintosh Navigation Services have been updated in SoftMax Pro to incorporate these changes. Compatibility with earlier operating systems has been maintained.

Interprocess Messaging

A command for exporting data has been added to Interprocess Messaging. The ExportAs command saves files to the Autosave directory or to subdirectories of the Autosave directory. The “.txt” extension is automatically appended to these files. Also, the GetTiming command for determining the length of time needed to read a plate has been updated to provide more accurate information.

Instrument Settings Changes

The ability to choose between wavelength and column priority reads has been added to Endpoint and Spectrum modes in the SpectraMax Plus and SpectraMax Plus384. The ability to use Speed Read for Endpoint reads has been added to the SpectraMax Plus, SpectraMax Plus384, SpectraMax 190, SpectraMax 340PC and VersaMax.

Password Protection

Password protection has been updated to use a new encryption scheme. Compatibility with older files has been maintained.

Minimum Kinetic Interval

Minimum Kinetic interval calculations have been updated to include the SpectraMax Plus384 and the SpectraMax Gemini XS. The calculations for large-well plates have also been updated.

Autosave Changes

The Autosave option in the Preferences dialog has been enhanced so that the file creation date can be appended to the file name when files are saved in sequence. An Append Date checkbox is used to activate this feature. The names of the files created when Append Date is activated begin with the file prefix, followed by the date, the iteration number, and the file extension. If the file prefix field is left blank in the Preferences dialog, the autosaved files will use the protocol creation date as the file prefix.

Autoprint Changes

When Autoprint and Autosave are both selected in the Preferences dialog, the name used in the footer of the printed document will match the name of the correspondingly saved file rather than the on-screen document name. If Autoprint is used without Autosave, the on-screen document name is used.
SoftMax Pro 3.1.1 Update Specification

Correction of Problems in SoftMax Pro 3.1

Several problems were found in SoftMax Pro 3.1 that were corrected in SoftMax Pro 3.1.1.

- Password protected files from version 3.0 did not open correctly in version 3.1.
- In the Display dialog, displaying raw data in 1000's could not be deactivated after it was activated.
- Well scan files with custom plates were not defaulting to the correct plate type.
- Wavelength settings for Gemini Spectrum reads were not being correctly verified. Problems occurred with Start wavelengths higher than Stop wavelengths.
- The wrong error message appeared when the number of Kinetic reads was set higher than 10,000.
- AutoPMT was available in Kinetic mode on a fluorescence reader when an absorbance Kinetic protocol was opened. Also, AutoPMT was available on the Gemini for spectra when an absorbance Spectrum file was opened.

New Interprocess Messaging Features

The NewPlate command creates a new Plate section in the currently selected Experiment. The plate will be named following the normal rules for SoftMax Pro. This plate name will be Plate#X, where X is the lowest number not already being used for a section.

The NewNotes command creates a new Notes section in the currently selected Experiment. The notes will be named following the normal rules for SoftMax Pro. This notes name will be Notes#X, where X is the lowest number not already being used for a section.

The SaveAs, OpenAssay, ExportAs and ImportTemplate commands have been modified to allow full pathnames. The file path can be fully redirected by beginning the filename with a partition letter and a colon (D:\mySubDirectory\myFile, for example).
Appendix A: SoftMax Pro Version Specifications

SoftMax Pro 3.1.2 Update Specification

New and Revised Interprocess Messaging Features

New and Modified Features for Robotic Integration

1) Expanded COM ports selection (0–9).
2) Extended communication response timeout value and removed the time-out warning dialog during remote command operation.
3) Added SetFolderAs:XXX command.
   User can set the current protocol directory using this remote command.
   User has to specify the directory or file path.
   Example: SetFolderAs: c:\SoftMax Pro 3.1.2\Basic Protocols
4) Added a parameter to the ExportAs:XXX command (append data to an existing export file and import the file as a single document).
   The ExportAs command without the –“a” attribute overwrites any existing file without warning. However, user can choose to append export data to the end of an existing export file by specifying the –“a” attribute. In addition, this export file can then be imported and all data can be viewed as a single document file.
   Please note that a single space is required between the attribute and the following directory and file string (XXX).
   Example: ExportAs: -a c:\SoftMax Pro 3.1.2\exportfile.txt

SoftMax Pro 3.2 Update Specification

FlexStation Features

- Supports all the features of the new FlexStation instrument including a new read mode (also called “FlexStation”). New tabs are included in the Instrument Settings dialog box for the new read mode.
- The Plate section for FlexStation instruments shows which wells have been selected for transfers: small, color-coded triangles in the corners of the wells show first and subsequent transfers.
- Information about the transfer settings and compound sources is shown beneath the Plate display.
- Because intervals between readings are not predictable in FLEX mode, SoftMax Pro collects and stores a time tag for each reading made in FLEX mode. This time tag is used in analysis and graphing of the resulting data.
- When SoftMax Pro is connected to a FlexStation instrument, additional items are available in the Control menu:
  - Open/Close Tip Drawer
  - Open/Close Compound Drawer
  - Set Air Gap: Allows you to set the distance (from 0 to 200 milliliters) between the tip of the pipette and the bottom of the plate well.
- Bottom Read allows the FlexStation instrument to take readings upward from the bottom of a microplate instead of downward from the top.
New Accessors

- New accessors have been created to accommodate the new instrument settings included for FLEX mode. These include accessors for transfer volumes, transfer rates, transfer timing, pipetter heights, and source types for each transfer. Accessors for transfer areas, source areas, and tip types are also available.

Checksum

- The checksum feature has been activated for the FlexStation instrument to check for accuracy of received data.

Import/Export

- SoftMax Pro can now export a tab-delimited time-tagged file from FlexStation data. SoftMax Pro is also able to re-import the time-tagged file data.

- A tab-delimited text file with time-interpolated data can be exported from SoftMax Pro. Such data can facilitate analysis using third-party software (such as Microsoft Excel). Time-interpolated files cannot be re-imported into SoftMax Pro.

- The import feature has been expanded to include the ability to import a tab-delimited text file exported from FLIPR®.

Autoread

- This new feature is included for all instruments (not available in Kinetic and FLEX read modes). Autoread enables the sequential reading of multiple plates within an experiment. You can set intervals between plate reads, if desired.

Reduction Modifications

- A new Kinetic reduction dialog box is available for FlexStation read mode that adds special display options: Raw Values, Baseline Offset Values, and % Increase Values. These display options are used to alter the way in which the data is graphed. Additionally, for Slope and Area Under the Curve calculations for curve fitting, the raw data is smoothed using a simple moving average. You can choose the period of this moving average from a popup menu.

- Additional reduction formulas are available in the FlexStation Kinetic reduction dialog box: Time at Minimum, Time at Maximum, Time at 1/2 Minimum, Peak, and Max-Min.
Appendix A: SoftMax Pro Version Specifications

SoftMax Pro 4.0/4.01 Update Specification

GLP/GMP Support

New levels of file protection have been added:

• In addition to standard password protection of a file, you may now add an author’s name to a file. This name is saved with the file, will print with the report, and is shown on the screen.

• To prevent any and all changes to a file, including saving it under a different name or accidentally overwriting it with a file of the same name, you may choose to shield a file. The author of the file must include his/her name and password, as well as a new shielding name and password as part of the file protection.

• Exported files now show the date, author, and file name.

• All printed pages now show the file name, date, author, and Molecular Devices copyright information on all pages.

Analyst System Files

• Import Analyst... has been added to the Import menu. This selection allows you to import verbose reports generated using Criterion Host or SCREEN-PLAY software for all instrument modes. After import, the data from the Analyst System file can be viewed and analyzed just as if it had been generated by SoftMax Pro.

FLIPR Files

• Import FLIPR... has been added to the Import menu. This selection allows you to import “FPD” files exported from FLIPR software. After import, the data from the FLIPR file can be viewed and analyzed just as if it had been generated by SoftMax Pro.

Robotics

• Autosaving a file now saves time with seconds.

• New robotics commands have been added to automate opening and closing the tip and compound drawers of the FlexStation instrument.

• COM port switching for multiple instruments is now available.

• STATUS has been clarified (application vs. instrument busy status).

• A user name and password can be entered to open a password-protected file.

FlexStation Enhancements

• 384-well plates are now supported for both reading and for use as a compound source.
Well Scan Mode

• Blank subtractions are performed differently: previously a point-to-point subtraction was used; now all points in the well are averaged and that average is subtracted from the average of all sample points.

Export Function Updates

• Notes sections are now exported with data from Plate sections
• Molecular Devices copyright information added to the bottom of exported data
• Exported information is formatted with tabs between items so that it can be opened and viewed using Excel and the data will parse properly into columns

Multithreading of Serial Input (PC only)

• PC serial input/output is handled using a separate thread in order to enhance serial communication performance.

Macintosh Communications Toolbox Support

• Macintosh serial communications through a USB-to-serial port have been enhanced.

SpectraMax Gemini and Gemini XS Enhancements

• Ability to read a single well in Gemini and Gemini XS

Enhanced 4-Parameter Fit

• The 4-Parameter curve fit has been enhanced to be more robust.

Documentation & Software Enhancements

• A robotics program example has been added to the CD files provided.
• Added examples to the Formula Reference Guide. The results of these examples are included as PDA files that can be used as tutorials.
• Life Cycle Documentation for SoftMax Pro 4.0 is included in the SoftMax Pro 4.0 Validation Manual.
• A feature request plan and testing plan are included in the SoftMax Pro 4.0 Validation Manual.

Specifications

• Added support for Windows ME.
• Dropped support for Windows 95 and Mac OS below 8.6.
Appendix A: SoftMax Pro Version Specifications

• Increased minimum required computer hardware and software specifications when FlexStation and/or robotics are used.

SoftMax Pro 4.1 Specification

Specifications

Added support for the SpectraMax Gemini EM instrument. The Instrument Settings dialog box for the Gemini EM includes choices for “Bottom Read” and a 325-nm additional cutoff filter (total of 16 cutoff filters for the Gemini EM; the other Gemini instruments have 15). The choice for Time-Resolved Fluorescence has been removed from the settings for the Gemini EM.
Appendix B  Glossary of Terms

Absorbance, A

The amount of light absorbed by a solution. To measure absorbance accurately, it is necessary to eliminate light scatter. In the absence of turbidity, absorbance = optical density - reflection.

\[ A = \log \left( \frac{I_0}{I} \right) \]

\( I_0 = \) incident light

\( I = \) transmitted light

In this manual, we use the terms absorbance and optical density interchangeably.

Active

The window or icon that you are currently using or that is currently selected.

ANSI Character Set

The American National Standards Institute 8-bit character set. It contains 256 characters.

Area Under Curve

Reduction formula for a Kinetic or Spectrum scan that determines the area under the Kinetic or Spectrum plot, or under a plot in a Graph section. First the area under the curve is divided into a series of trapezoids; then the area defined by each trapezoid is computed and all areas are summed.

ASCII Character Set

The American Standard Code for Information Interchange 7-bit character set. It consists of the first 128 (0–127) characters of the ANSI character set (and most other 8-bit character sets). The ASCII character set is the most universal character-coding set.

Author Name

The Author Name is entered from the password dialog box at the time when file shielding is turned on. The Author Name is different from the User Name in that it may be the name of the author of a protocol file that is later used to read data.
AutoCalibrate

For absorbance instruments, an air reference reading is taken before runs (and sometimes between Kinetic readings during a run) as determined by the type of instrument and read settings. For fluorescence instruments, measurement occurs before reads (and sometimes between Kinetic reads if the interval is long enough). Calibration data is stored in volatile memory and is used by SoftMax Pro until the instrument is powered down or the wavelength is changed. Autocalibration can be turned off (see “AutoCalibrate” on page 5-18 for more information).

Automix

The Automix function determines how often, if at all, automated shaking of the microplate is performed during a reading. This feature is covered by U.S. Patent Number 5,112,134.

AutoRead

This feature enables automatic reading of subsequent Plate sections in the order in which they appear within an experiment. You can set intervals (delay times) between the plate readings, if desired.

Baud

A data transmission rate (measured in bits/second) for communication devices.

Blanking—CuvetteSet Section (SpectraMax Plus or Plus only)

Three types of blanking are available in the CuvetteSet section for the SpectraMax Plus or Plus: Ref Blanking, Template Blanking, and Group Blanking.

A Ref Blank is created when you click the [Ref] button or choose Ref from the Control menu. This command causes the SpectraMax Plus or Plus to read the cuvette in the cuvette port and applies this reading as a reference for all cuvettes in the CuvetteSet section.

Template Blanks are created by entering a Blank group in the CuvetteSet section template. After a reading, the average of the blank values obtained from the Blank group is subtracted from all cuvettes.

Group-Associated Blanks are created by placing blank cuvettes within a group in the template. The values of group blanks are averaged and subtracted from the values of the cuvettes within that group only.

Blanking—Plate Section

Three types of blanking are available in the Plate section: Pre-Read Blanking, Plate Blanking, and Group Blanking.

Pre-Read Blanking subtracts background signal caused by the microplate itself, as well as by solvents, reagents, or samples. The individual blank reading from each well can be subtracted from the final reading from the same individual wells (choose “Pre-read plate” from within the Instrument Settings dialog box). This is usually used for measurement in the deep UV or for path-length correction.

NOTE: Pre-read blanking is not available with all instruments and also is generally not used with Kinetic assays. If used with Kinetics, it will complete a pre-read Kinetic run and then subtract these values on a
point-by-point basis from the “normal” Kinetic run.

**Plate Blanks** are created by entering a Blank group in the template. After a reading, the average of the blank values obtained from the Blank group is subtracted from all wells in the plate.

**Group-Associated Blanks** are created by placing blank wells within a group in the template. The values of group blanks are averaged and subtracted from the values of the wells within that group only.

**Bottom Read (FlexStation only)**
Available in the Instrument Settings, this selection causes the FlexStation to read up through the bottom of the microplate rather than down from the top.

**Checkbox**
A small, square box that appears in a dialog box and that can be selected or cleared. When the checkbox is selected, an X appears in the box. A checkbox represents an option that you can turn on or off.

**Clear**
Within the Template Editor, **Clear** removes information that was designated previously for selected wells. By highlighting wells and then choosing **Clear**, any information regarding those wells will be erased (the wells will return to their default status of empty). Note that if you clear the entire template, the groups themselves will not be deleted and are still selectable. Keeping the groups allows you to reassign wells without having to recreate groups.

**Click**
You click an object on the screen by pressing and quickly releasing the mouse button while the pointer is on that object. When you click once on an object, such as an icon or file name, it becomes highlighted, which means it is selected. Whatever action you choose next will affect a selected object.

**Clipboard**
A temporary storage location within the operating system used to transfer data within and between files and applications.

**Compound and Tip Columns (FlexStation only)**
A selected tip column and compound column are assigned for fluid transfer to a specific assay plate column.

**Compound Source (FlexStation only)**
Compounds are transferred from the compound source plate to the assay plate.

**Compound Transfer (FlexStation only)**
Microplate fluid transfer from the compound source to assay plate.

**Concentration**
The amount of a substance present per unit volume. Used as the default sample descriptor for a series of samples.
**Control**
A sample that is run as an internal check of the assay. The control has a predictable or known assay result against which other results can be compared.

**Control Menu Box (Windows)**
The icon that opens the Control menu for the window. It is located at the left of the SoftMax Pro title bar. The Control menu can be activated by clicking in this box with the mouse or by pressing \texttt{ALT, SPACEBAR}.

**Copy**
A function common to most software applications that duplicates the selected text or item and places this duplicate on the clipboard. The copy function is enabled by pressing \texttt{⌘C} on the Macintosh and \texttt{CTRL+C} in Windows.

**Copy-and-Paste**
A method of copying selected text or graphics from one location and pasting them to a different location in the same file or into another file (which could be in an application other than SoftMax Pro).

**Analyst System™**
Molecular Devices’ Analyst System line of instrumentation, formerly from LJL BioSystems, is specifically designed to address the microplate-based assay detection needs of Life Science and Drug Discovery laboratories.

**Cubic Spline (Curve Fit)**
This curve fitting option generates a fit to a cubic equation between each pair of data points. The cubic equations are computed such that these equations and their first two derivatives are continuous everywhere.

More information regarding curve fits can be found in Chapters 7 and 8.

**Curve Fit**
Specifies the type of curve (linear, logarithmic, quadratic, and so on) that is applied to the data points in a plot. The curve is a graphic representation of the mathematical relationship between the data points in the plot. More information regarding curve fits can be found in Chapters 7 and 8.

**Cutoff**
A filter used to condition the light entering or exciting the monochromators. In automatic mode, the instrument sets the cutoffs automatically based upon the wavelength(s) chosen for reading; with some read modes and types, however, you can choose a different filter wavelength (manual setting) for the emission monochromator.

**CuvetteSet Section (SpectraMax Plus and Plus³84 only)**
The CuvetteSet sections determine how the cuvettes will be read, display data as it is acquired from the instrument, and define how the data will be displayed and used in reduction. CuvetteSet sections can display samples in three different ways: three samples per row, one sample per row, and in a grid of cells which corresponds to a microplate format.
Appendix B: Glossary of Terms

Cut
A function common to most software applications that removes a selection of text or graphics and places it on the clipboard. The cut function is enabled by pressing ⌘X on the Macintosh and CTRL+X in Windows.

Cut-and-Paste
A method of moving selected text or graphics from one location to a different location in the same file or into another file (which could be in an application other than SoftMax Pro).

Data Display
Located in the Plate section or CuvetteSet section, the data display is a grid that corresponds to the layout of the wells in the microplate (for specialized cuvette displays, see “CuvetteSet Section,” above). This display can show the results of the reading in various formats [for example: raw signal data (OD, RFU, RLU), raw %Transmittance (for absorbance instruments only), reduced data (number or plot), Threshold, Ranged, and Gray Scale].

Data File
Contains the raw data collected from the instrument, as well as any associated sections or settings (Notes, Graphs, Groups, Instrument Setup, Display Options, and Data Reductions).

Data Mode
Reduction option to view absorbance data as OD (absorbance) or %Transmittance.

Default Protocol
A protocol file, included with the SoftMax Pro program or created by a user, that resides in the default folder. The Default Protocol file defines the initial information that will appear when you open SoftMax Pro or when you create a new file from within the program. Both Macintosh and Windows versions of this file are called “Default Protocol”; Windows versions append the 3-character “.ppr” extension.

Desktop
The background on which windows and icons appear.

Dialog Box
A rectangular window that appears temporarily to request information. Some dialog boxes have options you must choose before SoftMax Pro can carry out a command and must be closed before you can continue in the software.

Dilution Factor
Specifies the amount of dilution for a given sample. This factor can be multiplied against interpolated values to determine concentration of undiluted sample.

Dimmed
Unavailable or disabled. A dimmed button or command is displayed in light gray instead of black and it cannot be chosen.
Double-Click
To rapidly press and release the mouse button twice while the pointer is on an object. Double-clicking carries out an action, such as opening an icon.

Drag
To move an object on the screen by clicking it, holding down the mouse button, and then moving the mouse. Also to select an item in a list by dragging through the list or to select multiple items by dragging across them.

Duplicate
A command available in the Edit menu that allows you to create identical copies (except data) of all sections and experiments. The name of the duplicated item will be the same as the previously active item with the word “Copy” appended.

Emission Spectral Scan
Measures fluorescence or luminescence across a spectrum of wavelengths for emitted light for a fixed excitation wavelength. The default value reported for each well is the wavelength of maximum emission (fluorescence or luminescence).

Endpoint
A single reading of optical density made at one or more wavelengths.

End Time
Reduction parameter used to omit the end of a Kinetic, Spectrum, or FLEX run from data reduction.

Excitation Spectral Scan
Measures fluorescence at a single emission wavelength across a spectrum of excitation wavelengths. The default value reported for each well is the excitation wavelength of maximum fluorescence.

Export
Data from SoftMax Pro is copied to a new file and formatted so that it can be opened by another program such as a spreadsheet or word processing application. Data from some or all Plate, CuvetteSet, or Group sections may be exported. Text exported from SoftMax Pro is tab-delimited.

Exponential (Curve Fit)
The exponential function used to generate this curve fit is:

\[ y = A + B \times (1 - \exp^{(x / C)}) \]

More information regarding curve fits can be found in Chapters 7 and 8.

FLEX
A read mode using fluorescence that is available with the FlexStation instrument. You can specify compound additions and trituration for individual wells. Data is collected over time, with readings taken at regular intervals (that can be less than one second—FLEX runs are measured in seconds and fractions of seconds). FLEX readings can be single- or multiple-wavelength (up to four).
FLIPR®
Molecular Devices’ FLIPR Fluorometric Imaging Plate Reader system was developed to perform cell-based, high-throughput screening (HTS) assays.

Fluorescence
The light emitted by certain substances resulting from the absorption of incident radiation. To measure fluorescence accurately, it is necessary to reduce light scatter. The governing equation for fluorescence is:

\[ \text{Fluorescence} = \text{extinction coefficient} \times \text{concentration} \times \text{quantum yield} \times \text{excitation intensity} \times \text{pathlength} \times \text{emission collection efficiency} \]

Fluorophore
A material that absorbs light energy of a characteristic wavelength, undergoes an electronic state change, and instantaneously emits light of a longer wavelength.

Four Parameter Logistic (Curve Fit)
The equation used to generate this curve fit is:

\[ y = \frac{(A - D)}{(1 + (x / C)^B)} + D \]

More information regarding curve fits can be found in Chapters 7 and 8.

Gain
The amount of increase in signal power expressed as the ratio of output to input for a photomultiplier tube.

Gray Scale Data Display
Raw or reduced data is displayed proportionally in a plate format using seven shades of gray, ranging from light shading at the low end to dark shading at the high end, based on user-defined high and low limits.

Group
Wells can be assigned to group types using the Template Editor. Depending on the default protocol used, certain group types (such as Standard or Unknown) may be created automatically; you can create others as required.

Highlight
Selecting an object or piece of text is selected so that it will be affected by your next action. Highlighted text appears in reverse video or in color. Highlighted objects may change color or be surrounded by a selection cursor.

Icon
A graphical representation of an element of the computer or software such as a disk drive, application, or file.

Import
Bringing information or data from another application into SoftMax Pro. Information can be brought into SoftMax Pro in two ways: by copying tab-delimited text to the clipboard and then pasting this information into the Plate section or CuvetteSet section within SoftMax Pro; or by using the Import command under the File menu to import ASCII text files having specific formats.
**Incubator**

Choosing **Incubator** from the **Control** menu or clicking the incubator button opens a dialog box allowing you to start or stop temperature regulation and to select an elevated temperature for the microplate chamber on instruments that have temperature control capability.

**Instrument Icon**

Located in the status bar, the instrument icon shows the status of the connection between the computer and the instrument. If the icon has an “X” through it, the connection is not functioning or no instrument is connected; if the instrument icon appears without an “X,” the connection is working properly.

**Instrument Setup**

Defines the parameters (mode, wavelengths, automatic mixing, run time, read interval, etc.) used to read the microplate or cuvette.

**Interleaved Display**

A display choice in which the wells are shown in a format that “skips” every other well as follows: all odd columns and rows begin in the upper left corner of the plate display and are followed by all even columns and rows. This display is most useful when the 384-well plate comprises four daughter plates of 96 wells each.

**Interprocess Messaging (Windows only)**

Messages that can be sent to and received from other applications. This feature is very useful for interfacing MDC Microplate System instrument with robotic systems and for sending and receiving data from LIMS systems. See Chapter 12 of this manual for information about the commands that are available and how to use them.

**Kinetic**

During Kinetic readings, data is collected over time, with multiple readings made at regular intervals (measured in seconds). The values calculated based on raw Kinetic data are Vmax, Vmax per Sec, Time to Vmax, and Onset Time. Kinetic readings can be single- or multiple-wavelength readings (up to six, if using a SpectraMax instrument other than the SpectraMax Gemini or Gemini XS which have a maximum of four, or the FlexStation which also has four).

**Lag Time**

Lag time in a Kinetic assay is the period of very slow growth (microorganisms) or the rate of reaction that may precede the rapid/linear phase of reaction. When a lag time is specified in SoftMax Pro, data collected prior to the lag time is not included in data reduction.

**Large Display**

A display choice available with 384-well plates. This setting is useful when looking at large numbers if you are using a monitor that is 17-inches or larger.

**Linear (Curve Fit)**

The linear function fits the best straight line to the data. The equation for this fit has the form of:

\[ y = A + Bx \]
where A is the y-intercept of the line and B is the slope. A linear fit should be used whenever the values appear to lie on or scattered around a straight line. More information regarding curve fits can be found in Chapters 7 and 8.

**Log-Logit (Curve Fit)**

The Log-Logit is also called a two-parameter curve fit. The equation used to generate this curve fit is:

\[ y = \frac{(A - D)}{1 + \left(\frac{X}{C}\right)^B} + D \]

More information regarding curve fits can be found in Chapters 7 and 8.

**Luminescence**

The emission of light by processes that derive energy from essentially non-thermal changes, the motion of subatomic particles, or the excitation of an atomic system by radiation.

**Mask**

Lets you “hide” the data in selected wells of the Plate display so that the data stored there will not be used for calculations and will not be reported. The Mask function is commonly used to suppress outliers.

**Maximum**

Reduction for a Spectrum scan that reports the maximum signal within the reduction parameters.

**MaxOD, MaxRFU or MaxRLU**

The limit for the maximum value you wish to use for displaying and analyzing Kinetic data or Spectrum scan data. The default is 100 OD or 20,000 RFU or RLU. Any values that are above these limits will not be shown and will be excluded from data reduction.

**Maximize Button (Windows)**

The small box containing an up arrow at the right of the title bar. Mouse users can click the Maximize button to enlarge a window to its maximum size. Keyboard users can use the Maximize command on the Control menu.

**Menu**

A list of items, most of which are commands. Menu item names appear in the menu bar at the top of the window.

To choose an item in a menu, place the pointer on the menu heading and drag to the selection you desire—then release the mouse button.

**Menu Bar**

A list of items, most of which are commands. Menu item names appear in the menu bar (the horizontal bar that appears below the title bar at the top of the window).

**Minimum**

Reduction for a Spectrum scan that reports the minimum signal within the reduction parameters.
**MinOD or MinRFU or MinRLU**

The limit for the minimum value you wish to use for display and analysis of Kinetic or Spectrum scan data. Any values that are under this limit will not be shown and will be excluded from data reduction. The default is 0. To display negative Kinetics, the value should be set below 0 (zero).

**Minimize Button (Windows)**

The small box containing a down arrow at the right of the title bar. Mouse users can click the Minimize button to reduce a window to its icon. Keyboard users can use the **Minimize** command on the **Control** menu. A minimized application continues running and you can select the icon to make it the active application.

**Modem Port (Macintosh)**

A serial communication port on some Macintosh models that is marked with the icon of a telephone handset (⊗).

**Normal Display**

The default display for 384-well plates in the Plate section.

**NVRAM**

Refers to the Non-Volatile Random Access Memory of the instrument. Information stored in the NVRAM is not lost when power to the instrument is turned off.

**Onset OD, Onset RFU, or Onset RLU**

The change in signal required to compute the onset time (for Kinetic readings).

**Onset Time**

The time it takes for a given increase in signal, called the onset OD (or RFU or RLU) to occur.

**Open/Close Triangle**

A small triangle located on the left-hand side of section and experiment tool bars. Used to open/close sections and experiments within a SoftMax Pro file.

**Optical Density, OD**

The amount of light passing through a sample to a detector relative to the total amount of light available. Optical Density includes absorbance of the sample plus light scatter from turbidity.

**Option Button (Radio Button)**

A small, round button that appears in a dialog box or window. Within a group of related option buttons, you can select only one.

**Parallel Port (Windows)**

A connection on a computer, usually LPT1, to plug in the cable for a parallel printer. Windows supports parallel ports LPT1 through LPT3.
Appendix B: Glossary of Terms

**Paste**
A function that copies the contents of the clipboard and inserts this copied information at the current selection or cursor position. The paste function is enabled by pressing \( \text{⌘V} \) on the Macintosh and \( \text{CTRL}+\text{V} \) in Windows.

**Path (Windows)**
Specifies the location of a file within the directory tree. For example, to specify the path of a file named ASSAY.BAT located in the SOFTMAX directory on drive C, you would type `c:\softmax\assay.bat`.

**PathCheck**
Instrument setup option within SoftMax Pro for the SpectraMax Plus, Plus384, 190, or 340PC that allows data collected in a Plate section to be normalized to a 1-cm pathlength. PathCheck is covered by U.S. Patent Number 5,959,738.

**Photomultiplier Tube (PMT)**
A vacuum tube that detects light especially from dim sources through the use of photoemission and successive instances of secondary emission to produce enough electrons to generate a useful current.

**Pipette Tips (FlexStation only)**
The FlexStation instrument requires the use of pipette tips which are kept in a separate instrument drawer. Molecular Devices suggests that you load a complete set of pipette tips each time you make a run to ensure that sufficient tips are always available. Please see the instrument manual for the FlexStation regarding the types of tips that can be used with this instrument and how they should be loaded.

**Plate Section**
The Plate section is used to display data, to specify how microplates will be read, and to define how the data received from the instrument should be reduced. The data display in this section is a matrix that corresponds to the well format of the microplate in use.

**Plate Type**
A choice in the Instrument Settings dialog that determines the type of microplate being read. The specification of the plate type depends on the well format and manufacturer of the microplate.

**Point (Using the Mouse)**
You point to an object on the screen by moving the mouse so that the pointer is positioned on that object. When the pointer is an arrow, the tip of the arrow must be on the object.

**Point-to-Point**
This curve-fitting option fits a linear equation to each pair of data points.

**Port**
A connection or socket on the computer. Ports are common used for connecting devices, such as printers or monitors, to your computer, and for sending information to and/or from your computer to such devices.
**Protocol File**
Contains the template(s), instrument settings, and reduction parameters. Protocol files are useful if you repeat a particular type of assay frequently.

**Quadratic (Curve Fit)**
A mathematical description of a parabola:

\[ y = A + Bx + Cx^2 \]

**RAM (Random Access Memory)**
The memory that can be used by applications to perform necessary tasks while the computer is on. When you turn the computer off, all information in RAM is lost.

**Ranged Data Display**
Raw or reduced data is assigned proportionally to integer values from 0 through 9 based on user-defined limits. Values above the high limit are displayed as plus (+) and values below the low limit are displayed as minus (-).

**Raw Data**
Signal reported from the MDC Microplate System instrument with no alteration. This will be reported as OD, RFU, or RLU, depending on the instrument type.

**Read Interval**
The interval of time between the start of one reading and the start of the next reading during a Kinetic or FLEX run.

**Read Button or Command**
Starts the reading process and shows the Endpoint, Kinetic, Spectrum, Well Scan, or FLEX data in the data display of the Plate or CuvetteSet section.

**Read Mode**
The method used to read the microplate or cuvette: Endpoint, Kinetic, Spectrum, Well Scan, or FLEX. Note that not all modes are available with all instruments.

**Read Type (fluorescence instruments only)**
The type of reading performed in the instrument: choose fluorescence, time-resolved fluorescence, or luminescence.

**Readings per Well**
The number of times (settable by the user) that readings are taken on a well in fluorescence and time-resolved fluorescence modes. This setting also determines the amount of time that data is collected in luminescence mode.

**Reduced Data**
Data reduction causes the raw signal values reported by the instrument to be calculated and displayed according to user-defined formula settings.
**Reduction Limits**
Sets limits on data to be included in reduction for Kinetic, Spectrum, Well Scan, or FLEX readings.

**Reference**
A reading of buffer or water taken in the cuvette that is used as \( I_0 \) to calculate Absorbance or %Transmittance of sample read in the cuvette port.

**Relative Fluorescence Units**

**Relative Luminescence Units**

---

**Restore Box (Windows)**
The small box containing both an up and a down arrow at the right of the title bar. The Restore box appears only after you have enlarged a window to its maximum size. Mouse users can click the Restore box to return the window to its previous size. Keyboard users can use the **Restore** command on the **Control** menu.

**Rotated Display**
A display option for 384-well plates that shows the plate rotated 90 degrees.

**Scroll**
To move up, down, right, or left through text or graphics in order to see parts of the file or list that cannot fit on the screen. A scroll bar appears at the bottom and/or right edge of a window whose contents are not entirely visible. Each scroll bar contains a scroll box and two scroll arrows. A scroll box is a small box that shows the position of information currently in the window or list box relative to the contents of the entire window. A scroll arrow is an arrow on either end of a scroll bar that you can use to scroll through the contents of the window or list box.

**Semi-Log (Curve Fit)**
The semi-log function fits the best straight line to a set of data for \( \log(X) \) plotted against \( Y \). The resulting curve displayed will be a straight line with the X-axis drawn in logarithmic scale.

**Serial Port (PC/Windows)**
A connection on a computer, usually COM1, where you plug in the cable for a serial device such as a plate reader, a printer, or a modem. Serial, asynchronous, and RS232 interfaces are all the same type by which the computer sends single bits of information to the connected device, one after the other. Windows supports COM1 through COM10. MDC Microplate System instruments require COM1 or COM2.

**Series**
The Series function allows you to work with groups of wells in the Template so that the standard value or dilution factor increases or decreases in specified steps. The name can be incremented as well.
Appendix B: Glossary of Terms

Slope
A reduction option that determines the slope of the combined plot (i.e., the slope of the line using linear regression after the wavelength combination reduction). This reduction uses all timepoints visible in the reduction window. Slope is the same as Vmax Rate when Vmax Rate is set to the same number of points as the run (i.e., the default). Slope is not the same as Vmax Rate if you have modified the number of Vmax Points.

Spectrum
This read mode allows you to collect absorbance or fluorescence data across a spectrum of wavelengths. This data is displayed as OD, RFU, or RLU versus wavelength. The default reduction displays the wavelength that corresponds to the maximum signal.

Standard Curve
A mathematically idealized representation of the relationship between the concentration of a standard calibrator (X-value) and the OD/RFU/RLU (Y-value). The standard curve may be set to a linear, semi-log, log-log, quadratic, 4-parameter logistic, log-logit (2-parameter logistic), exponential, cubic spline, or point-to-point curve fits.

Status Bar
Shown above the SoftMax Pro window, the Status Bar contains the instrument icon, the current temperature within the microplate chamber of the instrument, and buttons allowing you to activate the Read function, the incubator, Automix, and to open or close the drawer(s) of the instrument (note: not all functions are available with all instruments).

Stokes Shift
The difference between the wavelengths of the excitation and emission peaks.

Template Editor
A representation of the microplate or a set of cuvettes shown as a grid of wells that can be used to designate the location of blanks, standards, controls, unknowns, empty wells, or to assign wells to other groups you create. The template is a map of the microplate. It tells the software what is in the various wells of the microplate or cuvette.

Threshold Data Display
Data is displayed as plus (+) for values above, asterisk (*) for values within, and minus (-) for values below user-defined limits.

Time at Half Maximum
Reduction for a Kinetic or FLEX run that reports the time at half the maximum signal within the reduction limits as follows: SoftMax Pro first determines the point (within the reduction limits) that has the maximum signal level. It then scans the plot from left to right until it finds two points that have signals bracketing one-half of that signal value. A linear interpolation between these two points is used to estimate the Time at Half Maximum.
Appendix B: Glossary of Terms

**Time at Maximum**
Reduction for a Kinetic or FLEX run that reports the time at the maximum signal within the reduction limits.

**Time at Minimum**
Reduction for a Kinetic or FLEX run that reports the time at the minimum signal within the reduction limits.

**Time-Resolved Fluorescence**
Most fluorescence substances are not suitable for this type of reading. However, the fluorescence emitted by lanthanide dyes is delayed long enough to measure fluorescence after the lamp is turned off. Time-resolved fluorescence is used to reduce the amount of background noise which interferes with fluorescence. The excitation lamp flashes and, after it is off, the delayed emission is collected for a set period of time before the lamp flashes again.

**Time to Vmax**
The elapsed time until the maximum reaction rate of a Kinetic or FLEX reading is reached, reported in seconds.

**Title Bar**
The horizontal bar (at the top of a window) that contains the title of the window or dialog box. On many windows within the Windows environment, the title bar also contains the Control-menu box and Maximize and Minimize buttons. On the Macintosh, the title bar also contains the Close box and Zoom box.

**%Transmittance, T**
The ratio of transmitted light to the incident light (for absorbance readings).

\[ \%T = \left( \frac{I}{I_0} \right) \times 100 \]

**Triturate (FlexStation only)**
To mix a solution by means of aspirate and dispense cycles.

**Undo**
Cancels the previous operation (if possible). The paste function is enabled by choosing **Undo** from the **File** menu, pressing `⌘ V` on the Macintosh, or pressing `CTRL+V` in Windows.

**USB (Universal Serial Bus) Port**
A serial communications port found on some Macintosh and PC computers. An adapter may be required to connect your computer to this port (see Chapter 2 for more information).

**User Name**
The User Name is the name of the person who reads data into the shielded file. The User name is entered after the [Read] button is pressed but before the reading begins.
Vertical Display
A display option for 384-well plates which shows the plate as two $8 \times 12$ arrays stacked vertically.

Vmax Points
The number of points in the Kinetic or FLEX curve included in each of a series of regressions to calculate the maximum rate, Vmax, or the time segment used to calculate the Time to Vmax.

Vmax
The rate reported as signal/min (milli-OD, RFU, or RLU units per minute) for a Kinetic or FLEX reading. It is calculated using a linear curve fit, $y = Ax + B$. A creeping iteration is performed using Vmax Points and the slope of the steepest line segment is reported as Vmax Rate. It may also be reported as units per second (the default for fluorescence and luminescence).

Wavelength(s)
Specifies the wavelength(s) that will be used to read the microplate.

Well Graph
One or more wells in a plate section having data shown in plots format may be expanded by selecting them and clicking the Graph button on the Plate section tool bar. This selection is valid only with data shown in plots format.

Well Scan (SpectraMax Gemini/Gemini XS and FlexStation only)
Some applications involve the detection of whole cells in large-area tissue culture plates. Well Scan mode can be used with such microplates to allow maximum surface area detection in whole-cell assays. Since many cell lines tend to grow as clumps or in the corners of microplate wells, you can choose from several patterns and define the number of points to be scanned to work best with your particular application.

Zoom Box (Macintosh)
A small box containing a smaller box at the right of the title bar. You can click the Zoom box to return the window to its previous size.
**Index**

### Symbols

* % Baseline with Multiplier 8-34
* %Transmittance 1-4, 4-9, 4-11, 4-16, 7-12, 7-18, 7-24, 7-36, 7-37, 9-20, B-5, B-13, B-15

### Numerics

1-Ref 7-39
4-Parameter (curve fit) 7-59, 8-57

### A

About SOFTmax PRO 3-26
Absolute values 7-18, 7-31, 7-32, 8-24, 8-25, 8-28, 8-34
Absorbance 1-3, 1-4, 4-11, 4-16, 7-18, 7-24, 7-37, B-1, B-5, B-10, B-13
Active 3-9, 3-10, 3-11, 3-24, 3-26, 3-27, 3-28, 3-30, 3-34, B-1
Add Software (Enterprise Administrator) 6-19
Add Statements 6-29
Administrator 6-5
Administrator Login 6-8
Alerts 11-3
ANSI Character Set B-1
AppleTalk 2-4, 11-12, 11-13
Area Under Curve 4-10, 5-11, 7-33, 7-35, 7-36, 7-37, 8-26, 8-28, 8-29, 8-30, 8-33, B-1
ASCII
  * Character Set B-1
    * file 2-21, 3-16, 3-18, 3-26, 3-34, 3-36, B-7
      * string-based messaging 3-40
Assays
  * folder 2-23, 3-24, 9-3, 9-4, 12-10
  * menu 2-23, 3-24, 3-32, 9-3, 9-4, 12-10
Audit Trail 6-12, 6-25
Author name B-1
AutoCalibrate 4-4, 4-18, 4-39, 4-40, 4-44, 5-4, 5-18, 5-34, 5-43, B-2
Automix 3-31, 4-4, 4-5, 4-10, 4-17, 4-43, 5-4, 5-11, 5-17, 5-38, 5-44, B-2, B-14
button 3-7, 3-8
AutoPrint 2-22, 3-29, 9-11, 11-12
Preferences setting 2-16
with ROBOmax 9-10

### B

Background
  * Constant subtraction 4-15, 4-19, 7-23
  * Interference 4-15, 5-14, 5-15
  * interference 4-15
Baud B-2
Blanking 4-33, 4-34, 5-30, 5-31, B-2, B-3, B-14
  * blanks in combination 4-34, 5-31
  * CuvetteSet section B-2
  * group-associated blanks 4-33, 4-34, 5-31, B-2, B-3
  * plate blank 4-33, 5-31, 7-26, 10-12, 11-14, B-3
  * pre-read plate blank 3-31, 4-15, 4-19, 4-33, 5-30, 7-26, 7-37, B-2
  * Ref 4-33, B-2
  * template blank 4-34, B-2
Bottom Read B-3

### C

Cable connections 2-7, 2-16, 11-10, 11-11
  * Macintosh 2-3, 2-4, 11-12
  * PC 2-5, B-10, B-13
Calculation
  * dialog box 3-14, 3-20, 7-38, 7-46, 7-47, 8-36, 8-44, 8-45
  * hierarchical 7-23, 8-19
Calibration 3-31, 4-44, 5-11
Change Password (Enterprise Administrator) 6-20
Checkbox B-3
Chooser 2-4, 3-27, 9-11, 9-15, 11-12, 11-13
Clear (command) 3-28, B-3
Clear button 4-21, 4-23, 4-28, 5-20, 5-22, 5-26

Close (command) 3-26
Close Drawer (command) 3-31
Column
  adding/deleting 3-28, 7-41, 7-45, 8-38, 8-42, 8-43
  Autosize 3-20, 3-38, 7-43, 8-40, 10-26, 10-58
  copy/paste 9-27
Create (command) 3-20, 3-38
editing 3-20, 3-38, 7-41, 7-43, 7-44, 8-38, 8-40, 8-41
enlarge 7-42, 8-39
format 4-25, 5-23
formulas 7-45, 8-43
  copy/paste 9-27
  editing 7-43, 8-40
  modifying 7-44, 8-41
  showing/hiding 3-20, 7-41, 8-38
hiding 3-38, 7-41, 7-42, 8-38, 8-39
reference to other 7-45, 8-43
resizing 7-41, 7-42, 8-38, 8-39
showing 3-38
showing/hiding formulas 3-20, 7-41, 8-38
text format 7-47, 8-45
Column vs. wavelength priority (reading) 4-44, 5-35
Communication
  instrument icon 2-15
  ports—Preferences setting 2-16
  problems 11-10
  serial port 2-16
Connect Points 7-65, 8-62
Connections
  to Macintosh 2-3, 2-4
  to PC 2-5
Control menu box (Windows) B-4
Copy 9-25, B-4
  command 3-28, 9-25
  formulas 9-27
Group columns 9-27
Plate data 9-25
pre-read data 4-15
template 9-25
Create Column (command) 3-38, 7-45, 8-42
Create Summary (command) 3-36, 3-38, 7-46, 7-47, 8-44, 8-45
Cross-platform files 9-7
Cubic Spline (curve fit) 7-62, 8-59, B-4
Curve fit 7-53, 7-54, 8-51, 8-52, B-4
  4-Parameter 7-59, 8-57
Cubic Spline 7-62, 8-59, B-4
Exponential 7-63, 8-60, B-6
judging a good fit 7-64, 8-61
Linear 7-55, 8-53, B-8
Log-Log 7-57, 8-55
Log-Logit 7-59, 8-57, B-9
minimum number of standards 7-64, 8-61
Point-to-Point 7-61, 8-59, B-11
Quadratic 7-58, 8-56, B-12
Semi-Log 7-55, 7-56, 8-53, 8-54, B-13
Custom formulas 7-67, 8-64
  reduction 7-38, 8-35
Cut (command) 3-28, B-5
Cutoffs 5-15, B-4
CuvetteSet
  menu commands/buttons 3-17, 3-35
  reduction options 7-4, 8-4
  resizing the display 7-11, 7-12
  section 3-17, 7-4, B-4
  data display 7-4
  Settings (command) 3-36

D
Data
  exporting/importing 9-16, 9-21
Data display 4-45, 5-36, 5-52, 7-3, 7-4, 7-5, 7-41, 8-3, 8-4, 8-5, 8-38, 10-22, 10-54, B-5
  Gray Scale 7-15, 7-17, 8-11, 8-14
  Group section 7-41, 8-38
  limits 7-15, 8-11
  Ranged 7-15, 7-16, 8-11, 8-12
  reduced number 7-14, 8-8
  Threshold 7-15, 8-11
  well graph 4-45, 5-36, 5-52, 7-18, 8-14
Data file 2-9, 2-10, 7-3, 8-3, 9-5, B-5
  locating 9-5
Data mode (%T/Absorbance) 7-37, 9-20, B-5
Data points 7-30, 7-31, 7-64, 7-67, 8-23, 8-24, 8-61, 8-64, 11-14
  one or more points lost 11-6
Data reduction 1-3, 7-23, 8-19
  calculation, hierarchical 7-23, 8-19
Database (Enterprise Administrator) 6-8
Default protocol 9-3, B-5
Delete (command) 3-9, 3-10, 4-21, 5-20
Delete Section (command) 3-28
Desktop B-5
Dialog box B-5
Dilution factor B-5
Dimmed B-5
Display
  command 3-33, 3-35
  default settings 7-6, 7-12, 8-6, 8-8
  dialog box 7-6, 8-6
  options 9-17
  parameters 7-3, 8-3
  problems 11-14
  reduced number 7-14, 8-8
Drawer button 3-8
Dual wavelength 7-39
Duplicate (command) 9-27, B-6

E
Edit Column (command) 3-38
Edit Summary (command) 3-36, 3-38
Emission scan (spectral) B-6
End (wavelength) nm 7-36, 8-29
End Time 7-28, 7-31, 8-21, 8-23
Endpoint 1-3, 4-9, 5-10, 7-27, 8-21
  display defaults 7-6, 8-6
  reduction 7-27, 8-21
Enlarged well graphs 7-18, 8-14
Enterprise Administrator Pre-Installation
  Information 6-3
Enterprise Edition 6-28
Error bars 7-53, 8-51
Error messages 11-8
  pasted text 11-8
E-Statements 6-29
Excitation scan (spectral) B-6
Experiment
  active 3-9, 3-30
  menu 3-30
  section 3-8
Exponential (curve fit) 7-63, 8-60, B-6
Export
  command 3-26, 9-16
  data 9-16
  format 2-17
    Preferences setting 2-16, 9-16
Export (Enterprise Administrator) 6-24
Export Options (Enterprise Administrator) 6-12

F
File
  autosaving 9-9
  creating 9-3, 9-5
  cross-platform 9-7
  data 2-9, 2-10, 9-5
  management 9-3, 9-5
  menu 3-26
  name
    number of characters allowed 9-5, 9-9
  opening 9-6
    SoftMax 9-6
  protocol 2-9, 9-5
  saving 9-8, 10-21, 10-53
  saving manually 9-8
  stationery 10-21, 10-53
File protection 9-29
File sheilding 9-29
Filename extensions 2-10
Fluorescence 1-3, 5-34, 5-51
Fluorophore B-7
Format text 9-14
Formula 7-67, 8-64
  column 7-45, 8-43
  copy 9-27
  custom 7-67, 8-64
  custom reduction 7-38, 8-35
  editing 7-43, 8-40
  help 1-9
  plot 7-47, 8-45
  summary 7-46, 8-44
Formula (button) 7-38, 8-36
G
G4 2-4
Global Options 6-22
Glossary of Terms B-1
Graph 7-47, 8-45
  command 3-33, 3-35
  connect points 7-65, 8-62
  copying 9-25
  curve fit 7-53, 7-54, 8-51, 8-52
  error bars 7-53, 8-51
  formulas 7-47, 8-45
  menu 3-37
  options 7-65, 8-62
     axes 7-67, 8-64
     bar 7-66, 8-63
     button 7-19, 8-16
     defaults 7-65, 8-62
     scatter 7-65, 8-62
     standard curve 10-31
     summary 7-47, 8-45
Graph section 3-10, 3-21, 7-47, 7-54, 8-45, 8-52
  curve fit 7-53, 7-54, 8-51, 8-52
  menu commands/buttons 3-22
  plots 7-54, 8-52
Graph Type (command) 3-37, 7-65, 8-62
Graphing wells 7-18, 8-14
Gray Scale display 7-15, 7-17, 8-11, 8-14
Group 3-10, 3-19, 10-25, 10-57
  blank (plate blank) 10-12
  boundaries 4-21, 4-22, 5-20, 5-21
  columns 10-25, 10-57
     adding 7-45, 8-42
     copy/paste 9-27
     formulas 7-43, 7-45, 8-40, 8-43
  customizing 3-10
  menu 3-38
  sample descriptor 4-31, 5-29
  sample name 4-31, 5-28
  series 4-31, 5-29
  Template Editor 4-20, 5-19
  text format 9-14
  units 10-12
Group section 7-41, 8-38
  menu commands/buttons 3-20
Group Settings (command) 3-38
Group Settings (dialog box)
  assign area 4-29, 5-27
  sample area 4-28, 5-26
  sample descriptor 4-25, 5-23
Group-associated blanks 4-33, 4-34, 5-30, 5-31, B-2, B-3
Groups Page 6-11

H
Help 1-9, 1-10
  formula 1-9
  hypertext links 1-12
  search function (Windows) 1-11
Hide (command) 3-38, 7-42, 8-39
Hide Formulas (command) 7-43, 8-40
Hide Replicates (command) 3-38
Highlight B-7

I
Icon, instrument 2-15
Idle Time-out 6-10
iMac 2-4
Import 9-21
  Criterion 9-21
  data 9-21
  FLIPR 9-21
Import/Export 9-21
Importing data 9-21
Incubator (command) 3-31
Incubator button 3-8
Installation 2-8
Installation (Enterprise Administrator) 6-7
Instrument settings 3-23, 4-4, 5-4, 5-38, 10-9, 10-38
  mode 4-9, 5-10, 5-40
  read type 5-13
  summary 4-5, 5-5
  wavelengths 4-11
Instrument Setup (command) 3-31
Interpolate Raw Data 8-34
Interpolate Wells 9-16

K
Kinetic 1-3, 4-10, 5-11, 7-28, 8-21
  display defaults 7-6, 8-6
  interval 4-10, 5-11, 5-44
  limits 7-28, 8-21
  negative OD values 7-28, 8-21
  reduction 7-28, 7-33, 8-21, 8-26, 8-30
  run time 4-10, 5-11, 5-44

L
Lag Time 7-28, 7-30, 8-21, 8-23
Lambda at Maximum 7-37, 8-30
Lambda at Maximum/Minimum 7-37, 8-30
Large Display B-8
License (Enterprise Administrator) 6-26
License Page 6-13
Limits
  data display 7-15, 8-11
  MaxOD 7-28, 7-36, 8-21, 8-29
  MinOD 7-36, 8-29
  Linear (curve fit) 7-55, 8-53, B-8
  Lock software after three logon attempts 6-10
  Log-Log (curve fit) 7-57, 8-55
  Log-Logit (curve fit) 7-59, 8-57, B-9
  Luminescence B-9

M
  Macintosh
    computer 2-6
    memory insufficient 11-16
    problems 11-15
    software 2-8
  Mask 7-22, 8-18
    button 7-22, 8-18
    command 3-33, 3-35, 7-22, 8-18
    wells or cuvettes 7-22, 8-18
  Mask (command) 7-22, 8-18
  Max Lambda 7-37, 8-30
  Maximum 7-36, 8-29
  Maximum (reduction) B-9
  Max-Min 8-33
  MaxOD 7-28, 7-32, 7-36, 8-21, 8-29, B-9
  MaxRFU/RLU 8-21, 8-25, B-9
  Mean 8-33
  Memory
    insufficient (Macintosh) 11-16
Menu
  Assay 3-32
  bar 3-4
  CuvetteSet 3-35
  Experiment 3-30
  File 3-26
  Graph 3-37
  Group 3-38
  Notes 3-36
  Plate 3-33
  View 3-30
Message boxes 11-3
Minimize (command) 3-30
Minimum 7-36, 8-29
Minimum (reduction) B-9
MinOD 7-28, 7-30, 7-36, 8-29, B-10
MinRFU/RLU 8-21, 8-22, 8-29, B-10
Mode 4-9, 5-10, 5-40
  Endpoint 4-9, 5-10
  FLEX 1-4, 5-40
  Kinetic 4-10, 5-11
    interval 4-10, 5-11, 5-44
    run time 4-10, 5-11, 5-44
  Spectrum 4-11, 5-12
  Well Scan 1-4
  Modem port 2-16
  Molecular Devices Technical Service 11-3
N
  New (command) 3-26, 9-5
  New Window (command) 3-34, 3-36, 3-37, 3-38
  Non-Volatile RAM B-10
  Normal Display B-10
  Notes menu 3-36
  Notes section 3-9, 3-13, 7-47, 8-45
    text format 9-14
  Notes Settings (command) 3-37
  NVRAM B-10
O
  OD values, absolute 7-18, 7-31, 7-32, 8-24, 8-25,
    8-28, 8-34
  Onset Time 4-10, 5-11, 7-35, 8-28, 8-32
  Open (command) 3-26, 9-6
  Optical density (OD) 4-39, B-1, B-10
  Option button (radio button) B-10
P
  Page Setup (command) 3-6, 3-27, 7-45, 8-42
  Parallel Port (Windows) B-10
  Partial plate read 4-18, 5-18, 5-43
  Password 6-7
  Password Aging 6-10
  Password protection 9-29
    author name B-1
    changing 9-31
    setting 9-31
    user name B-15
  Paste 9-25, B-4
    command 3-28, 9-25
    Group columns 9-27
    pre-read data 4-15
  PathCheck 4-14, 7-26, 7-27
  Pathlength correction 4-14, 7-26, 7-27
  Peak 8-33
  Percent Baseline with Multiplier 8-34
  Permissions 6-5
  Plate blanks 4-33, 4-34, 5-30, 5-31, B-2, B-3
Plate menu 3-33
Plate section 3-9, 3-15, 7-4
  data display 4-45, 5-36, 5-52, 7-4, 7-5, 8-5, 10-22, 10-54
instrument settings
  summary 4-5, 5-5
menu commands/buttons 3-16
reduction options 7-4, 8-4
Plate Settings (command) 3-34
Plots 7-47, 7-54, 8-45, 8-52
  command 7-47, 8-45
PMT
  sensitivity 5-43
Point-to-Point (curve fit) 7-61, 8-59, B-11
Port B-11
Preferences 2-16
  command 3-29, 9-9
Pre-Installation (Enterprise Administrator) 6-5
Pre-read plate blanks 4-19, 4-33, 4-34, 5-30, 5-31, B-2, B-3
  copy/paste data 4-15
Print (command) 3-27, 9-14
Print Section (command) 3-27
Printing 9-11
  Autoprint 9-11
  options 9-11
  problems 11-14
  report 9-11, 9-12, 10-34, 10-67
    including/excluding sections 9-12
  section 9-11
  order 9-12
  setup 9-11
  template 9-11
  well graph 7-21, 8-17, 9-11
PrintShop
  Conflict with SOFTmax PRO 11-15
privileges 6-14
Protocol file 2-9, 9-4, 9-5
  default 9-3, B-5
  locating 9-5
  saving 10-21, 10-53

R
Radio button (option button) B-10
RAM (Random Access Memory) B-12
Ranged display 7-15, 7-16, 8-11, 8-12
Read 4-40, 5-34, 5-51, 10-22, 10-54
  button 3-8
    command 3-31, 4-40, 5-34, 5-51
  cuvette 4-39, 4-41, 5-51
  entire plate 4-18, 5-18
  microplate 4-39, 4-40, 5-34, 5-51
  mode 4-9, 5-10, 5-40
    Endpoint 1-3, 4-9, 5-10
      FLEX 5-40
      Kinetic 1-3, 4-10, 5-11
      Spectrum 1-3, 4-11, 5-12
      Well Scan 1-4
      partial plate (Strips) 4-18, 5-18, 5-43
      priority 4-44, 5-35
      strips 4-18, 5-18, 5-43
      wells to read 5-43
Read type 5-13
Reader (pop-up menu) 2-18
Recalculate Now (command) 3-29, 7-40, 8-37
Recalculation options 7-40, 8-37
Reduced Number (display) 7-14, 8-8
Reduction 1-3, 7-4, 7-23, 7-26, 8-4, 8-19
  command 3-33, 3-35
  custom formula 7-38, 8-35
  defaults 7-27, 7-28, 7-33, 7-36, 8-21, 8-26, 8-29, 8-30
  kinetic 7-33, 8-26
  options 7-4, 8-4
  parameters 7-3, 8-3
  spectrum 7-36, 8-29
Reduction Display Options 8-34
Ref (Cuvette Set) 4-33
Ref button 3-8
Reference
  problems 11-15
  reading 4-41
Registration dialog box 2-13
Replicates 4-30, 5-27
Report 9-12
  customizing 9-12
  default setting 10-34, 10-67
  printing 9-11, 9-12, 10-34, 10-67
    including/excluding sections 9-12
Report (Enterprise Administrator) 6-23
Report Page 6-12
RFU/RLU values, absolute 7-18, 7-31, 7-32, 8-24, 8-25, 8-28, 8-34
ROBOmax 9-10

Q
Quadratic (curve fit) 7-58, 8-56, B-12
Quit (command) 3-27
S
Sample descriptor 4-25, 5-23
Save (command) 3-26, 9-5, 9-8, 10-21, 10-53
Save As (command) 3-26, 9-5, 9-8
Saving files manually 9-8
Scroll B-13
Scroll bar 3-11
Section 3-9
active 3-10, 3-11, 3-24, 3-27, 3-28, 3-30, 3-34, B-1
changing order 9-13
creating 3-10
CuvetteSet 3-17
deleting 3-9, 3-10
Graph 3-10, 3-21, 7-47, 7-54, 8-45, 8-52
curve fit 7-53, 7-54, 8-51, 8-52
options 7-65, 8-62
plots 7-54, 8-52
Group 3-10, 3-19, 7-41, 8-38, 10-25, 10-57
columns 10-25, 10-57
customizing 3-10
text format 9-14
inactive 3-10
Notes 3-9, 3-13, 7-47, 8-45
text format 9-14
opening/closing 3-12
order 9-13
Plate 3-9, 3-15
printing order 9-12
relationship 7-3, 8-3
tool bar 3-11
Security Menu 6-28
Select All (command) 3-28
Semi-Log (curve fit) 7-55, 7-56, 8-53, 8-54, B-13
Sensitivity
PMT 5-43
Serial port 2-16, 11-10, B-13
G4 2-4
iMac 2-4
Series 4-30, 4-31, 5-27, 5-29
replicates 4-30, 5-27
Shielding 9-29
Show All (command) 3-38, 7-42, 8-39
Show Formulas (command) 3-37, 3-38, 7-43, 7-46, 7-47, 8-40, 8-44, 8-45
Sign Statement 6-32
Signatures 6-32
Size box 7-21, 8-17
Slope 7-35, 8-28, 8-33, B-14
Smoothing 8-33
SoftMax files 9-6

SoftMax Pro
earlier version files 9-6
What’s New 1-4
Specifications
Macintosh computer requirements 2-6
Windows-compatible computer 2-7
Spectral emission scan B-6
Spectral excitation scan B-6
Spectrum 1-3, 4-11, 5-12, 7-36, 8-29, B-14
display defaults 7-6, 8-6
Speed Read 4-13
Standard curve 7-64, 8-61, 10-31
Standards, minimum number 7-64, 8-61
Start and End (wavelengths) 7-36, 8-29
Statement 6-29
Stationery file 10-21, 10-53
Status bar 3-4, 3-7, 4-43, 5-35, 5-52
Stokes shift B-14
Strips 4-18, 5-18
Summary 7-46, 7-47, 8-44, 8-45
adding/editing 7-41, 7-46, 8-38, 8-44
aligning 7-46, 8-44
formula 7-46, 8-44
line up with column 7-46, 8-44
moving 7-46, 8-44
plot 7-47, 8-45
Suspend Recalculation (command) 3-29, 7-40, 8-38

T
Temperature display 3-7
Template 3-9, 4-22, 5-21
blanks 4-34
clear 9-26, B-3
command 3-33, 3-35
copy/paste 4-35, 5-33, 9-25
groups 4-20, 4-21, 5-19, 5-20
hierarchy 4-21, 5-20
import/export 4-37, 9-24
samples 4-21, 5-20
selecting wells 4-22, 5-21
series 4-30, 5-27
fill direction 4-31, 5-29
Template Editor 3-33, 3-35, 4-20, 4-22, 5-19, 5-21, 5-51, 10-12, 10-48
Group area 4-23, 5-22
tool bar 4-23, 5-21
Text
format 9-14
Text Style (command) 3-29, 9-14
Threshold display 7-15, 8-11
Time at 1/2 Maximum 7-35, 8-28, 8-32, B-14
Time at Maximum 7-35, 8-28, 8-32, B-15
Time at Minimum 7-35, 8-28, 8-32, B-15
Time to Vmax 4-10, 5-11, 7-34, 8-27, 8-32
Time-resolved fluorescence B-15
Title Bar B-15
Title screen 2-13, 2-14, 3-3
ToolBar 3-11
Transmittance (%T) 1-4, 4-9, 4-11, 4-16, 7-12,
7-18, 7-24, 7-36, 7-37, 9-20, B-5, B-13, B-15
Troubleshooting
  Technical Support 1-12

U
Undo (command) 3-28, B-15
Uninstall 2-9
Units (group) 10-12
User name B-15
Users Page 6-10

V
Values, absolute 7-18, 7-31, 7-32, 8-24, 8-25,
  8-28, 8-34
Vertical Display B-16
View menu 3-30
Vmax 4-10, 5-11, 7-33, 8-26, 8-31
Vmax (kinetic reduction) 7-33, 8-26, 8-31
Vmax Points 7-18, 7-29, 7-30, 7-33, 7-34, 8-15,
  8-22, 8-23, 8-26, 8-27, 8-31, 8-32

W
Wavelengths 4-11
  Spectrum 4-13, 5-15
Well graph 7-18, 7-21, 8-14, 8-17
  printing 7-21, 8-17, 9-11
Well Scan 1-4
Wells
  graphing 7-18, 8-14
  masking 7-22, 8-18
  selecting in template 4-22, 5-21
Wells to Read 5-18, 5-43
Window
  active 3-26, 3-34, B-1
  Page Setup command 3-6
  scroll bar 3-11
  size 3-6, 3-12
  sizing 7-21, 8-17
Windows-compatible computer requirements 2-7

X
X-axis (command) 3-37, 7-67, 8-64